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Getting Started

* “Curve Fitting Toolbox Product Description” on page 1-2
+ “Curve Fitting Tools” on page 1-3

*  “Curve Fitting” on page 1-4

* “Surface Fitting” on page 1-6

* “Spline Fitting” on page 1-8



1 Getting Started

Curve Fitting Toolbox Product Description

Fit curves and surfaces to data using regression, interpolation, and smoothing

Curve Fitting Toolbox™ provides an app and functions for fitting curves and surfaces to
data. The toolbox lets you perform exploratory data analysis, preprocess and post-process
data, compare candidate models, and remove outliers. You can conduct regression
analysis using the library of linear and nonlinear models provided or specify your

own custom equations. The library provides optimized solver parameters and starting
conditions to improve the quality of your fits. The toolbox also supports nonparametric
modeling techniques, such as splines, interpolation, and smoothing.

After creating a fit, you can apply a variety of post-processing methods for plotting,
interpolation, and extrapolation; estimating confidence intervals; and calculating
integrals and derivatives.

Key Features

+  Curve Fitting app for curve and surface fitting
* Linear and nonlinear regression with custom equations
* Library of regression models with optimized starting points and solver parameters

* Interpolation methods, including B-splines, thin plate splines, and tensor-product
splines

*  Smoothing techniques, including smoothing splines, localized regression, Savitzky-
Golay filters, and moving averages

*  Preprocessing routines, including outlier removal and sectioning, scaling, and
weighting data

+ Post-processing routines, including interpolation, extrapolation, confidence intervals,
integrals and derivatives



Curve Fitting Tools

Curve Fitting Tools

Curve Fitting Toolbox software allows you to work in two different environments:

* An interactive environment, with the Curve Fitting app and the Spline Tool

A programmatic environment that allows you to write object-oriented MATLAB® code
using curve and surface fitting methods

To open the Curve Fitting app or Spline Tool, enter one of the following:

+ cftool. See Curve Fitting.
+ splinetool

To list the Curve Fitting Toolbox functions for use in MATLAB programming, type
help curvefit

The code for any function can be opened in the MATLAB Editor by typing

edit function_name

Brief, command line help for any function is available by typing

help function_name

Complete documentation for any function is available by typing

doc function_name

You can change the way any toolbox function works by copying and renaming its file,
examining your copy in the editor, and then modifying it.

You can also extend the toolbox by adding your own files, or by using your code in
combination with functions from other toolboxes, such as Statistics and Machine
Learning Toolbox or Optimization Toolbox software.


http://www.mathworks.com/products/statistics/
http://www.mathworks.com/products/statistics/
http://www.mathworks.com/products/optimization/

1 Getting Started

Curve Fitting

1-4

Interactive Curve Fitting

To interactively fit a curve, follow the steps in this simple example:

1

Load some data at the MATLAB command line.

load hahnl
Open the Curve Fitting app. Enter:

cftool
In the Curve Fitting app, select X Data and Y Data.

Curve Fitting app creates a default interpolation fit to the data.

Choose a different model type using the fit category drop-down list, e.g., select
Polynomial.

Try different fit options for your chosen model type.
Select File > Generate Code.

Curve Fitting app creates a file in the Editor containing MATLAB code to recreate
all fits and plots in your interactive session.

For more information about fitting curves in the Curve Fitting app, see “Interactive
Curve and Surface Fitting” on page 2-2.

For details and examples of specific model types and fit analysis, see the following

sections:

1 “Linear and Nonlinear Regression”
2 “Interpolation”

3  “Smoothing”

4  “Fit Postprocessing”

Programmatic Curve Fitting

To programmatically fit a curve, follow the steps in this simple example:

1

Load some data.



Curve Fitting

load hahnl

Create a fit using the it function, specifying the variables and a model type (in this
case rat23 is the model type).

f = fit( temp, thermex, "rat23" )
Plot your fit and the data.

plot( ¥, temp, thermex )
f( 600 )

To learn what functions you can use to create and work with fits, see: “Curve and Surface
Fitting” on page 3-2.

For details and examples of specific model types and fit analysis, see the following
sections:

“Linear and Nonlinear Regression”

“Interpolation”

“Smoothing”

AW N -

“Fit Postprocessing”

See Also
fit

Related Examples

. “Interactive Curve and Surface Fitting” on page 2-2

1-5
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Surface Fitting
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Interactive Surface Fitting

To interactively fit a surface, follow the steps in this simple example:

1

Load some data at the MATLAB command line.

load franke
Open the Curve Fitting app. Enter:

cftool
In the Curve Fitting app, select X Data, Y Data and Z Data.

Curve Fitting app creates a default interpolation fit to the data.

Choose a different model type using the fit category drop-down list, e.g., select
Polynomial.

Try different fit options for your chosen model type.
Select File > Generate Code.

Curve Fitting app creates a file in the Editor containing MATLAB code to recreate
all fits and plots in your interactive session.

For more information about fitting surfaces in the Curve Fitting app, see “Interactive
Curve and Surface Fitting” on page 2-2.

For details and examples of specific model types and fit analysis, see the following

sections:

1 “Linear and Nonlinear Regression”
2 “Interpolation”

3  “Smoothing”

4  “Fit Postprocessing”

Programmatic Surface Fitting

To programmatically fit a surface, follow the steps in this simple example:

1

Load some data.



Surface Fitting

load franke
2 Create a fit using the it function, specifying the variables and a model type (in this
case poly23 is the model type).
f = fit( [x, y], z, "poly23" )
3 Plot your fit and the data.

plot(f, [x,yl. 2)

To learn what functions you can use to create and work with fits, see: “Curve and Surface
Fitting” on page 3-2.

For details and examples of specific model types and fit analysis, see the following
sections:

“Linear and Nonlinear Regression”

“Interpolation”

“Smoothing”

AW N -

“Fit Postprocessing”

See Also
fit

Related Examples

. “Interactive Curve and Surface Fitting” on page 2-2

1-7
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Spline Fitting
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In this section...

“About Splines in Curve Fitting Toolbox” on page 1-8
“Interactive Spline Fitting” on page 1-8

“Programmatic Spline Fitting” on page 1-9

About Splines in Curve Fitting Toolbox
You can work with splines in Curve Fitting Toolbox in several ways.
Using the Curve Fitting app or the it function you can:

* Fit cubic spline interpolants to curves or surfaces

* Fit smoothing splines and shape-preserving cubic spline interpolants to curves (but
not surfaces)

+ Fit thin-plate splines to surfaces (but not curves)

The toolbox also contains specific splines functions to allow greater control over what you
can create. For example, you can use the csapi function for cubic spline interpolation.
Why would you use csapi instead of the Fit function "cubicinterp” option? You
might require greater flexibility to work with splines for the following reasons:

* You want to combine the results with other splines, e.g., by addition.

* You want vector-valued splines. You can use csapi with scalars, vectors, matrices,
and ND-arrays. The Fit function only allows scalar-valued splines.

* You want other types of splines such as ppform, B-form, tensor-product, rational, and
stform thin-plate splines.

*  You want to create splines without data.

*  You want to specify breaks, optimize knot placement, and use specialized functions
for spline manipulation such as differentiation and integration.

If you require specialized spline functions, see the following sections for interactive and
programmatic spline fitting.

Interactive Spline Fitting

You can access all spline functions from the splinetool GUI.



Spline Fitting

See “Introducing Spline Fitting” on page 8-2.

Programmatic Spline Fitting

To programmatically fit splines, see “Construction” for descriptions of types of splines
and numerous examples.
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Interactive Fitting

*  “Interactive Curve and Surface Fitting” on page 2-2

+ “Data Selection” on page 2-10

+ “Create Multiple Fits in Curve Fitting App” on page 2-14

* “Generating MATLAB Code and Exporting Fits” on page 2-20
* “Compare Fits in Curve Fitting App” on page 2-21

+  “Surface Fitting to Franke Data” on page 2-34
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Interactive Curve and Surface Fitting

2-2

In this section...

“Introducing the Curve Fitting App” on page 2-2

“Fit a Curve” on page 2-2

“Fit a Surface” on page 2-4

“Model Types for Curves and Surfaces” on page 2-6
“Selecting Data to Fit in Curve Fitting App” on page 2-7

“Save and Reload Sessions” on page 2-8

Introducing the Curve Fitting App

You can fit curves and surfaces to data and view plots with the Curve Fitting app.

Create, plot, and compare multiple fits.
Use linear or nonlinear regression, interpolation, smoothing, and custom equations.

View goodness-of-fit statistics, display confidence intervals and residuals, remove
outliers and assess fits with validation data.

Automatically generate code to fit and plot curves and surfaces, or export fits to the
workspace for further analysis.

Fit a Curve

Load some example data at the MATLAB command line:

load census

Open the Curve Fitting app by entering:

cftool

Alternatively, click Curve Fitting on the Apps tab.

Select X data and Y data. For details, see “Selecting Data to Fit in Curve Fitting
App” on page 2-7.




Interactive Curve and Surface Fitting

Fit name: |untitled fit 1

X data: cdate -
¥ data: pop -
7 data: (none) -
Weights: | (none) -

The Curve Fitting app creates a default polynomial fit to the data.

Try different fit options. For example, change the polynomial Degree to 3 to fit a
cubic polynomial.

Polynomial -
Degree: | 3 -
Robust: | Off -

Center and scale
Fit Options...

Select a different model type from the fit category list, e.g., Smoothing Spline. For
information about models you can fit, see “Model Types for Curves and Surfaces” on
page 2-6.
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| Polynomial v

Gaussian -
Interpolant

Palynaomial o
Power

Rational

| Sum of Sine

Weibull

1

6 Select File > Generate Code.

The Curve Fitting app creates a file in the Editor containing MATLAB code to
recreate all fits and plots in your interactive session.

Tip: For a detailed workflow example, see “Compare Fits in Curve Fitting App” on page
2-21.

To create multiple fits and compare them, see “Create Multiple Fits in Curve Fitting
App” on page 2-14.

Fit a Surface

1 Load some example data at the MATLAB command line:

load franke

2 Open the Curve Fitting app:

cftool

3 Select X data, Y data and Z data. For more information, see “Selecting Data to Fit
in Curve Fitting App” on page 2-7.



Interactive Curve and Surface Fitting

Fit name: |untitled fit 1

X data: :x v:
¥ data: :],f v:
Z data: :z v:
Weights: :l[nonej v:

The Curve Fitting app creates a default interpolation fit to the data.
4  Select a different model type from the fit category list, e.g., Polynomial.

For information about models you can fit, see “Model Types for Curves and Surfaces”
on page 2-6.

| Interpolant hd

Interpolant

Custom Equation
Lowess

5 Try different fit options for your chosen model type.
6 Select File > Generate Code.

The Curve Fitting app creates a file in the Editor containing MATLAB code to
recreate all fits and plots in your interactive session.

Tip: For a detailed example, see “Surface Fitting to Franke Data” on page 2-34.

To create multiple fits and compare them, see “Create Multiple Fits in Curve Fitting
App” on page 2-14.
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Model Types for Curves and Surfaces

Based on your selected data, the fit category list shows either curve or surface fit
categories. The following table describes the options for curves and surfaces.

Fit Category ‘ Curves ‘ Surfaces

Regression Models

Polynomial Yes (up to degree 9) Yes (up to degree 5)

Exponential Yes

Fourier Yes

Gaussian Yes

Power Yes

Rational Yes

Sum of Sine Yes

Weibull Yes

Interpolation

Interpolant Yes Yes
Methods: Methods:
Nearest neighbor Nearest neighbor
Linear Linear
Cubic Cubic

Shape-preserving (PCHIP) |Biharmonic (v4)
Thin-plate spline

Smoothing

Smoothing Spline Yes

Lowess Yes

Custom

Custom Equation on page |Yes Yes
5-2

Linear Fitting on page Yes
5-7

For information about these fit types, see:

2-6
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* “Linear and Nonlinear Regression”
+ “Custom Models” on page 5-2
*  “Interpolation”

+ “Smoothing”

Selecting Data to Fit in Curve Fitting App

To select data to fit, use the drop-down lists in the Curve Fitting app to select variables
in your MATLAB workspace.

+ To fit curves:

+ Select X data and Y data.
+ Select only Y data to plot Y against index (x=1:length( y )).
+ To fit surfaces, select X data, Y data and Z data.

You can use the Curve Fitting app drop-down lists to select any numeric variables (with
more than one element) in your MATLAB workspace.

Similarly, you can select any numeric data in your workspace to use as Weights.

Fit name: |untitled fit1

A data: cdate -
Y data: pop -
£ data: (none) -
Weights: | (none) -

For curves, X, Y, and Weights must be matrices with the same number of elements.
For surfaces, X, Y, and Z must be either:

*  Matrices with the same number of elements

* Data in the form of a table

For surfaces, weights must have the same number of elements as Z.
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For more information see “Selecting Compatible Size Surface Data” on page 2-11.

When you select variables, the Curve Fitting app immediately creates a curve or surface
fit with the default settings. If you want to avoid time-consuming refitting for large data
sets, you can turn off Auto fit by clearing the check box.

Note: The Curve Fitting app uses a snapshot of the data you select. Subsequent
workspace changes to the data have no effect on your fits. To update your fit data from
the workspace, first change the variable selection, and then reselect the variable with the
drop-down controls.

If there are problems with the data you select, you see messages in the Results pane.
For example, the Curve Fitting app ignores Infs, NaNs, and imaginary components of
complex numbers in the data, and you see messages in the Results pane in these cases.

If you see warnings about reshaping your data or incompatible sizes, read “Selecting
Compatible Size Surface Data” on page 2-11 and “Troubleshooting Data Problems” on
page 2-12 for information.

Save and Reload Sessions

+ “Overview” on page 2-8
+ “Saving Sessions” on page 2-8
+ “Reloading Sessions” on page 2-9

* “Removing Sessions” on page 2-9
Overview

You can save and reload sessions for easy access to multiple fits. The session file contains
all the fits and variables in your session and remembers your layout.

Saving Sessions

To save your session, first select File > Save Session to open your file browser. Next,
select a name and location for your session file (with file extension .sFit).

After you save your session once, you can use File > Save MySessionName to overwrite
that session for subsequent saves.



Interactive Curve and Surface Fitting

To save the current session under a different name, select File > Save Session As .
Reloading Sessions

Use File > Load Session to open a file browser where you can select a saved curve
fitting session file to load.

Removing Sessions

Use File > Clear Session to remove all fits from the current Curve Fitting app session.

Related Examples
. “Compare Fits in Curve Fitting App” on page 2-21
. “Create Multiple Fits in Curve Fitting App” on page 2-14
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Data Selection

2-10

In this section...

“Selecting Data to Fit in Curve Fitting App” on page 2-10
“Selecting Compatible Size Surface Data” on page 2-11
“Troubleshooting Data Problems” on page 2-12

Selecting Data to Fit in Curve Fitting App

To select data to fit, use the drop-down lists in the Curve Fitting app to select variables
in your MATLAB workspace.

+ To fit curves:

+ Select X data and Y data.
+ Select only Y data to plot Y against index (x=1:length( y )).
+ To fit surfaces, select X data, Y data and Z data.

You can use the Curve Fitting app drop-down lists to select any numeric variables (with
more than one element) in your MATLAB workspace.

Similarly, you can select any numeric data in your workspace to use as Weights.

Fit name: |untitled fit1

X data: cdate A
Y data: pop -
£ data: (none) -
Weights: | (none) -

For curves, X, Y, and Weights must be matrices with the same number of elements.
For surfaces, X, Y, and Z must be either:

*  Matrices with the same number of elements




Data Selection

+ Data in the form of a table
For surfaces, weights must have the same number of elements as Z.
For more information see “Selecting Compatible Size Surface Data” on page 2-11.

When you select variables, the Curve Fitting app immediately creates a curve or surface
fit with the default settings. If you want to avoid time-consuming refitting for large data
sets, you can turn off Auto fit by clearing the check box.

Note: The Curve Fitting app uses a snapshot of the data you select. Subsequent
workspace changes to the data have no effect on your fits. To update your fit data from
the workspace, first change the variable selection, and then reselect the variable with the
drop-down controls.

Selecting Compatible Size Surface Data

For surface data, in Curve Fitting app you can select either “Matrices of the Same Size”
on page 2-11 or “Table Data” on page 2-11.

Matrices of the Same Size

Curve Fitting app expects inputs to be the same size. If the sizes are different but the
number of elements are the same, then the tool reshapes the inputs to create a fit and
displays a warning in the Results pane. The warning indicates a possible problem with
your selected data.

Table Data

Table data means that X and Y represent the row and column headers of a table
(sometimes called breakpoints) and the values in the table are the values of the Z output.

Sizes are compatible if:

+ Xis a vector of length n.
* Y is a vector of length m.
* 7 1is a 2D matrix of size [m,n].

The following table shows an example of data in the form of a table withn = 4 andm =
3.
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x(1) x(2) x(3) x(4)
y(1) z(1,1) z(1,2) z(1,3) z(1,4)
y(2) z(2,1) z(2,2) z(2,3) z(2,4)
y(3) z(3,1) z(3,2) z(3,3) z(3,4)

Like the surf function, the Curve Fitting app expects inputs where length(X) = n,
length(Y) = mandsize(Z) = [m,n]. If the size of Z is [n,m], the tool creates a fit
but first transposes Z and warns about transforming your data. You see a warning in the
Results pane like the following example:

Using X Input for rows and Y Input for columns
to match Z Output matrix.

For suitable example table data, run the following code:

x = linspace( 0, 1, 7 );
y = linspace( 0, 1, 9 ).";
z = bsxfun( @franke, X, vy );

For surface fitting at the command line with the Fit function, use the
prepareSurfaceData function if your data is in table form.

Weights

If you specify surface Weights, assign an input the same size as Z. If the sizes are
different but the number of elements is the same, Curve Fitting app reshapes the
weights and displays a warning.

Troubleshooting Data Problems

If there are problems with the data you select, you see messages in the Results pane.
For example, the Curve Fitting app ignores Infs, NaNs, and imaginary components of
complex numbers in the data, and you see messages in the Results pane in these cases.

If you see warnings about reshaping your data or incompatible sizes, read “Selecting
Compatible Size Surface Data” on page 2-11 for information.

If you see the following warning: Duplicate x-y data points detected: using
average of the z values, this means that there are two or more data points where
the input values (x, y) are the same or very close together. The default interpolant




Data Selection

fit type needs to calculate a unique value at that point. You do not need do anything
to fix the problem, this warning is just for your information. The Curve Fitting app
automatically takes the average z value of any group of points with the same x-y values.

Other problems with your selected data can produce the following error:

Error computing Delaunay triangulation. Please try again with

different data.

Some arrangements of data make it impossible for Curve Fitting app to compute a
Delaunay triangulation. Three out of the four surface interpolation methods (linear,
cubic, and nearest) require a Delaunay triangulation of the data. An example of data that
can cause this error is a case where all the data lies on a straight line in x-y. In this case,
Curve Fitting app cannot fit a surface to the data. You need to provide more data in order
to fit a surface.

Note: Data selection is disabled if you are in debug mode. Exit debug mode to change
data selections.
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Create Multiple Fits in Curve Fitting App

2-14

In this section...

“Refining Your Fit” on page 2-14

“Creating Multiple Fits” on page 2-14

“Duplicating a Fit” on page 2-15

“Deleting a Fit” on page 2-15

“Displaying Multiple Fits Simultaneously” on page 2-15

“Using the Statistics in the Table of Fits” on page 2-18

Refining Your Fit

After you create a single fit, you can refine your fit, using any of the following optional
steps:

* Change fit type and settings. Select GUI settings to use the Curve Fitting app built-in
fit types or create custom equations. For fit settings for each model type, see “Linear
and Nonlinear Regression”, “Interpolation”, and “Smoothing”.

+  Exclude data by removing outliers in the Curve Fitting app. See “Remove Outliers” on
page 7-10.

+  Select weights. See “Data Selection” on page 2-10.

+ Select validation data. See “Select Validation Data” on page 7-15

*  Create multiple fits and you can compare different fit types and settings side by side
in the Curve Fitting app. See “Creating Multiple Fits” on page 2-14.

Creating Multiple Fits

After you create a single fit, it can be useful to create multiple fits to compare. When you
create multiple fits you can compare different fit types and settings side-by-side in the
Curve Fitting app.

After creating a fit, you can add an additional fit using any of these methods:

*  Click the New Fit button next to your fit figure tabs in the Document Bar.
* Right-click the Document Bar and select New Fit.
* Select Fit > New Fit.




Create Multiple Fits in Curve Fitting App

Each additional fit appears as a new tab in the Curve Fitting app and a new row in the
Table of Fits. See “Create Multiple Fits in Curve Fitting App” on page 2-14 for
information about displaying and analyzing multiple fits.

Optionally, after you create an additional fit, you can copy your data selections from a
previous fit by selecting Fit > Use Data From > Other Fit Name. This copies your

selections for X, y, and z from the previous fit, and any selected validation data. No fit
options are changed.

Use sessions to save and reload your fits. See “Save and Reload Sessions” on page 2-8.

Duplicating a Fit

To create a copy of the current fit tab, select Fit > Duplicate "Current Fit Name".
You also can right-click a fit in the Table of Fits and select Duplicate

Each additional fit appears as a new tab in the Curve Fitting app.

Deleting a Fit

Delete a fit from your session using one of these methods:

* Select the fit tab display and select Fit > Delete Current Fit Name.
+ Select the fit in the Table of Fits and press Delete.
+ Right-click the fit in the table and select Delete Current Fit Name.

Displaying Multiple Fits Simultaneously

When you have created multiple fits you can compare different fit types and settings side
by side in the Curve Fitting app. You can view plots simultaneously and you can examine
the goodness-of-fit statistics to compare your fits. This section describes how to compare
multiple fits.

To compare plots and see multiple fits simultaneously, use the layout controls at the top
right of the Curve Fitting app. Alternatively, you can click Window on the menu bar

to select the number and position of tiles you want to display. A fit figure displays the

fit settings, results pane and plots for a single fit. The following example shows two fit
figures displayed side by side. You can see multiple fits in the session listed in the Table
of Fits.
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A\ Curve Fitting Tool - exampleinteractivecurvefits EI@
File Fit View Tools Desktop Window Help L
%R e - B % BE # O
poly2 x| poly? x[ep x| T
Exp poky3 O a X
Fit name: |exp Exponential Fit name: | poly3 Polynomial
Adata: | cdate = Number of terms: 1 Kdata: | cdate | Degree: | 3
¥ data: pop v: Equation: e ¥ data: pop ': Robust: | Off
Z data: (none) v: [T Center and scale Z data: (none) - Center and scale
Weights: (none) v: Weights: (none) v:
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Table of Fits g 0 &
Fit na.. = Data Fit type S5E R-square DFE AdjR-sq  RMSE #Coeff  Validati.. Validati... WValidati...
& exp pop vs. Co. [expl 1.8942e+...|0.9847 19 0.9839 99847 2 =
& poly2  |pop vs. c... |poly2 754368  |0.9994 18 0.9993 20472 3 |_
& poly3  |pop vs. c... |poly3 149.7687 |0.9988 17 0.9986 2.9682 4 |=
[ polyd  |pop vs. c... |polyd 1459680 |0.0988 16 0.9985 2.0204 5 m
[d polyS  |pop vs. c... [polyS 1441661 |0.9988 15 0.9984 31002 6 &

You can close fit figures displays (with the Close button, Fit menu, or context menu), but
they remain in your session. The Table of Fits displays all your fits (open and closed).
Double-click a fit in the Table of Fits to open (or focus if already open) the fit figure. To
remove a fit, see “Deleting a Fit” on page 2-15

Tip: If you want more space to view and compare plots, as shown next, use the View
menu to hide or show the Fit Settings, Fit Results, or Table of Fits panes.
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4\ Curve Fitting Tool - exampleinteractivecurvefits E'IE'

File Fit View Tools Desktop Window Help k|
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You can dock and undock individual fits and navigate between them using the standard
MATLAB Desktop and Window menus in the Curve Fitting app. For more information,
see “Optimize Desktop Layout for Limited Screen Space” (MATLAB) in the MATLAB
Desktop Tools and Development Environment documentation.
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Using the Statistics in the Table of Fits

The Table of Fits list pane shows all fits in the current session.

ratle gy Al

Fitname  Data Fit type S5E R-square  DFE AdjR-sq  RMSE # Coeff
M polyt  |pop vs. cd...|poly6 1069276  |0.9991 14 0.9988 2.7636 7

M poly5  |pop vs. cd...|polyS 1441661  |0.9988 15 0.9984 3.1002 i

[ polyd  |pop vs. cd...|polyd 1459689 09938 16 09985 3.0204 5

[ poly3  |pop vs. cd...|poly3 1497687  |D.9988 17 09986 2.9682 4

M poly2  |pop vs. cd...|poly2 159.0292  |0.99&7 18 0.9986 29724 E

M exp pop vs. cd..|expl 1.8942e+03 |0.9847 19 09839 9.9847 2

After using graphical methods to evaluate the goodness of fit, you can examine the
goodness-of-fit statistics shown in the table to compare your fits. The goodness-of-fit
statistics help you determine how well the model fits the data. Click the table column
headers to sort by statistics, name, fit type, and so on.

The following guidelines help you use the statistics to determine the best fit:

+ SSE is the sum of squares due to error of the fit. A value closer to zero indicates a fit
that is more useful for prediction.

+ R-square is the square of the correlation between the response values and the
predicted response values. A value closer to 1 indicates that a greater proportion of
variance is accounted for by the model.

* DFE is the degree of freedom in the error.

* Adj R-sq is the degrees of freedom adjusted R-square. A value closer to 1 indicates a
better fit.

* RMSE is the root mean squared error or standard error. A value closer to 0 indicates
a fit that is more useful for prediction.

+ # Coeff is the number of coefficients in the model. When you have several fits with
similar goodness-of-fit statistics, look for the smallest number of coefficients to help
decide which fit is best. You must trade off the number of coefficients against the
goodness of fit indicated by the statistics to avoid overfitting.

For a more detailed explanation of the Curve Fitting Toolbox statistics, see “Goodness-of-
Fit Statistics” on page 7-55.
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To compare the statistics for different fits and decide which fit is the best tradeoff

between over- and under-fitting, use a similar process to that described in “Compare Fits
in Curve Fitting App” on page 2-21.

Related Examples

“Compare Fits in Curve Fitting App” on page 2-21

“Compare Fits Programmatically” on page 7-41
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Generating MATLAB Code and Exporting Fits

2-20

Interactive Code Generation and Programmatic Fitting

Curve Fitting app makes it easy to plot and analyze fits at the command line. You can
export individual fits to the workspace for further analysis, or you can generate MATLAB
code to recreate all fits and plots in your session. By generating code you can use your
interactive curve fitting session to quickly assemble code for curve and surface fits and
plots into useful programs.

1 Select File > Generate Code.

The Curve Fitting app generates code from your session and displays the file in the
MATLAB Editor. The file includes all fits and plots in your current session. The file
captures the following information:
+  Names of fits and their variables
+ Fit settings and options

Plots

+  Curve or surface fitting objects and methods used to create the fits:

+ A cell-array of cFit or sfitobjects representing the fits

* A structure array with goodness-of fit information.
2 Save the file.

For more information on working with your generated code, exporting fits to the
workspace, and recreating your fits and plots at the command line, see:

* “Generating Code from the Curve Fitting App” on page 7-16
+ “Exporting a Fit to the Workspace” on page 7-17



Compare Fits in Curve Fitting App

Compare Fits in Curve Fitting App

In this section...

“Interactive Curve Fitting Workflow” on page 2-21
“Loading Data and Creating Fits” on page 2-21
“Determining the Best Fit” on page 2-24

“Analyzing Your Best Fit in the Workspace” on page 2-31
“Saving Your Work” on page 2-33

Interactive Curve Fitting Workflow

The next topics fit some census data using polynomial equations up to the sixth degree,
and a single-term exponential equation. The steps demonstrate how to:

* Load data and explore various fits using different library models.

+ Search for the best fit by:

+  Comparing graphical fit results

Comparing numerical fit results including the fitted coefficients and goodness-of-
fit statistics

+  Export your best fit results to the MATLAB workspace to analyze the model at the
command line.

* Save the session and generate MATLAB code for all fits and plots.

Loading Data and Creating Fits

You must load the data variables into the MATLAB workspace before you can fit data
using the Curve Fitting app. For this example, the data is stored in the MATLAB file

census.mat.
1 Load the data:

load census

The workspace contains two new variables:
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+ cdate is a column vector containing the years 1790 to 1990 in 10-year
increments.

pop is a column vector with the U.S. population figures that correspond to the
years in cdate.

Open the Curve Fitting app:

cftool
Select the variable names cdate and pop from the X data and Y data lists.

The Curve Fitting app creates and plots a default fit to X input (or predictor data)
and Y output (or response data). The default fit is a linear polynomial fit type.
Observe the fit settings display Polynomial, of Degree 1.

Change the fit to a second degree polynomial by selecting 2 from the Degree list.

The Curve Fitting app plots the new fit. The Curve Fitting app calculates a new fit
when you change fit settings because Auto fit is selected by default. If refitting is
time consuming, e.g., for large data sets, you can turn off Auto fit by clearing the
check box.

The Curve Fitting app displays results of fitting the census data with a quadratic
polynomial in the Results pane, where you can view the library model, fitted
coefficients, and goodness-of-fit statistics.

Change the Fit name to poly2.
Display the residuals by selecting View > Residuals Plot.

The residuals indicate that a better fit might be possible. Therefore, continue
exploring various fits to the census data set.



Compare Fits in Curve Fitting App

4\ Curve Fitting Tool EI@
File Fit View Tools Desktop Window Help ¥ A X
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7 Add new fits to try the other library equations.

a

Right-click the fit in the Table of Fits and select Duplicate “poly2” (or use
the Fit menu).

Tip: For fits of a given type (for example, polynomials), use Duplicate
“fitname” instead of a new fit because copying a fit requires fewer steps. The
duplicated fit contains the same data selections and fit settings.
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b Change the polynomial Degree to 3 and rename the fit poly3.

¢ When you fit higher degree polynomials, the Results pane displays this
warning:

Equation is badly conditioned. Remove repeated data points
or try centering and scaling.

Normalize the data by selecting the Center and scale check box.

d Repeat steps a and b to add polynomial fits up to the sixth degree, and then add
an exponential fit.

e For each new fit, look at the Results pane information, and the residuals plot in
the Curve Fitting app.

The residuals from a good fit should look random with no apparent pattern. A
pattern, such as a tendency for consecutive residuals to have the same sign, can
be an indication that a better model exists.

About Scaling

The warning about scaling arises because the fitting procedure uses the cdate values

as the basis for a matrix with very large values. The spread of the cdate values results
in a scaling problem. To address this problem, you can normalize the cdate data.
Normalization scales the predictor data to improve the accuracy of the subsequent
numeric computations. A way to normalize cdate is to center it at zero mean and scale it
to unit standard deviation. The equivalent code is:

(cdate - mean(cdate))./std(cdate)

Note Because the predictor data changes after normalizing, the values of the fitted
coefficients also change when compared to the original data. However, the functional
form of the data and the resulting goodness-of-fit statistics do not change. Additionally,
the data is displayed in the Curve Fitting app plots using the original scale.

Determining the Best Fit

To determine the best fit, you should examine both the graphical and numerical fit
results.



Compare Fits in Curve Fitting App

Examine the Graphical Fit Results

1

Determine the best fit by examining the graphs of the fits and residuals. To view
plots for each fit in turn, double-click the fit in the Table of Fits. The graphical fit
results indicate that:

The fits and residuals for the polynomial equations are all similar, making it
difficult to choose the best one.

The fit and residuals for the single-term exponential equation indicate it is a poor
fit overall. Therefore, it is a poor choice and you can remove the exponential fit
from the candidates for best fit.

Examine the behavior of the fits up to the year 2050. The goal of fitting the census
data is to extrapolate the best fit to predict future population values.

a

Double-click the sixth-degree polynomial fit in the Table of Fits to view the plots
for this fit.

Change the axes limits of the plots by selecting Tools > Axes Limits.

Alter the X (edate) Maximum to 2050, and increase the Main Y (pop)
Maximum to 400, and press Enter.

Examine the fit plot. The behavior of the sixth-degree polynomial fit beyond the
data range makes it a poor choice for extrapolation and you can reject this fit.
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Evaluate the Numerical Fit Results

When you can no longer eliminate fits by examining them graphically, you should
examine the numerical fit results. The Curve Fitting app displays two types of numerical
fit results:

*  Goodness-of-fit statistics

+  Confidence bounds on the fitted coefficients

The goodness-of-fit statistics help you determine how well the curve fits the data. The
confidence bounds on the coefficients determine their accuracy.

Examine the numerical fit results:

1 For each fit, view the goodness-of-fit statistics in the Results pane.
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Results

pl=
pl=
p3 =
P4 =

Linear madel Poly3:
fo) =p1™ "3 +p2™"2 +p3™ +p4
where x is normalized by mean 1890 and std 62.05
Coeffidents {(with 95%: confidence bounds):
0.921 (-0.9743, 2.516)
25.18 (23.57, 26.79)
73.86 (70,33, 77.39)
51.74 (59.69, 63.8)

Goodness of fit:
S5E: 149.8

R-sguare: 0,.9953
Adjusted R-square: 0.9986

RMSE: 2.963

2 Compare all fits simultaneously in the Table of Fits. Click the column headings to
sort by statistics results.
Table of Fits
Fit name  Data Fit type S5E R-square  DFE AdjR-sq  RMSE # Coeff
M polys  |pop vs. cd...|poly6 1069276 [09991  [14 09988  [27636 |7
[ polyS  |pop vs. cd...[polyS 1441661  [0.9988 15 0.9984 31002 13
[ polyd  |pop vs. cd...|polyd 1459689  [0.9988 16 0.9985 3.0204 5
@ poly3  |pop vs. cd...[poly3 1497687  |0.9988 17 0.9986 29682 4
[ poly2  |pop vs. cd...[poly2 159.0293  [0.9987 15 0.9986 29724 3
A exp pop vs. cd...|expl 1.8942e+03 (09847 19 0.9839 9.9847 2
3 Examine the sum of squares due to error (SSE) and the adjusted R-square statistics

to help determine the best fit. The SSE statistic is the least-squares error of the fit,
with a value closer to zero indicating a better fit. The adjusted R-square statistic is
generally the best indicator of the fit quality when you add additional coefficients to

your model.

The largest SSE for expl indicates it is a poor fit, which you already determined
by examining the fit and residuals. The lowest SSE value is associated with poly®6.
However, the behavior of this fit beyond the data range makes it a poor choice for
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extrapolation, so you already rejected this fit by examining the plots with new axis
limits.

The next best SSE value is associated with the fifth-degree polynomial fit, poly5,
suggesting it might be the best fit. However, the SSE and adjusted R-square values
for the remaining polynomial fits are all very close to each other. Which one should
you choose?

Resolve the best fit issue by examining the confidence bounds for the remaining
fits in the Results pane. Double-click a fit in the Table of Fits to open (or focus if
already open) the fit figure and view the Results pane. A fit figure displays the fit
settings, results pane and plots for a single fit.

Display the fifth-degree polynomial and the poly2 fit figures side by side.
Examining results side by side can help you assess fits.

a To show two fit figures simultaneously, use the layout controls at the top right
of the Curve Fitting app or select Window > Left/Right Tile or Top/Bottom
Tile.

b To change the displayed fits, click to select a fit figure and then double-click the
fit to display in the Table of Fits.

¢ Compare the coefficients and bounds (p1, p2, and so on) in the Results pane for
both fits, poly5 and poly2. The toolbox calculates 95% confidence bounds on
coefficients. The confidence bounds on the coefficients determine their accuracy.
Check the equations in the Results pane (F(X)=pl*x+p2*xX...) to see the model
terms for each coefficient. Note that p2 refers to the p2*x term in Poly2 and
the p2*x~4 term in Poly5. Do not compare normalized coefficients directly with
non-normalized coefficients.

Tip: Use the View menu to hide the Fit Settings or Table of Fits if you want
more space to view and compare plots and results, as shown next. You can also
hide the Results pane to show only plots.
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4\ Curve Fitting Tool E'IE'
File Fit View Tools Desktop Window Help k|
FEE | % S @R | EE) % BOE® O
| poly2 poly5 poly6 x| ep x| [
poly>
Results 200 _ I I [ I . - I . I e
Linear model Poly5: i 8’ ) o igis cdate
0 = p1™~5 +p2%x"4 +p35x~3] | a 100 - " I

where x iz normalized by mean 189
Coefficients (with 95% confidence bour,
pl=  0.5877 (-2.305, 3.48)

p2=  0.7047 (-1.884, 3.009) |5

o —
] -—o—--—o-—o—-.—o—-"’""' T

1780 1800 1820 1840 1860 18-30 1900 1920 1940 1950 1980 2000

Linear model Poly2: —
f{x) =pl™"2 +p2¥x +p3
Coefficients (with 95% confidence bour,
pl= 0.006541 (0.006124, 0.00¢
p?= -23.51 {-25.08, -21.93)
p3 = 2.113e+004 (1.964e+004, |

m

Goodness of fit:
SSE: 159
R-sguare: 09937
Adjusted R-square: 0.9986
RMSE: 2,972

4 LI} 2

pi= -0.5193 (-10.19, 8.358) cdate
pd= 2347 {17.42, 29.52) T T . T | : : | . e )
pS= 74,97 {68.37, 31.57) [ . . y
B polys - residuals
pé = 62,23 {59.51, 64.95) S0 g0t o, o o ® T bl " u
[ .
Goodness of fit:
SSE: 144,2 St , & 4 ]
«Tw| = 1780 1300 1820 1840 1350 1880 1000 1920 1940 1960 1930 2000
cdate
poly2 o2 x
Results ‘ 200 _ I I | I . [ I . pl;l',fZ : .

g atel |
- M > s ate' |
0k . : 1 L i 1 L 1 1 -

1780 1800 1820 1840 1860 1880 1900 1920 1940 1960 1980 2000

cdate
4 - T T T T T T I. T T T -I. i g |
o % ' s ® ® 8 - « T hi e poly2 - residuals |
o 3. e hd . :  m— :
e 20 ]
-g : L ¢ & ]
1780 1800 1320 1340 1860 1330 1900 1920 1940 1960 1930' 2000'

cdate

The bounds cross zero on the pl, p2, and p3 coefficients for the fifth-degree
polynomial. This means you cannot be sure that these coefficients differ from
zero. If the higher order model terms may have coefficients of zero, they are not
helping with the fit, which suggests that this model overfits the census data.
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Results

Linear model Poly5:

() = p1®"5 + p2*xc"4 +p3=n3 + p4Rn2 +p5*x +pb

where x is normalized by mean 1390 and std 62.05
Coeffidents (with 95%¢ confidence bounds):

pl= 0.5877 (-2.305, 3.48)

p2 = 0.7047 (-1.684, 3.094)

p3i= -0.51593 (-10.19, 8.358)

p4= 23.47 (17.42, 29.52)

p5= 7457 (58.37, 81.57)

p6 =  £2.23 (59.51, £4.95)

Goodness of fit:
S5E: 144.2
R-sguare: 0.9983
Adjusted R-sguare: 0.9934
RMSE: 3.1

However, the small confidence bounds do not cross zero on p1, p2, and p3 for
the quadratic fit, poly2 indicate that the fitted coefficients are known fairly
accurately.

Results

Linear model Poly2:
(i) =p1™"2 + p2®x +p3
Coefficients (with 95%¢ confidence bounds):
pl= 0.006541 (0.006124, 0.006953)
p2=-23.51 {-25.09, -21.93)
p3 = 2.113e+004 (1.964e+004, 2,262 +004)

Goodness of fit:
55E: 159
R-square: 0.9987
Adjusted R-square: 0,9936
RMSE: 2,972

Therefore, after examining both the graphical and numerical fit results, you
should select poly2 as the best fit to extrapolate the census data.
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Note The fitted coefficients associated with the constant, linear, and quadratic terms are
nearly identical for each normalized polynomial equation. However, as the polynomial
degree increases, the coefficient bounds associated with the higher degree terms cross
zero, which suggests overfitting.

Analyzing Your Best Fit in the Workspace

You can use Save to Workspace to export the selected fit and the associated fit results
to the MATLAB workspace. The fit is saved as a MATLAB object and the associated fit
results are saved as structures.

1 Right-click the poly?2 fit in the Table of Fits and select Save “poly2” to
Workspace (or use the Fit menu).

o -

Save Fit to MATLAB Workspace E'@
[¥] save fit to MATLAB object named: fittedmodel
B Save goodness of fit to MATLAB struct named: goodness

=n

|¥| Save fit output to MATLAB struct named: output

Ok l Cancel ]

2 Click OK to save with the default names.

The Fittedmodel is saved as a Curve Fitting Toolbox cFit object.

>> whos fittedmodel
Name Size Bytes Class

fittedmodel 1x1 822 cfit

Examine the Fittedmodel cFit object to display the model, the fitted coefficients, and
the confidence bounds for the fitted coefficients:

Ffittedmodel

fittedmodel =
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Linear model Poly2:
fittedmodel (X) = pl1*x"2 + p2*x + p3
Coefficients (with 95% confidence bounds):

pl =  0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
p3 = 2.113e+004 (1.964e+004, 2.262e+004)

Examine the goodness structure to display goodness-of-fit results:

goodness

goodness =
sse: 159.0293
rsquare: 0.9987
dfe: 18
adjrsquare: 0.9986
rmse: 2.9724

Examine the output structure to display additional information associated with the fit,
such as the residuals:

output

output =
numobs: 21
numparam: 3
residuals: [21x1 double]
Jacobian: [21x3 double]
exitflag: 1
algorithm: "QR factorization and solve®
iterations: 1

You can evaluate (interpolate or extrapolate), differentiate, or integrate a fit over a
specified data range with various postprocessing functions.

For example, to evaluate the Fittedmodel at a vector of values to extrapolate to the

year 2050, enter:

y = Ffittedmodel (2000:10:2050)

y =
274.6221
301.8240
330.3341
360.1524
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391.2790
423.7137
Plot the fit to the census data and the extrapolated fit values:

plot(fittedmodel, cdate, pop)

hold on

plot(fittedmodel, 2000:10:2050, y)

hold off

For more examples and instructions for interactive and command-line fit analysis, and a
list of all postprocessing functions, see “Fit Postprocessing”.

For an example reproducing this interactive census data analysis using the command
line, see “Polynomial Curve Fitting”.

Saving Your Work

The toolbox provides several options for saving your work. You can save one or more fits
and the associated fit results as variables to the MATLAB workspace. You can then use
this saved information for documentation purposes, or to extend your data exploration
and analysis. In addition to saving your work to MATLAB workspace variables, you can:

+ Save the current curve fitting session by selecting File > Save Session. The session
file contains all the fits and variables in your session and remembers your layout. See
“Save and Reload Sessions” on page 2-8.

*  Generate MATLAB code to recreate all fits and plots in your session by selecting
File > Generate Code. The Curve Fitting app generates code from your session and
displays the file in the MATLAB Editor.

You can recreate your fits and plots by calling the file at the command line with
your original data as input arguments. You can also call the file with new data,
and automate the process of fitting multiple data sets. For more information, see
“Generating Code from the Curve Fitting App” on page 7-16.

Related Examples
. “Create Multiple Fits in Curve Fitting App” on page 2-14
. “Evaluate a Curve Fit” on page 7-20
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Surface Fitting to Franke Data

The Curve Fitting app provides some example data generated from Franke's bivariate
test function. This data is suitable for trying various fit settings in Curve Fitting app.

To load the example data and create, compare, and export surface fits, follow these steps:

1 Toload example data to use in the Curve Fitting app, enter load franke at the
MATLAB command line. The variables X, y, and z appear in your workspace.

The example data is generated from Franke's bivariate test function, with added
noise and scaling, to create suitable data for trying various fit settings in Curve
Fitting app. For details on the Franke function, see the following paper:

Franke, R., Scattered Data Interpolation: Tests of Some Methods, Mathematics of
Computation 38 (1982), pp. 181-200.

2 To divide the data into fitting and validation data, enter the following syntax:

Xxv = x(200:293);
yv = y(200:293);
zv = z(200:293);
X = x(1:199);
y = y(1:199);
z = z(1:199);

3 Tofit a surface using this example data:

a Open Curve Fitting app. Enter cFtool, or select Curve Fitting on the Apps
tab.

b  Select the variables X, y, and z interactively in the Curve Fitting app.
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Fit name; Iunﬁﬂed fit1
¥ input: (none) LI
E—
Z output; XV
Y
Weights: |vv
F —
Results v
ﬁ Select ¥ input, Y input and Z output

Alternatively, you can specify the variables when you enter cftool (x,y,z) to
open Curve Fitting app (if necessary) and create a default fit.

The Curve Fitting app plots the data points as you select variables. When you select

X, Y, and z, the tool automatically creates a default surface fit. The default fit is an
interpolating surface that passes through the data points.

2-35



2 Interactive Fitting

Weights: (none)

4\ Curve Fitting Tool EI@
File Fit View Tools Desktop ]
e [l | ® S Y@ A BOE®O
untitled fit1 x| 7]
untitled fit 1
Fit name: | untitled fit 1 Interpolant Auto fil
Kdata: | x 5 Method: Linear Fit
Ydata |y = Center and scale Stop
Z data: z -

Results

Linear interpolant: i
fx,y) = piecewise line[ |
where x is normalized
and where y is normal| =

Coefficents:

p = coeffident structy

Goodness of fit:
SSE: 1.001e-030
R-square: 1 x
A ] t
Table of Fits o a
Fit.. « Data Fittype SSE R-squ.. DFE Valida...
unti... ‘zvs.x, ¥ |Iinearin...‘1.0008&..11 ‘0

4 Try a Lowess fit type. Select the Lowess fit type from the drop-down list in the

Curve Fitting app.

Interpolant

[

Interpolant
Polynomial

Custom Equation

The Curve Fitting app creates a local smoothing regression fit.

5 Try altering the fit settings. Enter 10 in the Span edit box.
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By reducing the span from the default to 10% of the total number of data points
you produce a surface that follows the data more closely. The span defines the
neighboring data points the toolbox uses to determine each smoothed value.

i

LA
-

R
.
21

: . - . : .
i 500 1000 1500 2000 2500 3000
¥

Edit the Fit name to Smoothing regression.

If you divided your data into fitting and validation data in step 2, select this
validation data. Use the validation data to help you check that your surface is a good
model, by comparing it against some other data not used for fitting.

a Select Fit > Specify Validation Data. The Specify Validation Data dialog box
opens.

b  Select the validation variables in the drop-down lists for X input, Y input, and
Z output: xXv, yv, and zv.

Review your selected validation data in the plots and the validation statistics (SSE
and RMSE) in the Results pane and the Table of Fits.
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_ /1 =madothing regression
R Al ® zugow,y
O TVYS. KV, YY

1500 2000 2500 3000

X

0 “sop 1000

Create another fit to compare by making a copy of the current surface fit. Either
select Fit > Duplicate "Smoothing regression", or right-click the fit in the Table
of Fits, and select Duplicate

The tool creates a new fit figure with the same fit settings, data, and validation data.
It also adds a new row to the table of fits at the bottom.

Change the fit type to Polynomial and edit the fit name to Polynomial.

Lowess

El
Interpalant

Polynomial
Custom Equation
Lowess

10 Change the Degrees of x and y to 3, to fit a cubic polynomial in both dimensions.

11
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pane:

Equation is badly conditioned. Remove repeated data points
or try centering and scaling.
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Select the Center and scale check box to normalize and correct for the large

difference in scales in x and y.

Polynaomial ;I
Degrees: x: |3 LI Vi |3 LI

Robust: I off ;I

Fit Options... |

Normalizing the surface fit removes the warning message from the Results pane.

12 Look at the Results pane. You can view (and copy if desired):

* The model equation
+ The values of the estimated coefficients
The goodness-of-fit statistics

The goodness of validation statistics

Linear model Poly33:
f(X,y) = p00 + pl0*x + pOl*y + p20*x"2 + pll*x*y...
+ p02*y"2 + p30*X"3 + p21l*x/"2*y
+ pl2*x*y"2 + p03*y~"3
where x is normalized by mean 1977 and std 866.5
and where y is normalized by mean 0.4932 and std 0.29
Coefficients (with 95% confidence bounds):

po0 = 0.4359 (0.3974, 0.4743)
pl0 = -0.1375 (-0.194, -0.08104)
pol = -0.4274 (-0.4843, -0.3706)
p20 = 0.0161 (-0.007035, 0.03923)
pll = 0.07158 (0.05091, 0.09225)
p02 =  -0.03668 (-0.06005, -0.01332)
p30 = 0.02081 (-0.005475, 0.04709)
p21 = 0.02432 (0.0012, 0.04745)
pl2 =  -0.03949 (-0.06287, -0.01611)
po3 = 0.1185 (0.09164, 0.1453)

2-39



2 Interactive Fitting

Goodness of fit:
SSE: 4.125
R-square: 0.776
Adjusted R-square: 0.7653
RMSE: 0.1477

Goodness of validation:
SSE : 2.26745
RMSE : 0.155312

13 To export this fit information to the workspace, select Fit > Save to Workspace.
Executing this command also exports other information such as the numbers of
observations and parameters, residuals, and the fitted model.

You can treat the fitted model as a function to make predictions or evaluate the
surface at values of X and Y. For details see “Exporting a Fit to the Workspace” on
page 7-17.

14 Display the residuals plot to check the distribution of points relative to the surface.

Click the toolbar button |g or select View > Residuals Plot.

N

500 1000 1500 2000 2500 3000 .
. ¥

15 Right-click the residuals plot to select the Go to X-Z view. The X-Z view is not
required, but the view makes it easier to see to remove outliers.

16
To remove outliers, click the toolbar button = *
Outliers.

or select Tools > Exclude
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When you move the mouse cursor to the plot, it changes to a cross-hair to show you
are in outlier selection mode.

a Click a point that you want to exclude in the surface plot or residuals plot.
Alternatively, click and drag to define a rectangle and remove all enclosed

points.

A removed plot point displays as a red star in the plots.

I:IEI' ;4 u 1 T T
' : —® Falynomial - residuals

— Excluded z vs. %, ¥
= Polynomial - valldatmn residuals

[ n- il L] PP -2y
— —_— —_— = il
L, [ . III.‘

5 e, . e =
500 1 EIEIEI 1 EEIEI EEIEIEI EEEIEI 3IIIEIEI

b If you have Auto-fit selected, the Curve Fitting app refits the surface without
the point. Otherwise, you can click Fit to refit the surface.

To return to rotation mode, click the toolbar button " again to switch off

Exclude Outliers mode.

17 To compare your fits side-by-side, use the tile tools. Select Window > Left/Right
Tile, or use the toolbar buttons.
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4\ Curve Fitting Tool
File Fi i

Fit View Tools

Weights: (none)

Weights: (none)

Smoothing regression O » X | Polynomial
Fit name: | Smoothing regression Interpolant Fit name: | Polynomial Polynomial
Kdata | x ~ Method: Linear Kdata: | x Degrees: x: |3 V: ¥ :3
¥data: |y e Center and sca ¥data: |y Robust: Off
Z data: Lz - Z data: Lz Center and scale

Fit Options..

L e L BT
Results Results s i SR
Linear interpol = Linear model Poly33: = * IVS XY
fy) = e ® ZVS XY f{x,y) =p00 +p107] “ Excudedzvs. %,y
where x i [ ~ +pl2%*y
and when where x is normaliz
Coefficients: and where y is nor
p = coeffi Coefficents (with 95%
pol = 0.4141 (4
Goodness of f L plo= -0.1401
SSE: 1.001e p0l= -0.4191
R-square: 1 p20 = 0.02415
Adjusted R5 pil= 0.07373
RMSE: MaM ™~ p02 = -0.02437
p30 = 0.0219 (4
p2l= 0.01545 X
pl2z= -0.03682
p03 = 0.1177 {4 i
- ik
Goodness of fit: T & e Polynomial - residuals
S5E: 5.966 04 o 4 Excluded zvs. x, y
R-square: 0,776 i R 1
Adjusted R-square: 0. k)
RMSE: 0.1457
N
(™ b <« [ s
Mt | e s e . N ¥
Table of F Ex{mit
Fit name =« Data Fit type SSE R-square DFE Adj R-sq RMSE # Coeff Validation... Validation.. Validation...
@ Polyno... [zvs.xy  [poly33 |5.9663 [p.7760 281 |0.7688 01457 [10 | | |
[d Smoothi.|zvs.xy  |linearinterp [1.0008e-30 [1 o |Nan |Nan 203 | | |

18 Review the information in the Table of Fits. Compare goodness-of-fit statistics for
all fits in your session to determine which is best.
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19

20

21
22

To save your interactive surface fitting session, select File > Save Session. You can
save and reload sessions to access multiple fits. The session file contains all the fits
and variables in your session and remembers your layout.

After interactively creating and comparing fits, you can generate code for all fits and
plots in your Curve Fitting app session. Select File > Generate Code.

The Curve Fitting app generates code from your session and displays the file in the
MATLAB Editor. The file includes all fits and plots in your current session.

Save the file with the default name, createFits.m.

You can recreate your fits and plots by calling the file from the command line (with
your original data or new data as input arguments). In this case, your original
variables still appear in the workspace.

+ Highlight and evaluate the first line of the file (excluding the word function).
Either right-click and select Evaluate, press F9, or copy and paste the following
to the command line:

[fitresult, gof] = createFits(Xx, Yy, z, XV, yVv, zV)

The function creates a figure window for each fit you had in your session. Observe
that the polynomial fit figure shows both the surface and residuals plots that you
created interactively in the Curve Fitting app.

+ If you want you can use the generated code as a starting point to change the
surface fits and plots to fit your needs. For a list of methods you can use, see
sfit.

For more information on all fit settings and tools for comparing fits, see:

“Create Multiple Fits in Curve Fitting App” on page 2-14
“Linear and Nonlinear Regression”

“Interpolation”

“Smoothing”

“Fit Postprocessing”
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* “Curve and Surface Fitting” on page 3-2

*  “Curve and Surface Fitting Objects and Methods” on page 3-7



3 Programmatic Curve and Surface Fitting

Curve and Surface Fitting

3-2

In this section...

“Fitting a Curve” on page 3-2

“Fitting a Surface” on page 3-2

“Model Types and Fit Analysis” on page 3-3

“Workflow for Command Line Fitting” on page 3-3

Fitting a Curve

To programmatically fit a curve, follow the steps in this simple example:

1

Load some data.

load hahnl

Create a fit using the it function, specifying the variables and a model type (in this
case rat23 is the model type).

f = fit( temp, thermex, "rat23" )
Plot your fit and the data.

plot( f, temp, thermex )
f( 600 )

For an example comparing various polynomial fits, see “Polynomial Curve Fitting”.

Fitting a Surface

To programmatically fit a surface, follow the steps in this simple example:

1

Load some data.

load franke
Create a fit using the fit function, specifying the variables and a model type (in this
case poly23 is the model type).
T = fit( [x, y], z, "poly23” )
Plot your fit and the data.



Curve and Surface Fitting

plot(f, [x,y]l, 2)
For an example fitting custom equations, see “Surface Fitting With Custom Equations to

Biopharmaceutical Data”.

Model Types and Fit Analysis

For details and examples of specific model types and fit analysis, see the following
sections:

“Linear and Nonlinear Regression”

“Interpolation”

“Smoothing”

B W N —

“Fit Postprocessing”

Workflow for Command Line Fitting

Curve Fitting Toolbox software provides a variety of methods for data analysis and
modeling.

Tip: To quickly assemble MATLAB code for curve and surface fits and plots, use Curve
Fitting app and then generate code. You can transform your interactive analysis of a
single data set into a reusable function for command-line analysis or for batch processing
of multiple data sets. See “Generate Code and Export Fits to the Workspace” on page
7-16.

To use curve fitting functions for programmatic fitting and analysis, follow this workflow:

1 Import your data into the MATLAB workspace using the load command (if your
data has previously been stored in MATLAB variables) or any of the MATLAB
functions for reading data from particular file types. You might need to reshape your
data: see prepareCurveData or prepareSurfaceData.

2 (Optional) If your data is noisy, you might want to smooth it using the smooth
function. Smoothing is used to identify major trends in the data that can assist you
in choosing an appropriate family of parametric models. If a parametric model is not
evident or appropriate, smoothing can be an end in itself, providing a nonparametric
fit of the data.
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Note: Smoothing estimates the center of the distribution of the response at each
predictor. It invalidates the assumption that errors in the data are independent, and
so also invalidates the methods used to compute confidence and prediction intervals.
Accordingly, once a parametric model is identified through smoothing, the original
data should be passed to the Fit function.

3  Specify a parametric model for the data—either a Curve Fitting Toolbox library
model or a custom model that you define. You specify the model by passing a string
or expression to the Fit function or (optional) with a Fittype object you create with

the Fittype function.

To view available library models, see “List of Library Models for Curve and Surface

Fitting” on page 4-13.

4 (Optional) You can create a fit options structure for the fit using the fitoptions
function. Fit options specify things like weights for the data, fitting methods, and
low-level options for the fitting algorithm.

5 (Optional) You can create an exclusion rule for the fit using the excludedata
function. Exclusion rules indicate which data values will be treated as outliers and

excluded from the fit.

6 Specify the x and y (and z, if surface fitting) data, a model (string, expression or
fittype object), and (optionally) a fit options structure and an exclusion rule, with
the Fit function to perform the fit.

The Fit function returns a cFit (for curves) or sFit (for surfaces) object that
encapsulates the computed coefficients and the fit statistics. If you want to learn
more about the fit objects, see “Curve and Surface Fitting Objects and Methods” on

page 3-7.

7 You can postprocess the fit objects returned by the Fit function, by passing them
to a variety of functions, such as feval, differentiate, integrate, plot,
coeffvalues, probvalues, confint, and predint.

Use the following functions to work with curve and surface fits.

Curve or Surface Fit Method

Description

argnames

Get input argument names

category

Get fit category

coeffnames

Get coefficient names
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Curve or Surface Fit Method Description

coeffvalues Get coefficient values

confint Get confidence intervals for fit coefficients
dependnames Get dependent variable name
differentiate Differentiate fit

excludedata Exclude data from fit

feval Evaluate model at specified predictors
fittype Construct Fittype object

formula Get formula string

indepnames Get independent variable name
integrate Integrate curve fit

islinear Determine if model is linear

numargs Get number of input arguments
numcoeffs Get number of coefficients

plot Plot fit

predint Get prediction intervals

probnames Get problem-dependent parameter names
probvalues Get problem-dependent parameter values
quad2d Numerically integrate surface fit (SFit object)
setoptions Set model fit options

type Get name of model
See Also

excludedata | fit | Fitoptions | Fittype | prepareCurveData |
prepareSurfaceData

Related Examples
. “Generating MATLAB Code and Exporting Fits” on page 2-20
. “List of Library Models for Curve and Surface Fitting” on page 4-13

. “Polynomial Curve Fitting”
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. “Custom Nonlinear Census Fitting” on page 5-21

. “Surface Fitting With Custom Equations to Biopharmaceutical Data”
. “Evaluate a Curve Fit” on page 7-20

. “Evaluate a Surface Fit” on page 7-32

. “Fit Postprocessing”
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Curve and Surface Fitting Objects and Methods

In this section...

“Curve Fitting Objects” on page 3-7
“Curve Fitting Methods” on page 3-9
“Surface Fitting Objects and Methods” on page 3-11

This section describes how to use Curve Fitting Toolbox functions from the command-line
or to write programs for curve and surface fitting applications.

The Curve Fitting app allows convenient, interactive use of Curve Fitting Toolbox
functions, without programming. You can, however, access Curve Fitting Toolbox
functions directly, and write programs that combine curve fitting functions with
MATLAB functions and functions from other toolboxes. This allows you to create a curve
fitting environment that is precisely suited to your needs.

Models and fits in the Curve Fitting app are managed internally as curve fitting objects.
Objects are manipulated through a variety of functions called methods. You can create
curve fitting objects, and apply curve fitting methods, outside of the Curve Fitting app.

Curve Fitting Objects

In MATLAB programming, all workspace variables are objects of a particular class.
Familiar examples of MATLAB classes are double, char, and function_handle. You
can also create custom MATLAB classes, using object-oriented programming.

Methods are functions that operate exclusively on objects of a particular class. Data types
package together objects and methods so that the methods operate exclusively on objects
of their own type, and not on objects of other types. A clearly defined encapsulation of
objects and methods is the goal of object-oriented programming.

Curve Fitting Toolbox software provides you with new MATLAB data types for
performing curve fitting:

+ fittype — Objects allow you to encapsulate information describing a parametric
model for your data. Methods allow you to access and modify that information.

+ cfitand sfit — Two subtypes of Fittype, for curves and surfaces. Objects capture
information from a particular fit by assigning values to coefficients, confidence
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intervals, fit statistics, etc. Methods allow you to post-process the fit through plotting,
extrapolation, integration, etc.

fittype
objects

Because cFitis a subtype of Fittype, cFit inherits all Fittype methods. In other
words, you can apply Fittype methods to both Fittype and cFit objects, but cFit
methods are used exclusively with cFit objects. Similarly for sFit objects.

As an example, the Fittype method islinear, which determines if a model is linear
or nonlinear, would apply equally well before or after a fit; that is, to both fittype

and cfit objects. On the other hand, the cfit methods coeffvalues and confint,
which, respectively, return fit coefficients and their confidence intervals, would make no
sense if applied to a general Fittype object which describes a parametric model with
undetermined coefficients.

Curve fitting objects have properties that depend on their type, and also on the
particulars of the model or the fit that they encapsulate. For example, the following code
uses the constructor methods for the two curve fitting types to create a Fittype object
and a cFit object c:

T = Fittype("a*x"2+b*exp(n*x) ")
¥ =
General model:
f(a,b,n,x) = a*x"2+b*exp(n*x)
c = cfFit(f,1,10.3,-1e2)
Cc =

General model:
c(X) = a*x™2+b*exp(n*x)
Coefficients:
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a = 1
b = 10.3
n = -100

Note that the display method for Fittype objects returns only basic information, piecing
together outputs from formula and indepnames.

cFit and Fittype objects are evaluated at predictor values X using feval. You can call
feval indirectly using the following functional syntax:

y
y

cfun(x) % cfit objects;
ffun(coefl,coef2,...,x) % Fittype objects;

Curve Fitting Methods

Curve fitting methods allow you to create, access, and modify curve fitting objects. They
also allow you, through methods like plot and integrate, to perform operations that
uniformly process the entirety of information encapsulated in a curve fitting object.

The methods listed in the following table are available for all Fittype objects, including
cfTit objects.

Fit Type Method Description

argnames Get input argument names
category Get fit category

coeffnames Get coefficient names

dependnames Get dependent variable name

feval Evaluate model at specified predictors
fittype Construct Fittype object

formula Get formula string

indepnames Get independent variable name
islinear Determine if model is linear

numargs Get number of input arguments
numcoeffs Get number of coefficients

probnames Get problem-dependent parameter names
setoptions Set model fit options
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Fit Type Method Description
type Get name of model
The methods listed in the following table are available exclusively for cFit objects.
Curve Fit Method Description
cfit Construct cFit object
coeffvalues Get coefficient values
confint Get confidence intervals for fit coefficients
differentiate Differentiate fit
integrate Integrate fit
plot Plot fit
predint Get prediction intervals
probvalues Get problem-dependent parameter values

A complete list of methods for a curve fitting object can be obtained with the MATLAB
methods command. For example,

T = Fittype("a*x™"2+b*exp(n*x)");
methods(F)

Methods for class fittype:

argnames dependnames fittype islinear probnames
category feval formula numargs setoptions
coeffnames fitoptions indepnames numcoeffs type

Note that some of the methods listed by methods do not appear in the tables above,

and do not have reference pages in the Curve Fitting Toolbox documentation. These
additional methods are generally low-level operations used by the Curve Fitting app, and
not of general interest when writing curve fitting applications.

There are no global accessor methods, comparable to getField and setfield, available
for Fittype objects. Access is limited to the methods listed above. This is because many
of the properties of Fittype objects are derived from other properties, for which you do
have access. For example,

f = fittype("a*cos( b*x-c )*)
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f =
General model:
f(a,b,c,x) = a*cos( b*x-c )
formula(f)
ans =

a*cos( b*x-c )

argnames(f)
ans =

You construct the Fittype object ¥ by giving the formula, so you do have write access
to that basic property of the object. You have read access to that property through

the formula method. You also have read access to the argument names of the object,
through the argnames method. You don't, however, have direct write access to the
argument names, which are derived from the formula. If you want to set the argument
names, set the formula.

Surface Fitting Objects and Methods
Surface Fitting Objects and Methods

The surface fit object (sSFit) stores the results from a surface fitting operation, making it
easy to plot and analyze fits at the command line.

Like cFit objects, sFit objects are a subclass of Fittype objects, so they inherit all the
same methods of Fittype listed in “Curve Fitting Methods” on page 3-9.

sFit objects also provide methods exclusively for sFit objects. See sFit.

One way to quickly assemble code for surface fits and plots into useful programs is to
generate a file from a session in the Curve Fitting app. In this way, you can transform
your interactive analysis of a single data set into a reusable function for command-line
analysis or for batch processing of multiple data sets. You can use the generated file
without modification, or edit and customize the code as needed. See “Generate Code and
Export Fits to the Workspace” on page 7-16.
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+ “Parametric Fitting” on page 4-2

+  “List of Library Models for Curve and Surface Fitting” on page 4-13
* “Polynomial Models” on page 4-19

+  “Exponential Models” on page 4-37

+ “Fourier Series” on page 4-46

+ “Gaussian Models” on page 4-57

* “Power Series” on page 4-61

+  “Rational Polynomials” on page 4-65
*  “Sum of Sines Models” on page 4-72
+ “Weibull Distributions” on page 4-75
+  “Least-Squares Fitting” on page 4-78
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Parametric Fitting

In this section...

“Parametric Fitting with Library Models” on page 4-2
“Selecting a Model Type Interactively” on page 4-3
“Selecting Model Type Programmatically” on page 4-5
“Using Normalize or Center and Scale” on page 4-5

“Specifying Fit Options and Optimized Starting Points” on page 4-6

Parametric Fitting with Library Models

Parametric fitting involves finding coefficients (parameters) for one or more models that
you fit to data. The data is assumed to be statistical in nature and is divided into two
components:

data = deterministic component + random component

The deterministic component is given by a parametric model and the random component
is often described as error associated with the data:

data = parametric model + error

The model is a function of the independent (predictor) variable and one or more
coefficients. The error represents random variations in the data that follow a specific
probability distribution (usually Gaussian). The variations can come from many different
sources, but are always present at some level when you are dealing with measured data.
Systematic variations can also exist, but they can lead to a fitted model that does not
represent the data well.

The model coefficients often have physical significance. For example, suppose you
collected data that corresponds to a single decay mode of a radioactive nuclide, and you
want to estimate the half-life (74/5) of the decay. The law of radioactive decay states that
the activity of a radioactive substance decays exponentially in time. Therefore, the model
to use in the fit is given by

-t
Y=JXo€
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where yg is the number of nuclei at time ¢ = 0, and A is the decay constant. The data can
be described by

data = yOe_/lt + error

Both yy and A are coefficients that are estimated by the fit. Because T, = In(2)/A, the
fitted value of the decay constant yields the fitted half-life. However, because the data
contains some error, the deterministic component of the equation cannot be determined
exactly from the data. Therefore, the coefficients and half-life calculation will have some
uncertainty associated with them. If the uncertainty is acceptable, then you are done
fitting the data. If the uncertainty is not acceptable, then you might have to take steps to
reduce it either by collecting more data or by reducing measurement error and collecting
new data and repeating the model fit.

With other problems where there is no theory to dictate a model, you might also modify
the model by adding or removing terms, or substitute an entirely different model.

The Curve Fitting Toolbox parametric library models are described in the following
sections.

Selecting a Model Type Interactively

Select a model type to fit from the drop-down list in the Curve Fitting app.

Polynormial -
Degree: |1 A
Robust: | Off -

Center and scale

Fit Options...

What fit types can you use for curves or surfaces? Based on your selected data, the fit
category list shows either curve or surface categories. The following table describes the
options for curves and surfaces.
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Fit Category ‘ Curves ‘ Surfaces

Regression Models

Polynomial Yes (up to degree 9) Yes (up to degree 5)

Exponential Yes

Fourier Yes

Gaussian Yes

Power Yes

Rational Yes

Sum of Sine Yes

Weibull Yes

Interpolation

Interpolant Yes Yes
Methods: Methods:
Nearest neighbor Nearest neighbor
Linear Linear
Cubic Cubic

Shape-preserving (PCHIP) |Biharmonic
Thin-plate spline

Smoothing

Smoothing Spline Yes

Lowess Yes

Custom

Custom Equation on page |Yes Yes
5-2

“Custom Linear Fitting” on Yes
page 5-7

For all fit categories, look in the Results pane to see the model terms, the values of the
coefficients, and the goodness-of-fit statistics.

Tip: If your fit has problems, messages in the Results pane help you identify better
settings.
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Selecting Fit Settings

The Curve Fitting app provides a selection of fit types and settings that you can change
to try to improve your fit. Try the defaults first, then experiment with other settings.

For an overview of how to use the available fit options, see “Specifying Fit Options and
Optimized Starting Points” on page 4-6.

You can try a variety of settings within a single fit figure, and you can also create
multiple fits to compare. When you create multiple fits you can compare different fit
types and settings side by side in the Curve Fitting app. See “Create Multiple Fits in
Curve Fitting App” on page 2-14.

Selecting Model Type Programmatically

You can specify a library model name as a string when you call the Fit function. For
example, to specify a quadratic poly2:

f = fit( x, y, "poly2® )

See “List of Library Models for Curve and Surface Fitting” on page 4-13 to view all
available library model names.

You can also use the Fittype function to construct a Fittype object for a library model,
and use the Fittype as an input to the Fit function.

Use the fitoptions function to find out what parameters you can set, for example:
fitoptions(poly2)

For examples, see the sections for each model type, listed in the table in “Selecting a
Model Type Interactively” on page 4-3. For details on all the functions for creating
and analysing models, see “Curve and Surface Fitting” on page 3-2.

Using Normalize or Center and Scale

Most model types in the Curve Fitting app share the Center and scale option. When
you select this option, the tool refits with the data centered and scaled, by applying the
Normal ize setting to the variables. At the command line, you can use Normalize as an
input argument to the Fitoptions function. See the Fitoptions reference page.

Generally, it is a good idea to normalize inputs (also known as predictor data), which can
alleviate numerical problems with variables of different scales. For example, suppose
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your surface fit inputs are engine speed with a range of 500—4500 r/min and engine load
percentage with a range of 0—1. Then, Center and scale generally improves the fit
because of the great difference in scale between the two inputs. However, if your inputs
are in the same units or similar scale (e.g., eastings and northings for geographic data),
then Center and scale is less useful. When you normalize inputs with this option, the
values of the fitted coefficients change when compared to the original data.

If you are fitting a curve or surface to estimate coefficients, or the coefficients have
physical significance, clear the Center and scale check box. The Curve Fitting app plots
use the original scale with or without the Center and scale option.

At the command line, to set the option to center and scale the data before fitting, create
the default fit options structure, set Normalize to on, then fit with the options:

options = fitoptions;
options.Normal = "on";
options
options =
Normalize: "on”
Exclude: [1x0 double]
Weights: [1x0 double]
Method: "None*

load census
fl = fit(cdate,pop, "poly3”,options)

Specifying Fit Options and Optimized Starting Points

+ “About Fit Options” on page 4-6

+ “Fitting Method and Algorithm” on page 4-9

+  “Finite Differencing Parameters” on page 4-9

+  “Fit Convergence Criteria” on page 4-9

+ “Coefficient Parameters” on page 4-10

* “Optimized Starting Points and Default Constraints” on page 4-10
+ “Specifying Fit Options at the Command Line” on page 4-11

About Fit Options

Interactive fit options are described in the following sections. To specify the same fit
options programmatically, see “Specifying Fit Options at the Command Line” on page
4-11.
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To specify fit options interactively in the Curve Fitting app, click the Fit Options button
to open the Fit Options dialog box. All fit categories except interpolants and smoothing
splines have configurable fit options.

The available options depend on whether you are fitting your data using a linear model, a
nonlinear model, or a nonparametric fit type:

All the options described next are available for nonlinear models.

Lower and Upper coefficient constraints are the only fit options available in the
dialog box for polynomial linear models. For polynomials you can set Robust in the
Curve Fitting app, without opening the Fit Options dialog box.

Nonparametric fit types have no additional fit options dialog box (interpolant,
smoothing spline, and lowess).

The fit options for the single-term exponential are shown next. The coefficient starting
values and constraints are for the census data.
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4\ Fit Options Iﬁ

Method: MonlinearLeastSquares —
Robust of 7| | |- Fitting method and algorithm
Algaorithm: Trust-Region > |
DiffMinChange: 108 [ [| e w o )
- Finite differencing parameters
DiffMaxChange: 01|
MazxFunEvals: 600
Maxdter: 40011 L Fit convergence criferia
TelFun: 1.0e-6
Tolx: 1.0e-6 |
Coefficie.. StartPoint  Lower Upper (oeﬁicieni para meters
a 9.0416e-15 -Inf Inf
b 00191 -Inf Inf] | —
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Fitting Method and Algorithm

Method — The fitting method.

The method is automatically selected based on the library or custom model you use.
For linear models, the method is LinearLeastSquares. For nonlinear models, the
method is NonlinearLeastSquares.

Robust — Specify whether to use the robust least-squares fitting method.

Off — Do not use robust fitting (default).
On — Fit with the default robust method (bisquare weights).
LAR — Fit by minimizing the least absolute residuals (LAR).

Bisquare — Fit by minimizing the summed square of the residuals, and reduce
the weight of outliers using bisquare weights. In most cases, this is the best choice
for robust fitting.

Algorithm — Algorithm used for the fitting procedure:

Trust-Region — This is the default algorithm and must be used if you specify
Lower or Upper coefficient constraints.

Levenberg-Marquardt — If the trust-region algorithm does not produce a
reasonable fit, and you do not have coefficient constraints, try the Levenberg-
Marquardt algorithm.

Finite Differencing Parameters

DiffMinChange — Minimum change in coefficients for finite difference Jacobians.
The default value is 10°®.

DiffMaxChange — Maximum change in coefficients for finite difference Jacobians.
The default value is 0.1.

Note that DiffMinChange and DiffMaxChange apply to:

Any nonlinear custom equation, that is, a nonlinear equation that you write

Some of the nonlinear equations provided with Curve Fitting Toolbox software

However, DiffMinChange and DiffMaxChange do not apply to any linear equations.

Fit Convergence Criteria

MaxFunEvals — Maximum number of function (model) evaluations allowed. The

default value 1s 600.
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+ MaxIter — Maximum number of fit iterations allowed. The default value is 400.

* TolFun — Termination tolerance used on stopping conditions involving the function
(model) value. The default value is 10°°.

+ TolX — Termination tolerance used on stopping conditions involving the coefficients.
The default value is 10°.

Coefficient Parameters

+ Coefficients — Symbols for the unknown coefficients to be fitted.

+ StartPoint — The coefficient starting values. The default values depend on the
model. For rational, Weibull, and custom models, default values are randomly
selected within the range [0,1]. For all other nonlinear library models, the starting
values depend on the data set and are calculated heuristically. See optimized starting
points below.

+ Lower — Lower bounds on the fitted coefficients. The tool only uses the bounds with
the trust region fitting algorithm. The default lower bounds for most library models
are — Inf, which indicates that the coefficients are unconstrained. However, a few
models have finite default lower bounds. For example, Gaussians have the width
parameter constrained so that it cannot be less than 0. See default constraints below.

+ Upper — Upper bounds on the fitted coefficients. The tool only uses the bounds with
the trust region fitting algorithm. The default upper bounds for all library models are
Inf, which indicates that the coefficients are unconstrained.

For more information about these fit options, see the 1sqcurvefit function in the
Optimization Toolbox documentation.

Optimized Starting Points and Default Constraints

The default coefficient starting points and constraints for library and custom models are
shown in the next table. If the starting points are optimized, then they are calculated
heuristically based on the current data set. Random starting points are defined on the
interval [0,1] and linear models do not require starting points.

If a model does not have constraints, the coefficients have neither a lower bound nor an
upper bound. You can override the default starting points and constraints by providing

your own values using the Fit Options dialog box.

Default Starting Points and Constraints
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Model Starting Points Constraints
Custom linear N/A None
Custom nonlinear Random None
Exponential Optimized None
Fourier Optimized None
Gaussian Optimized >0
Polynomial N/A None
Power Optimized None
Rational Random None
Sum of Sine Optimized b;>0
Weibull Random a,b>0

Note that the sum of sines and Fourier series models are particularly sensitive to
starting points, and the optimized values might be accurate for only a few terms in the
associated equations.

Specifying Fit Options at the Command Line

Create the default fit options structure and set the option to center and scale the data
before fitting:

options = fitoptions;
options.Normal = "on";
options
options =
Normalize: "on”
Exclude: [1x0 double]
Weights: [1x0 double]
Method: "None*

Modifying the default fit options structure is useful when you want to set the
Normalize, Exclude, or Weights fields, and then fit your data using the same options
with different fitting methods. For example:

load census

fl = fit(cdate,pop, "poly3”,options);
2 = fit(cdate,pop, "expl”,options);
3 = fit(cdate,pop, "cubicsp®,options);
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Data-dependent fit options are returned in the third output argument of the fit
function. For example, the smoothing parameter for smoothing spline is data-dependent:

[f,go0f,out]

smoothparam

smoothparam
0.0089

fit(cdate,pop, "smooth™);
out.p

Use fit options to modify the default smoothing parameter for a new fit:

options = fitoptions("Method", "Smooth", "SmoothingParam®,0.0098);
[f,gof,out] = fit(cdate,pop, "smooth”,options);

For more details on using fit options, see the Fitoptions reference page.
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List of Library Models for Curve and Surface Fitting

In this section...
“Use Library Models to Fit Data” on page 4-13
“Library Model Types” on page 4-13

“Model Names and Equations” on page 4-14

Use Library Models to Fit Data

You can use the Curve Fitting Toolbox library of models for data fitting with the Fit
function. You use library model names as input arguments in the fit, Fitoptions, and
Fittype functions.

Library Model Types

The following tables describe the library model types for curves and surfaces.

* Use the links in the table for examples and detailed information on each library type.

+ If you want a quick reference of model names for input arguments to the Fit function,
see “Model Names and Equations” on page 4-14.

Library Model Types for Description

Curves

distribution Distribution models such as Weibull. See “Weibull
Distributions” on page 4-75.

exponential Exponential function and sum of two exponential functions.
See “Exponential Models” on page 4-37.

fourier Up to eight terms of Fourier series. See “Fourier Series” on
page 4-46.

gaussian Sum of up to eight Gaussian models. See “Gaussian Models”
on page 4-57.

interpolant Interpolating models, including linear, nearest neighbor,
cubic spline, and shape-preserving cubic spline. See
“Nonparametric Fitting” on page 6-2.

polynomial Polynomial models, up to degree nine. See “Polynomial
Models” on page 4-19.
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Library Model Types for Description

Curves

power Power function and sum of two power functions. See “Power
Series” on page 4-61.

rational Rational equation models, up to 5th degree/5th degree (i.e.,
up to degree 5 in both the numerator and the denominator).
See “Rational Polynomials” on page 4-65.

sin Sum of up to eight sin functions. See “Sum of Sines Models”
on page 4-72.

spline Cubic spline and smoothing spline models. See
“Nonparametric Fitting” on page 6-2.

Library Model Types for Description

Surfaces

interpolant Interpolating models, including linear, nearest neighbor,
cubic spline, biharmonic, and thin-plate spline interpolation.
See “Interpolation Methods” on page 6-3.

lowess Lowess smoothing models. See “Lowess Smoothing” on page
6-20.

polynomial Polynomial models, up to degree five. See “Polynomial
Models” on page 4-19.

Model Names and Equations

To specify the model you want to fit, consult the following tables for a model name to use
as an input argument to the Fit function. For example, to specify a quadratic curve with

model name “poly2” :

f = fit(x, y, T"poly2%)

Polynomial Model Names and Equations

Examples of Polynomial Model Names for Equations

Curves

polyl Y = pl*x+p2

poly2 Y = pl*x"2+p2*x+p3
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Examples of Polynomial Model Names for Equations
Curves
poly3 Y = pl*X"3+p2*x"2+. . .+p4

...etc., up to poly9

Y = pl*x"9+p2*x/8+. . .+pl0

For polynomial surfaces, model names are "polyij", where i is the degree in x and j

is the degree in y. The maximum for both 1 and j is five. The degree of the polynomial

is the maximum of 1 and j. The degree of x in each term will be less than or equal to 1,
and the degree of y in each term will be less than or equal to j. See the following table for
some example model names and equations, of many potential examples.

Examples of Polynomial Model Names for Equations

Surfaces

poly21 Z = p00 + plO*x + pOl*y + p20*x~"2
+ pll*x*y

polyl3 Z = p00 + pl0*x + pOl*y + pll*x*y
+ p02*y"2 + pl2*x*y"2 + p03*y"3

poly55 Z = p00 + pl0*x + pOl*y +...+
pl4*x*y"4 + p05*y"5

Distribution Model Name and Equation

Distribution Model Names

Equations

weibull

Y = a*b*x*(b-1)*exp(-a*x"b)

Exponential Model Names and Equations

Exponential Model Names

Equations

expl

Y = a*exp(b*x)

exp2

Y = a*exp(b*x)+c*exp(d*x)

Fourier Series Model Names and Equations

Fourier Series Model Names

Equations

fourierl

Y = a0+al*cos(xX*p)+bl*sin(x*p)
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Fourier Series Model Names Equations

fourier2 Y = a0+al*cos(X*p)+bl*sin(X*p)...
+a2*cos(2*x*p)+b2*sin(2*x*p)

fourier3

Y = a0+al*cos(X*p)+bl*sin(xX*p)...
+a3*cos(3*x*p)+b3*sin(3*x*p)

...etc., up to Fourier8

Y = a0+al*cos(X*p)+bl*sin(xX*p)...
+a8*cos(8*x*p)+b8*sin(8*x*p)

Where p = 2*pi/(max(xdata)-min(xdata)).

Gaussian Model Names and Equations

Gaussian Model Names Equations

gaussl Y = al*exp(-((x-b1)/c1)"2)

gauss?2 Y = al*exp(-((x-b1)/c1)"2)+a2*. ..
exp(-((x-b2)/c2)"2)

gauss3 Y = al*exp(-((x-bl1l)/c1)"2)+. ..

+a3*exp(-((x-b3)/c3)"2)

...etc., up to gauss8

Y = al*exp(-((x-b1)/c1)"2) +...
+a8*exp(-((x-b8)/c8)"2)

Power Model Names and Equations

Power Model Names Equations
powerl Y = a*x™b
power2 Y = a*x"b+c

Rational Model Names and Equations

Rational models are polynomials over polynomials with the leading coefficient of the
denominator set to 1. Model names are ratij, where i is the degree of the numerator
and j is the degree of the denominator. The degrees go up to five for both the numerator

and the denominator.

Examples of Rational Model Names

Equations

rat02

Y = (pl)/(x"2+ql*x+q2)
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Examples of Rational Model Names

Equations

rat21

Y = (p1*x"2+p2*x+p3)/(x+ql)

rats5

Y = (p1*X/5+. . .+p6)/ (X" 5+. . .+q5)

Sum of Sine Model Names and Equations

Sum of Sine Model Names

Equations

sinl Y = al*sin(bl*x+cl)

sin2 Y = al*sin(bl*x+cl)+a2*sin. ..
(b2*x+c2)

sin3 Y = al*sin(bl*x+cl)+...
+a3*sin(b3*x+c3)

...etc., up to sin8 Y = al*sin(bl*x+cl)+...
+a8*sin(b8*x+c8)

Spline Model Names

Spline models are supported for curve fitting, not for surface fitting.

Spline Model Names

Description

cubicspline

Cubic interpolating spline

smoothingspline

Smoothing spline

Interpolant Model Names

Type Interpolant Model Names Description
Curves and Surfaces |linearinterp Linear interpolation
nearestinterp Nearest neighbor interpolation
cubicinterp Cubic spline interpolation
Curves only pchipinterp Shape-preserving piecewise
cubic Hermite (pchip)
interpolation
Surfaces only biharmonicinterp Biharmonic (MATLAB
griddata) interpolation
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Type

Interpolant Model Names

Description

thinplateinterp

Thin-plate spline interpolation

Lowess Model Names

Lowess models are supported for surface fitting, not for curve fitting.

Lowess Model Names Description
lowess Local linear regression
loess Local quadratic regression
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Polynomial Models

In this section...

“About Polynomial Models” on page 4-19

“Fit Polynomial Models Interactively” on page 4-20
“Fit Polynomials Using the Fit Function” on page 4-22
“Polynomial Model Fit Options” on page 4-34

“Defining Polynomial Terms for Polynomial Surface Fits” on page 4-35

About Polynomial Models

Polynomial models for curves are given by

n+l1

y= Z pixn+1—z
=

where n + 1 is the order of the polynomial, n is the degree of the polynomial, and 1 <n <
9. The order gives the number of coefficients to be fit, and the degree gives the highest
power of the predictor variable.

In this guide, polynomials are described in terms of their degree. For example, a third-
degree (cubic) polynomial is given by

2
¥ = p1x® + pox® + pax+ py

Polynomials are often used when a simple empirical model is required. You can use the
polynomial model for interpolation or extrapolation, or to characterize data using a global
fit. For example, the temperature-to-voltage conversion for a Type J thermocouple in the

0 to 760° temperature range is described by a seventh-degree polynomial.

Note If you do not require a global parametric fit and want to maximize the flexibility of
the fit, piecewise polynomials might provide the best approach. Refer to “Nonparametric
Fitting” on page 6-2 for more information.
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The main advantages of polynomial fits include reasonable flexibility for data that is not
too complicated, and they are linear, which means the fitting process is simple. The main
disadvantage is that high-degree fits can become unstable. Additionally, polynomials of
any degree can provide a good fit within the data range, but can diverge wildly outside
that range. Therefore, exercise caution when extrapolating with polynomials.

When you fit with high-degree polynomials, the fitting procedure uses the predictor
values as the basis for a matrix with very large values, which can result in scaling
problems. To handle this, you should normalize the data by centering it at zero mean and
scaling it to unit standard deviation. Normalize data by selecting the Center and scale
check box in the Curve Fitting app.

Fit Polynomial Models Interactively
1  Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.
2 In the Curve Fitting app, select curve or surface data.
If you select curve data (X data and Y data, or just Y data against index), Curve
Fitting app creates the default curve fit, Polynomial.

+ If you select surface data (X data, Y data, and Z data), Curve Fitting app
creates the default surface fit, Interpolant. Change the model type from
Interpolant to Polynomial.

For curves, the Polynomial model fits a polynomial in x.

Polynomial -
Degree: | 1 -
Robust: | Off -

Center and scale

Fit Options...

For surfaces, the Polynomial model fits a polynomial in x and y.
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Polynomial A
Degrees: » |1 * y |1 -
Reobust: Off -

Center and scale

| Fit Options... |

You can specify the following options:

The degree for the x and y inputs:

*  For curves, degree of x can be up to 9.

+  For surfaces, degree of x and y can be up to 5.

The degree of the polynomial is the maximum of x and y degrees. See “Defining
Polynomial Terms for Polynomial Surface Fits” on page 4-35.

The robust linear least-squares fitting method to use (OFF, LAR, or Bisquare). For
details, see Robust on the Fitoptions reference page.

Set bounds or exclude terms by clicking Fit Options. You can exclude any term by
setting its bounds to 0.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

Tip: If your input variables have very different scales, select and clear the Center and
scale check box to see the difference in the fit. Messages in the Results pane prompt you
when scaling might improve your fit.

For an example comparing various polynomial fits, see “Compare Fits in Curve Fitting
App” on page 2-21.
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Fit Polynomials Using the Fit Function

This example shows how to use the Fit function to fit polynomials to data. The steps
fit and plot polynomial curves and a surface, specify fit options, return goodness of fit
statistics, calculate predictions, and show confidence intervals.

The polynomial library model is an input argument to the fit and fittype functions.
Specify the model type poly followed by the degree in x (up to 9), or x and y (up to 5). For
example, you specify a quadratic curve with "poly2” , or a cubic surface with "poly33*

Create and Plot a Quadratic Polynomial Curve

Load some data and fit a quadratic polynomial. Specify a quadratic, or second-degree
polynomial, with the string "poly2* .

load census;
fitpoly2=Ffit(cdate,pop, "poly2)

% Plot the fit with the plot method.
plot(fitpoly2,cdate,pop)

% Move the legend to the top left corner.
legend("Location”, "NorthWest" );

fitpoly2 =
Linear model Poly2:

Fitpoly2(X) = pl*x"2 + p2*x + p3
Coefficients (with 95% confidence bounds):

pl = 0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
p3 = 2.113e+04 (1.964e+04, 2.262e+04)
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250 T
+  data
fitted curve

20071 b
150 i
100 b

50 F h

D '_‘I._ 1 i 1

1750 1800 1850 1800 1950 2000

Create a Cubic Curve
Fit a cubic polynomial "poly3*.

fitpoly3=Ffit(cdate,pop, "poly3™)
plot(Ffitpoly3,cdate,pop)

Warning: Equation is badly conditioned. Remove repeated data points or try
centering and scaling.

fitpoly3 =
Linear model Poly3:

Fitpoly3(X) = pl*x"3 + p2*x™2 + p3*x + p4
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Coefficients (with 95% confidence bounds):

pl = 3.855e-06 (-4.078e-06, 1.179e-05)
p2 = -0.01532 (-0.06031, 0.02967)
p3 = 17.78 (-67.2, 102.8)
p4 = -4852 (-5.834e+04, 4.863e+04)
300 T T T T
+ data
fitted curve
280 b
200 b
=150 1 . 7
100 . 7
50 7
.-"ff‘
___.-i'-
0 -— +_L_J---' i i i
1750 1800 1850 1900 1950 2000
x
Specify Fit Options

The cubic fit warns that the equation is badly conditioned, so you should try centering
and scaling by specifying the "Normal ize" option. Fit the cubic polynomial with both
center and scale and robust fitting options. Robust "on” is a shortcut equivalent to
"Bisquare” , the default method for robust linear least-squares fitting method.
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fit3=fFit(cdate, pop,“poly3~,"Normalize®,"on", "Robust”,"on")
plot(fit3,cdate,pop)

fit3 =

Linear model Poly3:
FiIt3(X) = pl*X"3 + p2*x"2 + p3*x + p4

where X is normalized by mean 1890 and std 62.05
Coefficients (with 95% confidence bounds):

pl = -0.4619 (-1.895, 0.9707)
p2 = 25.01 (23.79, 26.22)
p3 = 77.03 (74.37, 79.7)
p4 = 62.81 (61.26, 64.37)

250

200

T T T T l."I'

+ data
fitted curve

1750

1800 1850 1900 1950

2000

4-25



4 \linear and Nonlinear Regression

To find out what parameters you can set for the library model "poly3* , use the
fitoptions function.

fitoptions poly3

ans =

Normalize: “off*
Exclude: []
Weights: []
Method: T“LinearLeastSquares”
Robust: “Off*
Lower: [1x0 double]
Upper: [1x0 double]

Get Goodness of Fit Statistics

Specify the "gof”" output argument to get the goodness-of-fit statistics for the cubic
polynomial fit.

[fit4, gof]=Fit(cdate, pop, “poly3", "Normalize","on");
gof
gof =
struct with fields:
sse: 149.7687
rsquare: 0.9988
dfe: 17

adjrsquare: 0.9986
rmse: 2.9682

Plot the Residuals to Evaluate the Fit

To plot residuals, specify "residuals” as the plot type in the plot method.

plot(fit4,cdate, pop, “residuals®);
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data
zero line

-8 L

1750 1800 1850

Examine a Fit Beyond the Data Range

1900

1950

2000

By default, the fit is plotted over the range of the data. To plot a fit over a different
range, set the x-limits of the axes before plotting the fit. For example, to see values

extrapolated from the fit, set the upper x-limit to 2050.

plot( cdate, pop, “0" );
xlim( [1900, 2050] );
hold on

plot( fit4 );

hold off
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450 T T

fitted curve |/
400 i

350 [ -
300 [ -
> 250 [ -
200 .

180 ;*’6/ 4

L g i
100 [

5D i i
1900 1950 2000 20350

Plot Prediction Bounds

To plot prediction bounds, use "predobs”® or "predfun® as the plot type.

plot(fit4,cdate,pop, "predobs®)
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300 T T T T
+ data
i fitted curve i
250 prediction bounds
200 n
150 N

100 i
S0 b
D | — __L__ :-é-:_-.r- n
-50 i i i i
1750 1800 1850 1900 1950 2000

X

Plot prediction bounds for the cubic polynomial up to year 2050.

plot( cdate, pop, “0" );
xlim( [1900, 2050] )
hold on

plot( fit4, “predobs” );
hold off
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500 T T

fitted curve
450 prediction bounds |

400

350

300

250

200

150

100 1

1900 1950 2000 20350
X

Get Confidence Bounds at New Query Points

Evaluate the fit for some new query points.
cdateFuture = (2000:10:2020).";
popFuture = Fit4( cdateFuture )
popFuture =

276.9632

305.4420
335.5066
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Compute 95% confidence bounds on the prediction for the population in the future, using
the predint method.

ci predint( fit4, cdateFuture, 0.95, “observation® )

267.8589 286.0674
294 _3070 316.5770
321.5924 349.4208

Plot the predicted future population, with confidence intervals, against the fit and data.

plot(cdate, pop, "07%);

x1im([1900, 2040]1)

hold on

plot(fit4)

h = errorbar(cdateFuture,popFuture,popFuture-ci(:,1),ci(:,2)-popFuture,”.");
hold off

legend("cdate v pop®,"poly3*","prediction”, "Location”, *NorthWest")
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450 T T T T T T

O cdate v pop

400 | poly3
I prediction

350

300

= 250

200

150

100

i

ED i i i i i i
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Fit and Plot a Polynomial Surface

Load some surface data and fit a fourth-degree polynomial in x and y.

load franke;
fitsurface=fFit([x,yl,z, "poly44","Normalize","on")
plot(fitsurface, [X,y],z)

Linear model Poly44:
Ffitsurface(x,y) = p00 + plO*x + pOl*y + p20*x"2 + pll*x*y + p02*y"2 + p30*x"3
+ p2LFXN2*y + pl2*x*y~2 + p03*y"3 + p40*x™M4 + p31*xN3*y
+ p22FXN2*yN2 + pl3*x*y"3 + p04*ry™4
where x is normalized by mean 1982 and std 868.6
and where y is normalized by mean 0.4972 and std 0.2897
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Coefficients (with 95% confidence bounds):

pO0
p10
pO1
p20
pl1
p02
p30
p21
pl12
p03
p40
p31
p22
p13
po4

0.3471
-0.1502
-0.4203

0.2165

0.1717
0.03189
0.02778
0.01501

-0.03659
0.1184
-0.07661
-0.02487
0.0007464
-0.02962
-0.02399

(0.3033, 0.3909)
(-0.1935, -0.107)
(-0.4637, -0.377)
(0.1514, 0.2815)
(0.1175, 0.2259)
(-0.03351, 0.09729)
(0.00749, 0.04806)
(-0.002807, 0.03283)
(-0.05439, -0.01879)
(0.09812, 0.1387)
(-0.09984, -0.05338)
(-0.04512, -0.004624)
(-0.01948, 0.02098)
(-0.04987, -0.009366)
(-0.0474, -0.0005797)
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Polynomial Model Fit Options

All fitting methods have the default properties Normalize, Exclude, Weights, and
Method. For an example, see “Specifying Fit Options at the Command Line” on page
4-11.

Polynomial models have the Method property value LinearLeastSquares, and the

additional fit options properties shown in the next table. For details on all fit options, see
the Fitoptions reference page.
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Property

Description

Robust

Specifies the robust linear least-squares fitting method to use.
Values are "on", "off", "LAR", or "Bisquare”. The default is
"off".

"LAR" specifies the least absolute residual method and
"Bisquare” specifies the bisquare weights method. "on” is
equivalent to "Bisquare”, the default method.

Lower

A vector of lower bounds on the coefficients to be fitted. The
default value is an empty vector, indicating that the fit is
unconstrained by lower bounds. If bounds are specified, the
vector length must equal the number of coefficients. Individual
unconstrained lower bounds can be specified by - Inf.

Upper

A vector of upper bounds on the coefficients to be fitted. The
default value is an empty vector, indicating that the fit is
unconstrained by upper bounds. If bounds are specified, the
vector length must equal the number of coefficients. Individual
unconstrained upper bounds can be specified by Inf.

Defining Polynomial Terms for Polynomial Surface Fits

You can control the terms to include in the polynomial surface model by specifying the
degrees for the x and y inputs. If i is the degree in x and j is the degree in y, the total
degree of the polynomial is the maximum of i and j. The degree of x in each term is
less than or equal to i, and the degree of y in each term is less than or equal to j. The
maximum for both i and j is five.

For example:

poly21 Zz
polyl3 Zz
poly55 Z

p00 + p1l0*x + pOl*y + p20*x"2 + pll*x*y

p00 + p1l0*x + pOl*y + pll*x*y + p02*y~2

+ pl2*x*y”~2 + p03*y"3

p00 + p1l0*x + pOl*y +...+ plé*x*y™4

+ pO5*yn5

For example, if you specify an x degree of 3 and a y degree of 2, the model name is
poly32. The model terms follow the form in this table.
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Degree of Term 0 1 2

0 1 y >

1 X Xy xy”
2 2 %y N/A
3 e N/A N/A

The total degree of the polynomial cannot exceed the maximum of i and j. In this

example, terms such as x’y and x’y* are excluded because their degrees sum to more
than 3. In both cases, the total degree is 4.

See Also
“Polynomial Model Names and Equations” on page 4-14 | fit | fitoptions | Fittype

Related Examples

. Compare Polynomial Fits Interactively on page 2-21
. “Polynomial Curve Fitting”

. Polynomial Curve Fitting in MATLAB (MATLAB)
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Exponential Models

In this section...

“About Exponential Models” on page 4-37
“Fit Exponential Models Interactively” on page 4-37

“Fit Exponential Models Using the fit Function” on page 4-40

About Exponential Models

The toolbox provides a one-term and a two-term exponential model as given by

y:aebx

y = ae®® +ce

dx

Exponentials are often used when the rate of change of a quantity is proportional to the
initial amount of the quantity. If the coefficient associated with b and/or d is negative,
y represents exponential decay. If the coefficient is positive, y represents exponential
growth.

For example, a single radioactive decay mode of a nuclide is described by a one-term
exponential. a is interpreted as the initial number of nuclei, b is the decay constant, x
is time, and y is the number of remaining nuclei after a specific amount of time passes.
If two decay modes exist, then you must use the two-term exponential model. For the
second decay mode, you add another exponential term to the model.

Examples of exponential growth include contagious diseases for which a cure is
unavailable, and biological populations whose growth is uninhibited by predation,
environmental factors, and so on.

Fit Exponential Models Interactively

1  Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 In the Curve Fitting app, select curve data X data and Y data, or just Y data
against index).
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Curve Fitting app creates the default curve fit, Polynomial.
3 Change the model type from Polynomial to Exponential.

! Exponential [ w
Mumber of terms: | 1 -
Equaticn: a*exp(b™])

Center and scale Fit Options...

You can specify the following options:

* Choose one or two terms to fit expl or exp2.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

* (Optional) Click Fit Options to specify coefficient starting values and constraint
bounds appropriate for your data, or change algorithm settings.

The toolbox calculates optimized start points for exponential fits, based on the current
data set. You can override the start points and specify your own values in the Fit
Options dialog box.

The fit options for the single-term exponential are shown next. The coefficient starting
values and constraints are for the census data.
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4\ Fit Options ﬁ

Method: MonlinearLeastSquares —
Robust o ™| | |~ Fitting method and algorithm
Algorithm: Trust-Region =
DiffMinChange: 10e8 [ [ w v I )
— Finite differencing parameters
DiffMaxChange: 01
MaxFunEBvals: 600
Maxdter: 400111 L Fit convergence criteria
TelFun: 1.0e-6
Tolx: 1.0e-6 |
Coefficie.. StartPoint  Lower Upper [oeﬁicieni purnmeiers
a 9.0416e-15 -Inf Inf
b 0.0191 -Inf Inf| | —
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For an example specifying starting values appropriate to the data, see “Gaussian
Fitting with an Exponential Background” on page 5-35.

For more information on the settings, see “Specifying Fit Options and Optimized
Starting Points” on page 4-6.

Fit Exponential Models Using the fit Function
This example shows how to fit an exponential model to data using the Fit function.

The exponential library model is an input argument to the it and Fittype functions.
Specify the model type "expl® or "exp2” .

Fit a Single-Term Exponential Model

Generate data with an exponential trend and then fit the data using a single-term
exponential. Plot the fit and data.

x = (0:0.2:5)";

y = 2*exp(-0.2*x) + O.1*randn(size(x));
f = fit(x,y, "expl™)

plot(f,x,y)

f =

General model Expl:

T(x) = a*exp(b*x)

Coefficients (with 95% confidence bounds):
a = 2.021 (1.89, 2.151)
b = -0.1812 (-0.2104, -0.152)
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22 1 1 1 1 1 1 T T T

" + data
fitted curve |

16 o . 1

D'ﬁ i i i i i i i i i

Fit a Two-Term Exponential Model
2 = fit(x,y,"exp2”)
plot(f2,x,y)
2 =

General model Exp2:

f2(x) = a*exp(b*x) + c*exp(d*x)
Coefficients (with 95% confidence bounds):

a = 537.7 (-1.307e+10, 1.307e+10)
b = ~0.2573 (-4112, 4112)
c = -535.7 (-1.307e+10, 1.307e+10)
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d = -0.2576 (-4131, 4130)

22 1 1 1 1 1 1 T T T

" + data
fitted curve |

1671 ., - 7

DE i i i i i i i i i

Set Start Points

The toolbox calculates optimized start points for exponential fits based on the current
data set. You can override the start points and specify your own values.

Find the order of the entries for coefficients in the first model ( ) by using the
coeffnames function.

coeffnames(F)
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ans =

2x1 cell array

a
b

If you specify start points, choose values appropriate to your data. Set arbitrary start
points for coefficients a and b for example purposes.

f = fit(x,y,"expl”, "StartPoint”,[1,2])
plot(f,x,y)

¥ =

General model Expl:

T(X) = a*exp(b*x)

Coefficients (with 95% confidence bounds):
a 2.021 (1.89, 2.151)
b -0.1812 (-0.2104, -0.152)
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22 1 1 1 1 1 1 T T T

" + data
fitted curve |

16 . 1

DE i i i i i i i i i

Examine Exponential Fit Options

Examine the fit options if you want to modify fit options such as coefficient starting
values and constraint bounds appropriate for your data, or change algorithm settings.
For details on these options, see the table of properties for NonlinearLeastSquares on the
fitoptions reference page.

fitoptions("expl™)
ans =

Normalize: "off"
Exclude: []
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Weights: []
Method: “NonlinearLeastSquares”
Robust: "Off"
StartPoint: [1x0 double]
Lower: [1x0 double]
Upper: [1x0 double]
Algorithm: "Trust-Region®
DiffMinChange: 1.0000e-08
DiffMaxChange: 0.1000
Display: "Notify*
MaxFunkEvals: 600
Maxlter: 400
TolFun: 1.0000e-06
TolX: 1.0000e-06

See Also
fit | fitoptions | Fittype

Related Examples
. “Gaussian Fitting with an Exponential Background” on page 5-35

. “Specifying Fit Options and Optimized Starting Points” on page 4-6
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Fourier Series

4-46

In this section...

“About Fourier Series Models” on page 4-46
“Fit Fourier Models Interactively” on page 4-46
“Fit Fourier Models Using the fit Function” on page 4-47

About Fourier Series Models

The Fourier series is a sum of sine and cosine functions that describes a periodic signal.
It is represented in either the trigonometric form or the exponential form. The toolbox
provides this trigonometric Fourier series form

n
y=ag+ Zai cos(iwx) + b; sinGwx)
i=1

where ay models a constant (intercept) term in the data and is associated with the i =
0 cosine term, w is the fundamental frequency of the signal, n is the number of terms
(harmonics) in the series, and 1 <n < 8.

For more information about the Fourier series, refer to “Fourier Analysis and Filtering”
(MATLAB).

Fit Fourier Models Interactively

1  Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 In the Curve Fitting app, select curve data X data and Y data, or just Y data
against index).
Curve Fitting app creates the default curve fit, Polynomial.

3 Change the model type from Polynomial to Fourier.



Fourier Series

{ Fourier P
Mumber of terms: | 1 -
Equation: al + al*cos(™w) + bl *sin(x*w)

Center and scale Fit Options...

You can specify the following options:

+  Choose the number of terms: 1 to 8.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

+  (Optional) Click Fit Options to specify coefficient starting values and constraint
bounds, or change algorithm settings.

The toolbox calculates optimized start points for Fourier series models, based on the
current data set. You can override the start points and specify your own values in the
Fit Options dialog box.

For more information on the settings, see “Specifying Fit Options and Optimized
Starting Points” on page 4-6.

For an example comparing the library Fourier fit with custom equations, see “Custom

Nonlinear ENSO Data Analysis” on page 5-25.

Fit Fourier Models Using the fit Function
This example shows how to use the Fit function to fit a Fourier model to data.

The Fourier library model is an input argument to the it and Fittype functions.
Specify the model type Fourier followed by the number of terms, e.g., "fourierl” to
"fourier8- .

This example fits the El Nino-Southern Oscillation (ENSO) data. The ENSO data
consists of monthly averaged atmospheric pressure differences between Easter
Island and Darwin, Australia. This difference drives the trade winds in the southern
hemisphere.
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The ENSO data is clearly periodic, which suggests it can be described by a Fourier series.
Use Fourier series models to look for periodicity.

Fit a Two-Term Fourier Model

Load some data and fit an two-term Fourier model.

load enso;
f = fit(month,pressure, "fourier2™)
plot(f,month,pressure)

General model Fourier2:

f(x) = a0 + al*cos(x*w) + bl*sin(x*w) +
a2*cos(2*x*w) + b2*sin(2*x*w)

Coefficients (with 95% confidence bounds):

a0 = 10.63 (10.23, 11.03)

al = 2.923 (2.27, 3.576)

bl = 1.059 (0.01593, 2.101)
a2 = -0.5052 (-1.086, 0.07532)
b2 = 0.2187 (-0.4202, 0.8576)
w = 0.5258 (0.5222, 0.5294)
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The confidence bounds on a2 and b2 cross zero. For linear terms, you cannot be sure that
these coefficients differ from zero, so they are not helping with the fit. This means that
this two term model is probably no better than a one term model.

Measure Period

The w term is a measure of period. 2*pi/w converts to the period in months, because the
period of sin() and cos() is 2*pi .

w = F.w
2*pi/w
W =
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4-50

0.5258

ans =

11.9497

w is very close to 12 months, indicating a yearly period. Observe this looks correct on the
plot, with peaks approximately 12 months apart.

Fit an Eight-Term Fourier Model

2 = fit(month,pressure, “"fourier8®)
plot(f2,month,pressure)

2 =

General
f2(x) =

Coefficients (with
10.63 (10.

a0
al
bl
a2
b2
a3
b3
a4
b4
ab
b5
a6
b6
a7
b7
a8
b8

model Fouriers8:

a0 + al*cos(x*w) + bl*sin(x*w) +

a2*cos(2*x*w)
ad*cos(4*x*w)
a6*cos(6*x*w)
a8*cos(8*x*w)

+ b2*sin(2*x*w) + a3*cos(3*x*w) + b3*sin(3*x*w) +
+ bd*sin(4*x*w) + a5*cos(6*x*w) + b5*sin(5*x*w) +
+ b6*sin(6*x*w) + ar7*cos(7*x*w) + b7*sin(7*x*w) +
+ b8*sin(8*x*w)

95% confidence bounds):

28, 10.97)

0.5668 (0.07981, 1.054)

0.1969 (-0.
-1.203 (-1.
-0.8087 (-1.

2929, 0.6867)
69, -0.7161)
311, -0.3065)

0.9321 (0.4277, 1.436)
0.7602 (0.2587, 1.262)

-0.6653 (-1.
-0.703, 0.2954)
-0.5158, 0.4575)
-0.
-0
-0

-0.2038 (
-0.02919 (
-0.3701 (
-0.04856 (
-0.1368 (

2.811 (

152, -0.1788)

8594, 0.1192)

.5482, 0.4511)
.6317, 0.3581)
2.174, 3.449)

1.334 (0.3686, 2.3)

0.07979 (-0.
-0.1076 (-O.

4329, 0.5925)
6037, 0.3885)
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w = 0.07527 (0.07476, 0.07578)

18 T T T T T

14

120 .

data
fitted curve

Measure Period

w = f2.w
2*pi)/w

0.0753

ans =

120

140

160

180
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83.4736

With the ¥2 model, the period w is approximately 7 years.
Examine Terms
Look for the coefficients with the largest magnitude to find the most important terms.

* a7 and b7 are the largest. Look at the a7 term in the model equation:
ar*cos(7*x*w). 7*w == 7/7 = 1 year cycle. a7 and b7 indicate the annual cycle is the
strongest.

+ Similarly, al and b1 terms give 7/1, indicating a seven year cycle.

* a2 and b2 terms are a 3.5 year cycle (7/2). This is stronger than the 7 year cycle
because the a2 and b2 coefficients have larger magnitude than al and b1.

* a3 and b3 are quite strong terms indicating a 7/3 or 2.3 year cycle.

+  Smaller terms are less important for the fit, such as a6, b6, a5, and b5.

Typically, the El Nino warming happens at irregular intervals of two to seven years, and
lasts nine months to two years. The average period length is five years. The model results
reflect some of these periods.

Set Start Points

The toolbox calculates optimized start points for Fourier fits, based on the current data
set. Fourier series models are particularly sensitive to starting points, and the optimized
values might be accurate for only a few terms in the associated equations. You can
override the start points and specify your own values.

After examining the terms and plots, it looks like a 4 year cycle might be present. Try to
confirm this by setting w. Get a value for w, where 8 years = 96 months.

w (2*pi)/96

0.0654

Find the order of the entries for coefficients in the model ('f2') by using the coeffnames
function.



Fourier Series

coeffnames(f2)

ans =
18x1 cell array

~a0"
"al"
"b1"
"a2"
"h2"
"a3"
"b3"
"ad"
"ba"
"a5"
"b5"
"26"
"b6"
“a7"
“H7"
~a8"
"ba"
"w

Get the current coefficient values.

coeffs = coeffvalues(f2)

coeffs
Columns 1 through 7
10.6261 0.5668 0.1969 -1.2031 -0.8087
Columns 8 through 14
-0.6653 -0.2038 -0.0292 -0.3701 -0.0486
Columns 15 through 18

1.3344 0.0798 -0.1076 0.0753

0.9321

-0.1368

0.7602

2.8112
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Set the last ceofficient, w, to 0.065.

coeffs(:,18) = w

coeffs =
Columns 1 through 7
10.6261 0.5668 0.1969 -1.2031 -0.8087 0.9321 0.7602
Columns 8 through 14
-0.6653 -0.2038 -0.0292 -0.3701 -0.0486 -0.1368 2.8112
Columns 15 through 18

1.3344 0.0798 -0.1076 0.0654

Set the start points for coefficients using the new value for w.

3 = fit(month,pressure, "fourier8®, "StartPoint”, coeffs);

Plot both fits to see that the new value for w in ¥3 does not produce a better fit than 2 .

plot(f3,month,pressure)
hold on

plot(f2, "b")

hold off

legend( "“Data®, "f3°, "f2%)
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Find Fourier Fit Options

Find available fit options using Fitoptions( modelname ).

Ffitoptions(“Fourier8%)

ans =

Normalize: "off~
Exclude: []
Weights: []
Method: “NonlinearLeastSquares”
Robust: "Off"

160

180
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StartPoint: [1x0 double]
Lower: [1x0 double]
Upper: [1x0 double]
Algorithm: "Trust-Region®
DiffMinChange: 1.0000e-08
DiffMaxChange: 0.1000
Display: "Notify*
MaxFunkEvals: 600
Maxlter: 400
TolFun: 1.0000e-06
TolX: 1.0000e-06

If you want to modify fit options such as coefficient starting values and constraint
bounds appropriate for your data, or change algorithm settings, see the options for
NonlinearLeastSquares on the Fitoptions reference page.

See Also
fit | fitoptions | fittype

Related Examples
. “Custom Nonlinear ENSO Data Analysis” on page 5-25
. “Specifying Fit Options and Optimized Starting Points” on page 4-6
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Gaussian Models

In this section...

“About Gaussian Models” on page 4-57
“Fit Gaussian Models Interactively” on page 4-57
“Fit Gaussian Models Using the fit Function” on page 4-58

About Gaussian Models

The Gaussian model fits peaks, and is given by

, z“ ]

where a is the amplitude, b is the centroid (location), c is related to the peak width, n 1s
the number of peaks to fit, and 1 <n < 8.

Gaussian peaks are encountered in many areas of science and engineering. For example,
Gaussian peaks can describe line emission spectra and chemical concentration assays.

Fit Gaussian Models Interactively

1  Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 In the Curve Fitting app, select curve data (X data and Y data, or just Y data
against index).
Curve Fitting app creates the default curve fit, Polynomial.

3 Change the model type from Polynomial to Gaussian.
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{ (Gaussian P
Mumber of terms: | 1 -
Equation: al*exp(-((x-bl)/c1)"2)

Center and scale Fit Options...

You can specify the following options:
*  Choose the number of terms: 1 to 8.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

*  (Optional) Click Fit Options to specify coefficient starting values and constraint
bounds, or change algorithm settings.

The toolbox calculates optimized start points for Gaussian models, based on the
current data set. You can override the start points and specify your own values in the
Fit Options dialog box.

Gaussians have the width parameter c1 constrained with a lower bound of 0. The
default lower bounds for most library models are - InF, which indicates that the
coefficients are unconstrained.

For more information on the settings, see “Specifying Fit Options and Optimized
Starting Points” on page 4-6.

Fit Gaussian Models Using the fit Function

This example shows how to use the Fit function to fit a Gaussian model to data.

The Gaussian library model is an input argument to the it and Fittype functions.
Specify the model type gauss followed by the number of terms, e.g., "gaussl® through
"gauss8- .

Fit a Two-Term Gaussian Model

Load some data and fit a two-term Gaussian model.
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[x,y] = titanium;
f = fit(x.",y.","gauss2")
plot(f,x,y)
¥ =
General model Gauss2:
(X)) = al*exp(-((x-bl)/c1)"2) + a2*exp(-((x-b2)/c2)"2)
Coefficients (with 95% confidence bounds):
al = 1.47 (1.426, 1.515)
bl = 897.7 (897, 898.3)
cl = 27.08 (26.08, 28.08)
a2 = 0.6994 (0.6821, 0.7167)
b2 = 810.8 (790, 831.7)
c2 = 592.9 (500.1, 685.7)
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See Also

fit | fitoptions | Fittype

Related Examples

“Gaussian Fitting with an Exponential Background” on page 5-35
“Specifying Fit Options and Optimized Starting Points” on page 4-6
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Power Series

In this section...

“About Power Series Models” on page 4-61
“Fit Power Series Models Interactively” on page 4-61

“Fit Power Series Models Using the fit Function” on page 4-62

About Power Series Models

The toolbox provides a one-term and a two-term power series model as given by

yzaxb

yzaxb+c

Power series models describe a variety of data. For example, the rate at which reactants
are consumed in a chemical reaction is generally proportional to the concentration of the
reactant raised to some power.

Fit Power Series Models Interactively

1  Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 Inthe Curve Fitting app, select curve data (X data and Y data, or just Y data
against index).
Curve Fitting app creates the default curve fit, Polynomial.

3 Change the model type from Polynomial to Power.

| Power [ w
Mumber of terms: | 1 A
Equation: a*x"b

Fit Options...
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You can specify the following options:

*  Choose the number of terms: 1 to 2.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

* (Optional) Click Fit Options to specify coefficient starting values and constraint
bounds, or change algorithm settings.

The toolbox calculates optimized start points for power series models, based on the
current data set. You can override the start points and specify your own values in the
Fit Options dialog box.

For more information on the settings, see “Specifying Fit Options and Optimized
Starting Points” on page 4-6.

Fit Power Series Models Using the fit Function

This example shows how to use the Fit function to fit power series models to data.

The power series library model is an input argument to the Fit and Fittype functions.
Specify the model type "powerl® or "power2” .

Fit a Single-Term Power Series Model

load hahni;
f = fit(temp,thermex, "powerl®)

plot(f,temp,thermex)
f =
General model Powerl:
f(xX) = a*x™b
Coefficients (with 95% confidence bounds):
a= 1.46 (1.224, 1.695)
b = 0.4094 (0.3825, 0.4363)
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Fit a Two-Term Power Series Model
T = fit(temp,thermex, "power2*)
plot(f,temp,thermex)
¥ =
General model Power2:

f(X) = a*x"b+c
Coefficients (with 95% confidence bounds):

a = -78.61 (-80.74, -76.48)
b = -0.2349 (-0.271, -0.1989)
c = 36.9 (33.09, 40.71)
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4-64

data

fitted curve
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See Also
fit | fitoptions | Fittype

Related Examples
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. “Specifying Fit Options and Optimized Starting Points” on page 4-6
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Rational Polynomials

In this section...
“About Rational Models” on page 4-65
“Fit Rational Models Interactively” on page 4-66

“Selecting a Rational Fit at the Command Line” on page 4-66

“Example: Rational Fit” on page 4-67

About Rational Models

Rational models are defined as ratios of polynomials and are given by

n+l

2 p_xn+1—i
i
=
y=

- m
XM+ Zqixm_l
=1

where n is the degree of the numerator polynomial and 0 < n <5, while m is the degree
of the denominator polynomial and 1 < m < 5. Note that the coefficient associated with

x™ is always 1. This makes the numerator and denominator unique when the polynomial
degrees are the same.

In this guide, rationals are described in terms of the degree of the numerator/the degree
of the denominator. For example, a quadratic/cubic rational equation is given by

2
p1x + pax+ p3

Like polynomials, rationals are often used when a simple empirical model is required.
The main advantage of rationals is their flexibility with data that has a complicated
structure. The main disadvantage is that they become unstable when the denominator
is around 0. For an example that uses rational polynomials of various degrees, see
“Example: Rational Fit” on page 4-67.

4-65



4 \inear and Nonlinear Regression

4-66

Fit Rational Models Interactively

1 Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 Inthe Curve Fitting app, select curve data (X data and Y data, or just Y data
against index).
Curve Fitting app creates the default curve fit, Polynomial.

3 Change the model type from Polynomial to Rational.

Rational -
Murnerator degree: 0 -
Denominator degree: i1 i w

Center and scale Fit Opticns...

You can specify the following options:

+  Choose the degree of the numerator and denominator polynomials. The numerator
can have degree O to 5, and the denominator from 1 to 5.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

+ (Optional) Click Fit Options to specify coefficient starting values and constraint
bounds, or change algorithm settings.

The toolbox calculates random start points for rational models, defined on the interval
[0,1]. You can override the start points and specify your own values in the Fit Options
dialog box.

For more information on the settings, see “Specifying Fit Options and Optimized
Starting Points” on page 4-6.
Selecting a Rational Fit at the Command Line

Specify the model type ratij, where i is the degree of the numerator polynomial and j is
the degree of the denominator polynomial. For example, "rat02", "rat21" or "rat55".



Rational Polynomials

For example, to load some data and fit a rational model:

load hahnil;
f = fit( temp, thermex, "rat32%)
plot(f,temp,thermex)

See “Example: Rational Fit” on page 4-67 to fit this example interactively with
various rational models.

If you want to modify fit options such as coefficient starting values and constraint bounds
appropriate for your data, or change algorithm settings, see the table of additional
properties with Nonl inearLeastSquares on the Fitoptions reference page.

Example: Rational Fit

This example fits measured data using a rational model. The data describes the
coefficient of thermal expansion for copper as a function of temperature in degrees kelvin.

For this data set, you will find the rational equation that produces the best fit. Rational
models are defined as a ratio of polynomials as given by:

n n-1
_ p1xX " + pox +.t+ Pui1

x4 qlxm_1 +otqy,

where n is the degree of the numerator polynomial and m is the degree of the
denominator polynomial. Note that the rational equations are not associated with
physical parameters of the data. Instead, they provide a simple and flexible empirical
model that you can use for interpolation and extrapolation.

1 Load the thermal expansion data from the file hahnl_mat, which is provided with
the toolbox.

load hahnl
The workspace contains two new variables:

temp is a vector of temperatures in degrees kelvin.
+ thermex is a vector of thermal expansion coefficients for copper.

2 Open the Curve Fitting app by entering:

4-67



4 \inear and Nonlinear Regression

cftool
3 Select temp and thermex from the X data and Y data lists.

The Curve Fitting app fits and plots the data.
4 Select Rational in the fit category list.

5 Try an initial choice for the rational model of quadratic/quadratic. Select 2 for both
Numerator degree and Denominator degree.

Rational -
Murnerator degree: 2 A
Denominator degree: 12 P

Center and scale Fit Options...

The Curve Fitting app fits a quadratic/quadratic rational.
6 Examine the residuals. Select View > Residuals Plot or click the toolbar button.
Examine the data, fit, and residuals. Observe that the fit misses the data for the

smallest and largest predictor values. Additionally, the residuals show a strong
pattern throughout the entire data set, indicating that a better fit is possible.
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rat22
s thermex vs. temp
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temp

7 For the next fit, try a cubic/cubic equation. Select 3 for both Numerator degree and

Denominator degree.

Examine the data, fit, and residuals. The fit exhibits several discontinuities around
the zeros of the denominator.

Note: Your results depend on random start points and may vary from those shown.
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T T 1
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8 Look in the Results pane. The message and numerical results indicate that the fit
did not converge.

Fit computation did not converge:
Fitting stopped because the number of iterations
or function evaluations exceeded the specified maximum.

Although the message in the Results pane indicates that you might improve the fit
if you increase the maximum number of iterations, a better choice at this stage of the
fitting process is to use a different rational equation because the current fit contains
several discontinuities. These discontinuities are due to the function blowing up at
predictor values that correspond to the zeros of the denominator.

9 Try fitting the data using a cubic/quadratic equation. Select 2 for the Denominator
degree and leave the Numerator degree set to 3.
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10 The input variables have very different scales, so select the Center and scale
option.

The data, fit, and residuals are shown below.

T T T 1
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The fit is well behaved over the entire data range, and the residuals are randomly
scattered about zero. Therefore, you can confidently use this fit for further analysis.

See Also
fit | fitoptions | Fittype

Related Examples
“Specifying Fit Options and Optimized Starting Points” on page 4-6
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Sum of Sines Models

4-72

In this section...

“About Sum of Sines Models” on page 4-72
“Fit Sum of Sine Models Interactively” on page 4-72

“Selecting a Sum of Sine Fit at the Command Line” on page 4-73

About Sum of Sines Models

The sum of sines model fits periodic functions, and is given by

n
y= zai sin(b;x + ¢;)
i=1

where a is the amplitude, b is the frequency, and c is the phase constant for each sine
wave term. n is the number of terms in the series and 1 < n < 8. This equation is closely
related to the Fourier series described in “Fourier Series” on page 4-46. The main
difference is that the sum of sines equation includes the phase constant, and does not
include a constant (intercept) term.

Fit Sum of Sine Models Interactively

1 Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 Inthe Curve Fitting app, select curve data (X data and Y data, or just Y data
against index).
Curve Fitting app creates the default curve fit, Polynomial.

3 Change the model type from Polynomial to Sum of Sine.



Sum of Sines Models

i Sum of Sine P w
Mumber of terms: | 1 -
Equation: al*sin(bl*x+cl)

Center and scale Fit Options...

You can specify the following options:
*  Choose the number of terms: 1 to 8.

Look in the Results pane to see the model terms, the values of the coefficients, and
the goodness-of-fit statistics.

* (Optional) Click Fit Options to specify coefficient starting values and constraint
bounds, or change algorithm settings.

The toolbox calculates optimized start points for sum of sine models, based on the
current data set. You can override the start points and specify your own values in the
Fit Options dialog box.

The sum of sine model has a lower bound constraint on ¢; of 0. The default lower
bounds for most library models are - Inf.

For more information on the settings, see “Specifying Fit Options and Optimized
Starting Points” on page 4-6.

Selecting a Sum of Sine Fit at the Command Line

Specify the model type sin followed by the number of terms, e.g., "sinl” to "sin8".

For example, to load some periodic data and fit a six-term sum of sine model:

load enso;
f = fit( month, pressure, "sin6")
plot(f,month,pressure)

If you want to modify fit options such as coefficient starting values and constraint bounds
appropriate for your data, or change algorithm settings, see the table of additional
properties with Nonl inearLeastSquares on the Fitoptions reference page.
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See Also
fit | fitoptions | Fittype

Related Examples

“Specifying Fit Options and Optimized Starting Points” on page 4-6
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Weibull Distributions

In this section...

“About Weibull Distribution Models” on page 4-75

“Fit Weibull Models Interactively” on page 4-75

“Selecting a Weibull Fit at the Command Line” on page 4-76

About Weibull Distribution Models

The Weibull distribution is widely used in reliability and life (failure rate) data analysis.
The toolbox provides the two-parameter Weibull distribution

xb

y=abx? e

where a is the scale parameter and b is the shape parameter.

Note that there are other Weibull distributions but you must create a custom equation to
use these distributions:

* A three-parameter Weibull distribution with x replaced by x — ¢ where c is the location
parameter
* A one-parameter Weibull distribution where the shape parameter is fixed and only

the scale parameter is fitted.

Curve Fitting Toolbox does not fit Weibull probability distributions to a sample of data.
Instead, it fits curves to response and predictor data such that the curve has the same
shape as a Weibull distribution.

Fit Weibull Models Interactively

1 Open the Curve Fitting app by entering cftool. Alternatively, click Curve Fitting
on the Apps tab.

2 In the Curve Fitting app, select curve data X data and Y data, or just Y data
against index).

Curve Fitting app creates the default curve fit, Polynomial.
3 Change the model type from Polynomial to Weibull.
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{Weibull P

Equation: a*b*x"(b-1)*exp(-a*x"hb)

Fit Opticns...

There are no fit settings to configure.

(Optional) Click Fit Options to specify coefficient starting values and constraint bounds,
or change algorithm settings.

The toolbox calculates random start points for Weibull models, defined on the interval
[0,1]. You can override the start points and specify your own values in the Fit Options
dialog box.

For more information on the settings, see “Specifying Fit Options and Optimized Starting
Points” on page 4-6.

Selecting a Weibull Fit at the Command Line

Specify the model type weibull.

For example, to load some example data measuring blood concentration of a compound
against time, and fit and plot a Weibull model specifying a start point:

time = [ 0.1; 0.1; 0.3; 0.3; 1.3; 1.7; 2.1;...
2.6; 3.9; 3.9; ...
5.1; 5.6; 6.2; 6.4; 7.7; 8.1; 8.2;...
8.9; 9.0; 9.5; ...
9.6; 10.2; 10.3; 10.8; 11.2; 11.2; 11.2;...
11.7; 12.1; 12.3; ...
12.3; 13.1; 13.2; 13.4; 13.7; 14.0; 14.3;...
15.4; 16.1; 16.1; ...
16.4; 16.4; 16.7; 16.7; 17.5; 17.6; 18.1;...
18.5; 19.3; 19.7:];
conc = [0.01; 0.08; 0.13; 0.16; 0.55; 0.90; 1.11;...
1.62; 1.79; 1.59;
1.83; 1.68; 2.09; 2.17; 2.66; 2.08; 2.26;...
1.65; 1.70; 2.39;
2.08; 2.02; 1.65; 1.96; 1.91; 1.30; 1.62;...

4-76



Weibull Distributions

1.57; 1.32; 1.56;

1.36; 1.05; 1.29; 1.32; 1.20; 1.10; 0.88;...
0.63; 0.69; 0.69;

0.49; 0.53; 0.42; 0.48; 0.41; 0.27; 0.36;...
0.33; 0.17; 0.20:]:

f=fFit(time, conc/25, “Weibull",
"StartPoint®, [0.01, 2] )
plot(f,time,conc/25, "0%);

If you want to modify fit options such as coefficient starting values and constraint bounds
appropriate for your data, or change algorithm settings, see the table of additional
properties with NonlinearLeastSquares on the fitoptions reference page.

Appropriate start point values and scaling conc/25 for the two-parameter Weibull
model were calculated by fitting a 3 parameter Weibull model using this custom
equation:

f=fFit(time, conc, " c*a*b*x"(b-1)*exp(-a*x™b)*", "StartPoint®, [0.01, 2, 5] )

f =
General model:
F(X) = c*a*b*x*(b-1)*exp(-a*x"b)
Coefficients (with 95% confidence bounds):

a=  0.009854 (0.007465, 0.01224)
b = 2.003 (1.895, 2.11)
c = 25.65 (24.42, 26.89)

This Weibull model is defined with three parameters: the first scales the curve along the
horizontal axis, the second defines the shape of the curve, and the third scales the curve
along the vertical axis. Notice that while this curve has almost the same form as the
Weibull probability density function, it is not a density because it includes the parameter
¢, which is necessary to allow the curve's height to adjust to data.

See Also
fit | fitoptions | fittype

Related Examples
. “Specifying Fit Options and Optimized Starting Points” on page 4-6
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In this section...

“Introduction” on page 4-78

“Error Distributions” on page 4-79
“Linear Least Squares” on page 4-79
“Weighted Least Squares” on page 4-82
“Robust Least Squares” on page 4-84
“Nonlinear Least Squares” on page 4-86
“Robust Fitting” on page 4-88

Introduction

Curve Fitting Toolbox software uses the method of least squares when fitting data.
Fitting requires a parametric model that relates the response data to the predictor data
with one or more coefficients. The result of the fitting process is an estimate of the model
coefficients.

To obtain the coefficient estimates, the least-squares method minimizes the summed
square of residuals. The residual for the ith data point r; is defined as the difference
between the observed response value y; and the fitted response value ¥;, and is identified
as the error associated with the data.

ri= i~ Yi
residual=data —fit

The summed square of residuals is given by
S=37 =2 3-3)

where n is the number of data points included in the fit and S is the sum of squares error
estimate. The supported types of least-squares fitting include:

* Linear least squares
+  Weighted linear least squares

* Robust least squares
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*  Nonlinear least squares

Error Distributions

When fitting data that contains random variations, there are two important assumptions
that are usually made about the error:

* The error exists only in the response data, and not in the predictor data.
* The errors are random and follow a normal (Gaussian) distribution with zero mean
and constant variance, o°.

The second assumption is often expressed as
error ~ N(O,O'Z)

The errors are assumed to be normally distributed because the normal distribution often
provides an adequate approximation to the distribution of many measured quantities.
Although the least-squares fitting method does not assume normally distributed errors
when calculating parameter estimates, the method works best for data that does not
contain a large number of random errors with extreme values. The normal distribution
is one of the probability distributions in which extreme random errors are uncommon.
However, statistical results such as confidence and prediction bounds do require
normally distributed errors for their validity.

If the mean of the errors is zero, then the errors are purely random. If the mean is not
zero, then it might be that the model is not the right choice for your data, or the errors
are not purely random and contain systematic errors.

A constant variance in the data implies that the “spread” of errors is constant. Data that
has the same variance is sometimes said to be of equal quality.

The assumption that the random errors have constant variance is not implicit to
weighted least-squares regression. Instead, it is assumed that the weights provided in
the fitting procedure correctly indicate the differing levels of quality present in the data.
The weights are then used to adjust the amount of influence each data point has on the
estimates of the fitted coefficients to an appropriate level.

Linear Least Squares

Curve Fitting Toolbox software uses the linear least-squares method to fit a linear model
to data. A linear model is defined as an equation that is linear in the coefficients. For
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example, polynomials are linear but Gaussians are not. To illustrate the linear least-
squares fitting process, suppose you have n data points that can be modeled by a first-
degree polynomial.

y=p1x+ps

To solve this equation for the unknown coefficients p; and p,, you write S as a system
of n simultaneous linear equations in two unknowns. If n is greater than the number of
unknowns, then the system of equations is overdetermined.

n

S=Y (5 - (P + py))°
i=1

Because the least-squares fitting process minimizes the summed square of the residuals,
the coefficients are determined by differentiating S with respect to each parameter, and
setting the result equal to zero.

0S 2

- -2 % (yi— (p1%; + p2)) =0
Py i=1

oS L

Fra —2;(%' ~(pyx; + pg)) =0

The estimates of the true parameters are usually represented by b. Substituting b; and
by for p; and ps, the previous equations become

Y % (y; — (byx; +b2)) =0
Y (3 —(byx; +b2)) =0

where the summations run from i = 1 to n. The normal equations are defined as

b Y, x? +by 3 % = 3%y
by Y x;+nby =y

Solving for b,
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b, O TRDXDIN
ny (L)

Solving for b using the b, value
1
by = ;(23’;‘ _blzxi)

As you can see, estimating the coefficients p; and ps requires only a few simple
calculations. Extending this example to a higher degree polynomial is straightforward

although a bit tedious. All that is required is an additional normal equation for each
linear term added to the model.

In matrix form, linear models are given by the formula
y=XB+e

where
* yis an n-by-1 vector of responses.
* Bis a m-by-1 vector of coefficients.

* Xis the n-by-m design matrix for the model.

* e1is an n-by-1 vector of errors.

For the first-degree polynomial, the n equations in two unknowns are expressed in terms
of y, X, and B as

Y1 x11
Yo | |%21
¥3| |xsl

Y] [%,1

The least-squares solution to the problem is a vector b, which estimates the unknown
vector of coefficients B. The normal equations are given by

X'X)b=X"y
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where X is the transpose of the design matrix X. Solving for b,

b=X"X%" X'y

Use the MATLAB backslash operator (nldivide) to solve a system of simultaneous
linear equations for unknown coefficients. Because inverting X’X can lead to
unacceptable rounding errors, the backslash operator uses Q@R decomposition with
pivoting, which is a very stable algorithm numerically. Refer to “Arithmetic” (MATLAB)
in the MATLAB documentation for more information about the backslash operator and
QR decomposition.

You can plug b back into the model formula to get the predicted response values, 3.
9 =Xb = Hy
H=XX"xX1'Xx"

A hat (circumflex) over a letter denotes an estimate of a parameter or a prediction from a
model. The projection matrix H is called the hat matrix, because it puts the hat on y.

The residuals are given by
r=y-3=(1-H)y

Weighted Least Squares

It is usually assumed that the response data is of equal quality and, therefore, has
constant variance. If this assumption is violated, your fit might be unduly influenced by
data of poor quality. To improve the fit, you can use weighted least-squares regression
where an additional scale factor (the weight) is included in the fitting process. Weighted
least-squares regression minimizes the error estimate

n
A 12
szzwi(yi_yi)

=1

where w; are the weights. The weights determine how much each response value
influences the final parameter estimates. A high-quality data point influences the fit
more than a low-quality data point. Weighting your data is recommended if the weights
are known, or if there is justification that they follow a particular form.

The weights modify the expression for the parameter estimates b in the following way,

b=p=XTwx) 1 xTwy
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where Wis given by the diagonal elements of the weight matrix w.

You can often determine whether the variances are not constant by fitting the data

and plotting the residuals. In the plot shown below, the data contains replicate data of
various quality and the fit is assumed to be correct. The poor quality data is revealed in
the plot of residuals, which has a “funnel” shape where small predictor values yield a
bigger scatter in the response values than large predictor values.

100 T T T T I

data

+  residuals

101 T : .
-5_ . = L] " " =1

fE!';I!Ei':aiilJ

[=]
T
.
Prra—

_i5 . ] 1 ] 1 1
0 1 2 3 4 5 B

The weights you supply should transform the response variances to a constant value. If
you know the variances of the measurement errors in your data, then the weights are
given by

Or, if you only have estimates of the error variable for each data point, it usually suffices
to use those estimates in place of the true variance. If you do not know the variances,

it suffices to specify weights on a relative scale. Note that an overall variance term is
estimated even when weights have been specified. In this instance, the weights define
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the relative weight to each point in the fit, but are not taken to specify the exact variance
of each point.

For example, if each data point is the mean of several independent measurements, it
might make sense to use those numbers of measurements as weights.

Robust Least Squares

It is usually assumed that the response errors follow a normal distribution, and that
extreme values are rare. Still, extreme values called outliers do occur.

The main disadvantage of least-squares fitting is its sensitivity to outliers. Outliers
have a large influence on the fit because squaring the residuals magnifies the effects of
these extreme data points. To minimize the influence of outliers, you can fit your data
using robust least-squares regression. The toolbox provides these two robust regression
methods:

+ Least absolute residuals (LAR) — The LAR method finds a curve that minimizes the
absolute difference of the residuals, rather than the squared differences. Therefore,
extreme values have a lesser influence on the fit.

* Bisquare weights — This method minimizes a weighted sum of squares, where the
weight given to each data point depends on how far the point is from the fitted line.
Points near the line get full weight. Points farther from the line get reduced weight.
Points that are farther from the line than would be expected by random chance get
zero weight.

For most cases, the bisquare weight method is preferred over LAR because it
simultaneously seeks to find a curve that fits the bulk of the data using the usual
least-squares approach, and it minimizes the effect of outliers.

Robust fitting with bisquare weights uses an iteratively reweighted least-squares
algorithm, and follows this procedure:
1  Fit the model by weighted least squares.

2 Compute the adjusted residuals and standardize them. The adjusted residuals are
given by
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r; are the usual least-squares residuals and h; are leverages that adjust the residuals
by reducing the weight of high-leverage data points, which have a large effect on the
least-squares fit. The standardized adjusted residuals are given by

u:radj

Ks

K is a tuning constant equal to 4.685, and s is the robust variance given by
MADI0.6745 where MAD is the median absolute deviation of the residuals.

3 Compute the robust weights as a function of u. The bisquare weights are given by

2
‘ 0 ES!

Note that if you supply your own regression weight vector, the final weight is the
product of the robust weight and the regression weight.

4  If the fit converges, then you are done. Otherwise, perform the next iteration of the
fitting procedure by returning to the first step.

The plot shown below compares a regular linear fit with a robust fit using bisquare

weights. Notice that the robust fit follows the bulk of the data and is not strongly
influenced by the outliers.
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Instead of minimizing the effects of outliers by using robust regression, you can mark
data points to be excluded from the fit. Refer to “Remove Outliers” on page 7-10 for
more information.

Nonlinear Least Squares

Curve Fitting Toolbox software uses the nonlinear least-squares formulation to fit a
nonlinear model to data. A nonlinear model is defined as an equation that is nonlinear in
the coefficients, or a combination of linear and nonlinear in the coefficients. For example,
Gaussians, ratios of polynomials, and power functions are all nonlinear.

In matrix form, nonlinear models are given by the formula
y=f&XpB)+e

where

* yis an n-by-1 vector of responses.

+ fis a function of B and X.
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* Bis a m-by-1 vector of coefficients.
*  Xis the n-by-m design matrix for the model.

* e1is an n-by-1 vector of errors.

Nonlinear models are more difficult to fit than linear models because the coefficients
cannot be estimated using simple matrix techniques. Instead, an iterative approach is
required that follows these steps:

1 Start with an initial estimate for each coefficient. For some nonlinear models, a
heuristic approach is provided that produces reasonable starting values. For other
models, random values on the interval [0,1] are provided.

2 Produce the fitted curve for the current set of coefficients. The fitted response value
is given by
y=[f X))

and involves the calculation of the Jacobian of f(X,b), which is defined as a matrix of
partial derivatives taken with respect to the coefficients.

3  Adjust the coefficients and determine whether the fit improves. The direction and
magnitude of the adjustment depend on the fitting algorithm. The toolbox provides
these algorithms:

*  Trust-region — This is the default algorithm and must be used if you specify
coefficient constraints. It can solve difficult nonlinear problems more efficiently
than the other algorithms and it represents an improvement over the popular
Levenberg-Marquardt algorithm.

Levenberg-Marquardt — This algorithm has been used for many years and has
proved to work most of the time for a wide range of nonlinear models and starting
values. If the trust-region algorithm does not produce a reasonable fit, and you

do not have coefficient constraints, you should try the Levenberg-Marquardt
algorithm.

4 Tterate the process by returning to step 2 until the fit reaches the specified
convergence criteria.

You can use weights and robust fitting for nonlinear models, and the fitting process is
modified accordingly.

Because of the nature of the approximation process, no algorithm is foolproof for all
nonlinear models, data sets, and starting points. Therefore, if you do not achieve a
reasonable fit using the default starting points, algorithm, and convergence criteria, you
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should experiment with different options. Refer to “Specifying Fit Options and Optimized
Starting Points” on page 4-6 for a description of how to modify the default options.
Because nonlinear models can be particularly sensitive to the starting points, this should
be the first fit option you modify.

Robust Fitting

This example shows how to compare the effects of excluding outliers and robust fitting.
The example shows how to exclude outliers at an arbitrary distance greater than 1.5
standard deviations from the model. The steps then compare removing outliers with
specifying a robust fit which gives lower weight to outliers.

Create a baseline sinusoidal signal:

xdata = (0:0.1:2*pi)";
y0 = sin(xdata);

Add noise to the signal with nonconstant variance.

% Response-dependent Gaussian noise
gnoise = y0.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(yO(sppoints));
ydata = y0 + gnoise + spnoise;

Fit the noisy data with a baseline sinusoidal model, and specify 3 output arguments to
get fitting information including residuals.

T = fittype("a*sin(b*x)");
[fitl,gof,Ffitinfo] = fit(xdata,ydata,f, StartPoint”,[1 1]);

Examine the information in the fitinfo structure.

fitinfo

fitinfo =
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struct with fields:

numobs: 63
numparam: 2
residuals: [63x1 double]
Jacobian: [63%x2 double]
exitflag: 3
firstorderopt: 0.0883
iterations: 5
funcCount: 18
cgiterations: O
algorithm: “trust-region-reflective*
stepsize: 4.1539e-04
message: "Success, but fitting stopped because change in residuals less than

Get the residuals from the fitinfo structure.

residuals = fitinfo.residuals;

Identify "outliers" as points at an arbitrary distance greater than 1.5 standard deviations
from the baseline model, and refit the data with the outliers excluded.

I = abs( residuals) > 1.5 * std( residuals );
outliers = excludedata(xdata,ydata, "indices”,1);

fit2 = fit(xdata,ydata,f, "StartPoint”,[1 1],---
"Exclude” ,outliers);

Compare the effect of excluding the outliers with the effect of giving them lower bisquare
weight in a robust fit.

fit3 = fit(xdata,ydata,f,"StartPoint”,[1 1], "Robust®,"on");
Plot the data, the outliers, and the results of the fits. Specify an informative legend.

plot(fitl, "r-",xdata,ydata, "k.",outliers, "m*")

hold on

plot(fit2,"c--")

plot(fit3,"b:")

xim([0 2*pi])

legend( "Data®, "Data excluded from second fit", "Original fit",...
"Fit with points excluded”, "Robust fit" )

hold off
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Plot the residuals for the two fits considering outliers:

figure

plot(fit2,xdata,ydata, "co”, "residuals™)

hold on

plot(fit3,xdata,ydata, "bx", "residuals®)

hold off
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* “Custom Models” on page 5-2

* “Custom Linear Fitting” on page 5-7

* “Custom Nonlinear Census Fitting” on page 5-21

* “Custom Nonlinear ENSO Data Analysis” on page 5-25

+  “Gaussian Fitting with an Exponential Background” on page 5-35

+  “Surface Fitting to Biopharmaceutical Data” on page 5-39
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Custom Models

5-2

In this section...

“Custom Models vs. Library Models” on page 5-2

“Selecting a Custom Equation Fit Interactively” on page 5-2

“Selecting a Custom Equation Fit at the Command Line” on page 5-5

Custom Models vs. Library Models

If the toolbox library does not contain a desired parametric equation, you can create
your own custom equation. Library models, however, offer the best chance for rapid
convergence. This is because:

*  For most library models, the toolbox calculates optimal default coefficient starting
points. For custom models, the toolbox chooses random default starting points on the
interval [0,1]. You need to find suitable start points for custom models.

+ Library models use an analytic Jacobian. Custom models use finite differencing.

Linear and Nonlinear Fitting

You can create custom general equations with the Custom Equation fit type. General
models are nonlinear combinations of (perhaps nonlinear) terms. They are defined by
equations that might be nonlinear in the parameters. The custom equation fit uses the
nonlinear least-squares fitting procedure.

You can define a custom linear equation using the Custom Equation fit type, though the
nonlinear fitting is less efficient and usually slower than linear least-squares fitting.

+ If you don’t know if your equation can be expressed as a set of linear functions, then
select Custom Equation. You might need to search for suitable start points.

+ If you need linear least-squares fitting for custom equations, select the Linear
Fitting model type instead. See “Custom Linear Fitting” on page 5-7.

Selecting a Custom Equation Fit Interactively
In the Curve Fitting app, select Custom Equation from the model type list.

Use the custom equation fit to define your own equations. An example custom equation
appears when you select Custom Equation from the list, as shown here for curve data.
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‘Custom Equation [ -

Y

= f{ |x )

= |1 a*exp(-b*x)+cC

If you have surface data, the example custom equation uses both x and y.

_ECu stom Equation [ .

z

= f( |x .Y )

=(1la + b*szin (m*pi*x*Vy)
2 + c*exRp (- (Wey) "2)

You can edit X, y, and z to any valid variable names.

In the lower box, edit the example to define your own custom equation. You can enter
any valid MATLAB expression in terms of your variable names. You can specify a
function or script name (see “Fitting a Curve Defined by a File in the Curve Fitting
App” on page 5-4).

Click Fit Options if you want to specify start points or bounds. By default, the
starting values are randomly selected on the interval [0,1] and are unconstrained.
You might need to search for suitable start points and bounds. For an example, see
“Custom Nonlinear ENSO Data Analysis” on page 5-25.

If you set fit options and then alter other fit settings, the app remembers your
choices for lower and upper bounds and start points, if possible. For custom
equations Curve Fitting app always remembers user values, but for many library
models if you change fit settings then the app automatically calculates new best
values for start points or lower bounds.
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You can save your custom equations as part of your saved Curve Fitting app sessions.

Your function can execute a number of times, both during fitting and during
preprocessing before fitting. Be aware this may be time-consuming if you are using
functions with side effects such as writing data to a file, or displaying diagnostic
information to the Command Window.

For examples, see:

* “Custom Nonlinear ENSO Data Analysis” on page 5-25
* “Gaussian Fitting with an Exponential Background” on page 5-35
+  “Surface Fitting to Biopharmaceutical Data” on page 5-39

* “Custom Linear Fitting” on page 5-7
Fitting a Curve Defined by a File in the Curve Fitting App

This example shows how to provide a function or script name as the fitting model in the
Curve Fitting app. Define a function in a file and use it to fit a curve.

1 Define a function in a MATLAB file.
function y = piecewiseLine(x,a,b,c,d,k)

% PIECEWISELINE A line made of two pieces
% that is not continuous.

y = zeros(size(X));
% This example includes a for-loop and if statement

% purely for example purposes.
for 1 = 1l:length(x)

if x(i) < kK,
y(i) = a + b.* x(i);
else
y(@) = c + d.* x(i);
end
end
end

Save the file on the MATLAB path.

2 Define some data and open the Curve Fitting app.

X = [0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;. ..
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Fit names;

X data:
Y data:
£ data:

Weights:

0.96;0.96;0.16;0.97;0.96];

y = [0.17;0.12;0.16;0.0035;0.37;0.082;0.34;0.56; ...
0.15;-0.046;0.17;-0.091;-0.071];

cftool

3 In the Curve Fitting app, select X and y in the X data and Y data lists.

4 Use your piecewiseline function in the Curve Fitting app by selecting the Custom
Equation fit type, and then entering your function expression in the custom equation
text box. The function takes x data and some parameters for fitting.

piecewiseLine( x, a, b, c, d, k)

The Curve Fitting app creates a fit using your function.

Custom Equation -
Piecewise Function
¥ = f( |x )
x -
= |1 piecewizgeline (®x,a,b,c,d, k)
:III' -
(none) -

Fit Opticns...

(none)

Tip: If you want to use the same function for fitting at the command line, use the same
expression as an input to Fittype, and then use the Fittype as an input to Fit:

ft = fittype(“piecewiseLine( x, a, b, ¢, d, k )");
f = fit( x, y, ft)
For more examples, see the Fit function.

Selecting a Custom Equation Fit at the Command Line

To fit custom models, either:

*  Supply a custom model to the Fit function in the FitType input argument. You can
use a MATLAB expression (including any .m file), a cell array of linear model terms,
or an anonymous function.
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+ Create a Fittype object with the Fittype function to use as an input argument for
the Fit function.

This example loads some data and uses a custom equation defining a Weibull model as
an input to the it function:

time = [ 0.1; 0.1; 0.3; 0.3; 1.3; 1.7; 2.1; 2.6; 3.9; 3.9; ..
5.1; 5.6; 6.2; 6.4; 7.7; 8.1; 8.2; 8.9; 9.0; 9.5; ..
9.6; 10.2; 10.3; 10.8; 11.2; 11.2; 11.2; 11.7; 12.1; 12.3; ..
12.3; 13.1; 13.2; 13.4; 13.7; 14.0; 14.3; 15.4; 16.1; 16.1; ..
16.4; 16.4; 16.7; 16.7; 17.5; 17.6; 18.1; 18.5; 19.3; 19.7:;];

conc = [0.01; 0.08; 0.13; 0.16; 0.55; 0.90; 1.11; 1.62; 1.79; 1.59; ..
1.83; 1.68; 2.09; 2.17; 2.66; 2.08; 2.26; 1.65; 1.70; 2.39;
2.08; 2.02; 1.65; 1.96; 1.91; 1.30; 1.62; 1.57; 1.32; 1.56;
1.36; 1.05; 1.29; 1.32; 1.20; 1.10; 0.88; 0.63; 0.69; 0.69;
0.49; 0.53; 0.42; 0.48; 0.41; 0.27; 0.36; 0.33; 0.17; 0.20;]

f = fit( time, conc, "c*a*b*x"(b-1)*exp(-a*x~b)*, "StartPoint®, [0.01, 2, 5] )

plot( f, time, conc )
To define a custom model using Fittype, use the form:

T = fittype(expr)
which constructs a custom model Fittype object for the MATLAB expression contained
in the string, cell array, or anonymous function expr.

See the Fittype reference page for details on:

+ Specifying dependent and independent variables, problem parameters, and
coefficients using Fittype.

* Specifying a cell array of terms to use a linear fitting algorithm for your custom
equation. If expr is a string or anonymous function, then the toolbox uses a nonlinear
fitting algorithm.

For more details on linear fitting, see “Selecting Linear Fitting at the Command Line”
on page 5-8.

+  Examples of linear and nonlinear custom models.

For a step-by-step example, see “Custom Nonlinear Census Fitting” on page 5-21.
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Custom Linear Fitting

In this section...

“About Custom Linear Models” on page 5-7
“Selecting a Linear Fitting Custom Fit Interactively” on page 5-7
“Selecting Linear Fitting at the Command Line” on page 5-8

“Fit Custom Linear Legendre Polynomials” on page 5-9

About Custom Linear Models

In the Curve Fitting app, you can use the Custom Equation fit to define your own
linear or nonlinear equations. The custom equation fit uses the nonlinear least-squares
fitting procedure.

You can define a custom linear equation in Custom Equation, but the nonlinear fitting
is less efficient and usually slower than linear least-squares fitting. If you need linear
least-squares fitting for custom equations, select Linear Fitting instead. Linear
models are linear combinations of (perhaps nonlinear) terms. They are defined by
equations that are linear in the parameters.

Tip: If you need linear least-squares fitting for custom equations, select Linear
Fitting. If you don’t know if your equation can be expressed as a set of linear
functions, then select Custom Equation instead. See “Selecting a Custom Equation Fit
Interactively” on page 5-2.

Selecting a Linear Fitting Custom Fit Interactively

1 In the Curve Fitting app, select some curve data in the X data and Y data lists. You
can only see Linear Fitting in the model type list after you select some curve
data, because Linear Fitting is for curves, not surfaces.

Curve Fitting app creates a default polynomial fit.

2 Change the model type from Polynomial to Linear Fitting in the model type
list.

An example equation appears when you select Linear Fitting from the list.
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Linear Fitting P

Y =f( = )

= |a®(Ein(-pi)) +b*= (- 100" 2 +c=(1)

| Edit || FitOptions.

3 You can change X and y to any valid variable names.

4 The lower box displays the example equation. Click Edit to change the example
terms in the Edit Custom Linear Terms dialog box and define your own equation.

For an example, see “Fit Custom Linear Legendre Polynomials in Curve Fitting App” on
page 5-9.

Selecting Linear Fitting at the Command Line

To use a linear fitting algorithm, specify a cell array of model terms as an input to the
Fit or Fittype functions. Do not include coefficients in the expressions for the terms. If
there is a constant term, use '1' as the corresponding expression in the cell array.

To specify a linear model of the following form:

coeffl * terml + coeff2 * term2 + coeff3 * term3 + ...
where no coefficient appears within any of terml, term2, etc., use a cell array where
each term, without coefficients, is specified in a cell array of strings, as follows:

LinearModelTerms = {"terml®, “term2®, “term3", ... }

1 Identify the linear model terms you need to input to Fittype. For example, the
model

a*log(x) + b*x + ¢
is linear in a, b, and c. It has three terms log(Xx), X, and 1 (because c=c*1).
To specify this model you use this cell array of terms: LinearModelTerms =

{"log(x)","x","1"}.
2 Use the cell array of linear model terms as the input to the fittype function:
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linearfittype = Fittype({ " log(x)","x","1"})
linearfittype =

Linear model:
linearfittype(a,b,c,x) = a*log(x) + b*x + c
3 Load some data and use the Fittype as an input to the Fit function.

load census
T = fit(cdate,pop, linearfittype)

¥f =
Linear model:

T(xX) = a*log(xX) + b*x + ¢
Coefficients (with 95% confidence bounds):

a = -4.663e+04 (-4.973e+04, -4.352e+04)
b = 25.9 (24.26, 27.55)
C = 3.029e+05 (2.826e+05, 3.232e+05)

Alternatively, you can specify the cell array of linear model terms as an input to the
fit function:

f = fit(x,z,{"log(x)","x","1"})
4 Plot the fit and data.

plot(f,cdate,pop)
For an example, see “Fit Custom Linear Legendre Polynomials at the Command Line” on
page 5-19.
Fit Custom Linear Legendre Polynomials
Fit Custom Linear Legendre Polynomials in Curve Fitting App

This example shows how to fit data using several custom linear equations. The data is

generated, and is based on the nuclear reaction *C(e,e'a)’Be. The equations use sums of
Legendre polynomial terms.

Consider an experiment in which 124 MeV electrons are scattered from **C nuclei. In the

subsequent reaction, alpha particles are emitted and produce the residual nuclei *Be. By
analyzing the number of alpha particles emitted as a function of angle, you can deduce
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5-10

certain information regarding the nuclear dynamics of '*C. The reaction kinematics are
shown next.

B is the inddent electron.

12 is the carhon furget.

s the momentum fransferred to fBe.
&' is the seattered electron.

ceisthe emitted alphu porticle.
_ B, is the electron scottering ong e,

B, is the olpho scottering ongle.

The data is collected by placing solid state detectors at values of @, ranging from 10° to
240° in 10° increments.

It is sometimes useful to describe a variable expressed as a function of angle in terms of
Legendre polynomials

yx) = a,P,(x)
n=0

where P,(x) is a Legendre polynomial of degree n, x is cos(0,), and a,, are the coefficients
of the fit. For information about generating Legendre polynomials, see the legendre
function.

For the alpha-emission data, you can directly associate the coefficients with the nuclear
dynamics by invoking a theoretical model. Additionally, the theoretical model introduces
constraints for the infinite sum shown above. In particular, by considering the angular
momentum of the reaction, a fourth-degree Legendre polynomial using only even terms
should describe the data effectively.

You can generate Legendre polynomials with Rodrigues' formula:

P,(x)=—1 (ij (x® -1)"
2"n!\ dx
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Legendre Polynomials Up to Fourth Degree

Pa(x)
1

X

(1/2)(3x*— 1)
(1/2)(5x° — 3x)
(1/8)(35x* — 30x” + 3)

B W N=R O3

This example shows how to fit the data using a fourth-degree Legendre polynomial with
only even terms:

y1(x) =ay +ay (% )(sz -D+ay [%](35x4 -30x% +3)

1 Load the *C alpha-emission data by entering

load carbonl2alpha

The workspace now contains two new variables:

* angle is a vector of angles (in radians) ranging from 10° to 240° in 10°
increments.

counts is a vector of raw alpha particle counts that correspond to the emission
angles in angle.

2 Open the Curve Fitting app by entering:

cftool

3 In the Curve Fitting app, select angle and counts for X data and Y data to create
a default polynomial fit to the two variables.

4  Change the fit type from Polynomial to Linear Fitting to create a default
custom linear fit.
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_ELinearFittinq il

Y =f( = )

= |a®(Ein(-pi)) +b*= (- 100" 2 +c=(1)

| Edit || FitOptions.

You use Linear Fitting instead of Custom Equation fit type, because the
Legendre polynomials depend only on the predictor variable and constants. The
equation you will specify for the model is y;(x) (that is, the equation given at the
beginning of this procedure). Because angle is given in radians, the argument of the
Legendre terms is given by cos(0,).

Click Edit to change the equation terms in the Edit Custom Linear Terms dialog
box.

a Change the Coefficients names to a2, a4, and a0.

b Change the Terms for a2 to
(1/72)*(3*cos(x)"2-1)

The Curve Fitting app updates the fit as you edit the terms.
¢ Change the Terms for a4 to

(1/8)*(35*cos(x)M4-30*cos(x)"2+3)
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Coefficients  Terms

2 (/2B cos09*2-1) ) (2]

a4 | *( | (1/8)* (35" coslx) “4-307cos( A2+ 3) =]

I ¢ ) (i)

The fit appears in the Curve Fitting app.

* Rename the Fit name to Leg4Even.
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Fit name: |LegdEven
X data: :angle =)
¥ data: :counts -
Z data: _(none) x|
Weights: [ (none) =
Results
Linear model:

a2=
a4 =
al =

SSE: 7968
R-square: 0

fi(x) = a2*((1/2)*(3%cos(x)~2-1)) +2
Coeffidents {with 95% confidence boun

Goodness of fit:

9668
Adjusted R-square: 0.9637
RMSE: 19.48

23.86 (4.436, 43.29)
201.9 (180.32, 223.6)
102.9 (93.21, 112.5)

5-14

counts

as0

Linear Fitting

¥

0.5

f( |x )

a2%((1/2)(3%cos(x) ~2-1)) +a4=((1/8)*(3
5%cos(x)~4-30%cos(x) ~2+3)) +a0=(1)

1.5 2 25 3
angle

Auto fit
Fit

Stop

«  countsvs angle.
Leg4Even

Display the residuals by selecting View > Residuals Plot.
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counts

counts

350 [ ! - —
= counts vs. angle
Leg4Ewven

300

2560 -

200 -

150 +

100 |-

50 -

0 0.5 1 1.5 2 2.5 3

20 ' + |eg4Even - residuals | -

10 - | *

{0k | | | 1

=20+

30 - . - =

0 0.5 1 1.5 2 2.5 3 3.5 4
angle

The fit appears to follow the trend of the data well, while the residuals appear to be
randomly distributed and do not exhibit any systematic behavior.

+  Examine the numerical fit results in the Results pane. Look at each coefficient value
and its confidence bounds in brackets. The 95% confidence bounds indicate that the
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coefficients associated with ay(x) and a(x) are known fairly accurately, but that the
as(x) coefficient has a relatively large uncertainty.

Results

Linear model:
(i) = a2*((1/2)=[3%cos(x) ~2-1)) + a4=((1/3)*(35%cos(x) ~4-30%cos(x) ~2+3)) + a0
Coefficents (with 95%6 confidence bounds):
2= 23.86 (4.435, 43.29)
a4= 2019 (180.2, 223.6)
al=  102.9 (93.21, 112.5)

Goodness of fit:
SSE: 7968
R-square: 0.9668
Adjusted R-sguare: 0.9637
REMSE: 19.48

Select Fit > Duplicate Leg4Even to make a copy of your previous Legendre
polynomial fit to modify.

The duplicated fit appears in a new tab.

To confirm the theoretical argument that the alpha-emission data is best described
by a fourth-degree Legendre polynomial with only even terms, next fit the data using
both even and odd terms:

Yo (x) = y;(x) +ayx+ ag (%)(53;’ —3x)

Rename the new fit to Leg4Even0dd.

Click Edit to change the equation terms. The Edit Custom Linear Terms dialog box
opens.

Edit the terms as follows to fit the model given by y,(x):

1 Click the + button to add a term twice, to add the odd Legendre terms.
2 Change the new coefficient names to al and a3.
3 Change the Terms for al to

cos(x)
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4 Change the Terms for a3 to

pro(1/2)*(5*cos(x)”"3-3*cos(x))

i

4\ Edit Custom Linear Terms @

az

ad

all

al

a3

Coefficients  Terms

(L2 (3 cos(x)"2-1)

=]
=)
=)
=)
=)

st

*[ | (L/8Y*(35% cos(x)“4-30%cos(x) ~2+3)

st

*l:l

[

* cosx)

—t

* [lfl]*l[S*cosl[x]"‘3-3*cos|[x]:l|

*  Observe the new fit plotted in the Curve Fitting app, and examine the numerical
results in the Results pane.

Results

Linear model;
fx) = a2*{(1/2)%(3%cos(x) ~2-1)) + a4™=({1/8)*(35%cos{x)*4-30%cos(x) ~2+3)
1+ a0 +al®cos(x) + a3=((1/2)*(5%cos(x) ~3-3%cos(x)])
Coeffidents (with 95%: confidence bounds):

a2=  24.19 (3.291,45.1)
a4= 2015 (177.5, 225.5)
al=  103.1 (92.71, 113.6)
al=  1.837 (-12.89, 15.56)
a3= -121 {-22.52, 20.1)
Goodness of fit:
S5E: 7340

R-square: 0,9669
Adjusted R-sgquare: 0.96
RMSE: 20.44
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Note that the odd Legendre coefficients (al and a3) are likely candidates for removal
to simplify the fit, because their values are small and their confidence bounds
contain zero. These results indicate that the odd Legendre terms do not contribute
significantly to the fit, and the even Legendre terms are essentially unchanged from
the previous fit. This confirms that the initial model choice in the Leg4Even fit is the
best one.

To compare the fits side by side, select Left/Right tile. You can display only the plots
by hiding the fit settings and results panes using the Curve Fitting app View menu.
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u Curve Fitting Tool - Legendre IE'
File Fit View Teols Desk‘top Window Help o
FEE | %S08 B B@E= 0
| Legdbven | | LegdOdd | + |
L] L]
300 = counts vs. angle 300 » counts vs. angle
Leg4Even Leg4Odd
w (2]
< 200 < 200
) 3
=] =]
Q Q
100 100
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angle . angle
| —— Leg4Even - residuals | —= Leg40dd - residuals |
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=201 | -20 l
=30 -30
0 1 2 3 4 0 1 2 3 4
angle angle
Table of Fits ®
Fit name « Data Fittype SSE R-sq.. DFE AdjR.. RMSE #Co.. Vali.. Vali.. Vali.
I Leg4Even counts ..[a2*({1/... |7.9681e..[0.9668 |21 09637 (194790 3 -
[ LegdOdd counts ...|a2*((1/.. [7.93%6e...|0.9669 [19 09600 |20.4419 |5 ¥

Fit Custom Linear Legendre Polynomials at the Command Line

Fit the same model at the command line that you created in Curve Fitting app.

1

To use a linear fitting algorithm, specify a cell array of model terms as an input to
the Fittype function. Use the same Terms you entered in Curve Fitting app for the
Leg4Even fit, and do not specify any coefficients.

linearft =

fittype({"(1/72)*(3*cos(x)"2-1)", ...
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"(1/8)*(35*cos(x)™M4-30*cos(xX)N2+3) ", 1" })
linearft =

Linear model:
linearft(a,b,c,x) = a*((1/72)*(3*cos(xX)"2-1))...
+ b*((1/8)*(35*cos(x)™M4-30*cos(x)"2+3)) + C

2 Load the angle and counts variables in the workspace.

load carbonl2alpha

3 Use the Fittype as an input to the Fit function, and specify the angle and counts
variables in the workspace.

f

fit(angle, counts, linearft)

f

Linear model:

T(xX) = a*((172)*(3*cos(xX)"2-1)). ..

+ b*((1/8)*(35*cos(x)™M4-30*cos(x)N2+3)) + cC
Coefficients (with 95% confidence bounds):

a = 23.86 (4.436, 43.29)
b = 201.9 (180.2, 223.6)
c = 102.9 (93.21, 112.5)

4  Plot the fit and data.
plot(f, angle, counts)

For more details on linear model terms, see the Fittype function.

5-20



Custom Nonlinear Census Fitting

Custom Nonlinear Census Fitting

This example shows how to fit a custom equation to census data, specifying bounds,
coefficients, and a problem-dependent parameter.

Load and plot the data in census.mat:

load census
plot(cdate,pop,“0")
hold on
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Create a fit options structure and a fittype object for the custom nonlinear model y =
a(x-b)n, where a and b are coefficients and n is a problem-dependent parameter. See the
fittype function page for more details on problem-dependent parameters.
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s = fitoptions(“Method", "NonlinearLeastSquares”, ...
"Lower*,[0,0],---
"Upper", [Inf,max(cdate)], - .-
“Startpoint®,[1 1]);

T = fittype(C"a*(x-b)”n", "problem®,"n",“options~,s);

Fit the data using the fit options and a value of n = 2:

[c2,g0f2] = Fit(cdate,pop,T, “problem®,2)

c2 =
General model:
c2(xX) = a*(x-b)™n
Coefficients (with 95% confidence bounds):
a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)
Problem parameters:
n = 2
gof2 =

struct with fields:

sse: 246.1543
rsquare: 0.9980
dfe: 19
adjrsquare: 0.9979

rmse: 3.5994

Fit the data using the fit options and a value of n = 3:

[c3,g0f3] = Fit(cdate,pop, T, “problem”,3)

c3 =

General model:

c3(xX) = a*(x-b)™n

Coefficients (with 95% confidence bounds):
a = 1.359e-05 (1.245e-05, 1.474e-05)
b = 1725 (1718, 1731)

Problem parameters:
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gof3 =
struct with fields:

sse: 232.0058
rsquare: 0.9981
dfe: 19
adjrsquare: 0.9980

rmse: 3.4944

Plot the fit results and the data:
plot(c2,"m")

plot(c3,°c")
legend( °“fit with n=2", *fit with n=3" )
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Custom Nonlinear ENSO Data Analysis

This example fits the ENSO data using several custom nonlinear equations. The ENSO
data consists of monthly averaged atmospheric pressure differences between Easter
Island and Darwin, Australia. This difference drives the trade winds in the southern
hemisphere.

The ENSO data is clearly periodic, which suggests it can be described by a Fourier series:

y(x)=agp+ Zai cos(Zn’ iJ+ b Sin[2ﬂ:ij

i=1 Ci G
where a; and b; are the amplitudes, and ¢; are the periods (cycles) of the data. The
question to answer here is how many cycles exist?

As a first attempt, assume a single cycle and fit the data using one cosine term and one
sine term.

G G

y1(x)=ag +ay oos(ZniJ+ b sin[2niJ

If the fit does not describe the data well, add additional cosine and sine terms with
unique period coefficients until a good fit is obtained.

The equation is nonlinear because an unknown coefficient ¢; is included as part of the
trigonometric function arguments.

In this section...

“Load Data and Fit Library and Custom Fourier Models” on page 5-25

“Use Fit Options to Constrain a Coefficient” on page 5-28

“Create Second Custom Fit with Additional Terms and Constraints” on page 5-30
“Create a Third Custom Fit with Additional Terms and Constraints” on page 5-32

Load Data and Fit Library and Custom Fourier Models

1 Load the data and open the Curve Fitting app:

load enso
cftool
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2 The toolbox includes the Fourier series as a nonlinear library equation. However,
the library equation does not meet the needs of this example because its terms are
defined as fixed multiples of the fundamental frequency w. Refer to “Fourier Series”
on page 4-46 for more information. Create the built-in library Fourier fit to compare
with your custom equations:

a Select month for X data and pressure for Y data.
b Select Fourier for the model type.

¢ Enter Fourier for the Fit name.
d Change the number of terms to 8.
Observe the library model fit. In the next steps you will create custom equations
to compare.
T T ] T I ] T T
- *r ]
. ., = pressure vs. month
15 - . ' . e Fourier i
- - i
b . - i .
- . ™ - "
] LN | . *
£ 10l b LM . ;
% - * . "
2 ;o o '
L] - : -
5| L - . - s - i
- . "
%
0 i i i i I i 1 1 i J
0 20 40 60 80 100 120 140 160
month

3 Duplicate your fit. Right-click your fit in the Table of Fits and select Duplicate
‘Fourier’.

4 Name the new fit EnsolPeriod.
5 Change the fit type from Fourier to Custom Equation.
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pressure

6 Replace the example text in the equation edit box with

a0+al*cos(2*pi*x/cl)+bl*sin(2*pi*x/cl)

. Custom Equation il

-

= f{ |x )

|1 al+al*cos (2%pi*x/cl) +bl*sin (2%pi*x/cl)
2

The toolbox applies the fit to the enso data.

The graphical and numerical results shown here indicate that the fit does not describe
the data well. In particular, the fitted value for c1 is unreasonably small. Your initial fit
results might differ from these results because the starting points are randomly selected.

. . " . pressure vs. month |
15L . L —s '-' . Enso1Period H
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.t L] * L] ™ L] . - .' e
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Results

General model:
f{x) = al+a1%cos(2*pi*x/cl) +h 1%sin(2*pi*xc 1)
Coeffidents (with 95% confidence bounds):
al=  10.64 (10.11, 11.17)
al= -0.2215 (-1.111, 0.6673)
bi= 0.0915 {-1,302, 1.485)
cl= 0.6447 (0.6404, 0.6453)

Goodness of fit:
55E: 1958
R-sgquare: 0.002451
Adjusted R-square: -0.0158
RMSE: 3.455

By default, the coefficients are unbounded and have random starting values from 0 to 1.
The data include a periodic component with a period of about 12 months. However, with
c1 unconstrained and with a random starting point, this fit failed to find that cycle.

Use Fit Options to Constrain a Coefficient
1 To assist the fitting procedure, constrain c1 to a value from 10 to 14. Click the Fit
Options button to view and edit constraints for unknown coefficients.

2 In the Fit Options dialog box, observe that by default the coefficients are unbounded
(bounds of —Inf and Inf).

3 Change the Lower and Upper bounds for c1 to constrain the cycle from 10 to 14
months, as shown next.
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o

4\ Fit Options ==
Method: MonlinearLeastSquares
Robust: Off -
Algorithm: :Trust-Hegion v:
DiffMinChange: 1.0e-8
DiffMaxChange: 01
MaxFunEBvals: 600
Mazdter: 400
TolFun: 1.0e-6
Tolx: 1.0e-6
Unknowns StartPoint  Lower Upper
all 0.6557 -Inf Inf
al 0.0357 -Inf Inf
bl 0.8491 -Inf Inf
cl 0.9340 10 14

4  Click Close. The Curve Fitting app refits.

5 Observe the new fit and the residuals plot. If necessary, select View > Residuals
Plot or use the toolbar button.
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The fit appears to be reasonable for some data points but clearly does not describe
the entire data set very well. As predicted, the numerical results in the Results
pane (c1=11.94) indicate a cycle of approximately 12 months. However, the
residuals show a systematic periodic distribution, indicating that at least one more
cycle exists. There are additional cycles that you should include in the fit equation.

Create Second Custom Fit with Additional Terms and Constraints

To refine your fit, you need to add an additional sine and cosine term to y;(x) as follows:

Yo(x) = y1(x) +ay cos(2n1J+ by sin[Zni]
C2 C2
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and constrain the upper and lower bounds of ¢, to be roughly twice the bounds used for

Ci.

1

Duplicate your fit by right-clicking it in the Table of Fits and selecting Duplicate
‘EnsolPeriod’.

Name the new fit Enso2Period.

Add these terms to the end of the previous equation:

+a2*cos(2*pi*x/c2)+h2*sin(2*pi*x/c2)

Click Fit Options. When you edit the custom equation, the tool remembers your fit
options. Observe the Lower and Upper bounds for c1 still constrain the cycle from
10 to 14 months. Add more fit options:

a Change the Lower and Upper for c2 to be roughly twice the bounds used for c1
(20<c2<30).

b Change the StartPoint for a0 to 5.

As you change each setting, the Curve Fitting app refits. The fit and residuals are
shown next.
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The fit appears reasonable for most data points. However, the residuals indicate that you
should include another cycle to the fit equation.

Create a Third Custom Fit with Additional Terms and Constraints
As a third attempt, add an additional sine and cosine term to ys(x)
x . x
y3(x) = y9(x) +ag cos| 2r — |+bg sin| 2r —
3 ]
and constrain the lower bound of ¢3 to be roughly triple the value of ¢;.

1  Duplicate your fit by right-clicking it in the Table of Fits and selecting Duplicate
‘Enso2Period’.
2 Name the new fit Enso3Period.

3 Add these terms to the end of the previous equation:
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+a3*cos(2*pi*x/c3)+b3*sin(2*pi*x/c3)

4 Click Fit Options Observe your previous fit options are still present.

5

a Change the Lower bound for c3 to be 36, which is roughly triple the value of

cl.

A\ Fit Options @
Method: MonlinearLeastSquares

Robust: Off -
Algorithm: Trust-Region -
DiffMinChange: 1e-008
DiffMaxChange: 01
MaxFunEvals: 600
Mazdter: 400
TolFurn: 1e-006
Tolk: 1e-006

Unknowns StartPoint Lower Upper

all 5 -Inf Inf
al 0.9585 -Inf Inf
a2 0.6557 -Inf Inf
a3 0.0357 -Inf Inf
bl 0.8491 -Inf Inf
b2 0.9340 -Inf Inf
b3 0.6787 -Inf Inf
cl 0.7577 10 14
c2 07431 20 30
3 0.3922 36 Inf
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b Close the dialog box. The Curve Fitting app refits. The fit and residuals appear
next.

pressure vs. month .
Enso3Period

i

pressure

0 20 40 60 B0 100 120 140 160
month

4 - ——= Enso3Period —residualsl 1

pressure

0 20 40 60 80 100 120 140 160

month

The fit is an improvement over the previous two fits, and appears to account for most
of the cycles in the ENSO data set. The residuals appear random for most of the data,
although a pattern is still visible indicating that additional cycles might be present, or
you can improve the fitted amplitudes.

In conclusion, Fourier analysis of the data reveals three significant cycles. The annual
cycle is the strongest, but cycles with periods of approximately 44 and 22 months are also
present. These cycles correspond to El Nino and the Southern Oscillation (ENSO).
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Gaussian Fitting with an Exponential Background

This example fits two poorly resolved Gaussian peaks on a decaying exponential
background using a general (nonlinear) custom model.

Fit the data using this equation

(2l
yx)=ae ™ +ae\ @ ) +age\ @

where a; are the peak amplitudes, b; are the peak centroids, and c; are related to the peak
widths. Because unknown coefficients are part of the exponential function arguments,
the equation is nonlinear.

1 Load the data and open the Curve Fitting app:

load gauss3
cftool

The workspace contains two new variables:

xpeak is a vector of predictor values.
+ ypeak is a vector of response values.
In the Curve Fitting app, select xpeak for X data and ypeak for Y data.
Enter Gauss2expl for the Fit name.
Select Custom Equation for the model type.

O b WOWDN

Replace the example text in the equation edit box with these terms:
a*exp(-b*x)+al*exp(-((x-bl)/cl)"2)+a2*exp(-((x-b2)/c2)"2)
The fit is poor (or incomplete) at this point because the starting points are randomly

selected and no coefficients have bounds.

6  Specify reasonable coefficient starting points and constraints. Deducing the starting
points is particularly easy for the current model because the Gaussian coefficients
have a straightforward interpretation and the exponential background is well
defined. Additionally, as the peak amplitudes and widths cannot be negative,
constrain a, as, ¢1, and ¢, to be greater than 0.

a Click Fit Options.
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b Change the Lower bound for a;, as, ¢1, and ¢, to 0, as the peak amplitudes and
widths cannot be negative.

¢ Enter start points as shown for the unknown coefficients.

Unknowns Start Point
a 100

al 100

a2 80

b 0.1

bl 110

b2 140

cl 20

c2 20
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4\ Fit Options ==
Method: MonlinearLeastSquares
Robust: off -
Algeorithm: Trust-Regicn -
DiffMinChange: 1.0e-8
DiffMaxChange: 01
MazxFunEvals: 600
MaxIter: 400
TelFun: 1.0e-6
Tolx: 1.0e-6
Unknowns 5StartPoint  Lower Upper
a 100 -Inf Inf
al 100 a Inf
a &0 0 Inf
b 0.1000 -Inf Inf
bl 110 -Inf Inf
b2 140 -Inf Inf
cl 20 0 Inf
2 20 ] Inf

As you change fit options, the Curve Fitting app refits. Press Enter or close the
Fit Options dialog box to ensure your last change is applied to the fit.

Following are the fit and residuals.

5-37



5 Custom Linear and Nonlinear Regression

140 ¢ : -. | I | I

| * ypeak vs. Xpeak'
120 GaussZexpi

100}

80

ypeak

60

40 }

20}

. [ « Gauss2exp1 - residuals -
q L] J

R @ﬂ?':l-f@‘i%}%ﬁ ¥l e =

ypeak

0 50 100 150 o .

5-38



Surface Fitting to Biopharmaceutical Data

Surface Fitting to Biopharmaceutical Data

Curve Fitting Toolbox software provides some example data for an anesthesia drug
interaction study. You can use Curve Fitting app to fit response surfaces to this data
to analyze drug interaction effects. Response surface models provide a good method for
understanding the pharmacodynamic interaction behavior of drug combinations.

This data is based on the results in this paper:

* Kern SE, Xie G, White JL, Egan TD. Opioid-hypnotic synergy: A response surface
analysis of propofol-remifentanil pharmacodynamic interaction in volunteers.
Anesthesiology 2004; 100: 1373-81.

Anesthesia is typically at least a two-drug process, consisting of an opioid and a sedative
hypnotic. This example uses Propofol and Reminfentanil as drug class prototypes. Their
interaction is measured by four different measures of the analgesic and sedative response
to the drug combination. Algometry, Tetany, Sedation, and Laryingoscopy comprise the
four measures of surrogate drug effects at various concentration combinations of Propofol
and Reminfentanil.

To interactively create response surfaces for this drug combination:

1  Use the Current Folder browser to locate and view the folder matlab\toolbox
\curvefit\curvefit.

2 Right-click the file OpioidHypnoticSynergy . txt, and select Import Data. The

Import Wizard appears.

a Leave the default Column delimiters set to Tab and Column vectors in the
Import tab.

Review the six variables selected for import: Propofol, Reminfentanil, Algometry,
Tetany, Sedation, and Laryingoscopy.

b On the Import tab, in the Import section, click Import Selection to import the
dose-response data into the MATLAB workspace.

Alternatively, you can import the data programmatically. Enter the following code to
read the dose-response data from the file into the MATLAB workspace.

data = importdata( "OpioidHypnoticSynergy.txt® );

Propofol = data.data(:,1);
Remifentanil = data.data(:,2);
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Algometry = data.data(:,3);
Tetany = data.data(:,4);
Sedation = data.data(:,5);
Laryingoscopy = data.data(:,6);

To create response surfaces you must select the two drugs for the X and Y inputs,
and one of the four effects for the Z output. After you load the variables into your
workspace, you can either open the tool and select variables interactively, or specify
the initial fit variables with the cftool command.

Enter the following to open Curve Fitting app (if necessary) and create a new
response surface for Algometry:

cftool (Propofol, Remifentanil, Algometry)

Review the Curve Fitting app X, Y, and Z input and output controls. The tool
displays the selected variables Propofol, Remifentanil and Algometry, with a
surface fit. The default fit is an interpolating surface that passes through the data
points.



Surface Fitting to Biopharmaceutical Data

n Curve Fitting Tool - surfacefittingbiopharm
File Fit View Tools Desktop Window Help e x
« &R OE = |EREE) % BOBO
| untitled fitl = | 4 |
-Interpolant - | [¥] Aut
Fit name: | untitled fit1 i :
r . Method: |Linear - Fit
Adatai | Propofol =) : el
[ 1 Center and scale | S
¥ data: | Remifentanil il = g
Z data: :Algometry v:
Weights: :(none] Y:
Results e
i Duplicate x-y data paints f rvrma IR -
Y uplicate x-y data poin = 1 = Algometry vs. Propofol, Remifentanil
£ - IFN ! . ; i
£
8
LI T b =2 054
.............. — |2
Linear interpolant: = 04
fa¢,y) = piecewise lim e : T
where x is normalized _ a0 T . I -
| e ..l.lm.m.an — FD e o 6
4 [om 3 i i s 2
Remifentani 0 0 Propofol
Table of Fits @
Fit .. = Data Fit type SSE R-squ.. DFE AdjR.. RMSE #Coeff Valid.. Valid.. Valid..
3 unti...|Algom... lineari... [9.8732... 1 o [NaN  NaN [207 | | |

Create a copy of the current surface fit by either:

a Selecting Fit > Duplicate "Current Fit Name".

b Right-clicking a fit in the Table of Fits, and selecting Duplicate.

Select the Custom Equation fit type from the drop-down list to define your own
equation to fit the data.

Select and delete the example custom equation text in the edit box.

You can use the custom equation edit box to enter MATLAB code to define your
model. The equation that defines the model must depend on the input variables x
and y and a list of fixed parameters, estimable parameters, or both.
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The model from the paper is:

n
E_ .. Ca + Cp +a. Ca ) Cp
o (1050, " 10505 " *'1C50, 1C50,

n
1+ CA- + CB +ao. CA . CB
IC50, IC50p IC50, IC50p

where Ca and Cg are the drug concentrations, and IC50A, IC50B, alpha, and n are
the coefficients to be estimated.

You can define this in MATLAB code as

Effect = Emax*( CA/IC50A + CB/IC50B + alpha*( CAZ/IC50A )...
.* ( CB/IC50B ) ).”~n ./(( CA/IC50A + CB/IC50B + ...
alpha*( CA/IC50A ) .* ( CB/ZIC50B ) ).~n + 1);

Telling the tool which variables to fit and which parameters to estimate, requires
rewriting the variable names CA and CB to X, and y. You must include X and y when
you enter a custom equation in the edit box. Assume Emax = 1 because the effect
output is normalized.

Enter the following text in the custom equation edit box.
( X/1C50A + y/I1C50B + alpha*( x/I1C50A ) .* ( y/IC50B ) ).”n

-/(( x/1C50A + y/1C50B + alpha*( x/IC50A ) .*
( y/IC50B ) ). + 1);

Curve Fitting app fits a surface to the data using the custom equation model.
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-4\ Curve Fitting Tool - surfacefittingbiopharm

Fit name: untitled fit1 copyl

X data: :Pmpofoi
Y data: jRemifentanii
Z data: :Aigometrg.r

Weights: (none)

Results

:CustomEqua’(ion
1 z = f(|x ' Y
; ) T ST =/TIC50A + w/ICS0E + al o
- 3 ( yw/ICSOB ) ).”n + 1): -
4 < | mn | +
r

General model:

1) +1);

IC50A =
IC50B =

alpha =
n= 883 (7.951,9.708)

Goodness of fit:
4| 1 |

flx,v) = { %/IC504 + y/IC50B + alpt
%/IC50A + y/ICS0B + alph:

Coefficents {with 95% confidence bour,
4,177 (4.005, 4.25)

8.882 (8.527,9.237) —
8.221 (7.328,9.113)

-

054"

Algometry

Table of Fits

el

«  Algometry vs. Propofol, Remifentanil |

Auto fit

Fit

Stop

—r

Fit name =
[ untitled fit 1

Data
Algomet... |linearint... (9.8733e-30 1

Fittype  SSE R-square

DFE
0

AdjR-sq  RMSE

Mal

Mal

297

# Coeff  Validati...

Validati...

Validat...

[A untitled fit1 copy 1

Algomet...|(x1C50A...2.1746

0.9764

393

0.9762

0.0744

4

8 Set some of the fit options by clicking Fit Options under your custom equation.

In the Fit Options dialog box:

a Set Robust to Lar
b Setthe alpha StartPoint to 1 and lower bound to —5.
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) Fit Options - x|
Method: MonlinearLeastSquares
Robust: Lar -
Algorithm: I Trust-Region ;I
DiffMinChange: | 1,0e-3
DiffMaxChange: I 0.1
MaxFunEvals: I 600
MaxIter: | 400
TalFur: I 1.0e-6
Toly: | 1.0e-6
Unknowns StartPoint Lower Upper
IC50A 0.4719 -Inf Inf
IC50B 0.4225 -Inf Inf
alpha i -5 Inf
n 0.8455 -Inf Inf
Close |

¢ Leave the other defaults, and click Close.

The tool refits with your new options.

9 Review the Results pane. View (and, optionally, copy) any of these results:

The model equation
* The values of the estimated coefficients
*  The goodness-of-fit statistics

10 Display the residuals plot to check the distribution of points relative to the surface

by clicking the toolbar button |E or selecting View > Residuals Plot.
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11 To generate code for all fits and plots in your Curve Fitting app session, select File >

Generate Code.
The Curve Fitting app generates code from your session and displays the file in the
MATLAB Editor. The file includes all fits and plots in your current session.

12 Save the file with the default name, createFits.m.

13 You can recreate your fits and plots by calling the file from the command line (with
your original data or new data as input arguments). In this case, your original data
still appears in the workspace.

Highlight the first line of the file (excluding the word function), and evaluate it
by either right-clicking and selecting Evaluate Selection in Command Window,
pressing F9, or copying and pasting the following to the command line:
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14

[fitresult, gof] = createFits(Propofol, ...
Remifentanil, Algometry)

The function creates a figure window for each fit you had in your session. The custom
fit figure shows both the surface and residuals plots that you created interactively in
the Curve Fitting app.

Create a new fit to the Tetany response instead of Algometry by entering:

[fitresult, gof] = createFits(Propofol, ...
Remifentanil, Tetany)

You need to edit the file if you want the new response label on the plots. You can use
the generated code as a starting point to change the surface fits and plots to fit your
needs. For a list of methods you can use, see sFit.

To see how to programmatically fit surfaces to the same example problem, see “Surface
Fitting With Custom Equations to Biopharmaceutical Data”.
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* “Nonparametric Fitting” on page 6-2

+  “Interpolation Methods” on page 6-3

+ “Selecting an Interpolant Fit” on page 6-6

* “Smoothing Splines” on page 6-11

+ “Lowess Smoothing” on page 6-20

+ “Fit Smooth Surfaces To Investigate Fuel Efficiency” on page 6-24
+ “Filtering and Smoothing Data” on page 6-34
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Nonparametric Fitting

In some cases, you are not concerned about extracting or interpreting fitted parameters.
Instead, you might simply want to draw a smooth curve through your data. Fitting of this
type is called nonparametric fitting. The Curve Fitting Toolbox software supports these
nonparametric fitting methods:

“Interpolation Methods” on page 6-3 — Estimate values that lie between known
data points.

“Smoothing Splines” on page 6-11 — Create a smooth curve through the data. You
adjust the level of smoothness by varying a parameter that changes the curve from a
least-squares straight-line approximation to a cubic spline interpolant.

“Lowess Smoothing” on page 6-20 — Create a smooth surface through the data
using locally weighted linear regression to smooth data.

For details about interpolation, see “Interpolation” (MATLAB).

You can also use smoothing techniques on response data. See “Filtering and Smoothing
Data” on page 6-34.

To view all available model types, see “List of Library Models for Curve and Surface
Fitting” on page 4-13.

Related Examples

6-2

“Selecting an Interpolant Fit” on page 6-6
“Smoothing Splines” on page 6-11

“Lowess Smoothing” on page 6-20

“Filtering and Smoothing Data” on page 6-34
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Interpolation Methods

About Interpolation Methods

Interpolation is a process for estimating values that lie between known data points.

Interpolant Methods
Method Description
Linear Linear interpolation. This method fits a different linear

polynomial between each pair of data points for curves, or
between sets of three points for surfaces.

Nearest neighbor

Nearest neighbor interpolation. This method sets the value of
an interpolated point to the value of the nearest data point.
Therefore, this method does not generate any new data points.

Cubic spline

Cubic spline interpolation. This method fits a different cubic
polynomial between each pair of data points for curves, or
between sets of three points for surfaces.

Shape-preserving

Piecewise cubic Hermite interpolation (PCHIP). This method
preserves monotonicity and the shape of the data.

For curves only.

Biharmonic (v4)

MATLAB 4 griddata method.

For surfaces only.

Thin-plate spline

Thin-plate spline interpolation. This method fits smooth
surfaces that also extrapolate well.

For surfaces only.

For surfaces, the Interpolant fit type uses the MATLAB scatteredinterpolant
function for linear and nearest methods, and the MATLAB griddata function for cubic
and biharmonic methods. The thin-plate spline method uses the tpaps function.

The type of interpolant to use depends on the characteristics of the data being fit, the
required smoothness of the curve, speed considerations, post-fit analysis requirements,
and so on. The linear and nearest neighbor methods are fast, but the resulting curves are
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not very smooth. The cubic spline and shape-preserving and v4 methods are slower, but
the resulting curves are very smooth.

For example, the nuclear reaction data from the carbonl2alpha.mat file is shown here
with a nearest neighbor interpolant fit and a shape-preserving (PCHIP) interpolant fit.
Clearly, the nearest neighbor interpolant does not follow the data as well as the shape-
preserving interpolant. The difference between these two fits can be important if you

are interpolating. However, if you want to integrate the data to get a sense of the total
strength of the reaction, then both fits provide nearly identical answers for reasonable
integration bin widths.

350 T T T T T = T

I
. a  C12Alpha
2 — nearest
-—- pchip

200~

counts

180

100

S0

45

Note Goodness-of-fit statistics, prediction bounds, and weights are not defined for
interpolants. Additionally, the fit residuals are always 0 (within computer precision)
because interpolants pass through the data points.

Interpolants are defined as piecewise polynomials because the fitted curve is constructed
from many “pieces” (except for Biharmonic for surfaces which is a radial basis function



Interpolation Methods

interpolant). For cubic spline and PCHIP interpolation, each piece is described by four
coefficients, which the toolbox calculates using a cubic (third-degree) polynomial.
* Refer to the spline function for more information about cubic spline interpolation.

* Refer to the pchip function for more information about shape-preserving
interpolation, and for a comparison of the two methods.

* Refer to the scatteredInterpolant, griddata, and tpaps functions for more
information about surface interpolation.

It is possible to fit a single “global” polynomial interpolant to data, with a degree one
less than the number of data points. However, such a fit can have wildly erratic behavior
between data points. In contrast, the piecewise polynomials described here always
produce a well-behaved fit, so they are more flexible than parametric polynomials and
can be effectively used for a wider range of data sets.

Related Examples
. “Selecting an Interpolant Fit” on page 6-6
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Selecting an Interpolant Fit

6-6

In this section...

“Selecting an Interpolant Fit Interactively” on page 6-6
“Fit Linear Interpolant Models Using the Fit Function” on page 6-7

Selecting an Interpolant Fit Interactively

In the Curve Fitting app, select Interpolant from the model type list.

The Interpolant fit category fits an interpolating curve or surface that passes
through every data point. For surfaces, the Interpolant fit type uses the MATLAB
scatteredlnterpolant function for linear and nearest methods, the MATLAB
griddata function for cubic and biharmonic methods, and the tpaps function for thin-

plate spline interpolation.

The settings are shown here.

Interpolant -

Method: |i Linear -

| Center and scale

You can specify the Method setting: Nearest neighbor, Linear, Cubic, Shape-
preserving (PCHIP) (for curves), Biharmonic (v4) (for surfaces) or Thin-plate
spline (for surfaces). For details, see “About Interpolation Methods” on page 6-3.

Tip: If you are fitting a surface and your input variables have different scales, turn the
Center and scale option on and off to see the difference in the surface fit. Normalizing
the inputs can strongly influence the results of the triangle-based (i.e., piecewise Linear
and Cubic interpolation) and Nearest neighbor surface interpolation methods.




Selecting an Interpolant Fit

For surfaces, try thin-plate splines when you require both smooth surface interpolation
and good extrapolation properties.

Fit Linear Interpolant Models Using the fit Function

This example shows how to use the Fit function to fit linear interpolant models to data.
Interpolant Fitting Methods

Specify the interpolant model method when calling the fit function using one of the
options outlined in “Interpolant Model Names”. None of the interpolant methods has any
additional fit option parameters.

Fit a Linear Interpolant Model
Load data and fit a linear interpolant model using the " linearinterp” option.
load census

f = fit(cdate,pop, “linearinterp®);
plot(f,cdate,pop);
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Compare Linear Interpolant Models

Load data and create both nearest neighbor and pchip interpolant fits using the
"nearestinterp” and "pchip” options.

load carbonl2alpha

1 fit(angle,counts, "nearestinterp”);
2 fit(angle,counts, "pchip™);
Compare the fitted curves 1 and 2 on a plot.
pl = plot(fl,angle,counts);

xlim([min(angle) ,max(angle)])
hold on
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p2 = plot(f2,"b");

hold off

legend([pl;p2], "Counts per Angle®,"Nearest Neighbor®,"pchip®,...
"Location®, "northwest")

350 T . T T T
*  Counts per Angle
Mearest Meighbor
300 pchip
250
200
=
180
100
80
D i i i i i i i i
0.5 1 1.5 2 25 3 35 4

For an alternative to 'cubicinterp' or 'pchipinterp', you can use other spline functions
that give you greater control over what you create. See “About Splines in Curve Fitting
Toolbox”.

See Also
fit
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Related Examples
. “Interpolation Methods” on page 6-3
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Smoothing Splines

In this section...

“About Smoothing Splines” on page 6-11
“Selecting a Smoothing Spline Fit Interactively” on page 6-12
“Fit Smoothing Spline Models Using the fit Function” on page 6-13

“Example: Nonparametric Fitting with Cubic and Smoothing Splines” on page 6-16

About Smoothing Splines

If your data is noisy, you might want to fit it using a smoothing spline. Alternatively, you
can use one of the smoothing methods described in “Filtering and Smoothing Data” on
page 6-34.

The smoothing spline s is constructed for the specified smoothing parameter p and the
specified weights w;. The smoothing spline minimizes

2
pr —s(x)? +(1- )I[dstx

If the weights are not specified, they are assumed to be 1 for all data points.

p is defined between 0 and 1. p = 0 produces a least-squares straight-line fit to the data,
while p = 1 produces a cubic spline interpolant. If you do not specify the smoothing
parameter, it is automatically selected in the “interesting range.” The interesting range
of p is often near 1/(1+h?/6) where A is the average spacing of the data points, and it is
typically much smaller than the allowed range of the parameter. Because smoothing
splines have an associated smoothing parameter, you might consider these fits to be
parametric in that sense. However, smoothing splines are also piecewise polynomials like
cubic spline or shape-preserving interpolants and are considered a nonparametric fit type
in this guide.

Note The smoothing spline algorithm is based on the csaps function.

The nuclear reaction data from the file carbon12alpha.mat is shown here with three
smoothing spline fits. The default smoothing parameter (p = 0.99) produces the
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smoothest curve. The cubic spline curve (p = 1) goes through all the data points, but is
not quite as smooth. The third curve (p = 0.95) misses the data by a wide margin and
illustrates how small the “interesting range” of p can be.
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Selecting a Smoothing Spline Fit Interactively

In the Curve Fitting app, select Smoothing Spline from the model type list.

Smoothing Spline -

Smoothing Pararmeter

Specify: < Srnoother | |0.8999999933329909 Rougher =

Center and scale

You can specify the following options:
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To make a smoother fit further from the data, click the < Smoother button
repeatedly until the plot shows the smoothness you want.

To make a rougher fit closer to the data, click the Rougher > button until you are
satisfied with the plot.

Alternatively, specify any value from 0 to 1 for the smoothing parameter. 0 produces
a linear polynomial fit (a least-squares straight-line fit to the data), while 1 produces
a piecewise cubic polynomial fit that passes through all the data points (a cubic spline
interpolant).

Click Default to return to the initial value. The toolbox attempts to select a default
value appropriate for your data. See “About Smoothing Splines” on page 6-11.

For example:

1

4

Load the data in “About Smoothing Splines” on page 6-11 by entering:

load carbonl2alpha

In the Curve Fitting app, select angle for X data and counts for Y data.
Select the Smoothing Spline fit type.

Try smoothing parameter values 1, 0.95, and the default value (0.99).

Fit Smoothing Spline Models Using the fit Function

This example shows how to use the Fit function to fit a smoothing spline model to data.

Fit a Smoothing Spline Model

Load data and fit a smoothing spline model by specifying "smoothingspline® when
calling the fit function.

load enso
f = fit(month,pressure, "smoothingspline®);
plot(f,month,pressure)
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View Calculated Smoothing Parameter

Create the model again and use the third output argument to view the calculated
smoothing parameter. The smoothing parameter is the p value in the out structure. The
default value depends on the data set.

[f,gof,out] = fit(month,pressure, “smoothingspline®);

out.p

ans

0.9000
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Specify Smoothing Parameter using “SmoothingParam®

Specify the smoothing parameter for a new fit with the "SmoothingParam® option. Its
value must be between 0 and 1.

f = fit(month,pressure, "smoothingspline”, "SmoothingParam®,0.07);
plot(f,month,pressure)
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Specify Smoothing Parameter using fitoptions

Alternatively, use Fitoptions to specify a smoothing parameter before fitting.
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options = fitoptions(“Method", "Smooth”,"SmoothingParam®,0.07);
[f,gof,out] = fit(month,pressure, "smooth”,options);
out.p

ans =

0.0700

For an alternative to "smoothingspline®, you can use the csaps cubic smoothing spline
function or other spline functions that allow greater control over what you can create. See
“About Splines in Curve Fitting Toolbox”.

Example: Nonparametric Fitting with Cubic and Smoothing Splines

This example fits some data using a cubic spline interpolant and several smoothing
splines.

1  Create the variables in your workspace:

X (4*pi)*[0 1 rand(1,25)];
y = sin(xX) + .2*(rand(size(x))-.5);

2 Open the Curve Fitting app by entering:

cftool
3 Select x and y from the X data and Y data lists.

The Curve Fitting app fits and plots the data.

4  Fit the data with a cubic spline interpolant by selecting Interpolant fit type and the
Method Cubic.

Interpolant -
Method: | Cubic *

| Center and scale

The Curve Fitting app fits and plots the cubic spline interpolant.
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5 Enter the Fit name cubicsp.

6 View the Results pane. Goodness-of-fit statistics such as RMSE are not defined
(shown as NaN) for interpolants.

Results

Cubic spline interpolant:
f(x) = piecewise polynomial computed from p
where x is normalized by mean 5.3% and std 3,938
Coeffidents:
p = coeffident structure

Goodness of fit:
S55E: 7.704e-034
R-sguare: 1
Adjusted R-sguare: NaM
EMSE: MaM

A cubic spline interpolation is defined as a piecewise polynomial that results in a
structure of coefficients (p). The number of “pieces” in the structure is one less than
the number of fitted data points, and the number of coefficients for each piece is four
because the polynomial degree is three. You can examine the coefficient structure p
if you export your fit to the workspace (e.g., enter fitname .p). For information on
the structure of coefficients, see “Constructing and Working with ppform Splines” on
page 10-12.

7 Create another fit to compare. Right-click your fit in the Table of Fits and select
Duplicate ‘cubicsp’.

8 Fit the data with a smoothing spline by selecting Smoothing Spline.

Smoothing 5pline >

Smocothing Parameter

@ Default

) Specify: | < 0.99045204581360742 >

[] Center and scale
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10

11

The level of smoothness is given by the Smoothing Parameter. The default
smoothing parameter value depends on the data set, and is automatically calculated
by the toolbox.

For this data set, the default smoothing parameter is close to 1, indicating that the
smoothing spline is nearly cubic and comes very close to passing through each data
point.

Name the default smoothing parameter fit Smoothl. If you do not like the level of
smoothing produced by the default smoothing parameter, you can specify any value
from O to 1. 0 produces a linear polynomial fit, while 1 produces a piecewise cubic
polynomial fit that passes through all the data points.

The numerical results for the smoothing spline fit are shown here.

Results

Smoothing spline:

f{x) = piecewise polynomial computed from p
Smoathing parameter:

p =0,99986514

Goodness of fit:
55E: 0.014994
R-square: 0,9937
Adjusted R-square: 0.994
RMSE: 0.05128

For comparison purposes, create another smoothing spline fit. Right-click your
fit in the Table of Fits and select Duplicate ‘smooth1’. Change the smoothing
parameter to 0.5 and name the fit Smooth2.

Compare the plots for your three fits. Explore the fit behavior beyond the data limits
by increasing the default abscissa scale. You change the axes limits with Tools >
Axes Limit Control menu item.

Note: Your results depend on random start points and may vary from those described.

Note that the default smoothing parameter produces a curve that is smoother than
the interpolant, but is a good fit to the data. In this case, decreasing the smoothing



Smoothing Splines

parameter from the default value produces a curve that is smoother still, but is not a
good fit to the data. As the smoothing parameter increases beyond the default value, the
associated curve approaches the cubic spline interpolant. The cubic spline and default
smoothing spline are similar for interior points, but diverge at the end points.

See Also
fit

Related Examples

. “Nonparametric Fitting” on page 6-2

. “Filtering and Smoothing Data” on page 6-34
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Lowess Smoothing

In this section...

“About Lowess Smoothing” on page 6-20
“Selecting a Lowess Fit Interactively” on page 6-20
“Fit Lowess Models Using the Fit Function” on page 6-21

About Lowess Smoothing

Use Lowess models to fit smooth surfaces to your data. The names “lowess” and “loess”
are derived from the term “locally weighted scatter plot smooth,” as both methods use
locally weighted linear regression to smooth data. The process is weighted because

the toolbox defines a regression weight function for the data points contained within
the span. In addition to the regression weight function, the Robust option is a weight
function that can make the process resistant to outliers.

For more information on these two types of smoothing fit, see “Local Regression
Smoothing” on page 6-38.

Selecting a Lowess Fit Interactively
In the Curve Fitting app, select Lowess from the model type list.

You can use the Lowess model type to fit smooth surfaces to your data with either
lowess or loess methods. The Lowess fits use locally weighted linear regression to
smooth data.

HLOWESS s T
Polynomial: | Limear A
Span: 25 %
Robust: Off *

#| Center and scale

You can specify the following options:
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Select Linear or Quadratic from the list to specify the type of Polynomial model
to use in the regression. In Curve Fitting Toolbox, lowess fitting uses a linear
polynomial, while loess fitting uses a quadratic polynomial.

Use Span to specify the span as a percentage of the total number of data points in
the data set. The toolbox uses neighboring data points defined within the span to
determine each smoothed value. This role of neighboring points is the reason why the
smoothing process is called “local.”

Tip: Increase the span to make the surface smoother. Reduce the span to make the
surface follow the data more closely.

The Robust linear least-squares fitting method you want to use (OFF, LAR, or
Bisquare). The local regression uses the Robust option. Using the Robust weight
function can make the process resistant to outliers. For details, see Robust on the
fitoptions reference page.

Tip: If your input variables have very different scales, turn the Center and scale option
on and off to see the difference in the surface fit. Normalizing the inputs can strongly
influence the results of a Lowess fitting.

For an interactive example using Lowess, see “Surface Fitting to Franke Data” on page
2-34.

Fit Lowess Models Using the fit Function

This example shows how to use the Fit function to fit a Lowess model to data.

Load some data and fit a Lowess model by specifying " lowess” when calling the fit
function.

load franke
T = fit([x y],z, " lowess")
plot(f,[x y],2)

Locally weighted smoothing linear regression:

f(x,y) = lowess (linear) smoothing regression computed from p
Coefficients:

p = coefficient structure
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1.5 ~

For a command-line example using Lowess, see “Fit Smooth Surfaces To Investigate Fuel
Efficiency”.

See Also
fit

Related Examples
. “Nonparametric Fitting” on page 6-2

. “Fit Smooth Surfaces To Investigate Fuel Efficiency”
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“Filtering and Smoothing Data” on page 6-34
“Surface Fitting to Franke Data” on page 2-34
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Fit Smooth Surfaces To Investigate Fuel Efficiency

6-24

This example shows how to use Curve Fitting Toolbox™ to fit a response surface to some
automotive data to investigate fuel efficiency.

The toolbox provides sample data generated from a GTPOWER predictive combustion
engine model. The model emulates a naturally aspirated spark-ignition, 2-liter, inline
4-cylinder engine. You can fit smooth lowess surfaces to this data to find minimum fuel
consumption.

The data set includes the required variables to model response surfaces:

*  Speed is in revolutions per minute (rpm) units.

* Load is the normalized cylinder air mass (the ratio of cylinder aircharge to maximum
naturally aspirated cylinder aircharge at standard temperature and pressure).

+ BSFC is the brake-specific fuel consumption in g/KWh. That is, the energy flow in,
divided by mechanical power out (fuel efficiency).

The aim is to model a response surface to find the minimum BSFC as a function of
speed and load. You can use this surface as a table, included as part of a hybrid vehicle
optimization algorithm combining the use of a motor and your engine. To operate the
engine as fuel efficiently as possible, the table must operate the engine near the bottom
of the BSFC bowl.

Load and Preprocess Data

Load the data from the XLS spreadsheet. Use the "basic” command option for non-
Windows® platforms.

Create a variable n that has all the numeric data in one array.
n = xIsread( "Engine_Data_ SI_NA 2L _I14.xlIs", *SI NA 2L 147, °", “basic” );
Extract from the variable n the columns of interest.

SPEED = n(:,2);
LOAD_CMD = n(:,3);
LOAD n(:,8);
BSFC n(:,22);

Process the data before fitting, to pick out the minimum BSFC values from each sweep.
The data points are organized in sweeps on speed/load.
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Get a list of the speed/load sites:

SL = unique( [SPEED, LOAD_CMD], “rows® );
nRuns = size( SL, 1 );

For each speed/load site, find the data at the site and extract the actual measured load
and the minimum BSFC.

minBSFC = zeros( nRuns, 1 );
Load = zeros( nRuns, 1 );
Speed = zeros( nRuns, 1 );

for 1 = 1:nRuns

idx = SPEED == SL(i,1) & LOAD_CMD == SL(i,2);
minBSFC(i) = min( BSFC(idx) );
Load(i) = mean( LOAD(idx) );
Speed(i) = mean( SPEED(idx) );
end
Fit a Surface

Fit a surface of fuel efficiency to the preprocessed data.

fl = fit( [Speed, Load], minBSFC, "Lowess", "Normalize®, "on" )

Locally weighted smoothing linear regression:
T1(x,y) = lowess (linear) smoothing regression computed from p
where x is normalized by mean 3407 and std 1214
and where y is normalized by mean 0.5173 and std 0.1766
Coefficients:
p = coefficient structure

Plot Fit
plot( f1, [Speed, Load], minBSFC );
xlabel ( "Speed [RPM]" );

ylabel ( "Load [%]" );
zlabel (. "Minimum BSFC [g/Kwh]*® );
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Minimum BSFC [g/Kwh]
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Remove Problem Points
Review the resulting plot.

There are points where BSFC is negative because this data is generated by an engine
simulation.

Remove those problem data points by keeping points in the range [0, Inf].

out = excludedata( Speed, minBSFC, “Range®, [0, Inf] );
2 = fit( [Speed, Load], minBSFC, “Lowess®, ...
"Normalize®, "on", "Exclude®, out )
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Minimum BSFC [g/Kwh]

Locally weighted smoothing linear regression:
f2(x,y) = lowess (linear) smoothing regression computed from p
where x is normalized by mean 3443 and std 1187
and where y is normalized by mean 0.521 and std 0.175
Coefficients:
p = coefficient structure

Plot the new fit. Note that the excluded points are plotted as red crosses.

plot( 2, [Speed, Load], minBSFC, "Exclude”, out );
xlabel ( "Speed [RPM]" );

ylabel ( "Load [%]" );

zlabel (. "Minimum BSFC [g/Kwh]" );
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Zoom In

Zoom 1in on the part of the z-axis of interest.

zlim([0, max( minBSFC )])
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You want to operate the engine efficiently, so create a contour plot to see the region
where the BSFC is low. Use the plot function, and specify the name/value parameter pair
"style”, "Contour”.

plot( f2, [Speed, Load], minBSFC, "Exclude®, out, "Style", "Contour® );

xlabel ( "Speed [RPM]" );
ylabel( "Load [%]" );
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Create a Table from the Surface
Generate a table by evaluating the model 2 over a grid of points.

Create variables for the table breakpoints.

speedbreakpoints = linspace( 1000, 5500, 17 );
loadbreakpoints = linspace( 0.2, 0.8, 13 );

To generate values for the table, evaluate the model over a grid of points.
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[tSpeed, tLoad] = meshgrid( speedbreakpoints,

tBSFC = f2( tSpeed, tlLoad );

Examine the rows and columns of the table at the command line.

tBSFC(1:2:end,1:2:end)

ans =

Columns 1

722.3280
503.9880
394_.7579
333.7740
295.9729
273.7512
251.5652

Columns 8

532.1533
396.3209
335.3871
286.3077
269.6837
258.0298
249.0083

through 7

766.7608
499.9201
364.3421
307.7736
282.7567
264.5167
247 .6746

through 9

466.9610
398.0199
346.3882
291.0075
272.2054
260.5269
250.4165

779.
481.
336.
295.
273.
259.
247 .

4296
7240
1811
1777
8287
7631
2747

757.
458.
330.
291.
270.
257.
247 .

Plot the Table Against the Original Model

The grid on the model surface shows the table breakpoints.

h = plot( 2 );

h_.EdgeColor

hold on

mesh( tSpeed, tlLoad, tBSFC,
"LineWidth®, 2,

= "none”;

"LineStyle®, "-",

"FaceColor”®,

hold off

"none”,

xlabel ( "Speed [RPM]" );
ylabel ( "Load [%]" );

zlabel (. "Minimum BSFC

[g/7Kwh]® );

4574
2803
1550
2068
8869
9215
4699

"FaceAlpha®, 1 );

694 .5378
427.7338
329.1635
290.3637
269.8485
256.9350
247 .3570

"EdgeColor*,

624.4095
422.1099
328.1810
290.0173
271.0547
258.3228
248.2433

KT, --.

loadbreakpoints );

576.
412.
329.
287.
270.
258.
248.

5235
1624
1144
8672
5502
6638
8139
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Minimum BSFC [g/Kwh]
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Check the Table Accuracy

View the difference between the model and the table by plotting the difference between
them on a finer grid. Then, use this difference in prediction accuracy between the table
and the model to determine the most efficient table size for your accuracy requirements.

The following code evaluates the model over a finer grid and plots the difference between
the model and the table.

[tfSpeed, tfLoad] = meshgrid( -..
linspace( 1000, 5500, 8*17+1 ),
linspace( 0.2, 0.8, 8*13+1 ) );

tfBSFC_model = f2( tfSpeed, tflLoad );
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tfBSFC_table = interp2( tSpeed, tLoad, tBSFC, tfSpeed, tfLoad, "“linear” );
tfDiff = tfBSFC_model - tfBSFC_table;

surf( tfSpeed, tfLoad, tfDiff, "LineStyle®, "none” );

hold on

mesh( tSpeed, tLoad, zeros( size( tBSFC ) ), -
“LineStyle®, *"-", "LineWidth", 2, "EdgeColor®, "k",
"FaceColor®, "none®", “FaceAlpha®, 1 );

hold off

axis tight

xlabel ( "Speed [RPM]" );

ylabel ( "Load [%]" );

zlabel ( "Difference between model and table [g/Kwh]" );

title( sprintf( "Max difference: %g", max( abs( tfDiff(z) ) ) ) );

Max difference: 10.039

n
i
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i
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I

-10 -

Difference between model and table [g/Kwh]
=
™

0.6 5000
4000
0.4 3000
2000
Load [D.-"ru] 0.2 1000 SpE"E'd [RPM]
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Create a Table Array Including Breakpoint Values

After creating a table by evaluating a model fit over a grid of points, it can be useful
to export your table data from MATLAB. Before exporting, create a table array that
includes the breakpoint values in the first row and column. The following command
reshapes your data to this table format:

+ X (speedbreakpoints) is a (1 x M) vector
* Y (loadbreakpoints) is an (N x 1) vector
* Z (tBSFC) is an (M x N) matrix
table = [
{"Load\Speed"}, num2cell(speedbreakpoints(:)." )

num2cell (loadbreakpoints (:) ), num2cell( tBSFC )
1:

Export Table to Spreadsheet File

You can use the xIswrite function to export your table data to a new Excel
Spreadsheet. Execute the following command to create a spreadsheet file.

xIswrite( "tabledata.xlsx®, table )
Create a Lookup Table Block

If you have Simulink™ software, you can create a Look Up Table block as follows.
Execute the following code to try it out.

1. Create a model with a 2-D Lookup Table block.

simulink

new_system( "my_model”® )

open_system( "my_model® )

add_block( “Simulink/Lookup Tables/2-D Lookup Table®, "my model/surfaceblock® )

2. Populate the Lookup Table with speed breakpoints, load breakpoints, and a lookup
table.
set_param( "my_model/surfaceblock”®, ...
"BreakpointsForDimensionl®, "loadbreakpoints®,...
"BreakpointsForDimension2®, "speedbreakpoints”,...
"Table®, "tBSFC" );

3. Examine the populated Lookup Table block.
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Filtering and Smoothing Data
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In this section...

“About Data Smoothing and Filtering” on page 6-34
“Moving Average Filtering” on page 6-34
“Savitzky-Golay Filtering” on page 6-36

“Local Regression Smoothing” on page 6-38
“Example: Smoothing Data” on page 6-43

“Example: Smoothing Data Using Loess and Robust Loess” on page 6-45

About Data Smoothing and Filtering

You can use the smooth function to smooth response data. You can use optional methods
for moving average, Savitzky-Golay filters, and local regression with and without weights
and robustness (lowess, loess, rlowess and rloess).

Moving Average Filtering

A moving average filter smooths data by replacing each data point with the average
of the neighboring data points defined within the span. This process is equivalent to
lowpass filtering with the response of the smoothing given by the difference equation

v, (D) = (yi+N)+yG+N-D+..+y@-N))

2N +1

where y,(i) is the smoothed value for the ith data point, N is the number of neighboring
data points on either side of y,(7), and 2N+1 is the span.

The moving average smoothing method used by Curve Fitting Toolbox follows these
rules:

*  The span must be odd.

* The data point to be smoothed must be at the center of the span.

* The span is adjusted for data points that cannot accommodate the specified number of
neighbors on either side.
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* The end points are not smoothed because a span cannot be defined.

Note that you can use Fi lter function to implement difference equations such as the
one shown above. However, because of the way that the end points are treated, the
toolbox moving average result will differ from the result returned by i lter. Refer to
Difference Equations and Filtering (MATLAB) in the MATLAB documentation for more
information.

For example, suppose you smooth data using a moving average filter with a span of 5.
Using the rules described above, the first four elements of y, are given by

ys(D = y(@)

Ys(2) = (y(D)+y(2)+y(3))/3

Ys(3) = (Y(D+y(D)+y(3)+y(H)+y(5))/5
Ys(B) = (Y(@+y(3D)+y(4)+y(5)+y(6))/5

Note that y;(1), ys(2), ... ,ys(end) refer to the order of the data after sorting, and not
necessarily the original order.

The smoothed values and spans for the first four data points of a generated data set are
shown below.
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Mowving Average Smoocthing
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Plot (@) indicates that the first data point is not smoothed because a span cannot be
constructed. Plot (b) indicates that the second data point is smoothed using a span of
three. Plots (¢) and (d) indicate that a span of five is used to calculate the smoothed

value.

Savitzky-Golay Filtering

Savitzky-Golay filtering can be thought of as a generalized moving average. You derive
the filter coefficients by performing an unweighted linear least-squares fit using a
polynomial of a given degree. For this reason, a Savitzky-Golay filter is also called a
digital smoothing polynomial filter or a least-squares smoothing filter. Note that a
higher degree polynomial makes it possible to achieve a high level of smoothing without

attenuation of data features.
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The Savitzky-Golay filtering method is often used with frequency data or with
spectroscopic (peak) data. For frequency data, the method is effective at preserving the
high-frequency components of the signal. For spectroscopic data, the method is effective
at preserving higher moments of the peak such as the line width. By comparison,

the moving average filter tends to filter out a significant portion of the signal's high-
frequency content, and it can only preserve the lower moments of a peak such as the
centroid. However, Savitzky-Golay filtering can be less successful than a moving average
filter at rejecting noise.

The Savitzky-Golay smoothing method used by Curve Fitting Toolbox software follows
these rules:

*  The span must be odd.

* The polynomial degree must be less than the span.

* The data points are not required to have uniform spacing.

Normally, Savitzky-Golay filtering requires uniform spacing of the predictor data.
However, the Curve Fitting Toolbox algorithm supports nonuniform spacing.
Therefore, you are not required to perform an additional filtering step to create data
with uniform spacing.

The plot shown below displays generated Gaussian data and several attempts at

smoothing using the Savitzky-Golay method. The data is very noisy and the peak widths
vary from broad to narrow. The span is equal to 5% of the number of data points.
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Savitzky—Golay Smoothing
&0 T T T T T

- data
— S5-G quadratic |
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— S-Gguartic []
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Plot (&) shows the noisy data. To more easily compare the smoothed results, plots (b)
and (c) show the data without the added noise.

Plot (b) shows the result of smoothing with a quadratic polynomial. Notice that the
method performs poorly for the narrow peaks. Plot (c) shows the result of smoothing
with a quartic polynomial. In general, higher degree polynomials can more accurately
capture the heights and widths of narrow peaks, but can do poorly at smoothing wider
peaks.

Local Regression Smoothing

* “Lowess and Loess” on page 6-39
+  “The Local Regression Method” on page 6-39
+ “Robust Local Regression” on page 6-41
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Lowess and Loess

The names “lowess” and “loess” are derived from the term “locally weighted scatter plot
smooth,” as both methods use locally weighted linear regression to smooth data.

The smoothing process is considered local because, like the moving average method, each
smoothed value is determined by neighboring data points defined within the span. The
process is weighted because a regression weight function is defined for the data points
contained within the span. In addition to the regression weight function, you can use

a robust weight function, which makes the process resistant to outliers. Finally, the
methods are differentiated by the model used in the regression: lowess uses a linear
polynomial, while loess uses a quadratic polynomial.

The local regression smoothing methods used by Curve Fitting Toolbox software follow
these rules:

* The span can be even or odd.

* You can specify the span as a percentage of the total number of data points in the
data set. For example, a span of 0.1 uses 10% of the data points.

The Local Regression Method

The local regression smoothing process follows these steps for each data point:

1 Compute the regression weights for each data point in the span. The weights are
given by the tricube function shown below.

(]

x 1s the predictor value associated with the response value to be smoothed, x; are
the nearest neighbors of x as defined by the span, and d(x) is the distance along the
abscissa from x to the most distant predictor value within the span. The weights
have these characteristics:

X —X;

d(x)

The data point to be smoothed has the largest weight and the most influence on
the fit.

+ Data points outside the span have zero weight and no influence on the fit.
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2 A weighted linear least-squares regression is performed. For lowess, the regression
uses a first degree polynomial. For loess, the regression uses a second degree
polynomial.

3 The smoothed value is given by the weighted regression at the predictor value of
interest.

If the smooth calculation involves the same number of neighboring data points on either
side of the smoothed data point, the weight function is symmetric. However, if the
number of neighboring points is not symmetric about the smoothed data point, then

the weight function is not symmetric. Note that unlike the moving average smoothing
process, the span never changes. For example, when you smooth the data point with the
smallest predictor value, the shape of the weight function is truncated by one half, the
leftmost data point in the span has the largest weight, and all the neighboring points are
to the right of the smoothed value.

The weight function for an end point and for an interior point is shown below for a span
of 31 data points.

Local Regression Weight Function
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Using the lowess method with a span of five, the smoothed values and associated
regressions for the first four data points of a generated data set are shown below.



Filtering and Smoothing Data

Lowess Smoothing
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Notice that the span does not change as the smoothing process progresses from data
point to data point. However, depending on the number of nearest neighbors, the
regression weight function might not be symmetric about the data point to be smoothed.
In particular, plots (@) and (b) use an asymmetric weight function, while plots (¢) and
(d) use a symmetric weight function.

For the loess method, the graphs would look the same except the smoothed value would
be generated by a second-degree polynomial.

Robust Local Regression

If your data contains outliers, the smoothed values can become distorted, and not reflect
the behavior of the bulk of the neighboring data points. To overcome this problem, you
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can smooth the data using a robust procedure that is not influenced by a small fraction of
outliers. For a description of outliers, refer to “Residual Analysis” on page 7-59.

Curve Fitting Toolbox software provides a robust version for both the lowess and loess
smoothing methods. These robust methods include an additional calculation of robust
weights, which is resistant to outliers. The robust smoothing procedure follows these
steps:

1 Calculate the residuals from the smoothing procedure described in the previous
section.

2 Compute the robust weights for each data point in the span. The weights are given
by the bisquare function,

2
(1-(r, /6 MAD))", |ril < 6MAD,
0, |ril > 6MAD,

wi:

where r; is the residual of the ith data point produced by the regression smoothing
procedure, and MAD is the median absolute deviation of the residuals,

MAD = median (Ir).

The median absolute deviation is a measure of how spread out the residuals are. If
r; is small compared to 6 MAD, then the robust weight is close to 1. If r; is greater
than 6MAD, the robust weight is 0 and the associated data point is excluded from
the smooth calculation.

3 Smooth the data again using the robust weights. The final smoothed value is
calculated using both the local regression weight and the robust weight.

4 Repeat the previous two steps for a total of five iterations.
The smoothing results of the lowess procedure are compared below to the results of the

robust lowess procedure for a generated data set that contains a single outlier. The span
for both procedures is 11 data points.
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Plot (a) shows that the outlier influences the smoothed value for several nearest
neighbors. Plot (b) suggests that the residual of the outlier is greater than six median
absolute deviations. Therefore, the robust weight is zero for this data point. Plot (c)
shows that the smoothed values neighboring the outlier reflect the bulk of the data.
Example: Smoothing Data
Load the data in count._dat:

load count.dat

The 24-by-3 array count contains traffic counts at three intersections for each hour of
the day.

First, use a moving average filter with a 5-hour span to smooth all of the data at once (by
linear index) :
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c = smooth(count(:));
Cl1 = reshape(c,24,3);

Plot the original data and the smoothed data:

subplot(3,1,1)
plot(count,”:");

hold on

plot(Cl,"-");

title("Smooth C1 (All Data)*®)

Second, use the same filter to smooth each column of the data separately:

C2 = zeros(24,3);
for 1 = 1:3,

C2(:,1) = smooth(count(:,1));
end

Again, plot the original data and the smoothed data:

subplot(3,1,2)

plot(count,”:");

hold on

plot(C2,"-%);

title("Smooth C2 (Each Column)*®)

Plot the difference between the two smoothed data sets:
subplot(3,1,3)

plot(C2 - C1,%0-7)
title("Difference C2 - C1%)
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smooth C1 (Al Data)
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Note the additional end effects from the 3-column smooth.

Example: Smoothing Data Using Loess and Robust Loess

Create noisy data with outliers:

X = 15*rand(150,1);

y = sin(x) + 0.5*(rand(size(x))-0.5);
y(ceil(length(xX)*rand(2,1))) = 3;

Smooth the data using the loess and rloess methods with a span of 10%:

smooth(x,y,0.1,"loess");
smooth(x,y,0.1,"rloess");

yyl
yy2

Plot original data and the smoothed data.

[xx,ind] = sort(x);

subplot(2,1,1)

plot(xx,y(ind),"b." ,xx,yyl(ind),"r-")

set(gca, "YLIm",[-1.5 3.5])

legend("Original Data-","Smoothed Data Using ""loess™""",_ ..
"Location®, "NW®)

subplot(2,1,2)
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plot(xx,y(ind), "b." ,xx,yy2(ind), "r-7)
set(gca, "YLIm",[-1.5 3.5])

legend("Original Data“,"Smoothed Data Using ""rloess""",...

"Location®, "NW®)

+  Qriginal Data *

3
2 H— Smoothed Data Using 'loess' .
0

+  Qriginal Data *
Smoothed Data Using 'rloess’ .

Note that the outliers have less influence on the robust method.

See Also

smooth

Related Examples

. “Nonparametric Fitting” on page 6-2
. “Smoothing Splines” on page 6-11

. “Lowess Smoothing” on page 6-20
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Fit Postprocessing

+ “Explore and Customize Plots” on page 7-2

+ “Remove Outliers” on page 7-10

+  “Select Validation Data” on page 7-15

+ “Generate Code and Export Fits to the Workspace” on page 7-16
+ “Evaluate a Curve Fit” on page 7-20

+ “Evaluate a Surface Fit” on page 7-32

* “Compare Fits Programmatically” on page 7-41

+  “Evaluating Goodness of Fit” on page 7-54

+ “Residual Analysis” on page 7-59

* “Confidence and Prediction Bounds” on page 7-65

+ “Differentiating and Integrating a Fit” on page 7-72
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Explore and Customize Plots

7-2

In this section...

“Displaying Fit and Residual Plots” on page 7-2
“Viewing Surface Plots and Contour Plots” on page 7-4
“Using Zoom, Pan, Data Cursor, and Outlier Exclusion” on page 7-6

“Customizing the Fit Display” on page 7-6

“Print to MATLAB Figures” on page 7-9

Displaying Fit and Residual Plots

Within each fit figure, you can display up to three plots simultaneously to examine the
fit. Use the toolbar or View menu to select the type of plot to display:

*  Main Plot shows the curve or surface fit.

+ Residuals Plot shows the errors between your fit and your data

+ Contour Plot shows a contour map of a surface fit (not available for curve fits).

The next example shows a main plot with a curve fit and prediction bounds, and the
residuals plot.
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When you select Tools > Prediction Bounds, two additional curves (or surfaces) are
plotted to show the prediction bounds on both sides of your model fit.

Choose which bounds to display: None, 90%, 95%, 99%, or Custom. The custom option
opens a dialog box where you can enter the required confidence level.

See also “Customizing the Fit Display” on page 7-6.
Residuals Plot
On the residuals plot, you can view the errors between your fit and your data, and you

can remove outliers. See “Remove Outliers” on page 7-10. This example shows a
residuals plot with some excluded outliers.
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Viewing Surface Plots and Contour Plots

If you fit a surface, then the main plot shows your surface fit. Click-and-drag rotation or
Rotate 3D is the default mouse mode for surface plots in the Curve Fitting app. Rotate
mode in the Curve Fitting app i1s the same as Rotate 3D in MATLAB figures. You can
change the mouse mode for manipulating plots just as for curve plots. See “Using Zoom,
Pan, Data Cursor, and Outlier Exclusion” on page 7-6.

Tip: To return to rotate mode, turn off any other mouse mode.

If you turn on a mouse mode for zoom, pan, data cursor or exclude outliers, turn the mode
off again to return to rotate mode. For example, click the Zoom in toolbar button a second
time to clear it and return to rotate mode.

If you have a surface fit, use the contour plot to examine a contour map of your surface.
Contour plots are not available for curve fits. On a surface fit, a contour plot makes it
easier to see points that have the same height. An example follows.
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X

For polynomial and custom fits, you also can use the Tools menu to display prediction
bounds. When you display prediction bounds, two additional surfaces are plotted to
show the prediction bounds on both sides of your model fit. The previous example shows
prediction bounds. You can see three surfaces on the plot. The top and bottom surfaces
show the prediction bounds at the specified confidence level on either side of your model
fit surface.

You can also switch your surface plot to a 2-D plot if desired. Your plot cursor must be

in rotate mode. Clear any other mouse mode if necessary. Then, right-click the plot to
select X-Y, X-Z, or Y-Z view, or to select Rotate Options. All these context menu options
are standard MATLAB 3-D plot tools. See “Rotate in 3-D” (MATLAB) in the MATLAB
Graphics documentation.
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Using Zoom, Pan, Data Cursor, and Outlier Exclusion

You can change mouse mode for manipulating plots. Use the toolbar or Tools menu to
switch to Zoom, Pan, Data Cursor, or Exclude Outliers modes.

The Curve Fitting app remembers your selected mouse mode in each fit figure within a
session.

Use the toolbar or Tools menu to toggle mouse mode in your plots:

Zoom In, Zoom Out, Pan, and Data Cursor are standard MATLAB plot tools.

On surfaces, turn all these modes off to return to Rotate 3D mode. For surface plots,
rotation is the default mouse mode in the Curve Fitting app. See “Viewing Surface
Plots and Contour Plots” on page 7-4.

|a
*= __ Data Cursor selects data cursor mode, where you can click points to display
input and output values.

B
*

¥
*x

— Exclude Outliers selects outlier mode, where you can click points to remove
or include in your fit. Exclude outliers is a mouse mode for graphically excluding data
from your fit. See “Remove Outliers” on page 7-10.

Customizing the Fit Display

To customize your plot display, use the toolbar, Tools menu, or the View menu. See also
“Create Multiple Fits in Curve Fitting App” on page 2-14.

Tools Menu and Toolbar

EE

— Legend toggles display of the legend on all plots in the currently selected fit

— Grid toggles display of the grid on all plots in the currently selected fit tab.

Tools > Prediction Bounds lets you choose which bounds to display: None, 90%,
95%, 99%, or Custom. The custom option opens a dialog box where you can enter the
required confidence level.

L2,
ﬂ — Axes Limits opens a dialog box where you can specify upper and lower
bounds for the X- and Y-axes of plots. Click Reset to return to the default axes limits.
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View Menu and Toolbar

Use the View controls to customize the display to show or hide the plots, fit settings,
results and table of fits.

+ Available in the View menu and the toolbar:

e

— Main Plot toggles the display of the main fit plot in the currently selected
fit figure. This item is disabled if only the main plot is displayed.

— Residuals Plot toggles the display of the residuals plot in the currently
selected fit tab. This item is disabled if only the residuals plot is displayed.

— Contour Plot toggles the display of the contour plot in the currently
selected fit tab. This item is disabled if only the contour plot is displayed.

* View > Fit Settings toggles the display of the fit controls pane in the currently
selected fit tab (Fit name, inputs, fit type, and so on).

* View > Fit Results toggles the display of the Results pane in the currently selected
fit tab. When you display the Results pane, you can see model terms and coefficients,
goodness-of-fit statistics, and information messages about the fit.

* View > Table of Fits toggles the display of the Table of Fits pane in the Curve
Fitting app.

Tip: For more space to view and compare plots, as shown next, use the View menu to
hide or show the Fit Settings, Fit Results, or Table of Fits panes.
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See also “Displaying Multiple Fits Simultaneously” on page 2-15.
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Print to MATLAB Figures

In the Curve Fitting app, select File > Print to Figure to produce MATLAB figures
from the results of curve fitting. Print to Figure creates a figure containing all plots for
the current fit. You can then use the interactive plotting tools to edit the figures showing
fitting results for presentation purposes, and export these in different formats.

Related Examples

“Remove Outliers” on page 7-10

“Compare Fits in Curve Fitting App” on page 2-21

“Create Multiple Fits in Curve Fitting App” on page 2-14
“Generate Code and Export Fits to the Workspace” on page 7-16

“Compare Fits Programmatically” on page 7-41
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Remove Outliers

In this section...

“Remove Outliers Interactively” on page 7-10

“Exclude Data Ranges” on page 7-10

“Remove Outliers Programmatically” on page 7-11

Remove Ouitliers Interactively
To remove outliers in the Curve Fitting app, follow these steps:

1 e
Select Tools > Exclude Outliers or click the toolbar button =~ *

When you move the mouse cursor to the plot, it changes to a cross-hair to show you
are in outlier selection mode.

2 Click a point that you want to exclude in the main plot or residuals plot.
Alternatively, click and drag to define a rectangle and remove all enclosed points.

A removed plot point becomes a red cross in the plots. If you have Auto-fit selected,
the Curve Fitting app refits the surface without the point. Otherwise, you can click
Fit to refit.

3 Repeat for all points you want to exclude.

When removing outliers from surface fits, it can be helpful to display a 2-D residuals plot
for examining and removing outliers. With your plot cursor in rotation mode, right-click
the plot to select X-Y, X-Z, or Y-Z view.

To replace individual excluded points in the fit, click an excluded point again in Exclude
Outliers mode. To replace all excluded points in the fit, right-click and select Clear all
exclusions.

In surface plots, to return to rotation mode, click the Exclude outliers toolbar button

x+

e again to turn off outlier selection mode.

Exclude Data Ranges

To exclude sections of data by range in the Curve Fitting app, follow these steps:
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Select Tools > Exclude By Rule.

2 Specify data to exclude. Enter numbers in any of the boxes to define beginning or
ending intervals to exclude in the X, Y, or Z data.

3 Press Enter to apply the exclusion rule.

Curve Fitting app displays shaded pink areas on the plots to show excluded ranges.
Excluded points become red.

Remove Outliers Programmatically

This example shows how to remove outliers when curve fitting programmatically, using
the 'Exclude' name/value pair argument with the fit or fitoptions functions. You can plot
excluded data by supplying an Exclude or outliers argument with the plot function.

Exclude Data Using a Simple Rule

For a simple example, load data and fit a Gaussian, excluding some data with an
expression, then plot the fit, data and the excluded points.

[x, y]l = titanium;

fl = fit(xX",y", "gauss2", "Exclude®, x<800);
plot(fl,x,y,x<800)
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Exclude Data by Distance from the Model

It can be useful to exclude outliers by distance from the model, using standard
deviations. The following example shows how to identify outliers using distance greater
than 1.5 standard deviations from the model, and compares with a robust fit which gives
lower weight to outliers.

Create a baseline sinusoidal signal:

xdata = (0:0.1:2*pi)";
y0 = sin(xdata);

Add noise to the signal with non-constant variance:
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% Response-dependent Gaussian noise
ghoise = yO.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));

ydata = y0 + gnoise + spnoise;
Fit the noisy data with a baseline sinusoidal model:

f = Fittype("a*sin(b*x)");
fitl = fit(xdata,ydata,f, "StartPoint”,[1 1]);

Identify "outliers" as points at a distance greater than 1.5 standard deviations from the
baseline model, and refit the data with the outliers excluded:

fdata = feval (Fitl,xdata);
1 = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata, "indices”,1);

fit2 = fit(xdata,ydata,f, "StartPoint”,[1 1],---
"Exclude” ,outliers);

Compare the effect of excluding the outliers with the effect of giving them lower bisquare
weight in a robust fit:

fit3 = fit(xdata,ydata,f,"StartPoint”,[1 1], "Robust®,"on");
Plot the data, the outliers, and the results of the fits:

plot(fitl, "r-",xdata,ydata, "k.",outliers, "m*")

hold on

plot(fit2,"c--")

plot(fit3,"b:")
xim([0 2*pi])
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See Also

excludedata | Fit

Related Examples

. “Explore and Customize Plots” on page 7-2
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Select Validation Data

To specify validation data for the currently selected fit, follow these steps:

1 Select Fit > Specify Validation Data. The Specify Validation Data dialog box
opens.

2 Select variables for X data and Y data (and Z data for surfaces).

When you select two or three variables, depending on whether your fit data is for

a curve or a surface, the tool calculates validation statistics (SSE and RMSE) and
displays them in the Results pane and the Table of Fits. For definitions of these
statistics, see “Using the Statistics in the Table of Fits” on page 2-18. Your validation
data points display on the main plot and residual plot along with the original data.

3 Close the dialog box.
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Generate Code and Export Fits to the Workspace

In this section...

“Generating Code from the Curve Fitting App” on page 7-16
“Exporting a Fit to the Workspace” on page 7-17

Generating Code from the Curve Fitting App

You can generate and use MATLAB code from an interactive session in the Curve Fitting
app. In this way, you can transform your interactive analysis into reusable functions

for batch processing of multiple data sets. You can use the generated file without
modification, or you can edit and customize the file as needed.

To generate code for all fits and plots in your Curve Fitting app session follow these
steps:

1 Select File > Generate Code.

The Curve Fitting app generates code from your session and displays the file in the
MATLAB Editor. The file includes all fits and plots in your current session. The file
captures the following information:
+  Names of fits and their variables

Fit settings and options
+ Plots

+  Curve and surface fitting objects and methods used to create the fits:

* A cell-array of cFit or sFit objects representing the fits
+ A structure array with goodness-of fit information.
2 Save the file.

To recreate your fits and plots, call the file from the command line with your original
data as input arguments. You also can call the file with new data.

For example, enter:

[fitresult, gof] = myFileName(a, b, c)
where a, b, and ¢ are your variable names, and myFileName is the file name.
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Calling the file from the command line does not recreate your Curve Fitting app and
session. When you call the file, you get the same plots you had in your Curve Fitting

app session in standard MATLAB figure windows. There is one window for each fit. For
example, if your fit in the Curve Fitting app session displayed main, residual and contour
plots, all three plots appear in a single figure window.

Curve Fitting Functions

The curve and surface fit objects (CFit and sFTit) store the results from a fitting
operation, making it easy to plot and analyze fits at the command line.

To learn about available functions for working with fits, see “Curve and Surface Fitting”
on page 3-2.

Exporting a Fit to the Workspace

To export a fit to the MATLAB workspace, follow these steps:

1  Select a fit and save it to the MATLAB workspace using one of these methods:

* Right-click the fit listed in the Table of Fits and select Save myfitname to
Workspace

Select a fit figure in the Curve Fitting app and select Fit > Save to Workspace.
The Save Fit to MATLAB Workspace dialog box opens.

o -

Save Fit to MATLAB Workspace E'@

[V] Save fit to MATLAB object named: fittedmode]

-

|i.-' Save goodness of fit to MATLAB struct named: goodness

=n

|¥| Save fit output to MATLAB struct named: output

Ok l Cancel ]

2 Edit the names as appropriate. If you previously exported fits, the toolbox
automatically adds a numbered suffix to the default names so there is no danger of
overwriting them.
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3 Choose which options you want to export by selecting the check boxes. Check box
options are as follows:

Save fit to MATLAB object named fittedmodel — This option creates a
cfitor sTitobject, that encapsulates the result of fitting a curve or surface to
data. You can examine the fit coefficients at the command line, for example:

fittedmodel
Linear model Poly22:
fittedmodell(x,y) = p00 + plO0*x + pOl*y + p20*x"2...
+ pll*x*y + p02*y~2
Coefficients (with 95% confidence bounds):

po0 = 302.1 (247.3, 356.8)

p10 = -1395 (-1751, -1039)

pol = 0.03525 (0.01899, 0.05151)

p20 = 1696 (1099, 2293)

pll = ~0.1119 (-0.1624, -0.06134)

p02 = 2.36e-006 (-8.72e-007, 5.593e-006)

You also can treat the cFit or sFit object as a function to make predictions or
evaluate the fit at values of X (or X and Y). See the cFit and sFit reference

page.
+ Save goodness of fit to MATLAB struct named goodness — This option
creates a structure array that contains statistical information about the fit, for

example:
goodness =
sse: 0.0234
rsquare: 0.9369
dfe: 128
adjrsquare: 0.9345
rmse: 0.0135

+ Save fit output to MATLAB struct named output — This option creates a
structure array that contains information such as numbers of observations and
parameters, residuals, and so on. For example:

output =
numobs: 134
numparam: 6
residuals: [134x1 double]
Jacobian: [134x6 double]
exitflag: 1
algorithm: "QR factorization and solve®
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iterations: 1

Note: Goodness of fit and Output arrays are outputs of the Fit function. See
the Fit reference page.

4 Click OK to save the fit options to the workspace.

After you save your fit to the workspace, you can use fit postprocessing functions. For
an example, see “Analyzing Your Best Fit in the Workspace” on page 2-31. For more
information and a list of functions, see “Fit Postprocessing”.

Related Examples
. “Evaluate a Curve Fit” on page 7-20

“Evaluate a Surface Fit” on page 7-32
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Evaluate a Curve Fit

This example shows how to work with a curve fit.

Load Data and Fit a Polynomial Curve

load census
curvefit = fit(cdate,pop, "poly3~, "normalize”,"on")

curvefit =

Linear model Poly3:
curvefit(x) = pl*x"3 + p2*x™2 + p3*x + p4

where x 1s normalized by mean 1890 and std 62.05
Coefficients (with 95% confidence bounds):

pl = 0.921 (-0.9743, 2.816)
p2 = 25.18 (23.57, 26.79)
p3 = 73.86 (70.33, 77.39)
p4 = 61.74 (59.69, 63.8)

The output displays the fitted model equation, the fitted coefficients, and the confidence
bounds for the fitted coefficients.

Plot the Fit, Data, Residuals, and Prediction Bounds

plot(curvefit,cdate,pop)
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Plot the residuals fit.

plot(curvefit,cdate,pop, "Residuals™)
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[+ T T T T

*+ data
zero line

-8
1750 1800 1850 1900 1950 2000

X

Plot the prediction bounds on the fit.

plot(curvefit,cdate,pop, "predfunc™)
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Evaluate the Fit at a Specified Point

Evaluate the fit at a specific point by specifying a value for X , using this form:y =
fittedmodel (X).

curvefit(1991)

ans =

252.6690
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Evaluate the Fit Values at Many Points

Evaluate the model at a vector of values to extrapolate to the year 2050.

xi = (2000:10:2050).";
curvefit(xi)

ans =

276.9632
305.4420
335.5066
367.1802
400.4859
435.4468

Get prediction bounds on those values.

ci predint(curvefit,xi)

267.8589 286.0674
294 _3070 316.5770
321.5924 349.4208
349.7275 384.6329
378.7255 422.2462
408.5919 462.3017

Plot the fit and prediction intervals across the extrapolated fit range. By default, the
fit is plotted over the range of the data. To see values extrapolated from the fit, set the
upper x-limit of the axes to 2050 before plotting the fit. To plot prediction intervals, use
predobs or predfun as the plot type.

plot(cdate,pop,“0")
x1im([1900,2050])

hold on

plot(curvefit, "predobs”)
hold off
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Get the Model Equation

Enter the fit name to display the model equation, the fitted coefficients, and the
confidence bounds for the fitted coefficients.

curvefit

curvefit =
Linear model Poly3:

curvefit(xX) = pl*x"3 + p2*x™2 + p3*x + p4
where x is normalized by mean 1890 and std 62.05
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Coefficients (with 95% confidence bounds):

pl = 0.921 (-0.9743, 2.816)
p2 = 25.18 (23.57, 26.79)
p3 = 73.86 (70.33, 77.39)
p4 = 61.74 (59.69, 63.8)

To get only the model equation, use formula.

formula(curvefit)

ans =

"PI*FXA3 + p2*xXN2 + p3*Fx + p4”

Get Coefficient Names and Values

Specify a coefficient by name.

curvefit.pl
curvefit.p2

pl
p2

pl

0.9210

p2 =

25.1834

Get all the coefficient names. Look at the fit equation (for example, F(x) =
pl*x~3+. .. ) to see the model terms for each coefficient.

coeffnames(curvefit)

ans =

4x1 cell array
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“p1°
“p2°
“p3*
“pa-

Get all the coefficient values.

coeffvalues(curvefit)

ans =

0.9210 25.1834 73.8598 61.7444

Get Confidence Bounds on the Coefficients

Use confidence bounds on coefficients to help you evaluate and compare fits. The
confidence bounds on the coefficients determine their accuracy. Bounds that are far
apart indicate uncertainty. If the bounds cross zero for linear coefficients, this means
you cannot be sure that these coefficients differ from zero. If some model terms have
coefficients of zero, then they are not helping with the fit.

confint(curvefit)

ans =
-0.9743 23.5736 70.3308 59.6907
2.8163 26.7931 77 .3888 63.7981
Examine Goodness-of-Fit Statistics

To get goodness-of-fit statistics at the command line, you can either:

*  Open Curve Fitting app and select Fit > Save to Workspace to export your fit and
goodness of fit to the workspace.

*  Specify the gof output argument using the it function.

Recreate the fit specifying the gof and output arguments to get goodness-of-fit statistics
and fitting algorithm information.
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[curvefit,gof,output] = fit(cdate,pop, "poly3”,"normalize”,"on")

curvefit =

Linear model Poly3:
curvefit(xX) = pl*x"3 + p2*x™2 + p3*x + p4

where x is normalized by mean 1890 and std 62.05
Coefficients (with 95% confidence bounds):

pl = 0.921 (-0.9743, 2.816)
p2 = 25.18 (23.57, 26.79)
p3 = 73.86 (70.33, 77.39)
p4 = 61.74 (59.69, 63.8)

struct with fields:

sse: 149.7687
rsquare: 0.9988
dfe: 17
adjrsquare: 0.9986

rmse: 2.9682

output =
struct with fields:
numobs: 21
numparam: 4
residuals: [21x1 double]
Jacobian: [21x4 double]
exitflag: 1

algorithm: "QR factorization and solve*
iterations: 1

Plot a histogram of the residuals to look for a roughly normal distribution.

histogram(output._residuals,10)
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Plot the Fit, Data, and Residuals

plot(curvefit,cdate,pop, "fit", "residuals™)
legend Location SouthWest

subplot(2,1,1)

legend Location NorthWest
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Find Methods
List every method that you can use with the fit.
methods(curvefit)
Methods for class cfit:
argnames confint formula numcoeffs setoptions
category dependnames indepnames plot type
cfit differentiate iIntegrate predint
coeffnames feval islinear probnames
coeffvalues fitoptions numargs probvalues
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Use the help command to find out how to use a fit method.
help cfit/differentiate

DIFFERENTIATE Differentiate a fit result object.
DERIV1 = DIFFERENTIATE(FITOBJ,X) differentiates the model FITOBJ at the
points specified by X and returns the result in DERIV1. FITOBJ is a Fit
object generated by the FIT or CFIT function. X is a vector. DERIV1 is
a vector with the same size as X. Mathematically speaking, DERIV1 =
D(FITOBJ)/D(X).
[DERIV1,DERIV2] = DIFFERENTIATE(FITOBJ, X) computes the first and
second derivatives, DERIV1 and DERIV2 respectively, of the model
FITOBJ.

See also CFIT/INTEGRATE, FIT, CFIT.
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Evaluate a Surface Fit

This example shows how to work with a surface fit.

Load Data and Fit a Polynomial Surface

load franke;
surffit = fit([x,y],z, "poly23", "normalize®,"on")

Linear model Poly23:
surffit(x,y) = p00 + plO0*x + pOl*y + p20*x"2 + pll*x*y + p02*y"2 + p2l*x/"2*y
+ pl2*x*y"2 + p03*y~3
where x is normalized by mean 1982 and std 868.6
and where y is normalized by mean 0.4972 and std 0.2897
Coefficients (with 95% confidence bounds):

po0 = 0.4253 (0.3928, 0.4578)

pl0 = ~0.106 (-0.1322, -0.07974)
pol = ~0.4299 (-0.4775, -0.3822)
p20 = 0.02104 (0.001457, 0.04062)
pll = 0.07153 (0.05409, 0.08898)
p02 =  -0.03084 (-0.05039, -0.01129)
p21 = 0.02091 (0.001372, 0.04044)
pl2 = -0.0321 (-0.05164, -0.01255)
po3 = 0.1216 (0.09929, 0.1439)

The output displays the fitted model equation, the fitted coefficients, and the confidence
bounds for the fitted coefficients.

Plot the Fit, Data, Residuals, and Prediction Bounds

plot(surffit, [x,y],2)
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1.5 ~

Plot the residuals fit.

plot(surffit,[x,y],z, Style”, "Residuals®)

7-33



7 Fit Postprocessing

0.2

0.4

Plot prediction bounds on the fit.

plot(surffit,[x,y],z,"Style", "predfunc™)
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1.5 ~

Evaluate the Fit at a Specified Point

Evaluate the fit at a specific point by specifying a value for x and y , using this form: z =
fittedmodel (x,y).

surffit(1000,0.5)

ans =

0.5673
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Evaluate the Fit Values at Many Points

X1 [500;1000;1200];
yi [0.7;0.6;0.5];
surffit(xi,yi)

ans =
0.3771

0.4064
0.5331

Get prediction bounds on those values.

[ci, zi] = predint(surffit,[xi,yi])

ci =
0.0713 0.6829
0.1058 0.7069
0.2333 0.8330
zi =
0.3771
0.4064
0.5331

Get the Model Equation

Enter the fit name to display the model equation, fitted coefficients, and confidence
bounds for the fitted coefficients.

surffit
Linear model Poly23:
surffit(x,y) = p00 + plO*x + pOl*y + p20*x"2 + pll*x*y + p02*y"2 + p2l*x"2*y

+ pl2*x*y"2 + p03*y"3
where x is normalized by mean 1982 and std 868.6
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and where y is normalized by mean 0.4972 and std 0.2897
Coefficients (with 95% confidence bounds):

po0 = 0.4253 (0.3928, 0.4578)

p10 = ~0.106 (-0.1322, -0.07974)
pol = -0.4299 (-0.4775, -0.3822)
p20 = 0.02104 (0.001457, 0.04062)
pll = 0.07153 (0.05409, 0.08898)
p02 =  -0.03084 (-0.05039, -0.01129)
p21 = 0.02091 (0.001372, 0.04044)
pl2 = -0.0321 (-0.05164, -0.01255)
po3 = 0.1216 (0.09929, 0.1439)

To get only the model equation, use formula.

formula(surffit)

ans =

"pO0 + plO*x + pOl*y + p20*x"2 + pll*x*y + p02*y"2 + p21l*x"2*y + pl2*x*y~2 + pO3*y’

Get Coefficient Names and Values

Specify a coefficient by name.

p00
p03

surffit.p00
surffit.p03

p00

0.4253

p03 =
0.1216
Get all the coefficient names. Look at the fit equation (for example, F(x,y) = p00 +

pl0*x. . .) to see the model terms for each coefficient.

coeffnames(surffit)
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ans =
9x1 cell array

00"
“p10*
“po1*
“p20°
“p11°
“p02*
“p21°
“p12°
“p03*

Get all the coefficient values.

coeffvalues(surffit)

ans =
Columns 1 through 7
0.4253 -0.1060 -0.4299 0.0210 0.0715 -0.0308 0.0209
Columns 8 through 9

-0.0321 0.1216

Get Confidence Bounds on the Coefficients

Use confidence bounds on coefficients to help you evaluate and compare fits. The
confidence bounds on the coefficients determine their accuracy. Bounds that are far
apart indicate uncertainty. If the bounds cross zero for linear coefficients, this means
you cannot be sure that these coefficients differ from zero. If some model terms have
coefficients of zero, then they are not helping with the fit.

confint(surffit)

ans =



Evaluate a Surface Fit

Columns 1 through 7

0.3928 -0.1322 -0.4775 0.0015 0.0541 -0.0504 0.0014
0.4578 -0.0797 -0.3822 0.0406 0.0890 -0.0113 0.0404

Columns 8 through 9

-0.0516 0.0993
-0.0126 0.1439

Find Methods

List every method that you can use with the fit.

methods(surffit)

Methods for class sfit:

argnames dependnames indepnames predint sfit
category differentiate islinear probnames type
coeffnames feval numargs probvalues
coeffvalues fitoptions numcoeffs quad2d

confint formula plot setoptions

Use the help command to find out how to use a fit method.

help sfit/quad2d

QUAD2D Numerically integrate a surface fit object.
Q = QUAD2D(FO, A, B, C, D) approximates the integral of the surface fit
object FO over the planar region A <= x <= B and C(x) <=y <= D(x). C and D
may each be a scalar, a function handle or a curve fit (CFIT) object.

[Q,ERRBND] = QUAD2D(...) also returns an approximate upper bound on the
absolute error, ERRBND.

[Q,ERRBND] = QUAD2D(FUN,A,B,C,D,PARAM1,VAL1,PARAM2,VAL2,...) performs
the integration with specified values of optional parameters.

See QUAD2D for details of the upper bound and the optional parameters.

See also: QUAD2D, FIT, SFIT, CFIT.
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Compare Fits Programmatically

This example shows how to fit and compare polynomials up to sixth degree using
Curve Fitting Toolbox, fitting some census data. It also shows how to fit a single-term
exponential equation and compare this to the polynomial models.

The steps show how to:

+ Load data and create fits using different library models.

Search for the best fit by comparing graphical fit results, and by comparing numerical
fit results including the fitted coefficients and goodness of fit statistics.

Load and Plot the Data

The data for this example is the file census.mat.

load census

The workspace contains two new variables:

* cdate 1s a column vector containing the years 1790 to 1990 in 10-year increments.

* pop is a column vector with the U.S. population figures that correspond to the years in
cdate .

whos cdate pop
plot(cdate,pop,“0")

Name Size Bytes Class Attributes
cdate 21x1 168 double
pop 21x1 168 double
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Create and Plot a Quadratic

Use the fit function to fit a a polynomial to data. You specify a quadratic, or second-
degree polynomial, with the string 'poly2'. The first output from fit is the polynomial, and
the second output, gof, contains the goodness of fit statistics you will examine in a later
step.

[population2,gof] = fit(cdate,pop, "poly27);
To plot the fit, use the plot method.
plot(population2,cdate,pop);

% Move the legend to the top left corner.
legend("Location®, "NorthWest");
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Create and Plot a Selection of Polynomials

To fit polynomials of different degrees, change the fittype string, e.g., for a cubic or third-
degree polynomial use 'poly3'. The scale of the input, cdate, is quite large, so you can
obtain better results by centering and scaling the data. To do this, use the 'Normalize'
option.

population3 = fit(cdate,pop, “poly3", *Normalize®,"on");
populationd4 = fit(cdate,pop, “poly4®, "Normalize®,"on");
population5 = fit(cdate,pop, “poly5”, *Normalize®,"on");
population6 = fit(cdate,pop, “poly6”, "Normalize®,"on");

A simple model for population growth tells us that an exponential equation should fit this
census data well. To fit a single term exponential model, use 'exp1' as the fittype.
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populationExp = Fit(cdate,pop, "expl);
Plot all the fits at once, and add a meaningful legend in the top left corner of the plot.

hold on

plot(population3, "b");

plot(population4,®g");

plot(population5,"m®);

plot(population6, "b--");

plot(populationExp, "r--");

hold off

legend("cdate v pop®,"poly2®,"poly3", "poly4*,“poly5","poly6”, "expl™, ...
"Location®, "NorthWest");
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Plot the Residuals to Evaluate the Fit

To plot residuals, specify 'residuals' as the plot type in the plot method.

plot(population2,cdate,pop, “"residuals®);

B . . ; .

*+ data

zero line

1750 1800 1850 1200 1950 2000
X

The fits and residuals for the polynomial equations are all similar, making it difficult to
choose the best one. If the residuals display a systematic pattern, it is a clear sign that
the model fits the data poorly.

plot(populationExp,cdate,pop, "residuals®);
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The fit and residuals for the single-term exponential equation indicate it is a poor fit
overall. Therefore, it is a poor choice and you can remove the exponential fit from the
candidates for best fit.

Examine Fits Beyond the Data Range

Examine the behavior of the fits up to the year 2050. The goal of fitting the census data
is to extrapolate the best fit to predict future population values. By default, the fit is
plotted over the range of the data. To plot a fit over a different range, set the x-limits of
the axes before plotting the fit. For example, to see values extrapolated from the fit, set
the upper x-limit to 2050.

plot(cdate,pop,“0");
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x1im([1900, 20501);
hold on

plot(population6);
hold off
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Examine the plot. The behavior of the sixth-degree polynomial fit beyond the data range
makes it a poor choice for extrapolation and you can reject this fit.

Plot Prediction Intervals
2050:

To plot prediction intervals, use 'predobs' or 'predfun' as the plot type. For example, to
see the prediction bounds for the fifth-degree polynomial for a new observation up to year

7-47



7 Fit Postprocessing

plot(cdate,pop,“0”);
x1im([1900, 2050])

hold on

plot(population5, "predobs®);
hold off
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Plot prediction intervals for the cubic polynomial up to year 2050.

plot(cdate,pop,“0”);
x1im([1900, 2050])

hold on

plot(population3, "predobs*®)
hold off
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Examine Goodness-of-Fit Statistics

The struct gof shows the goodness-of-fit statistics for the 'poly2' fit. When you created the
'poly2' fit with the fit function in an earlier step, you specified the gof output argument.

gof

gof =
struct with fields:

sse: 159.0293
rsquare: 0.9987
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dfe: 18
adjrsquare: 0.9986
rmse: 2.9724

Examine the sum of squares due to error (SSE) and the adjusted R-square statistics to
help determine the best fit. The SSE statistic is the least-squares error of the fit, with a
value closer to zero indicating a better fit. The adjusted R-square statistic is generally the
best indicator of the fit quality when you add additional coefficients to your model.

The large SSE for 'expl' indicates it is a poor fit, which you already determined by
examining the fit and residuals. The lowest SSE value is associated with "poly6'.
However, the behavior of this fit beyond the data range makes it a poor choice for
extrapolation, so you already rejected this fit by examining the plots with new axis limits.

The next best SSE value is associated with the fifth-degree polynomial fit, 'poly5’,
suggesting it might be the best fit. However, the SSE and adjusted R-square values for
the remaining polynomial fits are all very close to each other. Which one should you
choose?

Compare the Coefficients and Confidence Bounds to Determine the Best Fit

Resolve the best fit issue by examining the coefficients and confidence bounds for the
remaining fits: the fifth-degree polynomial and the quadratic.

Examine population2 and population5 by displaying the models, the fitted coefficients,
and the confidence bounds for the fitted coefficients:

population2

population5

population2 =

Linear model Poly2:
population2(x) = pl*x"2 + p2*x + p3
Coefficients (with 95% confidence bounds):

pl = 0.006541 (0.006124, 0.006958)

p2 = -23.51 (-25.09, -21.93)

p3 = 2.113e+04 (1.964e+04, 2.262e+04)
population5 =
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Linear model Poly5:

population5(x) = pl1*x"5 + p2*x™M + p3*X"3 + p4*x™2 + p5*x + p6
where x is normalized by mean 1890 and std 62.05

Coefficients (with 95% confidence bounds):

pl = 0.5877 (-2.305, 3.48)
p2 = 0.7047 (-1.684, 3.094)
p3 = ~0.9193 (-10.19, 8.356)
p4 = 23.47 (17.42, 29.52)
p5 = 74.97 (68.37, 81.57)
p6 = 62.23 (59.51, 64.95)

You can also get the confidence intervals by using confint.

Cl

confint(populationb)

-2.3046 -1.6841 -10.1943 17.4213 68.3655 59.5102
3.4801 3.0936 8.3558 29.5199 81.5696 64.9469

The confidence bounds on the coefficients determine their accuracy. Check the fit
equations (e.g. f(x)=p1*x+p2*x...) to see the model terms for each coefficient. Note that
p2 refers to the p2*x term in 'poly2' and the p2*x”~4 term in 'poly5'. Do not compare
normalized coefficients directly with non-normalized coefficients.

The bounds cross zero on the pl, p2, and p3 coefficients for the fifth-degree polynomial.
This means you cannot be sure that these coefficients differ from zero. If the higher
order model terms may have coefficients of zero, they are not helping with the fit, which
suggests that this model over fits the census data.

The fitted coefficients associated with the constant, linear, and quadratic terms are
nearly identical for each normalized polynomial equation. However, as the polynomial
degree increases, the coefficient bounds associated with the higher degree terms cross
zero, which suggests over fitting.

However, the small confidence bounds do not cross zero on p1, p2, and p3 for the
quadratic fit, indicating that the fitted coefficients are known fairly accurately.

Therefore, after examining both the graphical and numerical fit results, you should select
the quadratic population2 as the best fit to extrapolate the census data.
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Evaluate the Best Fit at New Query Points

Now you have selected the best fit, population2, for extrapolating this census data,
evaluate the fit for some new query points.

cdateFuture = (2000:10:2020).";
popFuture = population2(cdateFuture)

popFuture =

274.6221
301.8240
330.3341

To compute 95% confidence bounds on the prediction for the population in the future, use
the predint method:

(o] |

predint(population2,cdateFuture,0.95, "observation®)

266.9185 282.3257
293.5673 310.0807
321.3979 339.2702

Plot the predicted future population, with confidence intervals, against the fit and data.

plot(cdate,pop,“0”);

x1im([1900, 2040]1)

hold on

plot(population2)

h = errorbar(cdateFuture,popFuture,popFuture-ci(:,1),ci(:,2)-popFuture,”.");
hold off

legend("cdate v pop®,"poly2","prediction”, "Location”, *"NorthWest")



Compare Fits Programmatically

400 T T T T T T
O cdate v pop
i paly2
350 I prediction
300
250 -
200
150
-0
..f-*g
100 _,DI”QJ 7
&
ED 1 1 1 1 1 i
1900 1920 1940 19680 1980 2000 2020 2040

7-53



7 Fit Postprocessing

Evaluating Goodness of Fit

7-54

In this section...

“How to Evaluate Goodness of Fit” on page 7-54

“Goodness-of-Fit Statistics” on page 7-55

How to Evaluate Goodness of Fit

After fitting data with one or more models, you should evaluate the goodness of fit. A
visual examination of the fitted curve displayed in Curve Fitting app should be your first
step. Beyond that, the toolbox provides these methods to assess goodness of fit for both
linear and nonlinear parametric fits:

*  “Goodness-of-Fit Statistics” on page 7-55

+ “Residual Analysis” on page 7-59
+ “Confidence and Prediction Bounds” on page 7-65

As is common in statistical literature, the term goodness of fit is used here in several
senses: A “good fit” might be a model

+ that your data could reasonably have come from, given the assumptions of least-
squares fitting

* in which the model coefficients can be estimated with little uncertainty

+ that explains a high proportion of the variability in your data, and is able to predict
new observations with high certainty

A particular application might dictate still other aspects of model fitting that are
important to achieving a good fit, such as a simple model that is easy to interpret. The
methods described here can help you determine goodness of fit in all these senses.

These methods group into two types: graphical and numerical. Plotting residuals and
prediction bounds are graphical methods that aid visual interpretation, while computing
goodness-of-fit statistics and coefficient confidence bounds yield numerical measures that
aid statistical reasoning.

Generally speaking, graphical measures are more beneficial than numerical measures
because they allow you to view the entire data set at once, and they can easily display a




Evaluating Goodness of Fit

wide range of relationships between the model and the data. The numerical measures
are more narrowly focused on a particular aspect of the data and often try to compress
that information into a single number. In practice, depending on your data and analysis
requirements, you might need to use both types to determine the best fit.

Note that it is possible that none of your fits can be considered suitable for your

data, based on these methods. In this case, it might be that you need to select a

different model. It is also possible that all the goodness-of-fit measures indicate that a
particular fit is suitable. However, if your goal is to extract fitted coefficients that have
physical meaning, but your model does not reflect the physics of the data, the resulting
coefficients are useless. In this case, understanding what your data represents and how it
was measured is just as important as evaluating the goodness of fit.

Goodness-of-Fit Statistics

After using graphical methods to evaluate the goodness of fit, you should examine the
goodness-of-fit statistics. Curve Fitting Toolbox software supports these goodness-of-fit
statistics for parametric models:

* The sum of squares due to error (SSE)

+ R-square

* Adjusted R-square

* Root mean squared error (RMSE)

For the current fit, these statistics are displayed in the Results pane in the Curve
Fitting app. For all fits in the current curve-fitting session, you can compare the
goodness-of-fit statistics in the Table of fits.

To get goodness-of-fit statistics at the command line, either:

* In Curve Fitting app, select Fit > Save to Workspace to export your fit and
goodness of fit to the workspace.

+  Specify the goT output argument with the fit function.
Sum of Squares Due to Error
This statistic measures the total deviation of the response values from the fit to the

response values. It is also called the summed square of residuals and is usually labeled
as SSE.
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n
SSE =7 w; (y;~ 3 y
i

A value closer to 0 indicates that the model has a smaller random error component, and
that the fit will be more useful for prediction.

R-Square

This statistic measures how successful the fit is in explaining the variation of the data.
Put another way, R-square is the square of the correlation between the response values
and the predicted response values. It is also called the square of the multiple correlation
coefficient and the coefficient of multiple determination.

R-square is defined as the ratio of the sum of squares of the regression (SSR) and the
total sum of squares (SST). SSR is defined as

n
~ —\2
SSR=Y w,(5; )
=1
SST'is also called the sum of squares about the mean, and is defined as

n
SST = Zwl (yl _5)2
i=1

where SST = SSR + SSE. Given these definitions, R-square is expressed as

SSR SSE
R-square=——=1-——

SST SST
R-square can take on any value between 0 and 1, with a value closer to 1 indicating that
a greater proportion of variance is accounted for by the model. For example, an R-square
value of 0.8234 means that the fit explains 82.34% of the total variation in the data about
the average.

If you increase the number of fitted coefficients in your model, R-square will increase
although the fit may not improve in a practical sense. To avoid this situation, you should
use the degrees of freedom adjusted R-square statistic described below.



Evaluating Goodness of Fit

Note that it is possible to get a negative R-square for equations that do not contain a
constant term. Because R-square is defined as the proportion of variance explained by
the fit, if the fit is actually worse than just fitting a horizontal line then R-square is
negative. In this case, R-square cannot be interpreted as the square of a correlation. Such
situations indicate that a constant term should be added to the model.

Degrees of Freedom Adjusted R-Square

This statistic uses the R-square statistic defined above, and adjusts it based on the
residual degrees of freedom. The residual degrees of freedom is defined as the number of
response values n minus the number of fitted coefficients m estimated from the response
values.

v=n-m

v indicates the number of independent pieces of information involving the n data points
that are required to calculate the sum of squares. Note that if parameters are bounded
and one or more of the estimates are at their bounds, then those estimates are regarded
as fixed. The degrees of freedom is increased by the number of such parameters.

The adjusted R-square statistic is generally the best indicator of the fit quality when

you compare two models that are nested — that is, a series of models each of which adds
additional coefficients to the previous model.

SSE(n-1)

adjusted R-square =1—
SST(v)

The adjusted R-square statistic can take on any value less than or equal to 1, with
a value closer to 1 indicating a better fit. Negative values can occur when the model
contains terms that do not help to predict the response.

Root Mean Squared Error

This statistic is also known as the fit standard error and the standard error of the

regression. It is an estimate of the standard deviation of the random component in the
data, and is defined as

RMSE =s =~ MSE

where MSE is the mean square error or the residual mean square

7-57



7 Fit Postprocessing

SSE
v

MSE =

Just as with SSE, an MSE value closer to 0 indicates a fit that is more useful for
prediction.

See Also
fit

Related Examples

“Generate Code and Export Fits to the Workspace” on page 7-16
. “Evaluate a Curve Fit” on page 7-20

“Evaluate a Surface Fit” on page 7-32
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Residual Analysis

Plotting and Analysing Residuals

The residuals from a fitted model are defined as the differences between the response
data and the fit to the response data at each predictor value.

residual = data — fit

You display the residuals in Curve Fitting app by selecting the toolbar button or menu
item View > Residuals Plot.

Mathematically, the residual for a specific predictor value is the difference between the
response value y and the predicted response value 3.

r=y-y

Assuming the model you fit to the data is correct, the residuals approximate the random
errors. Therefore, if the residuals appear to behave randomly, it suggests that the model
fits the data well. However, if the residuals display a systematic pattern, it is a clear
sign that the model fits the data poorly. Always bear in mind that many results of
model fitting, such as confidence bounds, will be invalid should the model be grossly
inappropriate for the data.

A graphical display of the residuals for a first degree polynomial fit is shown below. The
top plot shows that the residuals are calculated as the vertical distance from the data
point to the fitted curve. The bottom plot displays the residuals relative to the fit, which
is the zero line.
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The residuals appear randomly scattered around zero indicating that the model describes
the data well.

A graphical display of the residuals for a second-degree polynomial fit is shown below.
The model includes only the quadratic term, and does not include a linear or constant
term.



Residual Analysis
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The residuals are systematically positive for much of the data range indicating that this
model is a poor fit for the data.

Example: Residual Analysis

This example fits several polynomial models to generated data and evaluates how well
those models fit the data and how precisely they can predict. The data is generated from
a cubic curve, and there is a large gap in the range of the x variable where no data exist.

X = [1:0.1:3 9:0.1:10]";
c = [2.5 -0.5 1.3 -0.1];
y = c(l) + c(@Q*x + c(3)*Xx."2 + c(4)*x."3 + (rand(size(x))-0.5);

Fit the data in the Curve Fitting app using a cubic polynomial and a fifth degree
polynomial. The data, fits, and residuals are shown below. Display the residuals in the
Curve Fitting app by selecting View > Residuals Plot.
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Both models appear to fit the data well, and the residuals appear to be randomly
distributed around zero. Therefore, a graphical evaluation of the fits does not reveal any
obvious differences between the two equations.

Look at the numerical fit results in the Results pane and compare the confidence bounds
for the coefficients.

The results show that the cubic fit coefficients are accurately known (bounds are small),
while the quintic fit coefficients are not accurately known. As expected, the fit results
for poly3 are reasonable because the generated data follows a cubic curve. The 95%
confidence bounds on the fitted coefficients indicate that they are acceptably precise.
However, the 95% confidence bounds for poly5 indicate that the fitted coefficients are
not known precisely.

The goodness-of-fit statistics are shown in the Table of Fits. By default, the adjusted
R-square and RMSE statistics are displayed in the table. The statistics do not reveal a
substantial difference between the two equations. To choose statistics to display or hide,
right-click the column headers.



Residual Analysis

The 95% nonsimultaneous prediction bounds for new observations are shown below. To
display prediction bounds in the Curve Fitting app, select Tools > Prediction Bounds

> 95%.
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The prediction bounds for poly3 indicate that new observations can be predicted with

a small uncertainty throughout the entire data range. This is not the case for poly5. It
has wider prediction bounds in the area where no data exist, apparently because the data
does not contain enough information to estimate the higher degree polynomial terms
accurately. In other words, a fifth-degree polynomial overfits the data.

The 95% prediction bounds for the fitted function using poly5 are shown below. As
you can see, the uncertainty in predicting the function is large in the center of the data.
Therefore, you would conclude that more data must be collected before you can make
precise predictions using a fifth-degree polynomial.

In conclusion, you should examine all available goodness-of-fit measures before deciding
on the fit that is best for your purposes. A graphical examination of the fit and residuals
should always be your initial approach. However, some fit characteristics are revealed
only through numerical fit results, statistics, and prediction bounds.



Confidence and Prediction Bounds

Confidence and Prediction Bounds

In this section...
“About Confidence and Prediction Bounds” on page 7-65

“Confidence Bounds on Coefficients” on page 7-66

“Prediction Bounds on Fits” on page 7-66

“Compute Prediction Intervals” on page 7-69

About Confidence and Prediction Bounds

Curve Fitting Toolbox software lets you calculate confidence bounds for the fitted
coefficients, and prediction bounds for new observations or for the fitted function.
Additionally, for prediction bounds, you can calculate simultaneous bounds, which take
into account all predictor values, or you can calculate nonsimultaneous bounds, which
take into account only individual predictor values. The coefficient confidence bounds are
presented numerically, while the prediction bounds are displayed graphically and are
also available numerically.

The available confidence and prediction bounds are summarized below.

Types of Confidence and Prediction Bounds

Interval Type Description

Fitted coefficients Confidence bounds for the fitted coefficients

New observation Prediction bounds for a new observation (response value)
New function Prediction bounds for a new function value

Note Prediction bounds are also often described as confidence bounds because you are
calculating a confidence interval for a predicted response.

Confidence and prediction bounds define the lower and upper values of the associated
interval, and define the width of the interval. The width of the interval indicates how
uncertain you are about the fitted coefficients, the predicted observation, or the predicted
fit. For example, a very wide interval for the fitted coefficients can indicate that you
should use more data when fitting before you can say anything very definite about the
coefficients.
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The bounds are defined with a level of certainty that you specify. The level of certainty is
often 95%, but it can be any value such as 90%, 99%, 99.9%, and so on. For example, you
might want to take a 5% chance of being incorrect about predicting a new observation.
Therefore, you would calculate a 95% prediction interval. This interval indicates that you
have a 95% chance that the new observation is actually contained within the lower and
upper prediction bounds.

Confidence Bounds on Coefficients

The confidence bounds for fitted coefficients are given by
C=b+tJS

where b are the coefficients produced by the fit, ¢ depends on the confidence level, and
is computed using the inverse of Student's ¢ cumulative distribution function, and S is a
vector of the diagonal elements from the estimated covariance matrix of the coefficient

estimates, (XTX)_ISZ. In a linear fit, X is the design matrix, while for a nonlinear fit X is
the Jacobian of the fitted values with respect to the coefficients. X” is the transpose of X,
and s” is the mean squared error.

The confidence bounds are displayed in the Results pane in the Curve Fitting app using
the following format.

pl = 1.275 (1.113, 1.437)

The fitted value for the coefficient p1l is 1.275, the lower bound is 1.113, the upper bound
is 1.437, and the interval width is 0.324. By default, the confidence level for the bounds is
95%.

You can calculate confidence intervals at the command line with the confint function.

Prediction Bounds on Fits

As mentioned previously, you can calculate prediction bounds for the fitted curve.

The prediction is based on an existing fit to the data. Additionally, the bounds can

be simultaneous and measure the confidence for all predictor values, or they can be
nonsimultaneous and measure the confidence only for a single predetermined predictor
value. If you are predicting a new observation, nonsimultaneous bounds measure the
confidence that the new observation lies within the interval given a single predictor
value. Simultaneous bounds measure the confidence that a new observation lies within
the interval regardless of the predictor value.



Confidence and Prediction Bounds

Bound Type Observation Functional

Simultaneous

yif\/s2 +xSxT yt f\/xSxT
Nonsimultaneous

yit\/s2 +xSxT yit\/xSxT

Where:

s”is the mean squared error

* t depends on the confidence level, and is computed using the inverse of Student's ¢
cumulative distribution function

+ fdepends on the confidence level, and is computed using the inverse of the F
cumulative distribution function.

S is the covariance matrix of the coefficient estimates, (X'X) s,

* x1s a row vector of the design matrix or Jacobian evaluated at a specified predictor
value.

You can graphically display prediction bounds using Curve Fitting app. With Curve
Fitting app, you can display nonsimultaneous prediction bounds for new observations
with Tools > Prediction Bounds. By default, the confidence level for the bounds

1s 95%. You can change this level to any value with Tools > Prediction Bounds >
Custom.

You can display numerical prediction bounds of any type at the command line with the
predint function.

To understand the quantities associated with each type of prediction interval, recall that
the data, fit, and residuals are related through the formula

data = fit + residuals
where the fit and residuals terms are estimates of terms in the formula
data = model + random error

Suppose you plan to take a new observation at the predictor value x,.;. Call the new
observation y,+1(x,+1) and the associated error £,+;. Then

Yn1(Xn1) = f(Xnr1) + €11
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where f(x,+1) 1s the true but unknown function you want to estimate at x,+1. The likely
values for the new observation or for the estimated function are provided by the
nonsimultaneous prediction bounds.

If instead you want the likely value of the new observation to be associated with any
predictor value, the previous equation becomes

Ynr1 () = f(x) + &

The likely values for this new observation or for the estimated function are provided by
the simultaneous prediction bounds.

The types of prediction bounds are summarized below.

Types of Prediction Bounds

7-68

Type of Bound Simultaneous or Non- Associated Equation
simultaneous

Observation Non-simultaneous Vor1(Xn+1)
Simultaneous Ynr1(x), for all x

Function Non-simultaneous f(x,41)
Simultaneous f(x), for all x

The nonsimultaneous and simultaneous prediction bounds for a new observation and
the fitted function are shown below. Each graph contains three curves: the fit, the lower
confidence bounds, and the upper confidence bounds. The fit is a single-term exponential
to generated data and the bounds reflect a 95% confidence level. Note that the intervals
associated with a new observation are wider than the fitted function intervals because
of the additional uncertainty in predicting a new response value (the curve plus random
errors).



Confidence and Prediction Bounds

Monsimultaneous observation bounds Simultaneous observation bounds
3 3
- +  data . - +  data
L fitted curve | ¢ = fitted curve

X ¥
Monsimultaneous functional bounds Simultaneous functional bounds
25 25
\} . . data + . data
2 N fitted curve |{ 207 fitted curve |4

Compute Prediction Intervals
Compute and plot observation and functional prediction intervals for a fit to noisy data.

Generate noisy data with an exponential trend.

X
y

(0:0.2:5)";
2*exp(-0.2*x) + 0.5*randn(size(x));

Fit a curve to the data using a single-term exponential.

Ffitresult = fit(x,y, "expl”);
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Compute 95% observation and functional prediction intervals, both simultaneous and
nonsimultaneous.

pll = predint(fitresult,x,0.95, "observation”, "off");
pl2 = predint(fitresult,x,0.95, "observation”, on");
p21 = predint(fitresult,x,0.95, "functional”, "off");
p22 = predint(fitresult,x,0.95, "functional”,"on");

Plot the data, fit, and prediction intervals. Note that the observation bounds are wider
than the functional bounds.

subplot(2,2,1)

plot(fitresult,x,y), hold on, plot(x,pll,“m--"), xblim([0 5]), ylim([-1 5])
title("Nonsimultaneous Observation Bounds®, "FontSize*",9)

legend off

subplot(2,2,2)

plot(fitresult,x,y), hold on, plot(x,pl2,"m--"), xblim([0 5]), ylim([-1 5])
title("Simultaneous Observation Bounds®, "FontSize*®,9)

legend off

subplot(2,2,3)

plot(fitresult,x,y), hold on, plot(x,p21, m--"), xblim([0 5]), ylim([-1 5])
title("Nonsimultaneous Functional Bounds®,"FontSize®,9)

legend off

subplot(2,2,4)
plot(fitresult,x,y), hold on, plot(x,p22,"m--"), xblim([0 5]), ylim([-1 5])
title("Simultaneous Functional Bounds®, "FontSize®",9)
legend({"Data", "Fitted curve®, "Prediction intervals®},...
"FontSize",8, "Location”, "northeast”)
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Differentiating and Integrating a Fit

This example shows how to find the first and second derivatives of a fit, and the integral
of the fit, at the predictor values.

Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)";
y0 = sin(xdata);

Add noise to the signal:

noise
ydata

2*y0._*randn(size(y0)); % Response-dependent noise
y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = Fittype("a*sin(b*x)");
fitl = fit(xdata,ydata,f, "StartPoint”,[1 1]);

Find the derivatives of the fit at the predictors:

[d1,d2] = differentiate(fitl,xdata);

Plot the data, the fit, and the derivatives:

subplot(3,1,1)

plot(fitl,xdata,ydata) % cfit plot method
subplot(3,1,2)

plot(xdata,dl,"m") % double plot method
grid on

legend("1st derivative®)

subplot(3,1,3)

plot(xdata,d2,"c") % double plot method
grid on

legend("2nd derivative®)
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Note that derivatives can also be computed and plotted directly with the cfit plot method,
as follows. The plot method, however, does not return data on the derivatives.

plot(fitl,xdata,ydata,{"fit", "derivl”, "deriv2"})
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Find the integral of the fit at the predictors:
int = integrate(fitl,xdata,0);

Plot the data, the fit, and the integral:

subplot(2,1,1)

plot(fitl,xdata,ydata) % cfit plot method
subplot(2,1,2)

plot(xdata,int,"m") % double plot method
grid on

legend("integral ™)
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Note that integrals can also be computed and plotted directly with the cfit plot method,
as follows. The plot method, however, does not return data on the integral.

plot(fitl,xdata,ydata,{"fit", "integral"})
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“Introducing Spline Fitting” on page 8-2
“Curve Fitting Toolbox Splines and MATLAB Splines” on page 8-4
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Introducing Spline Fitting
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In this section...

“About Splines in Curve Fitting Toolbox” on page 8-2
“Spline Overview” on page 8-3

“Interactive Spline Fitting” on page 8-3

“Programmatic Spline Fitting” on page 8-3

About Splines in Curve Fitting Toolbox
You can work with splines in Curve Fitting Toolbox in several ways.

Using the Curve Fitting app or the it function you can:

+ Fit cubic spline interpolants to curves or surfaces

+  Fit smoothing splines and shape-preserving cubic spline interpolants to curves (but
not surfaces)

+ Fit thin-plate splines to surfaces (but not curves)

The toolbox also contains specific splines functions to allow greater control over what you
can create. For example, you can use the csapi function for cubic spline interpolation.
Why would you use csapi instead of the Fit function "cubicinterp” option? You
might require greater flexibility to work with splines for the following reasons:

* You want to combine the results with other splines, e.g., by addition.

* You want vector-valued splines. You can use csapi with scalars, vectors, matrices,
and ND-arrays. The Fit function only allows scalar-valued splines.

*  You want other types of splines such as ppform, B-form, tensor-product, rational, and
stform thin-plate splines.

* You want to create splines without data.
* You want to specify breaks, optimize knot placement, and use specialized functions

for spline manipulation such as differentiation and integration.

If you require specialized spline functions, see the following sections for an overview of
splines, and interactive and programmatic spline fitting.
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Spline Overview

The Curve Fitting Toolbox spline functions are a collection of tools for creating,
viewing, and analyzing spline approximations of data. Splines are smooth piecewise
polynomials that can be used to represent functions over large intervals, where it would
be impractical to use a single approximating polynomial.

The spline functionality includes a graphical user interface (GUI) that provides easy
access to functions for creating, visualizing, and manipulating splines. The toolbox also
contains functions that enable you to evaluate, plot, combine, differentiate, and integrate
splines. Because all toolbox functions are implemented in the open MATLAB language,
you can inspect the algorithms, modify the source code, and create your own custom
functions.

Key spline features:
+  GUIs that let you create, view, and manipulate splines and manage and compare

spline approximations

*  Functions for advanced spline operations, including differentiation, integration,
break/knot manipulation, and optimal knot placement

*  Support for piecewise polynomial form (ppform) and basis form (B-form) splines
* Support for tensor-product splines and rational splines (including NURBS)

Interactive Spline Fitting
You can access all spline functions from the splinetool GUI. You can use the GUI to:

* Vary spline parameters and tolerances

+  View and modify data, breaks, knots, and weights

*  View the error of the spline, or the spline's first or second derivative

* Observe the toolbox commands that generated your spline

*  Create and import data, including built-in instructive data sets, and save splines to
the workspace

See splinetool.

Programmatic Spline Fitting

To programmatically fit splines, see “Construction” for descriptions of types of splines
and numerous examples.
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In this section...

“Curve Fitting Toolbox Splines” on page 8-4
“MATLAB Splines” on page 8-5

“Expected Background” on page 8-6

“Vector Data Type Support” on page 8-6

“Spline Function Naming Conventions” on page 8-7

“Arguments for Curve Fitting Toolbox Spline Functions” on page 8-8

“Acknowledgments” on page 8-8

Curve Fitting Toolbox Splines

Curve Fitting Toolbox spline functions contain versions of the essential MATLAB
programs of the B-spline package (extended to handle also vector-valued splines) as
described in A Practical Guide to Splines, (Applied Math. Sciences Vol. 27, Springer
Verlag, New York (1978), xxiv + 392p; revised edition (2001), xviii+346p), hereafter
referred to as PGS. The toolbox makes it easy to create and work with piecewise-
polynomial functions.

The typical use envisioned for this toolbox involves the construction and subsequent use
of a piecewise-polynomial approximation. This construction would involve data fitting,
but there is a wide range of possible data that could be fit. In the simplest situation, one
1s given points (f1,y1) and is looking for a piecewise-polynomial function f that satisfies
f(t1) = y1, all i, more or less. An exact fit would involve interpolation, an approximate fit
might involve least-squares approximation or the smoothing spline. But the function to be
approximated may also be described in more implicit ways, for example as the solution
of a differential or integral equation. In such a case, the data would be of the form (Af)
(t1), with A some differential or integral operator. On the other hand, one might want to
construct a spline curve whose exact location is less important than is its overall shape.
Finally, in all of this, one might be looking for functions of more than one variable, such
as tensor product splines.

Care has been taken to make this work as painless and intuitive as possible. In
particular, the user need not worry about just how splines are constructed or stored
for later use, nor need the casual user worry about such items as “breaks” or “knots” or
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“coefficients”. It is enough to know that each function constructed is just another variable
that is freely usable as input (where appropriate) to many of the commands, including

all commands beginning with fn, which stands for function. At times, it may be also
useful to know that, internal to the toolbox, splines are stored in different forms, with the
command fn2fm available to convert between forms.

At present, the toolbox supports two major forms for the representation of piecewise-
polynomial functions, because each has been found to be superior to the other in certain
common situations. The B-form is particularly useful during the construction of a spline,
while the ppform is more efficient when the piecewise-polynomial function is to be
evaluated extensively. These two forms are almost exactly the B-representation and the
pp representation used in A Practical Guide to Splines.

But, over the years, the Curve Fitting Toolbox spline functions have gone beyond the
programs in A Practical Guide to Splines. The toolbox now supports the “scattered
translates' form, or stform, in order to handle the construction and use of bivariate thin-
plate splines, and also two ways to represent rational splines, the rBform and the rpform,
in order to handle NURBS.

Splines can be very effective for data fitting because the linear systems to be solved for
this are banded, hence the work needed for their solution, done properly, grows only
linearly with the number of data points. In particular, the MATLAB sparse matrix
facilities are used in the Curve Fitting Toolbox spline functions when that is more
efficient than the toolbox's own equation solver, slvblk, which relies on the fact that
some of the linear systems here are even almost block diagonal.

All polynomial spline construction commands are equipped to produce bivariate (or
even multivariate) piecewise-polynomial functions as tensor products of the univariate
functions used here, and the various fn. .. commands also work for these multivariate
functions.

There are various examples, all accessible through the Help browser. You are strongly
urged to have a look at some of them, or at the GUI splinetool, to help you work with
splines.

MATLAB Splines

The MATLAB technical computing environment provides spline approximation via the
command spline. If called in the form cs = spline(X,Y), it returns the ppform of
the cubic spline with break sequence X that takes the value y(1) at x(i), all i, and
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satisfies the not-a-knot end condition. In other words, the command cs = spline(X,y)
gives the same result as the command cs = csapi(X,y) available in the Curve Fitting
Toolbox spline functions. But only the latter also works when X,y describe multivariate
gridded data. In MATLAB, cubic spline interpolation to multivariate gridded data is
provided by the command interpn(x1,...,xd,v,yl,...,yd,"spline”) which
returns values of the interpolating tensor product cubic spline at the grid specified by
yl,..yd.

Further, any of the Curve Fitting Toolbox spline fn. .. commands can be applied to
the output of the MATLAB spline(X,y) command, with simple versions of the Curve
Fitting Toolbox spline commands fnval, ppmak, fnbrk available directly in MATLAB,
as the commands ppval, mkpp, unmkpp, respectively.

Expected Background

The Curve Fitting Toolbox spline functions started out as an extension of the MATLAB
environment of interest to experts in spline approximation, to aid them in the
construction and testing of new methods of spline approximation. Such people will have
mastered the material in A Practical Guide to Splines.

However, the basic commands for constructing and using spline approximations are set
up to be usable with no more knowledge than it takes to understand what it means to,
say, construct an interpolant or a least squares approximant to some data, or what it
means to differentiate or integrate a function.

With that in mind, there are sections, like “Cubic Spline Interpolation” on page 9-2,

that are meant even for the novice, while sections devoted to a detailed example, like the
one on constructing a Chebyshev spline or on constructing and using tensor products, are
meant for users interested in developing their own spline commands.

“Glossary” provides definitions of almost all the mathematical terms used in the splines
documentation.

Vector Data Type Support

The Curve Fitting Toolbox spline functions can handle vector-valued splines, i.e., splines
whose values lie in R®. Since MATLAB started out with just one variable type, that of
a matrix, there is even now some uncertainty about how to deal with vectors, i.e., lists
of numbers. MATLAB sometimes stores such a list in a matrix with just one row, and
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other times in a matrix with just one column. In the first instance, such a I-row matrix

is called a row-vector; in the second instance, such a I-column matrix is called a column-
vector. Either way, these are merely different ways for storing vectors, not different kinds
of vectors.

In this toolbox, vectors, i.e., lists of numbers, may also end up stored in a 1-row matrix or
in a 1-column matrix, but with the following agreements.

A point in RY, i.e., a d-vector, is always stored as a column vector. In particular, if you
want to supply an n-list of d-vectors to one of the commands, you are expected to provide
that list as the n columns of a matrix of size [d,n].

While other lists of numbers (e.g., a knot sequence or a break sequence) may be stored

internally as row vectors, you may supply such lists as you please, as a row vector or a
column vector.

Spline Function Naming Conventions

Most of the spline commands in this toolbox have names that follow one of the following
patterns:

CS. .. commands construct cubic splines (in ppform)
Sp- - - commands construct splines in B-form

fn. .. commands operate on spline functions
..2... commands convert something

. .api commands construct an approximation by interpolation

- .aps commands construct an approximation by smoothing

- .ap2 commands construct a least-squares approximation

- . .knt commands construct (part of) a particular knot sequence

. . .dem commands are examples.

Note See the “Glossary” for information about notation.
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Arguments for Curve Fitting Toolbox Spline Functions

For ease of use, most Curve Fitting Toolbox spline functions have default arguments.

In the reference entry under Syntax, we usually first list the function with all necessary
input arguments and then with all possible input arguments. When there is more than
one optional argument, then, sometimes, but not always, their exact order is immaterial.
When their order does matter, you have to specify every optional argument preceding
the one(s) you are interested in. In this situation, you can specify the default value for an
optional argument by using [] (the empty matrix) as the input for it. The description in
the reference page tells you the default value for each optional input argument.

As in MATLAB, only the output arguments explicitly specified are returned to the user.
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* “Cubic Spline Interpolation” on page 9-2
* “Vector-Valued Functions” on page 9-11
+  “Fitting Values at N-D Grid with Tensor-Product Splines” on page 9-14

+  “Fitting Values at Scattered 2-D Sites with Thin-Plate Smoothing Splines” on page
9-16

+  “Postprocessing Splines” on page 9-18
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Cubic Spline Interpolation
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In this section...

“Cubic Spline Interpolant of Smooth Data” on page 9-2
“Periodic Data” on page 9-3

“Other End Conditions” on page 9-4

“General Spline Interpolation” on page 9-4

“Knot Choices” on page 9-6

“Smoothing” on page 9-7

“Least Squares” on page 9-10

Cubic Spline Interpolant of Smooth Data

Suppose you want to interpolate some smooth data, e.g., to
rng(6), x = (4*pi)*[0 1 rand(1,15)]; vy = sin(X);

You can use the cubic spline interpolant obtained by

cs = csapi(Xx,y);

and plot the spline, along with the data, with the following code:
fnplt(cs);

hold on

plot(x,y,"0")
legend("cubic spline”, "data")
hold off

This produces a figure like the following.
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Cubic Spline Interpolant of Smooth Data

This is, more precisely, the cubic spline interpolant with the not-a-knot end conditions,
meaning that it is the unique piecewise cubic polynomial with two continuous derivatives
with breaks at all interior data sites except for the leftmost and the rightmost one. It is
the same interpolant as produced by the MATLAB spline command, spline(X,y).

Periodic Data

The sine function is 2m-periodic. To check how well your interpolant does on that score,
compute, e.g., the difference in the value of its first derivative at the two endpoints,

diff(fnval (fnder(cs),[0 4*pil))
ans = -.0100

which is not so good. If you prefer to get an interpolant whose first and second
derivatives at the two endpoints, O and 4*pi, match, use instead the command csape
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which permits specification of many different kinds of end conditions, including periodic
end conditions. So, use instead

pcs = csape(X,y, "periodic™);
for which you get

diff(fnval (fnder(pcs),[0 4*pi]))

Output is ans = 0 as the difference of end slopes. Even the difference in end second
derivatives is small:

diff(fnval (fnder(pcs,2),[0 4*pi]))

Output is ans = -4.6074e-015.

Other End Conditions

Other end conditions can be handled as well. For example,

cs = csape(X,[3.Y.-41.[1 2D);

provides the cubic spline interpolant with breaks at the =) and with its slope at the
leftmost data site equal to 3, and its second derivative at the rightmost data site equal to
-4,

General Spline Interpolation

If you want to interpolate at sites other than the breaks and/or by splines other than
cubic splines with simple knots, then you use the spapi command. In its simplest form,
you would say sp = spapi(Kk,X,y); in which the first argument, k, specifies the order
of the interpolating spline; this is the number of coefficients in each polynomial piece, i.e.,
1 more than the nominal degree of its polynomial pieces. For example, the next figure
shows a linear, a quadratic, and a quartic spline interpolant to your data, as obtained by
the statements

sp2 = spapi(2,x,y); fnplt(sp2,2), hold on
sp3 = spapi(3,x,y); fnplt(sp3,2,k--"),
sp5 = spapi(5,x,y); fnplt(sp5,2,"r-."), plot(x,y,"0o")

legend("linear”, "quadratic®, "quartic®,“"data®), hold off
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Spline Interpolants of Various Orders of Smooth Data

Even the cubic spline interpolant obtained from spapi is different from the one provided
by csapi and spline. To emphasize their difference, compute and plot their second
derivatives, as follows:

fnplt(fnder(spapi(4,x,y),2)), hold on,
fnplt(fnder(csapi(x,y),2),2,"k--"),plot(x,zeros(size(x)),"0")
legend("from spapi”, "from csapi”, "data sites"), hold off

This gives the following graph:

9-5
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Second Derivative of Two Cubic Spline Interpolants of the Same Smooth Data

Since the second derivative of a cubic spline is a broken line, with vertices at the breaks
of the spline, you can see clearly that csapi places breaks at the data sites, while spapi
does not.

Knot Choices

It is, in fact, possible to specify explicitly just where the spline interpolant should have
its breaks, using the command sp = spapi(knots,X,y); in which the sequence knots
supplies, in a certain way, the breaks to be used. For example, recalling that you had
chosen y to be sin(x), the command

ch = spapi(augknt(x,4,2),[x x],Ly cos()]);
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provides a cubic Hermite interpolant to the sine function, namely the piecewise cubic
function, with breaks at all the x(i)'s, that matches the sine function in value and slope
at all the x(1)'s. This makes the interpolant continuous with continuous first derivative
but, in general, it has jumps across the breaks in its second derivative. Just how does
this command know which part of the data value array [y cos(x)] supplies the values
and which the slopes? Notice that the data site array here is given as [Xx x], i.e., each
data site appears twice. Also notice that y(1) is associated with the first occurrence of
x (1), and cos(x(1)) is associated with the second occurrence of X(1). The data value
associated with the first appearance of a data site is taken to be a function value; the
data value associated with the second appearance is taken to be a slope. If there were a
third appearance of that data site, the corresponding data value would be taken as the
second derivative value to be matched at that site. See “Constructing and Working with
B-form Splines” on page 10-21 for a discussion of the command augknt used here to
generate the appropriate "knot sequence".

Smoothing
What if the data are noisy? For example, suppose that the given values are
noisy = y + .3*(rand(size(x))-.5);

Then you might prefer to approximate instead. For example, you might try the cubic
smoothing spline, obtained by the command

scs = csaps(x,noisy);
and plotted by

fnplt(scs,2), hold on, plot(x,noisy,"0"),
legend("smoothing spline”, "noisy data"), hold off

This produces a figure like this:
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Cubic Smoothing Spline of Noisy Data

If you don't like the level of smoothing done by csaps(x,y), you can change it

by specifying the smoothing parameter, p, as an optional third argument. Choose

this number anywhere between 0 and 1. As p changes from O to 1, the smoothing
spline changes, correspondingly, from one extreme, the least squares straight-line
approximation to the data, to the other extreme, the "natural" cubic spline interpolant
to the data. Since csaps returns the smoothing parameter actually used as an optional
second output, you could now experiment, as follows:

[scs,p] = csaps(x,noisy); fnplt(scs,2), hold on
fnplt(csaps(x,noisy,p’/2),2,"k--"),

fnplt(csaps(x,noisy, (1+p)/2),2,"r:"), plot(x,noisy,"0")
legend("smoothing spline”,"more smoothed”, "less smoothed”, ...
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"noisy data"), hold off

This produces the following picture.
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Noisy Data More or Less Smoothed

At times, you might prefer simply to get the smoothest cubic spline sp that is
within a specified tolerance tol of the given data in the sense that norm(noisy
- fnval(sp,x))”2 <= tol. You create this spline with the command sp =
spaps(x,noisy,tol) for your defined tolerance tol.
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Least Squares

If you prefer a least squares approximant, you can obtain it by the statement sp =
spap2(knots,k,X,y); in which both the knot sequence knots and the order k of the
spline must be provided.

The popular choice for the order is 4, and that gives you a cubic spline. If you have no
clear idea of how to choose the knots, simply specify the number of polynomial pieces you
want used. For example,

sp = spap2(3,4,X,Y);

gives a cubic spline consisting of three polynomial pieces. If the resulting error is uneven,
you might try for a better knot distribution by using newknt as follows:

sp = spap2(newknt(sp),4,X,y);
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Vector-Valued Functions

The toolbox supports vector-valued splines. For example, if you want a spline curve

through given planar points (=i} »(E)). i =1, ....n then the following code defines some
data and then creates and plots such a spline curve, using chord-length parametrization
and cubic spline interpolation with the not-a-knot end condition.

x=[19 43 62 88 114 120 130 129 113 76 135 182 232 298 ...

348 386 420 456 471 485 463 444 414 348 275 192 106 ...

30 48 83 107 110 109 92 66 45 23 22 30 40 55 55 52 34 20 16];
y=[306 272 240 215 218 237 275 310 368 424 425 427 428 ...

397 353 302 259 200 148 105 77 47 28 17 10 12 23 41 43 ...

77 96 133 155 164 157 148 142 162 181 187 192 202 217 245 266 303];

xy = [x;yl; df = diff(xy,1,2);

t = cumsum([0, sqrt([1 1]*(dF.*dF))]);

cv = csapi(t,xy);

fnplt(cv), hold on, plot(x,y,"0"), hold off

9-11
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If you then wanted to know the area enclosed by this curve, you would want to evaluate

the integralj y(#)dx(t) = .[ ¥ (#)Dx(#)de , with [X{£).¥(£)) the point on the curve
corresponding to the parameter value £. For the spline curve in CcV just constructed, this
can be done exactly in one (somewhat complicated) command:

area = diff(fnval(fnint( ...
fnecmb(fnemb(cv, [0 11),"*",Ffnder(fncmb(cv, [1 01))) ---
). fnbrk(cv, "interval *)));

To explain, y=Fncmb(cv, [0 1]) picks out the second component of the curve

in cv, Dx=Fnder(fncmb(cv, [1 0])) provides the derivative of the first

component, and yDx=Fncmb(y, "*",Dx) constructs their pointwise product.

Then lyDx=Fnint(yDx) constructs the indefinite integral of yDx and, finally,
diff(fnval (1yDx, fnbrk(cv, "interval "))) evaluates that indefinite integral at
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the endpoints of the basic interval and then takes the difference of the second from the
first value, thus getting the definite integral of yDX over its basic interval. Depending
on whether the enclosed area is to the right or to the left as the curve point travels with
increasing parameter, the resulting number is either positive or negative.

Further, all the values Y (if any) for which the point (X,Y) lies on the spline curve in cv
just constructed can be obtained by the following (somewhat complicated) command:

X=250; %Define a value of X
Y = fnval(fncmb(cv,[0 11), --.
mean(fnzeros(fncmb(fncmb(cv,[1 0]),"-",X))))

To explain: x = fncmb(cv, [1 0]) picks out the first component of the curve in cv;
xmX = fncmb(X, "-",X) translates that component by X; t = mean(fnzeros(xmX))
provides all the parameter values for which xmX is zero, i.e., for which the first
component of the curve equals X; y = fncmb(cv, [0,1]) picks out the second
component of the curve in cv; and, finally, Y = fnval (y,t) evaluates that second
component at those parameter sites at which the first component of the curve in cv
equals X.

As another example of the use of vector-valued functions, suppose that you have
solved the equations of motion of a particle in some specified force field in the plane,

obtaining, at discrete times tp=tly).J= 1”1, the position (x(2;).p(2 )

(2(£;).5(2;))

as well as the

velocity stored in the 4-vector z(:+/), as you would if, in the standard way,
you had solved the equivalent first-order system numerically. Then the following
statement, which uses cubic Hermite interpolation, will produce a plot of the particle
path:fnplt(spapi (augknt(t,4,2),t,reshape(z,2,2*n))).

9-13
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Fitting Values at N-D Grid with Tensor-Product Splines

Vector-valued splines are also used in the approximation to gridded data, in any number
of variables, using tensor-product splines. The same spline-construction commands are
used, only the form of the input differs. For example, if X is an m-vector, Yy is an n-vector,
and z is an array of size [m,n], then cs = csapi({X,Y},z); describes a bicubic spline
f satisfying f(x(i),y(j))=z(i,j) for i=1:m, j=1:n. Such a multivariate spline can be vector-
valued. For example,

X = 0:4; y=-2:2; s2 = 1/sqrt(2);

z(3,:,:) =[01s20 -s2 -10]."*[11111];
z(2,:,:) =[10s21s20 -1]-"*[0 1 0 -1 0];
z(1,:,:) =[10s21s20 -1]-"*[1 0 -1 0 1];

sph = csape({x,y},z,{"clamped”, "periodic"});
fnplt(sph), axis equal, axis off

gives a perfectly acceptable sphere. Its projection onto the [X.Z)-plane is plotted by

fnplt(fncmb(sph,[1 0 0; 0 0 1])), axis equal, axis off

Both plots are shown below.

A Sphere Made by a 3-D-Valued Bivariate Tensor Product Spline

9-14
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Planar Projection of Spline Sphere

9-15
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Fitting Values at Scattered 2-D Sites with Thin-Plate Smoothing
Splines

9-16

Tensor-product splines are good for gridded (bivariate and even multivariate) data. For
work with scattered bivariate data, the toolbox provides the thin-plate smoothing spline.
Suppose you have given data values y(J) at scattered data sites X(:,j), J=1:N, in the
plane. To give a specific example,

n
X

65; t = linspace(0,2*pi,n+1);
[cos(t);sin(t)]; x(:,end) = [0;0];

provides 65 sites, namely 64 points equally spaced on the unit circle, plus the center of
that circle. Here are corresponding data values, namely noisy values of the very nice
function £x) = (x(1y+ 1/ 22 + (x(2)+ 1/ 22

xX(1,:)+.5)."2 + (xX(2,:)+.5)."2;
sy = y + (rand(size(y))-.5)/3;

y =
noi
Then you can compute a reasonable approximation to these data by
st = tpaps(X,noisy);

and plot the resulting approximation along with the noisy data by
fnplt(st); hold on

plot3(x(1,:),x(2,:),noisy, "wo", "markerfacecolor”, "k")
hold off

and so produce the following picture:
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Postprocessing Splines

9-18

You can use the following commands with any example spline, such as the cs, ch and sp
examples constructed in the section “Cubic Spline Interpolation” on page 9-2.

First construct a spline, for example:

sp = spmak(1:6,0:2)

To display a plot of the spline:

fnplt(sp)

To get the value at a, use the syntax fnval (¥, a), for example:
fnval (sp,4)

To construct the spline's second derivative:

DDf = fnder(fnder(sp))

An alternative way to construct the second derivative:

DDFf = fnder(sp,2);

To obtain the spline's definite integral over an interval [a..b], in this example from 2 to 5:
diff(fnval (Fnint(sp),[2:5]))

To compute the difference between two splines, use the form fncmb(spl, "-",sp2), for
example:

fncmb(sp, "-",DDF);



Types of Splines

* “Types of Splines: ppform and B-form” on page 10-2

+ “B-Splines and Smoothing Splines” on page 10-5

+  “Multivariate and Rational Splines” on page 10-8

* “The ppform” on page 10-10

* “Constructing and Working with ppform Splines” on page 10-12
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Types of Splines: ppform and B-form

10-2

In this section...

“Polynomials vs. Splines” on page 10-2
“ppform” on page 10-2
“B-form” on page 10-3

“Knot Multiplicity” on page 10-3

Polynomials vs. Splines

Polynomials are the approximating functions of choice when a smooth function is to be
approximated locally. For example, the truncated Taylor series

(x—a) D'f(a)/i!

M=

l

Il
o

provides a satisfactory approximation for f(x) if f is sufficiently smooth and x is
sufficiently close to a. But if a function is to be approximated on a larger interval, the
degree, n, of the approximating polynomial may have to be chosen unacceptably large.
The alternative is to subdivide the interval [a..b] of approximation into sufficiently small
intervals [§;..§j+1], with a = §;<--- <111 = b, so that, on each such interval, a polynomial p;
of relatively low degree can provide a good approximation to f. This can even be done in
such a way that the polynomial pieces blend smoothly, i.e., so that the resulting patched
or composite function s(x) that equals p;(x) for x<[; §;+1], all j, has several continuous
derivatives. Any such smooth piecewise polynomial function is called a spline. 1.dJ.
Schoenberg coined this term because a twice continuously differentiable cubic spline with
sufficiently small first derivative approximates the shape of a draftsman's spline.

There are two commonly used ways to represent a polynomial spline, the ppform and the
B-form. In this toolbox, a spline in ppform is often referred to as a piecewise polynomial,
while a piecewise polynomial in B-form is often referred to as a spline. This reflects the
fact that piecewise polynomials and (polynomial) splines are just two different views of
the same thing.

ppform

The ppform of a polynomial spline of order k provides a description in terms of its breaks
&1..&i11 and the local polynomial coefficients cj; of its [ pieces.
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b ki

pi(x)=(x=&;) ¢ j=1:1

=1

For example, a cubic spline is of order 4, corresponding to the fact that it requires four
coefficients to specify a cubic polynomial. The ppform is convenient for the evaluation and
other uses of a spline.

B-form

The B-form has become the standard way to represent a spline during its construction,
because the B-form makes it easy to build in smoothness requirements across breaks and
leads to banded linear systems. The B-form describes a spline as a weighted sum

n
Y. Bjra;
Jj=1

of B-splines of the required order k, with their number, n, at least as big as k-1 plus
the number of polynomial pieces that make up the spline. Here, B;,= B (- ¢, ...,¢jsx)

is the jth B-spline of order k for the knot sequence t;<ts<---<t,+:. In particular, B; is
piecewise-polynomial of degree < k, with breaks ¢, ...,t;1, , 1s nonnegative, is zero outside
the interval [¢;, ..¢;1z], and is so normalized that

n
2 Bj,k (x) =1 on [tk--tn+1]
j=1

Knot Multiplicity

The multiplicity of the knots governs the smoothness, in the following way: If the number
T occurs exactly r times in the sequence tj,...tj:x, then B; and its first k-r-1 derivatives

are continuous across the break t, while the (k-r)th derivative has a jump at ©. You can
experiment with all these properties of the B-spline in a very visual and interactive way
using the command bspligui.

Related Examples
. “Constructing and Working with ppform Splines” on page 10-12

10-3
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. “Constructing and Working with B-form Splines” on page 10-21

10-4
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B-Splines and Smoothing Splines

In this section...

“B-Spline Properties” on page 10-5
“Variational Approach and Smoothing Splines” on page 10-6

B-Spline Properties

Because B;, is nonzero only on the interval (¢;..¢;1%), the linear system for the B-
spline coefficients of the spline to be determined, by interpolation or least squares
approximation, or even as the approximate solution of some differential equation, is
banded, making the solving of that linear system particularly easy. For example, to
construct a spline s of order & with knot sequence t; < ¢, < *- < £, so that s(x;)=y; for
i=1, ..., n, use the linear system

n
ZBjyk(xi)aj =Y i=1:n
j=1

for the unknown B-spline coefficients a; in which each equation has at most %2 nonzero
entries.

Also, many theoretical facts concerning splines are most easily stated and/or proved
in terms of B-splines. For example, it is possible to match arbitrary data at sites

xq <---<x, uniquely by a spline of order k£ with knot sequence (ti, ..., tns) if and only
if B, x(x;)#0 for all j (Schoenberg-Whitney Conditions). Computations with B-splines are
facilitated by stable recurrence relations

x—t; Liyp—%
Bj(2)=———Bj, 4 (x)+ L

Bjp1(x)
tjvk-1—1; tivkh—tjs1

which are also of help in the conversion from B-form to ppform. The dual functional

a;(s)=3 (-D)*" ¥ (1)D's(q)

i<k

10-5
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provides a useful expression for the jth B-spline coefficient of the spline s in terms of its
value and derivatives at an arbitrary site t© between ¢; and ¢j., and with w;(£):=(¢j4-0) =~ (¢
+h-1-t)/(k=1)! It can be used to show that a;(s) is closely related to s on the interval [t;..tj.s],
and seems the most efficient means for converting from ppform to B-form.

Variational Approach and Smoothing Splines

The above constructive approach is not the only avenue to splines. In the variational
approach, a spline is obtained as a best interpolant, e.g., as the function with smallest
mth derivative among all those matching prescribed function values at certain sites.

As it turns out, among the many such splines available, only those that are piecewise-
polynomials or, perhaps, piecewise-exponentials have found much use. Of particular
practical interest is the smoothing spline s = s, which, for given data (x;y;) with xe[a..b],
all i, and given corresponding positive weights w;, and for given smoothing parameter p,
minimizes

Yl ~f () + - p) o7 ref ds

over all functions f with m derivatives. It turns out that the smoothing spline s is a
spline of order 2m with a break at every data site. The smoothing parameter, p, is chosen
artfully to strike the right balance between wanting the error measure

E(s) = Yuwily; =5 ()]

small and wanting the roughness measure

F(D7s)= [*|pms(e) a

small. The hope is that s contains as much of the information, and as little of the
supposed noise, in the data as possible. One approach to this (used in spaps) is to

make F(D™f) as small as possible subject to the condition that E(f) be no bigger than a
prescribed tolerance. For computational reasons, spaps uses the (equivalent) smoothing

parameter p=p/(1-p), i.e., minimizes pE(f) + F(D™f). Also, it is useful at times to use the
more flexible roughness measure
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m_\ _ b m 2
F(D"s)= [ a(e)|p"se)f dt
with A a suitable positive weight function.

Related Examples
. “Constructing and Working with B-form Splines” on page 10-21
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Multivariate and Rational Splines

10-8

In this section...

“Multivariate Splines” on page 10-8

“Rational Splines” on page 10-9

Multivariate Splines

Multivariate splines can be obtained from univariate splines by the tensor product
construct. For example, a trivariate spline in B-form is given by

w
2 Bu,k (x)Bv,l (y) Bw,m (Z)au,v,w
1 w=1

M=

U
Flayz)=Y

u=1v

with B, ,B, ;, B, » univariate B-splines. Correspondingly, this spline is of order % in

x, of order [ in y, and of order m in z. Similarly, the ppform of a tensor-product spline

is specified by break sequences in each of the variables and, for each hyper-rectangle
thereby specified, a coefficient array. Further, as in the univariate case, the coefficients
may be vectors, typically 2-vectors or 3-vectors, making it possible to represent, e.g.,

certain surfaces in R

A very different bivariate spline is the thin-plate spline. This is a function of the form

n-3
f(x)= Z‘I’(x—cj )aj +x(1)ay_o+x(2)ay_1+ay,
=)

with y(x)=|x| 210g |x|? the thin-plate spline basis function, and |x| denoting the
Euclidean length of the vector x. Here, for convenience, denote the independent variable
by x, but x is now a vector whose two components, x(1) and x(2), play the role of the two
independent variables earlier denoted x and y. Correspondingly, the sites c; are points in

R2,

Thin-plate splines arise as bivariate smoothing splines, meaning a thin-plate spline
minimizes
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n-3

Py

i=1

y; —fe?|+ (1~ p)j(|1)11)1f|2 +2|D Dy +|D2D2f|2)

over all sufficiently smooth functions f. Here, the y; are data values given at the data
sites ¢;, p is the smoothing parameter, and D;f denotes the partial derivative of f with

respect to x(j). The integral is taken over the entire R% The upper summation limit, n—3,
reflects the fact that 3 degrees of freedom of the thin-plate spline are associated with its
polynomial part.

Thin-plate splines are functions in stform, meaning that, up to certain polynomial terms,
they are a weighted sum of arbitrary or scattered translates W(- -c) of one fixed function,
W, This so-called basis function for the thin-plate spline is special in that it is radially
symmetric, meaning that W(x) only depends on the Euclidean length, | x|, of x. For

that reason, thin-plate splines are also known as RBFs or radial basis functions. See
“Constructing and Working with stform Splines” on page 10-35 for more information.

Rational Splines

A rational spline is any function of the form r(x) = s(x)/w(x), with both s and w splines
and, in particular, w a scalar-valued spline, while s often 1s vector-valued.

Rational splines are attractive because it is possible to describe various basic geometric
shapes, like conic sections, exactly as the range of a rational spline. For example, a circle
can so be described by a quadratic rational spline with just two pieces.

In this toolbox, there is the additional requirement that both s and w be of the same form
and even of the same order, and with the same knot or break sequence. This makes it
possible to store the rational spline r as the ordinary spline R whose value at x is the
vector [s(x);w(x)]. Depending on whether the two splines are in B-form or ppform, such a
representation is called here the rBform or the rpform of such a rational spline.

It is easy to obtain r from R. For example, if v is the value of R at x, then v(1:end-1)/
v(end) is the value of r at x. There are corresponding ways to express derivatives of r in
terms of derivatives of R.

Related Examples
. “Constructing and Working with Rational Splines” on page 10-31
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The ppform

10-10

In this section...

“Introduction to ppform” on page 10-10
“Definition of ppform” on page 10-10

Introduction to ppform

A univariate piecewise polynomial f is specified by its break sequence breaks and
the coefficient array coefs of the local power form (see equation in “Definition of
ppform” on page 10-10) of its polynomial pieces; see “Multivariate Tensor Product
Splines” on page 10-26 for a discussion of multivariate piecewise-polynomials. The
coefficients may be (column-)vectors, matrices, even ND-arrays. For simplicity, the
present discussion deals only with the case when the coefficients are scalars.

The break sequence is assumed to be strictly increasing,

breaks(1)
< breaks(2) < ... < breaks(1+1)

with I the number of polynomial pieces that make up f.

While these polynomials may be of varying degrees, they are all recorded as polynomials
of the same order k, i.e., the coefficient array coefs is of size [1,k], with coefs(J, :)
containing the K coefficients in the local power form for the jth polynomial piece, from
the highest to the lowest power; see equation in “Definition of ppform” on page 10-10.

Definition of ppform

The items breaks, coefs, I, and k, make up the ppform of f, along with the dimension
d of its coefficients; usually d equals 1. The basic interval of this form is the interval
[breaks(1) .. breaks(1+1)]. It is the default interval over which a function in ppform
is plotted by the plot command fnplt.

In these terms, the precise description of the piecewise-polynomial fis
f(t) = polyval(coefs(j,:), t - breaks(j))

for breaks(j)<t<breaks(j+1).
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Here, polyval(a,x) is the MATLAB function; it returns the number
k .
Z a(j)xk_J = a(l)xk_1 +a(2)xk_2 +...+a(k)x0
j=1

This defines f(t) only for ¢ in the half-open interval [breaks(1) . .breaks(1+1)]. For
any other ¢, f(t) is defined by

. . . 1,¢ < breaks(1)
f(t) = polyval (coefs(J,:),t —breaks(J)) j= Lt > breaks(L+1)

i.e., by extending the first, respectively last, polynomial piece. In this way, a function in
ppform has possible jumps, in its value and/or its derivatives, only across the interior
breaks, breaks(2:1). The end breaks, breaks([1, 1+1]), mainly serve to define the
basic interval of the ppform.

Related Examples
. “Constructing and Working with ppform Splines” on page 10-12
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Constructing and Working with ppform Splines
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In this section...

“Constructing a ppform” on page 10-12
“Working With ppform Splines” on page 10-13

“Example ppform” on page 10-13

Constructing a ppform

A piecewise-polynomial is usually constructed by some command, through a process of
interpolation or approximation, or conversion from some other form e.g., from the B-form,
and is output as a variable. But it is also possible to make one up from scratch, using the
statement

pp
= ppmak(breaks,coefs)

For example, if you enter pp=ppmak(-5:-1,-22:-11), or, more explicitly,

breaks = -5:-1;
coefs = -22:-11; pp = ppmak(breaks,coefs);

you specify the uniform break sequence -5:-1 and the coefficient sequence -22:-11.
Because this break sequence has 5 entries, hence 4 break intervals, while the coefficient

sequence has 12 entries, you have, in effect, specified a piecewise-polynomial of order 3 (=
12/4). The command

fnbrk(pp)

prints out all the constituent parts of this piecewise-polynomial, as follows:

breaks(1:1+1)
-5 -4 -3 -2 -1
coefficients(d*l,k)

-22 -21 -20
-19 -18 -17
-16 -15 -14
-13 -12 -11
pieces number 1

4
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order k
3
dimension d of target
1

Further, fnbrk can be used to supply each of these parts separately. But the point of
Curve Fitting Toolbox spline functionality is that you usually need not concern yourself
with these details. You simply use pp as an argument to commands that evaluate,
differentiate, integrate, convert, or plot the piecewise-polynomial whose description is
contained in pp.

Working With ppform Splines

Here are some functions for operations you can perform on a piecewise-polynomial.

v = fnval (pp,Xx) Evaluates

dpp = fnder(pp) Differentiates

dirpp = fndir(pp,dir) Differentiates in the direction dir

ipp = fnint(pp) Integrates

fnmin(pp, [a,b]) Finds the minimum value in given interval

fnzeros(pp,[a,b]) Finds the zeros in the given interval

p3 = fnbrk(pp,Jj) Pulls out the jth polynomial piece

pc = fnbrk(pp,[a b]) Restricts/extends to the interval [a..b]

po = fnxtr(pp,order) Extends outside its basic interval by
polynomial of specified order

fnplt(pp,[a,b]) Plots on given interval

sp = fn2fm(pp, "B-") Converts to B-form

pr = fnrfn(pp,morebreaks) Inserts additional breaks

Inserting additional breaks comes in handy when you want to add two piecewise-
polynomials with different breaks, as is done in the command fncmb.

Example ppform

Execute the following commands to create and plot the particular piecewise-polynomial
(ppform) described in the “Constructing a ppform” on page 10-12 section.

10-13
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1  Create the piecewise-polynomial with break sequence -5: -1 and coefficient
sequence -22:-11:
pp=ppmak(-5:-1,-22:-11)
2 Create the basic plot:
x = linspace(-5.5,-.5,101);
plot(x, fnval(pp,x),"x")
3 Add the break lines to the plot:
breaks=fnbrk(pp,“"b"); yy=axis; hold on
for j=1:fnbrk(pp,"1")+1

plot(breaks([i J1).yy(3:4))
end

4  Superimpose the plot of the polynomial that supplies the third polynomial piece:

plot(x,fnval (fnbrk(pp,3),x), " linew",1.3)
set(gca, "ylim",[-60 -10]), hold off

-10 T /4\
~15%0

~60 L L L L
-5.5 -5 -4.5 -4 -35 -3 -25 -2 -15 -1 -0.5

A Piecewise-Polynomial Function, lts Breaks, and the Polynomial Giving lis Third Piece

The figure above is the final picture. It shows the piecewise-polynomial as a sequence
of points and, solidly on top of it, the polynomial from which its third polynomial piece
is taken. It is quite noticeable that the value of a piecewise-polynomial at a break is its
limit from the right, and that the value of the piecewise-polynomial outside its basic
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interval is obtained by extending its leftmost, respectively its rightmost, polynomial
piece.

While the ppform of a piecewise-polynomial is efficient for evaluation, the construction
of a piecewise-polynomial from some data is usually more efficiently handled by
determining first its B-form, i.e., its representation as a linear combination of B-splines.

More About

. “Types of Splines: ppform and B-form” on page 10-2
. “The ppform” on page 10-10
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In this section...

“Introduction to B-form” on page 10-16
“Definition of B-form” on page 10-16
“B-form and B-Splines” on page 10-17
“B-Spline Knot Multiplicity” on page 10-18

“Choice of Knots for B-form” on page 10-19

Introduction to B-form

A univariate spline f is specified by its nondecreasing knot sequence t and by its B-spline
coefficient sequence a. See “Multivariate Tensor Product Splines” on page 10-26 for
a discussion of multivariate splines. The coefficients may be (column-)vectors, matrices,

even ND-arrays. When the coefficients are 2-vectors or 3-vectors, fis a curve in R? or R?
and the coefficients are called the control points for the curve.

Roughly speaking, such a spline is a piecewise-polynomial of a certain order and with
breaks t(i). But knots are different from breaks in that they may be repeated, i.e., € need
not be strictly increasing. The resulting knot multiplicities govern the smoothness of the
spline across the knots, as detailed below.

With [d,n] = size(a), and n+k = length(t), the spline is of order k. This means
that its polynomial pieces have degree < K. For example, a cubic spline is a spline of
order 4 because it takes four coefficients to specify a cubic polynomial.

Definition of B-form
These four items, ¢, a, n, and k, make up the B-form of the spline f.

This means, explicitly, that
n
f= ZBi’ka(:,L)
=1

with B;=B(-|t(i:i+k)) the ith B-spline of order k for the given knot sequence t, i.e.,
the B-spline with knots #(i),...,t(i+k). The basic interval of this B-form is the interval
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[t(1)..t(n+k)]. It is the default interval over which a spline in B-form is plotted by the
command Fnplt. Note that a spline in B-form is zero outside its basic interval while,
after conversion to ppform via fn2fm, this is usually not the case because, outside

its basic interval, a piecewise-polynomial is defined by extension of its first or last
polynomial piece. In particular, a function in B-form may have jumps in value and/or one
of its derivative not only across its interior knots, i.e., across £(i) with ¢(1)<t¢(i)<t(n+k), but
also across its end knots, #(1) and t(n+k).

B-form and B-Splines

The building blocks for the B-form of a spline are the B-splines. A B-Spline of Order 4,
and the Four Cubic Polynomials from Which It Is Made shows a picture of such a B-
spline, the one with the knot sequence [0 1.5 2.3 4 5], hence of order 4, together
with the polynomials whose pieces make up the B-spline. The information for that
picture could be generated by the command

bspline([0O 1.5 2.3 4 5])

4/-\\

A B-Spline of Order 4, and the Four Cubic Polynomials from Which It Is Made

To summarize: The B-spline with knots t(i)<--- < t(i+k) is positive on the interval
(t(2)..t(i+k))and is zero outside that interval. It is piecewise-polynomial of order K with
breaks at the sites t(i),...,t(i+k). These knots may coincide, and the precise multiplicity
governs the smoothness with which the two polynomial pieces join there.

10-17
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Definition of B-Splines

The shorthand

fe Sk,t

is one of several ways to indicate that fis a spline of order k with knot sequence t, i.e., a
linear combination of the B-splines of order K for the knot sequence t.

A word of caution: The term B-spline has been expropriated by the Computer-Aided
Geometric Design (CAGD) community to mean what is called here a spline in B-form,
with the unhappy result that, in any discussion between mathematicians/approximation
theorists and people in CAGD, one now always has to check in what sense the term is
being used.

B-Spline Knot Multiplicity
The rule is

knot multiplicity + condition multiplicity = order

OIN

All Third-Order B-Splines for a Certain Knot Sequence with Various Knot Multiplicities

For example, for a B-spline of order 3, a simple knot would mean two smoothness
conditions, i.e., continuity of function and first derivative, while a double knot would only

10-18
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leave one smoothness condition, i.e., just continuity, and a triple knot would leave no
smoothness condition, i.e., even the function would be discontinuous.

All Third-Order B-Splines for a Certain Knot Sequence with Various Knot Multiplicities
shows a picture of all the third-order B-splines for a certain mystery knot sequence

t. The breaks are indicated by vertical lines. For each break, try to determine its
multiplicity in the knot sequence (it is 1,2,1,1,3), as well as its multiplicity as a knot in
each of the B-splines. For example, the second break has multiplicity 2 but appears only
with multiplicity 1 in the third B-spline and not at all, i.e., with multiplicity 0, in the last
two B-splines. Note that only one of the B-splines shown has all its knots simple. It is the
only one having three different nontrivial polynomial pieces. Note also that you can tell
the knot-sequence multiplicity of a knot by the number of B-splines whose nonzero part
begins or ends there. The picture is generated by the following MATLAB statements,
which use the command spcol from this toolbox to generate the function values of all
these B-splines at a fine net X.

t=[0,1,1,3,4,6,6,6]; x=linspace(-1,7,81);
c=spcol (t,3,x);[1,m]=size(c);
c=c+ones(l,1)*[0:m-1];

axis([-1 7 0 m]); hold on

for tt=t, plot([tt tt],[0 m],"-"), end
plot(x,c, "linew",2), hold off, axis off

Further illustrated examples are provided by the example ”Construct and Work with the
B-form”. You can also use the GUI bspligui to study the dependence of a B-spline on its
knots experimentally.

Choice of Knots for B-form

The rule “knot multiplicity + condition multiplicity = order” has the following
consequence for the process of choosing a knot sequence for the B-form of a spline
approximant. Suppose the spline s is to be of order k, with basic interval [a..b], and
with interior breaks {;< - <g;. Suppose, further, that, at ;, the spline is to satisfy p;
smoothness conditions, i.e.,

Jjumpg DIs = D/s(&,)-D/s(§_) =0, 0<j<p;, i=2..,1

Then, the appropriate knot sequence ¢ should contain the break §; exactly k& — p; times,
i=2,...,1. In addition, it should contain the two endpoints, ¢ and b, of the basic interval
exactly k times. This last requirement can be relaxed, but has become standard. With
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this choice, there is exactly one way to write each spline s with the properties described
as a weighted sum of the B-splines of order £ with knots a segment of the knot sequence
t. This is the reason for the B in B-spline: B-splines are, in Schoenberg's terminology,
basic splines.

For example, if you want to generate the B-form of a cubic spline on the interval [1 .. 3],
with interior breaks 1.5, 1.8, 2.6, and with two continuous derivatives, then the following
would be the appropriate knot sequence:

t=101,1,1,1, 15,18, 2.6, 3, 3, 3, 3];

This is supplied by augknt([1, 1.5, 1.8, 2.6, 3], 4).If you wanted, instead,
to allow for a corner at 1.8, i.e., a possible jump in the first derivative there, you would
triple the knot 1.8, i.e., use

t=1]1,1, 1, 1, 1.5, 1.8, 1.8, 1.8, 2.6, 3, 3, 3, 3];
and this is provided by the statement

t = augknt([1, 1.5, 1.8, 2.6, 31, 4, [1, 3, 11 );

Related Examples
. “Constructing and Working with B-form Splines” on page 10-21
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Constructing and Working with B-form Splines

In this section...

“Construction of B-form” on page 10-21
“Working With B-form Splines” on page 10-22
“Example: B-form Spline Approximation to a Circle” on page 10-23

Construction of B-form

Usually, a spline is constructed from some information, like function values and/or
derivative values, or as the approximate solution of some ordinary differential equation.
But it is also possible to make up a spline from scratch, by providing its knot sequence
and its coefficient sequence to the command spmak.

For example, if you enter
sp = spmak(1:10,3:8);

you supply the uniform knot sequence 1:10 and the coefficient sequence 3:8. Because
there are 10 knots and 6 coefficients, the order must be 4(= 10 — 6), i.e., you get a cubic
spline. The command

Tfnbrk(sp)

prints out the constituent parts of the B-form of this cubic spline, as follows:

knots(1:n+k)
12345678910

coefficients(d,n)
345678

number n of coefficients
6

order k
4

dimension d of target
1

Further, fnbrk can be used to supply each of these parts separately.

But the point of the Curve Fitting Toolbox spline functionality is that there shouldn't
be any need for you to look up these details. You simply use sp as an argument to
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commands that evaluate, differentiate, integrate, convert, or plot the spline whose
description is contained in sp.

Working With B-form Splines

The following commands are available for spline work. There is spmak and fnbrk

to make up a spline and take it apart again. Use Fn2fm to convert from B-form to
ppform. You can evaluate, differentiate, integrate, minimize, find zeros of, plot, refine,
or selectively extrapolate a spline with the aid of fnval, fnder, fndir, fnint, fnmin,
fnzeros, fnplt, fnrfn, and fnxtr.

There are five commands for generating knot sequences:
+ augknt for providing boundary knots and also controlling the multiplicity of interior
knots

*  brk2knt for supplying a knot sequence with specified multiplicities

+ aptknt for providing a knot sequence for a spline space of given order that is suitable
for interpolation at given data sites

+ optknt for providing an optimal knot sequence for interpolation at given sites

+ newknt for a knot sequence perhaps more suitable for the function to be
approximated

In addition, there is:

+ aveknt to supply certain knot averages (the Greville sites) as recommended sites for
interpolation

* chbpnt to supply such sites

+  knt2brk and knt2mlt for extracting the breaks and/or their multiplicities from a
given knot sequence

To display a spline curve with given two-dimensional coefficient sequence and a uniform
knot sequence, use Spcrv.

You can also write your own spline construction commands, in which case you will need
to know the following. The construction of a spline satisfying some interpolation or
approximation conditions usually requires a collocation matrix, i.e., the matrix that, in
each row, contains the sequence of numbers I)'B; ;(7), i.e., the rth derivative at T of the
jth B-spline, for all j, for some r and some site t. Such a matrix is provided by spcol.
An optional argument allows for this matrix to be supplied by spcol in a space-saving
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spline-almost-block-diagonal-form or as a MATLAB sparse matrix. It can be fed to
slvblk, a command for solving linear systems with an almost-block-diagonal coefficient
matrix. If you are interested in seeing how spcol and slvblk are used in this toolbox,
have a look at the commands spapi, spap2, and spaps.

In addition, there are routines for constructing cubic splines. csapi and csape provide
the cubic spline interpolant at knots to given data, using the not-a-knot and various
other end conditions, respectively. A parametric cubic spline curve through given points
is provided by cscvn. The cubic smoothing spline is constructed in csaps.

Example: B-form Spline Approximation to a Circle

As another simple example,

points = _95*[0 -1 0 1;1 0 -1 O];
sp = spmak(-4:8,[points points]);

provides a planar, quartic, spline curve whose middle part is a pretty good approximation
to a circle, as the plot on the next page shows. It is generated by a subsequent

plot(points(l,:),points(2,:),"x"), hold on
fnplt(sp,[0,4]), axis equal square, hold off

Insertion of additional control points (+0.95,40.95)/ 1.9 would make a visually perfect

circle.

Here are more details. The spline curve generated has the form Esjlejﬁa(:, J), with -4:8
the uniform knot sequence, and with its control points a(:,j) the sequence (0,a),(—a,0),(0,—
a),(a,0),(0,a),(—a,0),(0,—a),(a,0) with a=0.95. Only the curve part between the parameter
values 0 and 4 is actually plotted.

To get a feeling for how close to circular this part of the curve actually is, compute its
unsigned curvature. The curvature k(¢) at the curve point y(¢) = (x(¢), y(¢)) of a space
curve y can be computed from the formula

_ |x;y”_yax”|

y,2)3/2

K
(x’2+

in which x', X", y', and y” are the first and second derivatives of the curve with respect to
the parameter used (¢). Treat the planar curve as a space curve in the (x,y)-plane, hence
obtain the maximum and minimum of its curvature at 21 points as follows:
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t = linspace(0,4,21);zt = zeros(size(t));

dsp = fnder(sp); dspt = fnval(dsp,t); ddspt = fnval(fnder(dsp),t);

kappa = abs(dspt(1,:)-*ddspt(2,:)-dspt(2,:)-*ddspt(1,:))-/--.
(sum(dspt.~2)) -~(372);

[min(kappa) ,max(kappa)]

ans =
1.6747 1.8611

So, while the curvature is not quite constant, it is close to 1/radius of the circle, as you see
from the next calculation:

1/norm(fnval (sp,0))

ans =
1.7864

0.6+ i

0.2 i

Spline Approximation to a Circle; Control Points Are Marked x

10-24



Constructing and Working with B-form Splines

More About

. “Types of Splines: ppform and B-form” on page 10-2
. “The B-form” on page 10-16
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In this section...

“Introduction to Multivariate Tensor Product Splines” on page 10-26
“B-form of Tensor Product Splines” on page 10-26
“Construction With Gridded Data” on page 10-27
“ppform of Tensor Product Splines” on page 10-27

“Example: The Mobius Band” on page 10-27

Introduction to Multivariate Tensor Product Splines

The toolbox provides (polynomial) spline functions in any number of variables, as tensor
products of univariate splines. These multivariate splines come in both standard forms,
the B-form and the ppform, and their construction and use parallels entirely that of

the univariate splines discussed in previous sections, “Constructing and Working with
ppform Splines” on page 10-12 and “Constructing and Working with B-form Splines” on
page 10-21. The same commands are used for their construction and use.

For simplicity, the following discussion deals just with bivariate splines.

B-form of Tensor Product Splines

The tensor-product idea is very simple. If fis a function of x, and g is a function of y,
then their tensor-product p (x,y): = f (x)g(y) is a function of x and y, i.e., a bivariate
function. More generally, with s=(si,...,8,,+1) and t=(t1,...,t,+,) knot sequences and
a;;ii=1,...,m;j=1,...n) a corresponding coefficient array, you obtain a bivariate spline as

m n
f(x7y) = ZZ B(.‘)C | Si,...,8i+h)B(y |tja'--7tj+k )G’U
=1 j=1

The B-form of this spline comprises the cell array {s,t} of its knot sequences, the
coefficient array a, the numbers vector [m,n], and the orders vector [A,k]. The command
sp = spmak({s,t},a);

constructs this form. Further, fnplt, fnval, fnder, fndir, fnrfn, and fn2fm can be
used to plot, evaluate, differentiate and integrate, refine, and convert this form.
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Construction With Gridded Data

You are most likely to construct such a form by looking for an interpolant or approximant
to gridded data. For example, if you know the values z(i,))=g(x(i),y(j)),i=1:m, j=1:n, of
some function g at all the points in a rectangular grid, then, assuming that the strictly
increasing sequence X satisfies the Schoenberg-Whitney conditions with respect to

the above knot sequence s, and that the strictly increasing sequence y satisfies the
Schoenberg-Whitney conditions with respect to the above knot sequence ¢, the command

sp=spapi({s,t}, [h,k],{x,y},2);

constructs the unique bivariate spline of the above form that matches the given values.
The command fnplt(sp) gives you a quick plot of this interpolant. The command pp

= fn2fm(sp, "pp") gives you the ppform of this spline, which is probably what you
want when you want to evaluate the spline at a fine grid ((xx(1),yy(d)) for i=1:M,
J=1:N), by the command:

values = fnval (pp,{xx,yy});

ppform of Tensor Product Splines

The ppform of such a bivariate spline comprises, analogously, a cell array of break
sequences, a multidimensional coefficient array, a vector of number pieces, and a vector
of polynomial orders. Fortunately, the toolbox is set up in such a way that there is
usually no reason for you to concern yourself with these details of either form. You use
interpolation, approximation, or smoothing to construct splines, and then use the fn...
commands to make use of them.

Example: The Mobius Band

Here is an example of a surface constructed as a 3-D-valued bivariate spline. The surface
1s the famous Mdobius band, obtainable by taking a longish strip of paper and gluing

its narrow ends together, but with a twist. The figure is obtained by the following
commands:

X = 0:1; y = 0:4; h = 1/4; 02 = 1/sqrt(2); s = 2; ss = 4;
v(3,:,:) = h*[0, -1, -02, 0, 02, 1, 0;0, 1, o2, 0, -02, -1, 0];
v(2,:,:) = [ss, 0, s-h*02, 0, -s-h*02, 0, ss;...

ss, 0, s+h*02, 0,-s+h*02, 0, ss]:
v(,:,:) = s*[0, 1, 0, -1+h, O, 1, O; O, 1, O, -1-h, O, 1, O];
cs = csape({x,v}.,Vv,.{"variational ", “"clamped®});
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fnplt(cs), axis([-2 2 -2.5 2.5 -.5 .5]), shading interp
axis off, hold on

values = squeeze(fnval(cs, {1, linspace(y(1),y(end),51)}));
plot3(values(l,:), values(2,:), values(3,:), k", "linew",2)
view(-149,28), hold off

A Mébius Band Made by Vector-Valued Bivariate Spline Interpolation

More About

. “Types of Splines: ppform and B-form” on page 10-2
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NURBS and Other Rational Splines

In this section...

“Introduction to Rational Splines” on page 10-29

“rsform: rpform, rBform” on page 10-29

Introduction to Rational Splines

A rational spline is, by definition, any function that is the ratio of two splines:

r(x)=s(x)/w(x)

This requires w to be scalar-valued, but s is often chosen to be vector-valued. Further, it
is desirable that w(x) be not zero for any x of interest.

Rational splines are popular because, in contrast to ordinary splines, they can be used to
describe certain basic design shapes, like conic sections, exactly.

rsform: rpform, rBform

The two splines, s and w, in the rational spline r(x)=s(x)/w(x) need not be related to one
another. They could even be of different forms. But, in the context of this toolbox, it is
convenient to restrict them to be of the same form, and even of the same order and with
the same breaks or knots. For, under that assumption, you can represent such a rational
spline by the (vector-valued) spline function

whose values are vectors with one more entry than the values of the rational spline r,
and call this the rsform of the rational spline, or, more precisely, the rpform or rBform,
depending on whether s and w are in ppform or in B-form. Internally, the only thing
that distinguishes these rational forms from their corresponding ordinary spline forms,
rpform and B-form, is their form part, i.e., the string obtained via fnbrk(r, "form").
This is enough to alert the fn. .. commands to act appropriately on a function in one of
the rsforms.
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For example, as is done in fnval, it is very easy to obtain r(x) from R(x). If v is the value
of R at %, then v(1:end-1)/v(end) is the value of r at x. If, in addition, dv is DR(x),
then (dv(1:end-1)-dv(end)*v(1:end-1))/v(end) is Dr(x). More generally, by
Leibniz's formula,

Js
DJs—DJ (wr =Z[ jD wDI
i

=0

Therefore,

J (5 . ..
D'r= DJS—Z(J, ]D’wDJ_Lr [w
i=1\*

This shows that you can compute the derivatives of r inductively, using the derivatives
of s and w (i.e., the derivatives of R) along with the derivatives of r of order less than j

to compute the jth derivative of r. This inductive scheme is used in fntlr to provide the
first so many derivatives of a rational spline. There is a corresponding formula for partial
and directional derivatives for multivariate rational splines.

Related Examples
. “Constructing and Working with Rational Splines” on page 10-31
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Constructing and Working with Rational Splines

In this section...

“Rational Spline Example: Circle” on page 10-31
“Rational Spline Example: Sphere” on page 10-32
“Functions for Working With Rational Splines” on page 10-33

Rational Spline Example: Circle

For example,
circle = rsmak("circle®);

provides a rational spline whose values on its basic interval trace out the unit circle, 1.e.,
the circle of radius 1 with center at the origin, as the command

fnplt(circle), axis square

readily shows; the resulting output is the circle in the figure A Circle and an Ellipse,
Both Given by a Rational Spline.

It is easy to manipulate this circle to obtain related shapes. For example, the next
commands stretch the circle into an ellipse, rotate the ellipse 45 degrees, and translate it
by (1,1), and then plot it on top of the circle.

ellipse = fncmb(circle,[2 0;0 1]);

s45 = 1/sqrt(2);

rtellipse = fncmb(fncmb(ellipse, [s45 -s45;s45 s45]), [1:;1] );
hold on, fnplt(rtellipse), hold off

As a further example, the "circle" just constructed is put together from four pieces. To
highlight the first such piece, use the following commands:

quarter = fnbrk(fn2fm(circle,"rp"),1);
hold on, fnplt(quarter,3), hold off

In the first command, fn2fm is used to change forms, from one based on the B-form to
one based on the ppform, and then fnbrk is used to extract the first piece, and this piece
is then plotted on top of the circle in A Circle and an Ellipse, Both Given by a Rational
Spline, with linewidth 3 to make it stand out.
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A Circle and an Ellipse, Both Given by a Rational Spline

Rational Spline Example: Sphere

As a surface example, the command rsmak("southcap®) provides a 3-vector valued
rational bicubic polynomial whose values on the unit square [-1 .. 1]*2 fill out a piece of
the unit sphere. Adjoin to it five suitable rotates of it and you get the unit sphere exactly.
For illustration, the following commands generate two-thirds of that sphere, as shown in
Part of a Sphere Formed by Four Rotates of a Quartic Rational.

southcap = rsmak("southcap™); fnplt(southcap)

xpcap = fncmb(southcap,[0 O -1;0 1 0;1 0 0]);

ypcap = fncmb(xpcap,[0 -1 0; 1 0 0; 0 0 1]);

northcap = fncmb(southcap,-1);

hold on, fnplt(xpcap), fnplt(ypcap), fnplt(northcap)

axis equal, shading interp, view(-115,10), axis off, hold off

Part of a Sphere Formed by Four Rotates of a Quartic Rational
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Functions for Working With Rational Splines

Having chosen to represent the rational spline r = s/w in this way by the ordinary spline
R=[s;w] makes it is easy to apply to a rational spline all the fn. .. commands in the
Curve Fitting Toolbox spline functions, with the following exceptions. The integral of

a rational spline need not be a rational spline, hence there is no way to extend fnint

to rational splines. The derivative of a rational spline is again a rational spline but one
of roughly twice the order. For that reason, fnder and fndir will not touch rational
splines. Instead, there is the command Fntlr for computing the value at a given x of all
derivatives up to a given order of a given function. If that function is rational, the needed
calculation is based on the considerations given in the preceding paragraph.

The command r = rsmak(shape) provides rational splines in rBform that describe
exactly certain standard geometric shapes , like "circle”, "arc”, "cylinder”,
"sphere®, "cone”, "torus”. The command fncmb(r, trans) can be used to apply
standard transformations to the resulting shape. For example, if trans is a column-
vector of the right length, the shape would be translated by that vector while, if trans is
a suitable matrix like a rotation, the shape would be transformed by that matrix.

The command r = rscvn(p) constructs the quadratic rBform of a tangent-continuous
curve made up of circular arcs and passing through the given sequence, p, of points in the
plane.

A special rational spline form, called a NURBS, has become a standard tool in CAGD. A
NURBS is, by definition, any rational spline for which both s and w are in the same B-
form, with each coefficient for s containing explicitly the corresponding coefficient for w
as a factor:

s= ZBiv(i)a(:,i), w= ZBiv(i)

The normalized coefficients a(:,i) for the numerator spline are more readily used

as control points than the unnormalized coefficients v(i)a(:,i) used in the rBform.
Nevertheless, this toolbox provides no special NURBS form, but only the more general
rational spline, but in both B-form (called rBform internally) and in ppform (called
rpform internally).

The rational spline circle used earlier is put together in rsmak by code like the
following.

x=[110-1-1-1 0 11];y=[011 1 0-1-1-10];
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s45 = 1/sqrt(2); w =[1 s45 1 s45 1 s45 1 s45 1];
circle = rsmak(augknt(0:4,3,2), [w-*X;w.-*y;w]);

Note the appearance of the denominator spline as the last component. Also note how
the coefficients of the denominator spline appear here explicitly as factors of the
corresponding coefficients of the numerator spline. The normalized coefficient sequence
[x;vy] is very simple; it consists of the vertices and midpoints, in proper order, of the
"unit square". The resulting control polygon is tangent to the circle at the places where
the four quadratic pieces that form the circle abut.

For a thorough discussion of NURBS, see [G. Farin, NURBS, 2nd ed., AKPeters Ltd,
1999] or [Les Piegl and Wayne Tiller, The NURBS Book, 2nd ed., Springer-Verlag, 1997].

More About

. “Multivariate and Rational Splines” on page 10-8
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Constructing and Working with stform Splines

In this section...

“Introduction to the stform” on page 10-35

“Construction and Properties of the stform” on page 10-35

“Working with the stform” on page 10-37

Introduction to the stform

A multivariate function form quite different from the tensor-product construct is the
scattered translates form, or stform for short. As the name suggests, it uses arbitrary
or scattered translates w(-—c;) of one fixed function w, in addition to some polynomial
terms. Explicitly, such a form describes a function

n—k
)= 2w (v=c;)a; + (2

in terms of the basis function W, a sequence (c;) of sites called centers and a corresponding
sequence (a)) of n coefficients, with the final & coefficients, a,.4+1,...,@,, involved in the
polynomial part, p.

When the basis function is radially symmetric, meaning that y(x) depends only on the
Euclidean length |x| of its argument, x, then y is called a radial basis function, and,
correspondingly, fis then often called an RBF.

At present, the toolbox works with just one kind of stform, namely a bivariate thin-plate
spline and its first partial derivatives. For the thin-plate spline, the basis function is w(x)

= @(|x1?), with @(¢) = tlogt, i.e., a radial basis function. Its polynomial part is a linear
polynomial, i.e., p(x)=x(1)a, _ s+x(2)a, _ 1+a,. The first partial derivative with respect to

its first argument uses, correspondingly, the basis function w(x)=¢(|x|?), with @(f) =
(D1t) (logt+1) and Dyt = Dt(x) = 2x(1), and p(x) = a,,.
Construction and Properties of the stform

A function in stform can be put together from its center sequence centers and its
coefficient sequence coefs by the command

f = stmak(centers, coefs, type);
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with the string type one of "tp00*", "tpl0~, "tp0Ol”, to indicate, respectively, a thin-
plate spline, a first partial of a thin-plate spline with respect to the first argument, and a
first partial of a thin-plate spline with respect to the second argument. There is one other
choice, "tp*~; it denotes a thin-plate spline without any polynomial part and is likely to
be used only during the construction of a thin-plate spline, as in tpaps.

A function fin stform depends linearly on its coefficients, meaning that

with wj either a translate of the basis function W or else some polynomial. Suppose you
wanted to determine these coefficients g; so that the function f matches prescribed values
at prescribed sites x;. Then you would need the collocation matrix (y;(x;)). You can obtain
this matrix by the command stcol (centers, X, type). In fact, because the stform has
a;j as the jth column, coefs(:,J), of its coefficient array, it is worth noting that stcol
can also supply the transpose of the collocation matrix. Thus, the command

values = coefs*stcol(centers,x,type, "tr-);

would provide the values at the entries of X of the st function specified by centers and
type.

The stform is attractive because, in contrast to piecewise polynomial forms, its
complexity is the same in any number of variables. It is quite simple, yet, because of the
complete freedom in the choice of centers, very flexible and adaptable.

On the negative side, the most attractive choices for a radial basis function share with
the thin-plate spline that the evaluation at any site involves all coefficients. For example,
plotting a scalar-valued thin-plate spline via fnplt involves evaluation at a 51-by-51
grid of sites, a nontrivial task when there are 1000 coefficients or more. The situation is
worse when you want to determine these 1000 coefficients so as to obtain the stform of

a function that matches function values at 1000 data sites, as this calls for solving a full
linear system of order 1000, a task requiring O(1079) flops if done by a direct method.
Just the construction of the collocation matrix for this linear system (by stcol) takes
0(1076) flops.

The command tpaps, which constructs thin-plate spline interpolants and approximants,
uses iterative methods when there are more than 728 data points, but convergence of
such iteration may be slow.
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Working with the stform

After you have constructed an approximating or interpolating thin-plate spline st with
the aid of tpaps (or directly via stmak), you can use the following commands:

fnbrk to obtain its parts or change its basic interval,
fnval to evaluate it
fnplt to plot it

fnder to construct its two first partial derivatives, but no higher order derivatives as
they become infinite at the centers.

This is just one indication that the stform is quite different in nature from the other
forms in this toolbox, hence other fn. .. commands by and large don't work with
stforms. For example, it makes no sense to use fnjmp, and fnmin or fnzeros only
work for univariate functions. It also makes no sense to use fnint on a function in
stform because such functions cannot be integrated in closed form.

The command Ast = fncmb(st,A) can be used on st, provided A is something that
can be applied to the values of the function described by st. For example, A might be
"sin", in which case Ast is the stform of the function whose coefficients are the sine
of the coefficients of st. In effect, Ast describes the function obtained by composing

A with st. But, because of the singularities in the higher-order derivatives of a thin-
plate spline, there seems little point to make fndir or fntlr applicable to such a st.
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+ “Least-Squares Approximation by Natural Cubic Splines” on page 11-2
* “Solving A Nonlinear ODE” on page 11-7

*  “Construction of the Chebyshev Spline” on page 11-13

+ “Approximation by Tensor Product Splines” on page 11-19
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Least-Squares Approximation by Natural Cubic Splines

The construction of a least-squares approximant usually requires that one have in hand
a basis for the space from which the data are to be approximated. As the example of

the space of “natural” cubic splines illustrates, the explicit construction of a basis is not
always straightforward.

This section makes clear that an explicit basis is not actually needed; it is sufficient

to have available some means of interpolating in some fashion from the space of
approximants. For this, the fact that the Curve Fitting Toolbox spline functions support
work with vector-valued functions is essential.

This section discusses these aspects of least-squares approximation by “natural” cubic
splines.

* “Problem” on page 11-2

*  “General Resolution” on page 11-2

+ “Need for a Basis Map” on page 11-3

+  “A Basis Map for “Natural” Cubic Splines” on page 11-3

*  “The One-line Solution” on page 11-4

* “The Need for Proper Extrapolation” on page 11-4

+ “The Correct One-Line Solution” on page 11-5

* “Least-Squares Approximation by Cubic Splines” on page 11-6

Problem

You want to construct the least-squares approximation to given data (X,y) from the space
S of “natural” cubic splines with given breaks b(1) <..<b(l+1).

General Resolution

If you know a basis, (f1,f2,...,fm), for the linear space S of all “natural” cubic splines with
break sequence b, then you have learned to find the least-squares approximation in the
form c(1)f1+ c(2)f2+ ... + c(m)fm, with the vector c the least-squares solution to the
linear system A*c = Yy, whose coefficient matrix is given by

A(l,]) = Ff(x(1)), i=1l:length(x), J=1:m .
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In other words, c = A\y.

Need for a Basis Map

The general solution seems to require that you know a basis. However, in order to
construct the coefficient sequence C, you only need to know the matrix A. For this, it is
sufficient to have at hand a basis map, namely a function F say, so that F(c) returns the
spline given by the particular weighted sum c(1)f1+c(2)f2+... +c(m)fm. For, with that,
you can obtain, for J=1:m, the j-th column of A as fnval (F(ej),Xx), with ej the j-th
column of eye(m), the identity matrix of order m.

Better yet, the Curve Fitting Toolbox spline functions can handle vector-valued functions,
so you should be able to construct the basis map F to handle vector-valued coefficients
c(1) as well. However, by agreement, in this toolbox, a vector-valued coefficient is a
column vector, hence the sequence c is necessarily a row vector of column vectors, i.e., a
matrix. With that, F(eye(m)) is the vector-valued spline whose i-th component is the
basis element fi, 1=1:m. Hence, assuming the vector X of data sites to be a row vector,
fnval (F(eye(m)),x) is the matrix whose (i, J)-entry is the value of fi at X(j), i.e.,
the transpose of the matrix A you are seeking. On the other hand, as just pointed out,
your basis map F expects the coefficient sequence c to be a row vector, i.e., the transpose
of the vector A\y. Hence, assuming, correspondingly, the vector y of data values to be a
row vector, you can obtain the least-squares approximation from S to data (X,y) as

F(y/fnval (F(eye(m)),x))

To be sure, if you wanted to be prepared for X and y to be arbitrary vectors (of the same
length), you would use instead

FQr(=)-"/tnval (F(eye(m)),x(:)-"))

A Basis Map for “Natural” Cubic Splines

What exactly is required of a basis map F for the linear space S of “natural” cubic splines
with break sequence b(1) < ... < b(1+1)? Assuming the dimension of this linear
space is m, the map F should set up a linear one-to-one correspondence between m-vectors
and elements of S. But that is exactly what csape(b, . ,"var®) does.

To be explicit, consider the following function F:

function s = F(c)
s = csape(b,c,"var®);
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For given vector c (of the same length as b), it provides the unique “natural” cubic spline
with break sequence b that takes the value c(i) at b(i), i=1:1+1. The uniqueness is
key. It ensures that the correspondence between the vector ¢ and the resulting spline
F(c) is one-to-one. In particular, m equals length(b). More than that, because the
value f(¢) of a function f at a point ¢ depends linearly on f, this uniqueness ensures that
F(c) depends linearly on ¢ (because c equals fnval (F(c),b) and the inverse of an
invertible linear map is again a linear map).

The One-line Solution

Putting it all together, you arrive at the following code

csape(b,y(:)."/fnval (csape(b,eye(length(b)), "var*),x(:)."), ...
"var®)

for the least-squares approximation by “natural” cubic splines with break sequence b.

The Need for Proper Extrapolation

Let's try it on some data, the census data, say, which is provided in MATLAB by the
command

load census

and which supplies the years, 1790:10:1990, as cdate and the values as pop. Use the
break sequence 1810:40:1970.

b = 1810:40:1970;

S csape(b, ...

pop(:)"/fnval (csape(b,eye(length(b)), "var®),cdate(:)"), "var");
fnplt(s, [1750,2050],2.2);

hold on

plot(cdate,pop, “or");

hold off

Have a look at Least-Squares Approximation by “Natural” Cubic Splines With Three
Interior Breaks which shows, in thick blue, the resulting approximation, along with the
given data.

This looks like a good approximation, -- except that it doesn't look like a “natural” cubic
spline. A “natural” cubic spline, to recall, must be linear to the left of its first break and



Least-Squares Approximation by Natural Cubic Splines

to the right of its last break, and this approximation satisfies neither condition. This is
due to the following facts.

The “natural” cubic spline interpolant to given data is provided by csape in ppform, with
the interval spanned by the data sites its basic interval. On the other hand, evaluation of
a ppform outside its basic interval is done, in MATLAB ppval or Curve Fitting Toolbox
spline function fnval, by using the relevant polynomial end piece of the ppform, i.e.,

by full-order extrapolation. In case of a “natural” cubic spline, you want instead second-
order extrapolation. This means that you want, to the left of the first break, the straight
line that agrees with the cubic spline in value and slope at the first break. Such an
extrapolation is provided by fnxtr. Because the “natural” cubic spline has zero second
derivative at its first break, such an extrapolation is even third-order, i.e., it satisfies
three matching conditions. In the same way, beyond the last break of the cubic spline,
you want the straight line that agrees with the spline in value and slope at the last
break, and this, too, is supplied by fnxtr.

400

3500 ——incorrect approximation
o population
300F ——correct approximation

2501

2001
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501

ok

_51%50 1800 1850 1900 1950 2000 2050

Least-Squares Approximation by “Natural” Cubic Splines With Three Interior Breaks

The Correct One-Line Solution

The following one-line code provides the correct least-squares approximation to data (X,y)
by “natural” cubic splines with break sequence b:

fnxtr(csape(b,y(:)-"/ ...
fnval (fnxtr(csape(b,eye(length(b)),"var®)),x(:)-"), "var"))
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But it is, admittedly, a rather long line.

The following code uses this correct formula and plots, in a thinner, red line, the
resulting approximation on top of the earlier plots, as shown in Least-Squares
Approximation by “Natural” Cubic Splines With Three Interior Breaks.

ss = fnxtr(csape(b,pop(:)"/ ...

fnval (fnxtr(csape(b,eye(length(b)), "var®)),cdate(:)"), "var®));
hold on, fnplt(ss,[1750,2050],1.2,"r"),grid, hold off
legend("incorrect approximation®, "population”,
"correct approximation®)

Least-Squares Approximation by Cubic Splines

The one-line solution works perfectly if you want to approximate by the space S of

all cubic splines with the given break sequence b. You don't even have to use the

Curve Fitting Toolbox spline functions for this because you can rely on the MATLAB
spline. You know that, with c a sequence containing two more entries than does b,
spline(b,c) provides the unique cubic spline with break sequence b that takes the
value c(i+1) at b(@), all i, and takes the slope c(1) at b(1), and the slope c(end) at
b(end). Hence, spline(b, .) is a basis map for S.

More than that, you know that spline(b,c,xi) provides the value(s) at xi of this
interpolating spline. Finally, you know that spline can handle vector-valued data.
Therefore, the following one-line code constructs the least-squares approximation by
cubic splines with break sequence b to data (X,y) :

spline(b,y(:)"/spline(b,eye(length(b)),x(:)"))
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Solving A Nonlinear ODE

This section discusses these aspects of a nonlinear ODE problem:

* “Problem” on page 11-7

+  “Approximation Space” on page 11-7

+ “Discretization” on page 11-8

* “Numerical Problem” on page 11-8

+ “Linearization” on page 11-9

* “Linear System to Be Solved” on page 11-9
+ “Iteration” on page 11-10

You can run this example: “Solving a Nonlinear ODE with a Boundary Layer by
Collocation”.

Problem

Consider the nonlinear singularly perturbed problem:

eng(x)+(g(x))2=1 on [0.1]

Approximation Space

Seek an approximate solution by collocation from C' piecewise cubics with a suitable
break sequence; for instance,

breaks = (0:4)/4;
Because cubics are of order 4, you have
k = 4;

Obtain the corresponding knot sequence as
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knots = augknt(breaks,k,2);

This gives a quadruple knot at both 0 and 1, which is consistent with the fact that you
have cubics, 1.e., have order 4.

This implies that you have

n
n

length(knots)-k;
10;

1.e., 10 degrees of freedom.

Discretization

You collocate at two sites per polynomial piece, i.e., at eight sites altogether. This,
together with the two side conditions, gives us 10 conditions, which matches the 10
degrees of freedom.

Choose the two Gaussian sites for each interval. For the standard interval [-0.5,0.5] of
length 1, these are the two sites

gauss = _5773502692*[-1/2; 1/2];

From this, you obtain the whole collection of collocation sites by

ninterv = length(breaks)-1;

temp = ((breaks(2:ninterv+l)+breaks(1:ninterv))/2);
temp = temp([1 1],:) + gauss*diff(breaks);
colsites = temp(:).";

Numerical Problem

With this, the numerical problem you want to solve is to find y € Sy 4, that satisfies

the nonlinear system

Dy(0)=0
(y(x))2 + 8D2y(x) =1forx € colsites
y)=0
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Linearization

If ¥ is your current approximation to the solution, then the linear problem for the
supposedly better solution z by Newton's method reads

Dz(0)=0

wp (x)2(x) +£D?z(x) = b(x) forx e colsites
2(1)=0

with wo(x)=2y(x),b(x)=(y(x))*+1. In fact, by choosing

wy) =1, wy;(0) =1

wy(x) =0, wy(x):= € for xe colsites

and choosing all other values of w,w,ws, b not yet specified to be zero, you can give your
system the uniform shape

wp (x)2(x) +w; (x) Dz (x) +wy (x) D?2(x) = b(x), for x e sites

with

sites = [0,colsites,1];

Linear System to Be Solved

Because zeS xnots, convert this last system into a system for the B-spline coefficients of
z. This requires the values, first, and second derivatives at every xesites and for all the
relevant B-splines. The command spcolspcol was expressly written for this purpose.

Use spcol to supply the matrix

colmat = ...
spcol (knots, k,brk2knt(sites,3));

From this, you get the collocation matrix by combining the row triple of colmat for x
using the weights wg(x),w:(x),w-(x) to get the row for x of the actual matrix. For this, you
need a current approximation y. Initially, you get it by interpolating some reasonable
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initial guess from your piecewise-polynomial space at the sites. Use the parabola x*—1,
which satisfies the end conditions as the initial guess, and pick the matrix from the full
matrix colmat. Here it is, in several cautious steps:

intmat = colmat([2 1+(1:(n-2))*3,1+(n-1)*3],:);
coefs = intmat\[0 colsites.*colsites-1 0].";
y = spmak(knots,coefs.");

Plot the initial guess, and turn hold on for subsequent plotting:

frplt(y,"g™);

legend("Initial Guess (x"2-1)", "location”,"NW");
axis([-0.01 1.01 -1.01 0.01]);

hold on

lteration

You can now complete the construction and solution of the linear system for the improved
approximate solution z from your current guess y. In fact, with the initial guess y
available, you now set up an iteration, to be terminated when the change z—y is small
enough. Choose a relatively mild ¢ = .1.

tolerance = 6.e-9;
epsilon = _1;
while 1
vtau = fnval(y,colsites);
weights=[0 1 O;
[2*vtau." zeros(n-2,1) repmat(epsilon,n-2,1)];
10 0];
colloc = zeros(n,n);
for j=1:n
colloc(J,:) = weights((,:)*colmat(3*(J-1)+(1:3),:);
end
coefs = colloc\[0 vtau.*vtau+l 0].";
z = spmak(knots,coefs.");
fnplt(z,"k");
maxdif = max(max(abs(z.coefs-y.coefs)));
fprintf("maxdif = %g\n",maxdif)
if (maxdif<tolerance), break, end
% now reiterate
y = Z;
end
legend({"Initial Guess (x"2-1)" "lterates"}, "location®,"NW");
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The resulting printout of the errors is:

maxdif = 0.206695
maxdif = 0.01207
maxdif = 3.95151e-005
maxdif = 4.43216e-010

If you now decrease ¢, you create more of a boundary layer near the right endpoint, and
this calls for a nonuniform mesh.

Use newknt to construct an appropriate finer mesh from the current approximation:

knots = newknt(z, ninterv+1l); breaks = knt2brk(knots);
knots = augknt(breaks,4,2);
n = length(knots)-k;

From the new break sequence, you generate the new collocation site sequence:
ninterv = length(breaks)-1;

temp = ((breaks(2:ninterv+l)+breaks(l:ninterv))/2);

temp = temp([1 1], :) + gauss*diff(breaks);

colpnts = temp(:).";

sites = [0,colpnts,1];

Use spcol to supply the matrix

colmat = spcol(knots,k,sort([sites sites sites]));

and use your current approximate solution z as the initial guess:

intmat = colmat([2 1+(1:(n-2))*3,1+(n-1)*3],:);
y = spmak(knots,[0 fnval(z,colpnts) O]/intmat.");

Thus set up, divide £ by 3 and repeat the earlier calculation, starting with the statements

tolerance=1.e-9;
while 1
vtau=fnval (y,colpnts);

Repeated passes through this process generate a sequence of solutions, for £ = 1/10, 1/30,
1/90, 1/270, 1/810. The resulting solutions, ever flatter at 0 and ever steeper at 1, are
shown in the example plot. The plot also shows the final break sequence, as a sequence
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of vertical bars. To view the plots, run the example “Solving a Nonlinear ODE with a
Boundary Layer by Collocation”.

In this example, at least, newknt has performed satisfactorily.
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Construction of the Chebyshev Spline

This section discusses these aspects of the Chebyshev spline construction:

* “What Is a Chebyshev Spline?” on page 11-13
* “Choice of Spline Space” on page 11-13
*  “Initial Guess” on page 11-14

* “Remez Iteration” on page 11-15

What Is a Chebyshev Spline?

The Chebyshev spline C=C;=C}, of order k for the knot sequence t=(¢;: i=1:n+k) is the
unique element of Sy, of max-norm 1 that maximally oscillates on the interval [t;..t,+1]
and 1s positive near f,+;. This means that there is a unique strictly increasing n-sequence
T so that the function C=C,eS},,; given by C(t)=(-1)""", all i, has max-norm 1 on [t;..t,+1].
This implies that ©=t;,t,=t,+1, and that ¢; < t; < t4;, for all i. In fact, #;+; < T;<t;p_1, all i.
This brings up the point that the knot sequence is assumed to make such an inequality
possible, i.e., the elements of Sy, are assumed to be continuous.

In short, the Chebyshev spline C looks just like the Chebyshev polynomial. It performs
similar functions. For example, its extreme sites t are particularly good sites to
interpolate at from Si; because the norm of the resulting projector is about as small as
can be; see the toolbox command chbpnt.

You can run the example Construction of a Chebyshev Spline to construct C for a
particular knot sequence &.

Choice of Spline Space

You deal with cubic splines, i.e., with order
k = 4;

and use the break sequence

breaks = [0 1 1.1 3 55.57 7.1 7.2 8];
Ipl = length(breaks);

11-13



11  Advanced Spline Examples

11-14

and use simple interior knots, 1.e., use the knot sequence

t
n

breaks([ones(1,k) 2:(Ipl-1) Ipl(:,ones(1,k))D:;
length(t)-k;

Note the quadruple knot at each end. Because k = 4, this makes [0..8] =
[breaks(1)..breaks(lpl)] the interval [¢..t,+1] of interest, with n = length(t)-k the
dimension of the resulting spline space Si;. The same knot sequence would have been
supplied by

t=augknt(breaks, k) ;

Initial Guess

As the initial guess for the T, use the knot averages

ti = (tl+1 + "'+ti+k—1)/(k_]‘)

recommended as good interpolation site choices. These are supplied by

tau=aveknt(t,k);

Plot the resulting first approximation to C, i.e., the spline ¢ that satisfies c(ti)=(—1)”'"i, all
i

b = cumprod(repmat(-1,1,n)); b = b*b(end);

c = spapi(t,tau,b);

fnplt(c,"-.%)
grid

Here is the resulting plot.
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First Approximation to a Chebyshev Spline

Remez lteration

Starting from this approximation, you use the Remez algorithm to produce a sequence
of splines converging to C. This means that you construct new T as the extrema of your
current approximation c to C and try again. Here is the entire loop.

You find the new interior t; as the zeros of De, 1.e., the first derivative of ¢, in several
steps. First, differentiate:

Dc = fnder(c);

Next, take the zeros of the control polygon of Dc as your first guess for the zeros of Dec.
For this, you must take apart the spline Dc.

[knots,coefs,np,kp] = fnbrk(Dc, "knots", "coefs”,"n","order");
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The control polygon has the vertices (tstar(i),coefs(i)), with tstar the knot
averages for the spline, provided by aveknt:

tstar = aveknt(knots,kp);
Here are the zeros of the resulting control polygon of Dc:

npp = (1:np-1);
guess = tstar(npp) -coefs(npp).*(diff(tstar)./diff(coefs));

This provides already a very good first guess for the actual zeros.

Refine this estimate for the zeros of Dc by two steps of the secant method, taking tau and
the resulting guess as your first approximations. First, evaluate Dc at both sets:

sites = tau(ones(4,1),2:n-1);

sites(1,:) = guess;

values = zeros(4,n-2);

values(1:2,:) = reshape(fnval(Dc,sites(1:2,:)),2,n-2);

Now come two steps of the secant method. You guard against division by zero by setting
the function value difference to 1 in case it is zero. Because Dc is strictly monotone near
the sites sought, this is harmless:
for j=2:3

rows = [j,j-1];Dcd=diff(values(rows,:));

Ded(Find(Dcd==0)) = 1:

sites(J+1,:) = sites(j,:) ---

-values((,:).-*(diff(sites(rows,:))./Dcd);

values(j+1,:) = fnval(Dc,sites(J+1,:));

end

The check

max(abs(values. "))
ans = 4.1176 5.7789 0.4644 0.1178

shows the improvement.

Now take these sites as your new tau,

tau = [tau(l) sites(4,:) tau(n)]:

and check the extrema values of your current approximation there:

extremes = abs(fnval(c, tau));
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The difference

max(extremes)-min(extremes)
ans = 0.6905

is an estimate of how far you are from total leveling.

Construct a new spline corresponding to the new choice of tau and plot it on top of the
old:

c = spapi(t,tau,b);
sites = sort([tau (0:100)*(t(n+1)-t(k))/100]);

values = fnval(c,sites);
hold on, plot(sites,values)

The following code turns on the grid and plots the locations of the extrema.
grid on

plot( tau(2:end-1), zeros( 1, np-1 ), “0o" )

hold off

legend( "Initial Guess®™, "Current Guess®", "Extreme Locations®,...
"location®, "NorthEastOutside® );

Following is the resulting figure (legend not shown).

15
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A More Nearly Level Spline
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If this is not close enough, one simply reiterates the loop. For this example, the next
iteration already produces C to graphic accuracy.
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Approximation by Tensor Product Splines

Because the toolbox can handle splines with vector coefficients, it is easy to implement
interpolation or approximation to gridded data by tensor product splines, as the following
illustration is meant to show. You can also run the example “Bivariate Tensor Product
Splines”.

To be sure, most tensor product spline approximation to gridded data can be obtained
directly with one of the spline construction commands, like spapi or csape, in this
toolbox, without concern for the details discussed in this example. Rather, this example is
meant to illustrate the theory behind the tensor product construction, and this will be of
help in situations not covered by the construction commands in this toolbox.

This section discusses these aspects of the tensor product spline problem:

+ “Choice of Sites and Knots” on page 11-19

+ “Least Squares Approximation as Function of y” on page 11-20
+ “Approximation to Coefficients as Functions of x” on page 11-21
* “The Bivariate Approximation” on page 11-25

+ “Switch in Order” on page 11-24

+ “Approximation to Coefficients as Functions of y” on page 11-25
*  “The Bivariate Approximation” on page 11-25

* “Comparison and Extension” on page 11-27

Choice of Sites and Knots

Consider, for example, least squares approximation to given data
2(1,)=f(x(i),y())),i=1:Nx,j=1:Ny. You take the data from a function used extensively

by Franke for the testing of schemes for surface fitting (see R. Franke, “A critical
comparison of some methods for interpolation of scattered data,” Naval Postgraduate
School Techn. Rep. NPS-53-79-003, March 1979). Its domain is the unit square. You
choose a few more data sites in the x-direction than the y-direction; also, for a better
definition, you use higher data density near the boundary.

X = sort([(0:10)/10,.03 .07, -93 .97]);
sort([(0:6)/6,.03 .07, -93 .97]);

y
[xx,yy] = ndgrid(x,y); z = franke(xx,yy):
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Least Squares Approximation as Function of y

Treat these data as coming from a vector-valued function, namely, the function

of y whose value at y(j) is the vector z(,j), all j. For no particular reason, choose to
approximate this function by a vector-valued parabolic spline, with three uniformly
spaced interior knots. This means that you choose the spline order and the knot sequence
for this vector-valued spline as

ky = 3; knotsy = augknt([O0,.25,.5,.75,1],ky);
and then use spap?2 to provide the least squares approximant to the data:
sp = spap2(knotsy,ky,y,z);

In effect, you are finding simultaneously the discrete least squares approximation from
Siy . knotsy to each of the Nx data sets

(9(3)2 (0 d)) 10y =15 N

In particular, the statements

yy = -.1:.05:1.1;
vals = fnval(sp,yy);

provide the array vals, whose entry vals(i, j) can be taken as an approximation
to the value f(x(7),yy(j))of the underlying function f at the mesh-point x(7),yy(j) because
vals(:,}) is the value at yy(j) of the approximating spline curve in sp.

This is evident in the following figure, obtained by the command:
mesh(x,yy,vals."), view(150,50)

Note the use of vals. ", in the mesh command, needed because of the MATLAB matrix-
oriented view when plotting an array. This can be a serious problem in bivariate
approximation because there it is customary to think of z(i, j) as the function value at the
point (x(2), y(j)), while MATLAB thinks of z(i, j) as the function value at the point (x(j),

y(@).
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A Family of Smooth Curves Pretending to Be a Surface
Note that both the first two and the last two values on each smooth curve are actually
zero because both the first two and the last two sites in yy are outside the basic interval

for the spline in sp.

Note also the ridges. They confirm that you are plotting smooth curves in one direction
only.

Approximation to Coefficients as Functions of x

To get an actual surface, you now have to go a step further. Look at the coefficients
coeTfsy of the spline in sp:

coefsy = fnbrk(sp, "coefs");

Abstractly, you can think of the spline in sp as the function
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1o Y coefsy (r) B gy ()

with the ith entry coefsy(i,r) of the vector coefficient coefsy(:,r) corresponding

to x(i), for all i. This suggests approximating each coefficient vector coefsy(q, :) by a
spline of the same order kx and with the same appropriate knot sequence knotsx. For no
particular reason, this time use cubic splines with four uniformly spaced interior knots:

kx = 4; knotsx = augknt([0:.2:1],kx);
sp2 = spap2(knotsx,kx,x,coefsy.");

Note that spap2(knots, k,x, x) expects FX(:, J) to be the datum at x(jJ), i.e., expects

each column of £X to be a function value. To fit the datum coefsy(q, :) at x(g), for all
g, present spap2 with the transpose of coefsy.

The Bivariate Approximation

Now consider the transpose of the coefficients cxy of the resulting spline curve:
coefs = fnbrk(sp2,"coefs").";
It provides the bivariate spline approximation

(%,9) |> X, > coefs (¢, 7) By s (%) By py ()

q

to the original data

(x(2), () I> 2(x(i),5(j)),i=1: Nx, j=1: Ny
To plot this spline surface over a grid, e.g., the grid
xv = 0:.025:1; yv = 0:.025:1;
you can do the following:

values = spcol(knotsx, kx,xv)*coefs*spcol (knotsy,ky,yv).";
mesh(xv,yv,values."), view(150,50);
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This results in the following figure.
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Spline Approximation to Franke's Function

This makes good sense because spcol (knotsx, kx,xv) is the matrix whose (i,q)th entry
equals the value By .(xv(?)) at xv(i) of the gth B-spline of order kx for the knot sequence
knotsx.

Because the matrices spcol (knotsx, kx,xv) and spcol (knotsy,Kky,yVv) are banded,
it may be more efficient, though perhaps more memory-consuming, for large xv and yv to
make use of fnval, as follows:

value2 = ...
fnval (spmak(knotsx, fnval (spmak(knotsy,coefs),yv)."),xv).";

This is, in fact, what happens internally when fnval is called directly with a tensor
product spline, as in

value2 = fnval (spmak({knotsx,knotsy},coefs),{xv,yv});

Here is the calculation of the relative error, i.e., the difference between the given data
and the value of the approximation at those data sites as compared with the magnitude
of the given data:

errors = z - spcol(knotsx,kx,x)*coefs*spcol (knotsy,ky,y).";
disp( max(max(abs(errors)))/max(max(abs(z))) )
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The output is 0.0539, perhaps not too impressive. However, the coefficient array was
only of size 8 6

disp(size(coefs))
to fit a data array of size 15 11.

disp(size(z))

Switch in Order

The approach followed here seems biased, in the following way. First think of the given
data z as describing a vector-valued function of y, and then treat the matrix formed by
the vector coefficients of the approximating curve as describing a vector-valued function
of x.

What happens when you take things in the opposite order, i.e., think of z as describing
a vector-valued function of x, and then treat the matrix made up from the vector
coefficients of the approximating curve as describing a vector-valued function of y?

Perhaps surprisingly, the final approximation is the same, up to roundoff. Here is the
numerical experiment.

Least Squares Approximation as Function of x

First, fit a spline curve to the data, but this time with x as the independent variable,
hence it is the rows of z that now become the data values. Correspondingly, you must
supply z. *, rather than z, to spap2,

spb = spap2(knotsx,kx,x,z.");

thus obtaining a spline approximation to all the curves (x ; z (;, j)). In particular, the
statement

valsb = fnval(spb,xv).";

provides the matrix valsb, whose entry valsb(i, j) can be taken as an approximation
to the value f(xv(i),y(j)) of the underlying function f at the mesh-point (xv(7),y(j)). This is
evident when you plot valsb using mesh:

mesh(xv,y,valsb_."), view(150,50)
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Another Family of Smooth Curves Pretending to Be a Surface

Note the ridges. They confirm that you are, once again, plotting smooth curves in one
direction only. But this time the curves run in the other direction.

Approximation to Coefficients as Functions of y

Now comes the second step, to get the actual surface. First, extract the coefficients:
coefsx = fnbrk(spb, "coefs");

Then fit each coefficient vector coefsx(r, :) by a spline of the same order ky and with
the same appropriate knot sequence knotsy:

spb2 = spap2(knotsy,ky,y,coefsx.");

Note that, once again, you need to transpose the coefficient array from spb, because
spap?2 takes the columns of its last input argument as the data values.

Correspondingly, there is now no need to transpose the coefficient array coefsb of the
resulting curve:

coefsb = fnbrk(spb2, "coefs*);

The Bivariate Approximation

The claim is that coefsb equals the earlier coefficient array coefs, up to round-off, and
here is the test:

11-25



11  Advanced Spline Examples

11-26

disp( max(max(abs(coefs - coefsb))) )
The output is 1.4433e-15.

The explanation is simple enough: The coefficients ¢ of the spline s contained in sp =
spap2(knots, k,Xx,y) depend linearly on the input values y. This implies, given that
both c and y are 1-row matrices, that there is some matrix A=Ayots .« SO that

c= yAknots,k,x

for any data y. This statement even holds when y is a matrix, of size d-by-N, say, in

which case each datum y(:,j) is taken to be a point in R% and the resulting spline is
correspondingly d-vector-valued, hence its coefficient array c is of size d-by-n, with n =
length(knots)-k.

In particular, the statements

sp = spap2(knotsy,ky,y,z);
coefsy =fnbrk(sp, "coefs®);

provide us with the matrix coefsy that satisfies

coefsy = z.Aynotsy ky,y

The subsequent computations

sp2 = spap2(knotsx,kx,x,coefsy.");
coefs = fnbrk(sp2, coefs®).";

generate the coefficient array coefs, which, taking into account the two transpositions,
satisfies

ki

_ b
coefs = ( (ZAknotsy,ky,y ) -Aknotsx,kx,x )

= (Aknotsx,kx,x ), 'Z'Aknotsy,ky,y

In the second, alternative, calculation, you first computed

spb = spap2(knotsx,kx,x,z.");
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coefsx = fnbrk(spb, "coefs®);
hence coefTsX=z'.Axpotsx kx.x- The subsequent calculation

spb2 = spap2(knotsy,ky,y,coefsx.");
coefsb = fnbrk(spb, "coefs");

then provided

j— > — b
coefsb = coefsx. 'Aknotsy,ky,y = (Aknotsx,kx,x ) 'Z'Aknotsy,ky v

Consequently, coefsb = coefs.

Comparison and Extension

The second approach is more symmetric than the first in that transposition takes place
in each call to spap2 and nowhere else. This approach can be used for approximation to
gridded data in any number of variables.

If, for example, the given data over a three-dimensional grid are contained in some
three-dimensional array v of size [Nx,Ny,Nz], with v(i, j,K) containing the value
f(x(0),y(j),z(k)), then you would start off with

coefs = reshape(v,Nx,Ny*Nz);
Assuming that nj = knots;j - kj, for j = X,y,z, you would then proceed as follows:

sp = spap2(knotsx,kx,x,coefs.");
coefs = reshape(fnbrk(sp, "coefs"),Ny,Nz*nx);
sp = spap2(knotsy,ky,y,coefs.");
coefs = reshape(fnbrk(sp, "coefs"),Nz,nx*ny);
sp = spap2(knotsz,kz,z,coefs.");
coefs = reshape(fnbrk(sp, "coefs"),nx,ny*nz);

See Chapter 17 of PGS or [C. de Boor, “Efficient computer manipulation of tensor
products,” ACM Trans. Math. Software 5 (1979), 173-182; Corrigenda, 525] for more
details. The same references also make clear that there is nothing special here about
using least squares approximation. Any approximation process, including spline
interpolation, whose resulting approximation has coefficients that depend linearly on the
given data, can be extended in the same way to a multivariate approximation process to
gridded data.
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This is exactly what is used in the spline construction commands csapi, csape, spapi,
spaps, and spap2, when gridded data are to be fitted. It is also used in fnval, when a
tensor product spline is to be evaluated on a grid.
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This glossary provides brief definitions of the basic mathematical terms and notation
used in this guide to splines. The terms are not in alphabetical order. Terms and

definitions are presented in order such that the explanation of each term only uses terms

discussed earlier. In this way, the first time, you can choose to read the entire glossary
from start to finish, for a cohesive introduction to these terms.

Intervals

Because MATLAB uses the notation [a,b] to indicate a matrix with the two
columns, a and b, this guide uses the notation [a .. b] to indicate the closed interval
with endpoints a and b. This guide does the same for open and half-open intervals.
For example, [a .. b) denotes the interval that includes its left endpoint, a, and
excludes its right endpoint, b.

Vectors

A d-vector is a list of d real numbers, i.e., a point in R¢. In MATLAB, a d-vector is
stored as a matrix of size [1,d], i.e., as a row-vector, or as a matrix of size [d,1], i.e.,
as a column-vector. In the Curve Fitting Toolbox spline functions, vectors are column
vectors.

Functions

In this toolbox, the term function is used in its mathematical sense, and so describes
any rule that associates, to each element of a certain set called its domain, some
element in a certain set called its target. Common examples in this toolbox are
polynomials and splines. But even a point x in R% i.e., a d-vector, may be thought of
as a function, namely the function, with domain the set {1,...,d} and target the real
numbers ‘R, that, for i = 1,...,d, associates to i the real number x(i).

The range of a function is the set of its values.

There are scalar-valued, vector-valued, matrix-valued, and ND-valued splines.
Scalar-valued functions have the real numbers R (or, more generally, the complex
numbers) as their target, while d-vector-valued functions have R? as their target; if,
more generally, d is a vector of positive integers, then d-valued functions have the d-
dimensional real arrays as their target. Curve Fitting Toolbox spline functions can
deal with univariate and multivariate functions. The former have some real interval,
or, perhaps, all of R as their domain, while m-variate functions have some subset, or

perhaps all, of R™ as their domain.
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Placeholder notation

If f 1s a bivariate function, and y is some specific value of its second variable, then

f(-)

is the univariate function whose value at x is f(x,y).

Curves and surfaces vs. functions

In this toolbox, the term function usually refers to a scalar-valued function. A vector-
valued function is called here a:

curve if its domain is some interval
surface if its domain is some rectangle

To be sure, to a mathematician, a curve is not a vector-valued function on some
interval but, rather, the range of such a (continuous) function, with the function itself
being just one of infinitely many possible parametrizations of that curve.

Tensor products

A bivariate tensor product is any weighted sum of products of a function in the first
variable with a function in the second variable, i.e., any function of the form

flay) =3, al, j)g;(@h;(y).

rJ

More generally, an m-variate tensor product is any weighted sum of products
21(x1)g2(x2)...8m () of m univariate functions.

Polynomials

A univariate scalar-valued polynomial is specified by the list of its polynomial
coefficients. The length of that list is the order of that polynomial, and, in this
toolbox, the list is always stored as a row vector. Hence an m-list of polynomials of
order k is always stored as a matrix of size [m , k].

The coefficients in a list of polynomial coefficients are listed from "highest" to
"lowest", to conform to the MATLAB convention, as in the command polyval (a, x).
To recall: assuming that X is a scalar and that a has K entries, this command returns
the number
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aDx* 1 +a@x" 2 .+ ak—Dx +ak).

In other words, the command treats the list a as the coefficients in a power form. For
reasons of numerical stability, such a coefficient list is treated in this toolbox, more
generally, as the coefficients in a shifted, or, local power form, for some given center
C. This means that the value of the polynomial at some point X is supplied by the
command polyval (a,x-c).

A vector-valued polynomial is treated in exactly the same way, except that now each
polynomial coefficient is a vector, say a d-vector. Correspondingly, the coefficient list
now becomes a matrix of size [d,K].

Multivariate polynomials appear in this toolbox mainly as tensor products. Assuming
first, for simplicity, that the polynomial in question is scalar-valued but m-variate,
this means that its coefficient “list” a is an m-dimensional array, of size [k,...,k,,] say,
and its value at some m-vector x is, correspondingly, given by

k2 k, ‘ ‘
2 2 a(il,...,im)(x(il)_C(il))kl—m (x(Lm)_ c(im))km—Lm ’
;=1

=)

Un

for some "center" c.

Piecewise-polynomials

A piecewise-polynomial function refers to a function put together from polynomial
pieces. If the function is univariate, then, for some strictly increasing sequence

&1 <...<&+1, and for i = 1:/, it agrees with some polynomial p; on the interval

[& .. & +1). Outside the interval [&; .. &+ 1), its value is given by its first, respectively
its last, polynomial piece. The & are its breaks. All the multivariate piecewise-
polynomials in this toolbox are tensor products of univariate ones.

B-splines

In this toolbox, the term B-spline is used in its original meaning only, as given to it
by its creator, I. J. Schoenberg, and further amplified in his basic 1966 article with
Curry, and used in PGS and many other books on splines. According to Schoenberg,
the B-spline with knots ¢, ..., i is given by the following somewhat obscure formula
(see, e.g., IX(1) in PGS):

B],k(x) = B(x | t”t]+k) = (tJJrk _t_] )[tj,,tj+k](x —')ﬁ_l.
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To be sure, this is only one of several reasonable normalizations of the B-spline, but it
is the one used in this toolbox. It is chosen so that

n
Y Bjrx)=1, t <x <ty
=1

But, instead of trying to understand the above formula for the B-spline, look at the
reference pages for the GUI bspligui for some of the basic properties of the B-
spline, and use that GUI to gain some firsthand experience with this intriguing
function. Its most important property for the purposes of this toolbox is also the
reason Schoenberg used the letter B in its name:

Every space of (univariate) piecewise-polynomials of a given order has a Basis
consisting of B-splines (hence the “B” in B-spline).

Splines
Consider the set

= 1
S = Hz;,k

of all (scalar-valued) piecewise-polynomials of order & with breaks & < ... <&, that,
for i = 2...], may have a jump across & in its y;th derivative but have no jump there
in any lower order derivative. This set is a linear space, in the sense that any scalar
multiple of a function in S is again in S, as i1s the sum of any two functions in S.

Accordingly, S contains a basis (in fact, infinitely many bases), that is, a sequence
fi,....f» so that every fin S can be written uniquely in the form

f0) =Y fjxa;,
Jj=1

for suitable coefficients a;. The number n appearing here is the dimension of the
linear space S. The coefficients a; are often referred to as the coordinates of f with
respect to this basis.

In particular, according to the Curry-Schoenberg Theorem, our space S has a
basis consisting of B-splines, namely the sequence of all B-splines of the form
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B(- |tj,...,tj+k) ,J = 1...n, with the knot sequence t obtained from the break sequence

¢ and the sequence u by the following conditions:

* Have both & and &+ occur in ¢ exactly & times
*  For each i = 2:[, have & occur in t exactly k — u; times

* Make sure the sequence is nondecreasing and only contains elements from ¢

Note the correspondence between the multiplicity of a knot and the smoothness of the
spline across that knot. In particular, at a simple knot, that is a knot that appears
exactly once in the knot sequence, only the (k — 1)st derivative may be discontinuous.

Rational splines
A rational spline is any function of the form r(x) = s(x)/w(x), with both s and w splines
and, in particular, w a scalar-valued spline, while s often is vector-valued. In this
toolbox, there is the additional requirement that both s and w be of the same form
and even of the same order, and with the same knot or break sequence. This makes
it possible to store the rational spline r as the ordinary spline R whose value at x 1s
the vector [s(x);w(x)]. It is easy to obtain r from R. For example, if v is the value of R
at x, then v(1:end-1)/v(end) is the value of r at x. As another example, consider
getting derivatives of r from those of R. Because s = wr, Leibniz' rule tells us that

m m . .
D™s = Z[ . ]DJme_Jr.
j=0\J

Hence, if v(:, j) contains D' 'R(x), j = 1..m + 1, then

m

(v@:end-1,m+1)- 2 [n?]v(end,j+ Du(l:end-1,j+1) /}(end, 1
J

J=1

provides the value of D" R(x).
Thin-plate splines

A bivariate thin-plate spline is of the form

n-3
f(x)= 2 g0(|x— c; |2)aj +x(Day,_g +x2)ay,_1 +a,,
j=1
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with @(f) = tlogt a univariate function, and [[y|| denoting the Euclidean length of
the vector y. The sites c; are called the centers, and the radially symmetric function

w(x) .= (| x]?) is called the basis function, of this particular stform.

Interpolation

Interpolation is the construction of a function f that matches given data values, y;, at
given data sites, x;, in the sense that f(x;) =y, all i.

The interpolant, f, is usually constructed as the unique function of the form
f()=3 fix)a;
J

that matches the given data, with the functions f; chosen “appropriately”. Many
considerations might enter that choice. One of these considerations is sure to be that
one can match in this way arbitrary data. For example, polynomial interpolation is
popular because, for arbitrary n data points (x;,y;) with distinct data sites, there is
exactly one polynomial of order n — 1 that matches these data. Explicitly, choose the f;
in the above “model” to be

fj(x):H(x_xi)’

i£]

which is an n — 1 degree polynomial for each j. fi(x;) = 0 for every i #j, but fi(x;) # 0 as
long as the x; are all distinct. Set a; = y;/fj(x;) so that
flx) = fix)a; = y; for all j.

In spline interpolation, one chooses the f; to be the n consecutive B-splines Bj(x) =
B(x|t,...,tj+z), j = 1:n, of order k for some knot sequence ¢; <3 < ... <t,+. For this
choice, there is the following important theorem.

Schoenberg-Whitney Theorem

Let x; < x5 < ... <ux,. For arbitrary corresponding values y;, i = 1...n, there exists
exactly one spline f of order k£ with knot sequence ¢;, j = 1...n+k, so that f(x;) = y;,

i = 1...n if and only if the sites satisfy the Schoenberg-Whitney conditions of order %
with respect to that knot sequence ¢, namely

ti<x;<tiup i=1..n,
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with equality allowed only if the knot in question has multiplicity %, i.e., appears k
times in ¢. In that case, the spline being constructed may have a jump discontinuity
across that knot, and it is its limit from the right or left at that knot that matches the
value given there.

Least-squares approximation

In least-squares approximation, the data may be matched only approximately.
Specifically, the linear system

f(x,)szJ(xl)aJ =Y i=1...n,
J

1s solved in the least-squares sense. In this, some weighting is involved, i.e., the
coefficients aj are determined so as to minimize the error measure
|2

E(f)=zwi|yi_f(xi)

for certain nonnegative weights w; at the user's disposal, with the default being to
have all these weights the same.

Smoothing

In spline smoothing, one also tries to make such an error measure small, but tries, at
the same time, to keep the following roughness measure small,

F(pmf)= [ acolp™ fof ax,
X

with A a nonnegative weight function that is usually just the constant function 1, and

D™f the mth derivative of f. The competing claims of small E(f) and small F(D™f) are
mediated by a smoothing parameter, for example, by minimizing

PE(N+F(D™f) or pE(f)+@A-p)F (D),

for some choice of p or of p, and over all f for which this expression makes sense.

Remarkably, if the roughness weight A is constant, then the unique minimizer f is a
spline of order 2m, with knots only at the data sites, and all the interior knots simple,
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and with its derivatives of orders m,...,2m—2 equal to zero at the two extreme data
sites, the so-called “natural” end conditions. The larger the smoothing parameter
p>0orp e [0..1] used, the more closely f matches the given data, and the larger is its
mth derivative.

For data values y; at sites c¢; in the plane, one uses instead the error measure and
roughness measure

BN =Y |y~ F(e)s F(D2F)= [(|D1af P +2|Diof f + (oo P )

and, correspondingly, the minimizer of the sum pE(f) + F(D?f) is not a polynomial
spline, but is a thin-plate spline.

Note that the unique minimizer of pE(f) + F(D*f) for given 0 < p < « is also the unique
minimizer of pE(f) + (1 — p)F(D*f) for p = p/(1 + p) < (0 .. 1) and vice versa.

2D, 3D, ND
Terms such as “a 2D problem” or “a 3D problem” are not used in this toolbox,

because they are not well defined. For example a 2D problem could be any one of the
following:

*  Points on some curve, where you must construct a spline curve, i.e., a vector-
valued spline function of one variable.

* Points on the graph of some function, where you must construct a scalar-valued
spline function of one variable.

+ Data sites in the plane, where you must construct a bivariate scalar-valued spline
function.

A “3D problem” is similarly ambiguous. It could involve a curve, a surface, a function
of three variables, ... . Better to classify problems by the domain and target of the
function(s) to be constructed.

Almost all the spline construction commands in this toolbox can deal with ND-valued
data, meaning that the data values are ND-arrays. If d is the size of such an array,
then the resulting spline is called d-valued.

Related Examples

. “Splines”
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Curve Fitting

Fit curves and surfaces to data

Description
The Curve Fitting app provides a flexible interface where you can interactively fit
curves and surfaces to data and view plots.

You can:

+ Create, plot, and compare multiple fits.
* Use linear or nonlinear regression, interpolation, smoothing, and custom equations.

*  View goodness-of-fit statistics, display confidence intervals and residuals, remove
outliers and assess fits with validation data.

+ Automatically generate code to fit and plot curves and surfaces, or export fits to the
workspace for further analysis.

Open the Curve Fitting App

+ MATLAB Toolstrip: On the Apps tab, under Math, Statistics and Optimization,
click the app icon.

* MATLAB command prompt: Enter cftool.

Examples

. “Interactive Curve and Surface Fitting” on page 2-2

. “Data Selection” on page 2-10

. “Compare Fits in Curve Fitting App” on page 2-21

. “Generating MATLAB Code and Exporting Fits” on page 2-20

Programmatic Use

cftool opens Curve Fitting app or brings focus to the app if it is already open.
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cftool ( X, y ) creates a curve fit to X input and y output. X and y must be numeric,
have two or more elements, and have the same number of elements. cftool opens Curve
Fitting app if necessary.

cftool( X, y, z ) creates a surface fit to X and y inputs and z output. X, y, and

Z must be numeric, have two or more elements, and have compatible sizes. Sizes are
compatible if X, y, and z all have the same number of elements or X and y are vectors,
z is a 2D matrix, length(x ) = n, and length(y) = mwhere [m,n] = size(2).
cftool opens Curve Fitting app if necessary.

cftool( x, y, [1, W ) creates a curve fit with weights w. w must be numeric and
have the same number of elements as X and y.

cftool( x, y, z, w ) creates a surface fit with weights w. w must be numeric and
have the same number of elements as z.

cftool ( filename ) loads the Curve Fitting session in Fi lename into Curve Fitting
app. The filename must have the extension .sFit.

See Also

See Also

Functions
fit

Topics

“Interactive Curve and Surface Fitting” on page 2-2

“Data Selection” on page 2-10

“Compare Fits in Curve Fitting App” on page 2-21
“Generating MATLAB Code and Exporting Fits” on page 2-20

Introduced before R2006a
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aptknt

Acceptable knot sequence

Syntax

knots = aptknt(tau,k)
[knots,k] = aptknt(tau,k)

Description

knots = aptknt(tau,k) returns a knot sequence suitable for interpolation at the
data sites tau by splines of order k with that knot sequence, provided tau has at least k
entries, is nondecreasing, and satisfies tau(i)<tau(i+k-1) for all i. In that case, there
1s exactly one spline of order k with knot sequence knots that matches given values at
those sites. This is so because the sequence knots returned satisfies the Schoenberg-
Whitney conditions

knots(i) < tau(i) < knots(i+k), i=1:length(tau)
with equality only at the extreme knots, each of which occurs with exact multiplicity K.

If tau has fewer than K entries, then K is reduced to the value length(tau). An error
results if tau fails to be nondecreasing and/or tau(i) equals tau(i+k-1) for some i.

[knots,k] = aptknt(tau,k) also returns the actual k used (which equals the
smaller of the input k and Iength(tau)).

Examples

If tau is equally spaced, e.g., equal to linspace(a,b,n) for some n>=4, and y is a
sequence of the same size as tau, then sp = spapi (aptknt(tau,4),tau,y) gives the
cubic spline interpolant with the not-a-knot end condition. This is the same cubic spline
as produced by the command spline(tau,y), but in B-form rather than ppform.
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Cautionary Note

If tau is very nonuniform, then use of the resulting knot sequence for interpolation to
data at the sites tau may lead to unsatisfactory results.

Algorithms

The (k-1)-point averages sum(tau(i+1:i+k-1))/(k-1) of the sequence

tau, as supplied by aveknt(tau, k), are augmented by a k-fold tau(l) and

a k-fold tau(end). In other words, the command gives the same result as
augknt([tau(l),aveknt(tau,k),tau(end)], k), provided tau has at least Kk entries
and k 1is greater than 1.

See Also

augknt | aveknt | newknt | optknt
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argnames

Input argument names of cfit, sFit, or Fittype object

Syntax

args = argnames(fun)

Description

args = argnames(fun) returns the input argument (variable and coefficient) names of
the cFit, sFit, or Fittype object fun as an n-by-1 cell array of character vectors args,
where n = numargs(fun).

Examples

f = fittype("a*x"2+b*exp(n*x)");
nargs = numargs(f)
nargs =

args
args

argnames(f)

. n
XSO 1 s
.

See Also

fittype | formula | numargs

Introduced in R2006b
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augknt

Augment knot sequence

Syntax

augknt(knots, k)
augknt(knots, k,mults)
[augknot,addl] = augknt(...)

Description

augknt(knots,k) returns a nondecreasing and augmented knot sequence that has
the first and last knot with exact multiplicity K. (This may actually shorten the knot
sequence.) )

augknt(knots,k,mults) makes sure that the augmented knot sequence returned
will, in addition, contain each interior knot mults times. If mults has exactly as

many entries as there are interior knots, then the jth one will appear mults(j) times.
Otherwise, the uniform multiplicity mults(1) is used. If knots is strictly increasing,
this ensures that the splines of order Kk with knot sequence augknot satisfy k-mults(j)
smoothness conditions across knots(J+1), j=1: length(knots)-2.

[augknot,addl] = augknt(...) alsoreturns the number addl of knots added on
the left. (This number may be negative.)

Examples

If you want to construct a cubic spline on the interval [a. .b], with two continuous
derivatives, and with the interior break sequence x1i, then augknt([a,b,xi],4) is the
knot sequence you should use.

If you want to use Hermite cubics instead, i.e., a cubic spline with only one continuous
derivative, then the appropriate knot sequence is augknt([a,xi,b],4,2).

augknt([1 2 3 3 3],2) returns the vector [1 1 2 3 3], as does
augknt([3 2 3 1 3],2). In either case, addl would be 1.
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aveknt

Provide knot averages

Syntax

tstar = aveknt(t,k)

Description
tstar = aveknt(t,k) returns the averages of successive k-1 knots, i.e., the sites
ti*::(ti-i-l+.”+ti+k—1)/(k_1)’ i1=1:n

which are recommended as good interpolation site choices when interpolating from

n+k

splines of order k with knot sequence ¢ = (¢; )i:1 .

Examples

aveknt([1 2 3 3 3],3) returns the vector [2.5000 3.0000], while
aveknt([1 2 3],3) returns the empty vector.

With k and the strictly increasing sequence breaks given, the statements

t = augknt(breaks,k); x = aveknt(t);
sp = spapi(t,x,sin(x));

provide a spline interpolant to the sine function on the interval
[breaks(1). .breaks(end)].

For sp the B-form of a scalar-valued univariate spline function, and with tstar and a
computed as

tstar = aveknt(fnbrk(sp, "knots®),fnbrk(sp, “"order®));
a = fnbrk(sp, "coefs®);
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the points (tstar(i), a(i)) constitute the conirol points of the spline, i.e., the vertices of the
spline's control polygon.

See Also

aptknt | chbpnt | optknt
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bkbrk

Part(s) of almost block-diagonal matrix

Syntax

[nb, rows,ncols, last,blocks] = bkbrk(blokmat)
bkbrk(blokmat)

Description

[nb, rows,ncols, last,blocks] = bkbrk(blokmat) returns the details of the
almost block-diagonal matrix contained in blokmat, with rows and last nb-vectors, and
blocks a matrix of size [sum(rows),ncols].

This utility program is not likely to be of interest to the casual user. It is used in slvblk
to decode the information, provided by spcol, about a spline collocation matrix in an
almost block diagonal form especially suited for splines. But bkbrk can also decode the
almost block-diagonal form used in [1].

bkbrk(blokmat) returns nothing, but the details are printed out. This is of use when
trying to understand what went wrong with such a matrix.

References

[1] C. de Boor and R. Weiss. “SOLVEBLOK: A package for solving almost block diagonal
linear systems.” ACM Trans. Mathem. Software 6 (1980), 80—87.

See Also

slvblk | spcol
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brk2knt

Convert breaks with multiplicities into knots

Syntax

knots = brk2knt(breaks,mults)

Description

knots = brk2knt(breaks,mults) returns the sequence knots that is the sequence
breaks but with breaks (i) occurring mults(i) times, all i. In particular, breaks(i)
will not appear unless mults(i)>0. If, as one would expect, breaks is a strictly
increasing sequence, then knots contains each breaks (i) exactly mults(i) times.

If mul ts does not have exactly as many entries as does breaks, then all mults(i) are
set equal to mults(1).

Examples

The statements
t=[112223455];
[xi,m] = knt2brk(t);

tt = brk2knt(xi,m)

give [1 2 3 4 5] forxi,[2 3 1 1 2] form, and, finally, t for tt.

See Also

augknt
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bspligui

Experiment with B-spline as function of its knots

Syntax

bspligui

Description

bspligui starts a graphical user interface (GUI) for exploring how a B-spline depends
on its knots. As you add, move, or delete knots, you see the B-spline and its first three
derivatives change accordingly.

You observe the following basic facts about the B-spline with knot sequence ¢y <---<t¢;:

The B-spline is positive on the open interval (¢..t). It is zero at the end knots, ¢, and
tr, unless they are knots of multiplicity k. The B-spline is also zero outside the closed
interval [Zy..2;], but that part of the B-spline is not shown in the GUIL.

Even at its maximum, the B-spline is never bigger than 1. It reaches the value 1
inside the interval (¢o..t;) only at a knot of multiplicity at least k—1. On the other
hand, that maximum cannot be arbitrarily small; it seems smallest when there are no
interior knots.

The B-spline is piecewise polynomial of order %, i.e., its polynomial pieces all are of
degree <k. For k = 1:4, you can even observe that all its nonzero polynomial pieces
are of exact degree k — 1, by looking at the first three derivatives of the B-spline. This
means that the degree goes up/down by 1 every time you add/delete a knot.

Each knot ¢;is a break for the B-spline, but it is permissible for several knots to
coincide. Therefore, the number of nontrivial polynomial pieces is maximally & (when
all the knots are different) and minimally 1 (when there are no “interior” knots), and
any number between 1 and k is possible.

The smoothness of the B-spline across a break depends on the multiplicity of the
corresponding knot. If the break occurs in the knot sequence m times, then the
(k—m)th derivative of the B-spline has a jump across that break, while all derivatives
of order lower than (k—m) are continuous across that break. Thus, by varying the
multiplicity of a knot, you can control the smoothness of the B-spline across that knot.



bspligui

* As one knot approaches another, the highest derivative that is continuous across both
develops a jump and the higher derivatives become unbounded. But nothing dramatic
happens in any of the lower-order derivatives.

* The B-spline is bell-shaped in the following sense: if the first derivative is not
identically zero, then it has exactly one sign change in the interval (¢,..t;), hence the
B-spline itself is unimodal, meaning that it has exactly one maximum. Further, if
the second derivative is not identically zero, then it has exactly two sign changes in
that interval. Finally, if the third derivative is not identically zero, then it has exactly
three sign changes in that interval. This illustrates the fact that, for j = 0:k — 1, if the
Jjth derivative is not identically zero, then it has exactly j sign changes in the interval
(to..t); it is this property that is meant by the term “bell-shaped”. For this claim to be
strictly true, one has to be careful with the meaning of “sign change” in case there are
knots with multiplicities. For example, the (k—1)st derivative is piecewise constant,
hence it cannot have k-1 sign changes in the straightforward sense unless there are k
polynomial pieces, i.e., unless all the knots are simple.

See Also

bspline | spcol | chbpnt

12-13



12  Functions — Alphabetical List

bspline

Plot B-spline and its polynomial pieces

Syntax
bspline(t)

bspline(t,window)
pp = bspline(t)

Description

bspline(t) plots the B-spline with knot sequence t, as well as the polynomial pieces
of which it i1s composed.

bspline(t,window) does the plotting in the subplot window specified by window; see
the MATLAB command subplot for details.

pp = bspline(t) plots nothing but returns the ppform of the B-spline.

Examples

The statement pp=fn2fm(spmak(t,1), "pp") has the same effect as the statement
pp=bspline(t).

See Also

bspligui
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category

Category of fit of cFit, sTit, or Fittype object

Syntax

chame = category(fun)

Description

cname = category(fun) returns the fit category cname of the cfit, sFit, or
Fittype object fun, where cname is one of "custom®, "interpolant®, "library”, or
"spline”.

Examples

fl = fittype(Ta*x"2+b*exp(n*x)");
category(fl)

ans =

custom

2 = fittype(“pchipinterp”);
category(f2)

ans =

interpolant

3 = fittype("fourierd™);
category(f3)

ans =

library

f4 = fittype(“smoothingspline®);
category(f4)

ans =

spline
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See Also

fittype | type

Topics
“List of Library Models for Curve and Surface Fitting” on page 4-13

Introduced in R2006b
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cfit

Constructor for cFit object

Syntax

cfun = cfit(ffun,coeffl,coeff2,...)

Description

cfun = cfit(ffun,coeffl,coeff2, .. ) constructs the cFit object cfun using
the model type specified by the Fittype object FFun and the coefficient values coefFl,
coeff2, etc.

Note: cFfit is called by the fit function when fitting fittype objects to data. To create
a cFit object that is the result of a regression, use Fit.

You should only call cFit directly if you want to assign values to coefficients and
problem parameters of a Fittype object without performing a fit.

Examples
T = fittype(Ta*x"2+b*exp(n*x) ")
¥ =
General model:
f(a,b,n,x) = a*x™2+b*exp(n*x)
c = cfFit(f,1,10.3,-1e2)
Cc =

General model:
c(X) = a*x™2+b*exp(n*x)

Coefficients:
a = 1
b = 10.3
n = -100
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See Also

fit | fittype | feval

Topics
“Evaluate a Curve Fit” on page 7-20
“Fit Postprocessing”

Introduced before R2006a
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chbpnt

Good data sites, Chebyshev-Demko points

Syntax

tau = chbpnt(t,k)
chbpnt(t,k, tol)
[tau,sp] = chbpnt(...)

Description

tau = chbpnt(t,k) are the extreme sites of the Chebyshev spline of order k with knot
sequence t. These are particularly good sites at which to interpolate data by splines of
order k with knot sequence t because the resulting interpolant is often quite close to the
best uniform approximation from that spline space to the function whose values at tau
are being interpolated.

chbpnt(t,k,tol) also specifies the tolerance tol to be used in the iterative process
that constructs the Chebyshev spline. This process is terminated when the relative
difference between the absolutely largest and the absolutely smallest local extremum of
the spline is smaller than tol. The default value for tol is .001.

[tau,sp] = chbpnt(...) alsoreturns, in sp, the Chebyshev spline.

Examples

chbpnt([-ones(1,k),ones(1,k)],k) provides (approximately) the extreme sites on
the interval [-1 .. 1] of the Chebyshev polynomial of degree k-1.

If you have decided to approximate the square-root function on the interval [0 .. 1] by
cubic splines, with knot sequence t as given by

k = 4; n =10; t = augknt(((0:n)/n)."8,k);

then a good approximation to the square-root function from that specific spline space is
given by
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X = chbpnt(t,k); sp = spapi(t,x,sqrt(x));

as is evidenced by the near equi-oscillation of the error.

Algorithms

The Chebyshev spline for the given knot sequence and order is constructed iteratively,
using the Remez algorithm, using as initial guess the spline that takes alternately

the values 1 and —1 at the sequence aveknt(t,k). The example “Constructing the
Chebyshev Spline” gives a detailed discussion of one version of the process as applied to a
particular example.

See Also

aveknt
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coeffnames

Coefficient names of cfit, sFit, or Fittype object

Syntax

coeffs = coeffnames(fun)

Description

coeffs = coeffnames(fun) returns the coefficient (parameter) names of the cFit,
sTit, or Fittype object fun as an n-by-1 cell array of character vectors coeffs, where
n = numcoeffs(fun).

Examples

f = fittype("a*x"2+b*exp(n*x)");
ncoeffs = numcoeffs(T)
ncoeffs =
3
coeffs
coeffs
“ar
IbI
"

coeffnames(f)

See Also

fittype | formula | numcoeffs | probnames | coeffvalues

Introduced in R2006b
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coeffvalues

Coefficient values of cFit or sFit object

Syntax

coeffvals = coeffvalues(fun)

Description

coeffvals = coeffvalues(fun) returns the values of the coefficients (parameters) of
the cFit object fun as a 1-by-n vector coeffvals, where n = numcoeffs(fun).

Examples

load census

T = Fittype("poly27);
coeffnames(f)
ans =
"p1"
"p2*
"p3"
formula(f)
ans =
pl*x"2 + p2*x + p3

c = fit(cdate,pop,fF);
coeffvalues(c)
ans =
1.0e+004 *
0.0000 -0.0024 2.1130

See Also

coeffnames | confint | predint | probvalues
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Introduced before R2006a
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confint

Confidence intervals for fit coefficients of cFit or sFit object

Syntax
ci = confint(fitresult)
ci = confint(fitresult,level)

Description

ci = confint(Ffitresult) returns 95% confidence bounds ci on the coefficients
associated with the cFit or sFit object Fitresult. Fitresult must be an output from
the Fit function to contain the necessary information for ci. ci is a 2-by-n array where
n = numcoeffs(Fitresult). The top row of ci contains the lower bound for each
coefficient; the bottom row contains the upper bound.

ci = confint(Ffitresult, level) returns confidence bounds at the confidence level
specified by level. level must be between O and 1. The default value of level is 0.95.

Examples

load census

fitresult
fitresult
Linear model Poly2:
fitresult(X) = pl1*x™2 + p2*x + p3
Coefficients (with 95% confidence bounds):

fit(cdate,pop, "poly2%)

pl = 0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
p3 = 2.113e+004 (1.964e+004, 2.262e+004)
ci = confint(fitresult,0.95)
ci =
0.0061242 -25.086 19641



confint

0.0069581 -21.934 22618

Note that Fit and confint display the confidence bounds in slightly different formats.

Tips

To calculate confidence bounds, confint uses R (the inverse R factor from QR
decomposition of the Jacobian), the degrees of freedom for error, and the root mean
squared error. This information is automatically returned by the fit function and
contained within Fitresult.

If coefficients are bounded and one or more of the estimates are at their bounds, those
estimates are regarded as fixed and do not have confidence bounds.

Note that you cannot calculate confidence bounds if category(fitresult) is
"spline” or "interpolant”.

See Also

fit | predint

Introduced before R2006a
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csape

Cubic spline interpolation with end conditions

Syntax

pp = csape(X,Y)
pp = csape(X,y,conds)
Description

pp = csape(X,Yy) isthe ppform of a cubic spline s with knot sequence X that satisfies
s(xX(3)) = y(:,)) for all j, as well as an additional end condition at the ends (meaning
the leftmost and at the rightmost data site), namely the default condition listed below.
The data values y( -, J) may be scalars, vectors, matrices, even ND-arrays. Data values
at the same data site are averaged.

pp = csape(X,Yy,conds) lets you choose the end conditions to be used, from a
rather large and varied catalog, by proper choice of conds. If needed, you supply the
corresponding end condition values as additional data values, with the first (last) data
value taken as the end condition value at the left (right) end. In other words, in that
case, s(x(jJ)) matches y(:, j+1) for all jJ, and the variable endcondvals used in the
detailed description below is set to y(:,[1 end]). For some choices of conds, these
end condition values need not be present and/or are ignored when present.

conds may be a character vector whose first character matches one of the following:
"complete” or "clamped”, "not-a-knot", "periodic”, "second”, "variational ",
with the following meanings.

"complete” or Match endslopes (as given, with default as under “default”).

"clamped~

'not-a-knot* Make second and second-last sites inactive knots (ignoring end
condition values if given).

"periodic” Match first and second derivatives at left end with those at
right end.



csape

"second*” Match end second derivatives (as given, with default [0 0], i.e.,
asin "variational").

"variational” Set end second derivatives equal to zero (ignoring end condition
values if given).

default Match endslopes to the slope of the cubic that matches the first

four data at the respective end (i.e., Lagrange).

By giving conds as a 1-by-2 matrix instead, it is possible to specify different conditions

at the two ends. Explicitly, the ith derivative, D's, is given the value endcondvals(;, j) at
the left (j is 1) respectively right (j is 2) end in case conds(j) is i,i = 1:2. There are default
values for conds and/or endcondvals.

Available conditions are:

clamped Ds(e) = endcondvals(:, ) if conds(j) == 1

curved D ?s(e) = endcondvals(:, j) iIf conds(j) == 2

Lagrange Ds(e) = Dp(e) default

periodic D’s(a)=D’s(b), r=1,2 if conds == [0 O]

variational D32s(e)=0 if conds(j) == 2 &
endcondvals(:,j) ==

Here, e is a (e is b), i.e., the left (right) end, in case j is 1 (J is 2), and (in the Lagrange
condition) P is the cubic polynomial that interpolates to the given data at e and the three
sites nearest e.

If conds(J) is not specified or is different from 0, 1, or 2, then it is taken to be 1 and the
corresponding endcondvals(:, j) is taken to be the corresponding default value.

The default value for endcondvals(:,J) is the derivative of the cubic interpolant at the
nearest four sites in case conds(j) is 1, and is 0 otherwise.

It is also possible to handle gridded data, by having X be a cell array containing m
univariate meshes and, correspondingly, having y be an m-dimensional array (or an
m+r-dimensional array if the function is to be r-valued). Correspondingly, conds is a cell
array with m entries, and end condition values may be correspondingly supplied in each
of the m variables. This, as the last example below, of bicubic spline interpolation, makes
clear, may require you to supply end conditions for end conditions.
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This command calls on a much expanded version of the Fortran routine CUBSPL in PGS.

Examples

csape(X,Yy) provides the cubic spline interpolant with the Lagrange end conditions,
while csape(X,VY,[2 2]) provides the variational, or natural cubic spline interpolant,
as does csape(X,y, "v").csape([-1 1],[3 -1 1 6],[1 2]) provides the cubic
polynomial p for which Dp(-1) = 3, p(-1) = -1, p(1) = 1, D*p(1) = 6, i.e., p(x) = x°. Finally,
csape([-1 1],[-1 1]) provides the straight line p for which p(+1) = £1, i.e., p(x) = x.

End conditions other than the ones listed earlier can be handled along the following lines.
Suppose that you want to enforce the condition

A(s) :=aDs(e) + szs(e) =c

for given scalars a, b, and ¢, and with e equal to X(1). Then one could compute the cubic
spline interpolant s; to the given data using the default end condition as well as the
cubic spline interpolant sg to zero data and some (nontrivial) end condition at e, and then
obtain the desired interpolant in the form

s=s;+((c=M(s7)) / Msy)s
Here are the (not inconsiderable) details (in which the first polynomial piece of s; and s,
is pulled out to avoid differentiating all of s; and sg):

% Data: x and y
[x, y] = titanium();

% Scalars a, b, and c

a= -2;
b = -1;
c = 0;

% End condition at left
e = x(1);

% The cubic spline interpolant sl to the
% given data using the default end

% condition

sl = csape(X,Y);
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% The cubic spline interpolant sO to

% zero data and some (nontrivial) end

% condition at e

sO0 = csape(X,[1,zeros(1,length(y)),0],[1,0]);

% Compute the derivatives of the first
% polynomial piece of sl and sO

dsl fnder (fnbrk(sl,1));

dsO fnder (fnbrk(s0,1));

% Compute interpolant with desired end conditions
laml = a*fnval(dsl,e) + b*fnval(fnder(dsl),e);
lam0 = a*fnval(ds0,e) + b*fnval (fnder(ds0),e);

pp = fncmb(sO, (c-laml)/1am0,sl);

Plot to see the results:

fnplt( pp, [594, 632] )
hold on
fnplt( s1, "b--", [594, 632] )
plot( x, y, "ro", "MarkerFaceColor®, "r* )
hold off
axis( [594, 632, 0.62, 0.655] )
legend "Desired end-conditions”
"Default end-conditions™ "Data“
Location SouthEast

As a multivariate vector-valued example, here is a sphere, done as a parametric bicubic
spline, 3D-valued, using prescribed slopes in one direction and periodic end conditions in

the other:

X = 0:4; y=-2:2; s2 = 1/sqrt(2);

v = zeros( 3, 7, 5);

v(1,:,:) =[10s21s20 -1].-"*[1 0 -1 0 1];
v(2,:,:) =[10s21s20 -1]."*[0 1 0 -1 0O];
v(3,:,:) =[01s20 -s2 -10]-"*[11111];

sph = csape({x,y},Vv,{"clamped”, "periodic"});
values = fnval(sph,{0:.1:4,-2:.1:2});

surf( squeeze(values(1,:,:)), ---
squeeze(values(2,:,:)), squeeze(values(3,:,:)) );
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axis equal
axis off

The lines involving fnval and surf could have been replaced by the simple command:
fnplt(sph). Note that v is a 3-dimensional array, with v(:, i+1,j) the 3-vector to

be matched at (x(1),y(J)), 1=1:5, j=1:5. Note further that, in accordance with
conds{1} being "clamped”, size(Vv, 2) is 7 (and not 5), with the first and last entry of
v(r,:,J) specifying the end slopes to be matched.

Here is a bivariate example that shows the need for supplying end conditions of end
conditions when supplying end conditions in both variables. You reproduce the bicubic
polynomial g(x,y) = x*3y”3 by complete bicubic interpolation. You then derive the needed
data, including end condition values, directly from g in order to make it easier for you to
see just how the end condition values must be placed. Finally, you check the result.

sites = {[0 1],[0 2]}; coefs = zeros(4, 4); coefs(1,1) = 1;
g = ppmak(sites,coefs);

Dxg fnval (fnder(g,[1 0]),sites);

Dyg fnval (fnder(g,[0 1]),sites);

Dxyg = fnval(fnder(g,[1 1]).,sites);

T = csape(sites, [Dxyg(1,1), Dxg(1,:), Dxyg(1,2);
Dyg(:,1), fnval(g,sites), Dyg(:,2) ;
Dxyg(2,1), Dxg(2,:), Dxyg(2,2)1,
{"complete”,“"complete"});
if any(squeeze(fnbrk(f,"c"))-coefs)
disp( "this is wrong® )
end

Cautionary Note
csape recognizes that you supplied explicit end condition values by the fact that you
supplied exactly two more data values than data sites. In particular, even when using

different end conditions at the two ends, if you wish to supply an end condition value at
one end, you must also supply one for the other end.

Algorithms

The relevant tridiagonal linear system is constructed and solved using the sparse matrix
capabilities of MATLAB.



csape

See Also

csapi | spapi | spline
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csapi

Cubic spline interpolation

Syntax

pp=csapi(x,y)
values = csapi(X,y,xx)

Description

pp=csapi(X,y) returnsthe ppform of a cubic spline s with knot sequence X that takes
the value y(:,}) at x(§) for j=1: length(x). The values y(:,J) can be scalars,
vectors, matrices, even ND-arrays. Data points with the same data site are averaged and
then sorted by their sites. With x the resulting sorted data sites, the spline s satisfies the
not-a-knot end conditions, namely jump,D’s = 0 = jJumpyena_1yD’s (with D’s the third
derivative of s).

If X 1is a cell array, containing sequences X1, ..., Xm, of lengths nl, ..., nm respectively,
then y is expected to be an array, of size [nl, .. .,nm] (or of size [d,n1, ... ,nm] if
the interpolant is to be d-valued). In that case, pp is the ppform of an m-cubic spline
interpolant s to such data. In particular, now s(x1(iy), ..., xm(iy)) equals y(,i4, ..., i) for i;
=1ml, ..., in=1:nm.

You can use the structure pp, in fnval, fnder, fnplt, etc, to evaluate, differentiate,
plot, etc, this interpolating cubic spline.

values = csapi(X,y,xx) isthe same as fnval (csapi(X,y),XxX), i.e., the values of
the interpolating cubic spline at the sites specified by XX are returned.

This command is essentially the MATLAB function spline, which, in turn, is a stripped-
down version of the Fortran routine CUBSPL in PGS, except that csapi (and now also
spline) accepts vector-valued data and can handle gridded data.

Examples

See the example “Spline Interpolation” for various examples.
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Up to rounding errors, and assuming that X is a vector with at least four entries, the
statement pp = csapi(X,Y) should put the same spline into pp as does the statement

pp = fn2fm(spapi (augknt(xX([1 3:(end-2) end]),4).,X,Y), " pp~):

except that the description of the spline obtained this second way will use no break at
X(2) and x(n-1).

Here is a simple bivariate example, a bicubic spline interpolant to the Mexican Hat
function being plotted:

X =.0001+[-4:.2:4]; y = -3:.2:3;
[yy,xx] = meshgrid(y,x); r = pi*sqrt(xXx."2+yy."2); z = sin(r)./r;
bcs = csapi( {x,y}, z ); fnplt( bcs ), axis([-5 5 -5 5 -.5 1])

Note the reversal of X and y in the call to meshgrid, needed because MATLAB likes

to think of the entry z(i,J) as the value at (x(§J),y (1)) while this toolbox follows the
Approximation Theory standard of thinking of z(i, j) as the value at (xX(i),y(})).
Similar caution has to be exerted when values of such a bivariate spline are to be
plotted with the aid of the MATLAB mesh function, as is shown here (note the use of the
transpose of the matrix of values obtained from fnval).

xF = linspace(x(1),x(end),41); yf = linspace(y(1),y(end),41);
mesh(xf, yf, fnval( bcs, {xf, yf}p).")

Algorithms

The relevant tridiagonal linear system is constructed and solved, using the MATLAB
sparse matrix capability.

The not-a-knot end condition is used, thus forcing the first and second polynomial piece of
the interpolant to coincide, as well as the second-to-last and the last polynomial piece.

See Also

csape | spapi | spline
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csaps

Cubic smoothing spline

Syntax

pp = csaps(X,y)

csaps(x,yY,p)

[---.p] = csaps(.-.)
csaps(x,y,p,[1.w)
values = csaps(X,y,p,xx)
csaps(X,y,p,XxX,w)

[---1 = csaps({x1,...,xm},y,...)

Description

pp = csaps(X,Yy) returns the ppform of a cubic smoothing spline f to the given data
X,Y, with the value of f at the data site x(J) approximating the data value y(:,j), for
J=1:length(x). The values may be scalars, vectors, matrices, even ND-arrays. Data
points with the same site are replaced by their (weighted) average, with its weight the
sum of the corresponding weights.

This smoothing spline f minimizes

10 2
pY Wiy, i)~ FaP + A~ p[ao| D @] de

J=1

Here, |z|? stands for the sum of the squares of all the entries of z, n is the number of
entries of X, and the integral is over the smallest interval containing all the entries of X.
The default value for the weight vector w in the error measure is ones(size(x)). The
default value for the piecewise constant weight function A in the roughness measure is
the constant function 1. Further, D*f denotes the second derivative of the function f. The
default value for the smoothing parameter, p, is chosen in dependence on the given data
sites X.
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If the smoothing spline is to be evaluated outside its basic interval, it must first be
properly extrapolated, by the command pp = fnxtr(pp), to ensure that its second
derivative is zero outside the interval spanned by the data sites.

csaps(X,Y,p) lets you supply the smoothing parameter. The smoothing parameter
determines the relative weight you would like to place on the contradictory demands

of having f be smooth vs having f be close to the data. For p =0, fis the least-squares
straight line fit to the data, while, at the other extreme, i.e., for p = 1, fis the variational,
or ‘natural' cubic spline interpolant. As p moves from 0 to 1, the smoothing spline
changes from one extreme to the other. The interesting range for p is often near 1/(1 +
h?16), with h the average spacing of the data sites, and it is in this range that the default
value for p is chosen. For uniformly spaced data, one would expect a close following of the
data for p = 1(1 + A%/60) and some satisfactory smoothing for p = 1/(1 + ~#%*/0.6). You can
input ap > 1, but this leads to a smoothing spline even rougher than the variational
cubic spline interpolant.

If the input p is negative or empty, then the default value for p is used.

[---.,p] = csaps(...) alsoreturns the value of p actually used whether or not
you specified p. This is important for experimentation which you might start with
[pp,pl=csaps(X,Yy) in order to obtain a ‘reasonable' first guess for p.

If you have difficulty choosing p but have some feeling for the size of the noise in y,

consider using instead spaps(X,y,tol) which, in effect, chooses p in such a way that
the roughness measure

9 2
[rw|D?se)ar
is as small as possible subject to the condition that the error measure

S w(]yC, ) -s ()

does not exceed the specified tol. This usually means that the error measure equals the
specified tol.

The weight function A in the roughness measure can, optionally, be specified as a
(nonnegative) piecewise constant function, with breaks at the data sites X , by inputing
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for p a vector whose ith entry provides the value of A on the interval (x(i-1) .. x(i))

for 1=2:length(x). The first entry of the input vector p continues to be used as the
desired value of the smoothness parameter p. In this way, it is possible to insist that the
resulting smoothing spline be smoother (by making the weight function larger) or closer
to the data (by making the weight functions smaller) in some parts of the interval than in
others.

csaps(X,Y,p,[1,w) lets you specify the weights w in the error measure, as a vector of
nonnegative entries of the same size as X.

values = csaps(X,y,p,xX) isthe same as fnval (csaps(x,y,p),XxX).
csaps(X,Y,p,Xxx,w) isthe same as fnval (csaps(x,y,p,[1,w),xx).

[---1 = csaps({x1,...,xm},y,...) provides the ppform of an m-variate tensor-
product smoothing spline to data on a rectangular grid. Here, the first argument

is a cell-array, containing the vectors X1, ..., Xm, of lengths n1, ..., nm, respectively.
Correspondingly, y is an array of size [n1, . . . ,nm] (or of size [d,nl, ...,nm] in case
the data are d-valued), with y(:,iy, ...,i,) the given (perhaps noisy) value at the grid site
x1(1), ..., xm(py).

In this case, p if input must be a cell-array with m entries or else an m-vector, except that
it may also be a scalar or empty, in which case it is taken to be the cell-array whose m
entries all equal the p input. The optional second output argument will always be a cell-
array with m entries.

Further, w if input must be a cell-array with m entries, with w{i1} either empty, to
indicate the default choice, or else a nonnegative vector of the same size as X1.

Examples

Example 1.

x = linspace(0,2*pi,21); y = sin(x)+(rand(1,21)-.5)*.1;
pp = csaps(x,y, -4, [1, [ones(1,10), repmat(5,1,10), O] );

returns a smooth fit to the (noisy) data that is much closer to the data in the right half,
because of the much larger error weight there, except for the last data point, for which
the weight is zero.



csaps

ppl = csaps(X,y, [-4,ones(1,10),repmat(.2,1,10)], [1,
[ones(1,10), repmat(5,1,10), 0]);

uses the same data, smoothing parameter, and error weight but chooses the roughness
weight to be only .2 in the right half of the interval and gives, correspondingly, a rougher
but better fit there, except for the last data point, which is ignored.

A plot showing both examples for comparison can now be obtained by

fnplt(pp); hold on, fnplt(ppl,“r--"), plot(x,y, "ok"), hold off

title(["cubic smoothing spline, with right half treated *,...
“differently:"])

xlabel(["blue: larger error weights; -,
“"red dashed: also smaller roughness weights®])

The resulting plot is shown below.

cubic smoothing spline, with right half treated differently:
15 T T T T

-15 L L L L I I
0 1

blue: larger error weights; red dashed: also smaller roughness weights

Example 2. This bivariate example adds some uniform noise, from the interval

[-1/2 .. 1/2], to values of the MATLAB peaks function on a 51-by-61 uniform grid, obtain
smoothed values for these data from csaps, along with the smoothing parameters chosen
by csaps, and then plot these smoothed values.
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x = {linspace(-2,3,51),linspace(-3,3,61)};
[xx,yyl = ndgrid(x{1},x{2}); y = peaks(xx,yy);
rng(0), noisy = y+(rand(size(y))-.5);
[smooth,p] = csaps(x,noisy,[].X);
surf(x{1},x{2},smooth."), axis off

Note the need to transpose the array smooth. For a somewhat smoother approximation,
use a slightly smaller value of p than the one, .9998889, used above by csaps. The final
plot is obtained by the following:

smoother = csaps(x,noisy, -996,x);
figure, surf(x{1},x{2},smoother."), axis off
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Algorithms

csaps is an implementation of the Fortran routine SMOOTH from PGS.

The default value for p is determined as follows. The calculation of the smoothing spline
requires the solution of a linear system whose coefficient matrix has the form p*A + (1-
p)*B, with the matrices A and B depending on the data sites x. The default value of p
makes p*trace(A) equal (1-p)*trace(B).

See Also

csape | spap2 | spaps | tpaps
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cscvn

“Natural” or periodic interpolating cubic spline curve

Syntax

curve = cscvn(points)

Description

curve = cscvn(points) returns a parametric variational, or natural, cubic spline
curve (in ppform) passing through the given sequence points(;j), j = 1:end. The parameter
value £(j) for the jth point is chosen by Eugene Lee's [1] centripetal scheme, i.e., as
accumulated square root of chord length:

2\/||points(:,i +1)—points (:,i)|| 9

i<j

If the first and last point coincide (and there are no other repeated points), then a
periodic cubic spline curve is constructed. However, double points result in corners.

Examples

The following provides the plot of a questionable curve through some points (marked as
circles):

pointss[0 1 10 -1-100; 001210 -1 -2];

fnplt(cscvn(points)); hold on,
plot(points(l,:),points(2,:),"0"), hold off

Here is a closed curve, good for 14 February, with one double point:

c=fnplt(cscvn([0O .82 .92 0 0 -.92 -.82 0; .66 .9 0 ...
-.83 -.83 0 .9 .66])); Fill(c(1,:),c(2,:),"r"), axis equal



cscvn

Algorithms

The break sequence t is determined as
t = cumsum([O0; ((diff(points.*)."2)*ones(d,1)) -~(1/74)])-":

and csape (with either periodic or variational end conditions) is used to construct the
smooth pieces between double points (if any).

References

[1] E. T. Y. Lee. “Choosing nodes in parametric curve interpolation.” Computer-Aided
Design 21 (1989), 363-370.

See Also

csape | fnplt | getcurve
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datastats

Data statistics

Syntax

xds = datastats(x)
[xds,yds] = datastats(x,y)
Description

xds = datastats(X) returns statistics for the column vector X to the structure xds.
Fields in xds are listed in the table below.

Field Description

num The number of data values

max The maximum data value

min The minimum data value

mean The mean value of the data
median The median value of the data
range The range of the data

std The standard deviation of the data

[xds,yds] = datastats(X,Yy) returns statistics for the column vectors X and y to the
structures xds and yds, respectively. xds and yds contain the fields listed in the table
above. X and y must be of the same size.

Examples

Compute statistics for the census data in census.mat:

load census
[xds,yds] = datastats(cdate,pop)




datastats

xds =

num:
max:
min:
mean:
median:
range:
std:

yds =

num:
max:
min:
mean:
median:
range:
std:

See Also

excludedata, smooth

Tips

21
1990
1790
1890
1890
200
62.048

21
248.7
3.9
85.729
62.9
244 .8
78.601

If X or y contains complex values, only the real parts are used in computing the statistics.

Data containing Inf or NaN are processed using the usual MATLAB rules.

Introduced before R2006a
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dependnames

Dependent variable of cFit, sFit, or Fittype object

Syntax

dep = dependnames(fun)

Description

dep = dependnames(fun) returns the (single) dependent variable name of the cfit,
sfit, or Fittype object Fun as a 1-by-1 cell array of character vectors dep.

Examples

fl = fittype("a*x "2+b*exp(n*x)");
depl = dependnames(fl)
depl

y

2 = fittype("a*x "2+b*exp(n*x) ", "dependent”, "power");
dep2 = dependnames(f2)
dep2 =

"power*

See Also

indepnames | Fittype | formula

Introduced in R2006b
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differentiate

Differentiate cFit or sFit object

Syntax

fx = differentiate(FO, X)

[fx, xx] = differentiate(...)

[fx, fy] = differentiate(FO, X, Y)

[fx, fy] = differentiate(FO, [x, Y1)

[fx, Ty, fxx, fxy, fyy] = differentiate(FO, ...)

Description
For Curves

x = differentiate(FO, X) differentiates the cFit object FO at the points specified
by the vector X and returns the result in fx.

[fx, Txx] = differentiate(...) also returns the second derivative in Fxx.
All return arguments are the same size and shape as X.
For Surfaces

[fx, fy] = differentiate(FO, X, Y) differentiates the surface FO at the points
specified by X and Y and returns the result in X and fy.

FO is a surface fit (sFit) object generated by the Fit function.
X and Y must be double-precision arrays and the same size and shape as each other.

All return arguments are the same size and shape as X and Y.

If FO represents the surface z = f(x,y) , then FX contains the derivatives with respect to

x, that is, g , and FY contains the derivatives with respect to y, that is, Z—f .
X y
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[fx, fy] = differentiate(FO, [X, Yy]), where X and Y are column vectors, allows
you to specify the evaluation points as a single argument.

[fx, fy, xx, fxy, fyy] = differentiate(FO, ...) computes the first and
second derivatives of the surface fit object FO.

2
XX contains the second derivatives with respect to X, that is, 8—2 .
ox

~

O%f
oxdy

TXy contains the mixed second derivatives, that is,

o%f

Tyy contains the second derivatives with respect to y, that is, y .

Examples

For Curves

Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)";
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent
% Gaussian noise

ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype("a*sin(b*x)");
fitl = fit(xdata,ydata,f, "StartPoint",[1 1]);

Find the derivatives of the fit at the predictors:
[d1,d2] = differentiate(fitl,xdata);

Plot the data, the fit, and the derivatives:
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subplot(3,1,1)
plot(fitl,xdata,ydata) % cfit plot method
subplot(3,1,2)

plot(xdata,dl,"m") % double plot method

grid on
legend("1st derivative®)
subplot(3,1,3)

plot(xdata,d2,"c") % double plot method

grid on
legend("2nd derivative®)

=

6
4
2
]

2

i . + data
fitted curve
0 1 2 3 4 G 6 7

2nd derivative

__________________________________________________________

..........................................................

___________________

...................
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You can also compute and plot derivatives directly with the cFit plot method, as
follows:

plot(fitl,xdata,ydata,{"fit", "derivl”, "deriv2"})

The plot method, however, does not return data on the derivatives, unlike the
differentiate method.

For Surfaces
You can use the differentiate method to compute the gradients of a fit and then use

the quiver function to plot these gradients as arrows. The following example plots the
gradients over the top of a contour plot.

X = [0.64;0.95;0.21;0.71;0.24;0.12;0.61;0.45;0.46;...
0.66;0.77;0.35;0.66];

y = [0.42;0.84;0.83;0.26;0.61;0.58;0.54;0.87;0.26; ...
0.32;0.12;0.94;0.65];

z = [0.49;0.051;0.27;0.59;0.35;0.41;0.3;0.084;0.6; ...
0.58;0.37;0.19;0.19];

fo = fit( [x, yl, z, "poly32®, "normalize®, "on*" );

[xx, yyl = meshgrid( 0:0.04:1, 0:0.05:1 );
[fx, Ffy] = differentiate( fo, XX, yy );

plot( fo, "Style", "Contour” );
hold on

= quiver( xx, yy, fx, fy,
hold off
colormap( copper )

r*, "LineWidth", 2 );
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If you want to use derivatives in an optimization, you can, for example, implement an

objective function for fmincon as follows.

function [z, g, H] = objectiveWithHessian( xy )

% The input Xy represents a single evaluation point

z = f(xy);

if nargout > 1
[fx, Ffy, fxx, fxy, fyy] = differentiate( f, xy );
g = [fx, fyl;
H = [fxx, fxy; fxy, fyy]l:

end

end

Tips

For library models with closed forms, the toolbox calculates derivatives analytically. For
all other models, the toolbox calculates the first derivative using the centered difference

quotient
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df _ fx+ Ax)— f(x— Ax)
dx 2Ax

where x is the value at which the toolbox calculates the derivative, A% is a small number

(on the order of the cube root of eps), flx+Ax) is fun evaluated at * *A% and flx—xA)

is fun evaluated at ¥ —AX
The toolbox calculates the second derivative using the expression

d*f _ [+ A+ f(x—A0)=2f (x)
dx? (Ax)?

The toolbox calculates the mixed derivative for surfaces using the expression

ﬁ(x y): f(x+A’C,y+Ay)—f(x—A’Cay+Ay)—f(x+ A’C,y_Ay)-i'f(x—A’C,y_Ay)
oxdy 4AxAy

See Also

fit | plot | integrate

Introduced before R2006a
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excludedata

Exclude data from fit

Syntax

outliers = excludedata(xdata,ydata,MethodName ,MethodVvalue)

Description

outliers = excludedata(xdata,ydata,MethodName ,MethodValue) identifies
data to be excluded from a fit using the specified MethodName and MethodValue.
outliersis alogical vector, with 1 marking predictors (xdata) to exclude and O
marking predictors to include. Supported MethodName and MethodValue pairs are
given in the table below.

You can use the output outliers as an input to the Fit function in the Exclude
name-value pair argument. You can alternatively use the Exclude argument to specify
excluded data as:

1  An expression describing a logical vector, e.g., x > 10.

2 A vector of integers indexing the points you want to exclude, e.g., [1 10 25].

MethodName MethodValue

"box*" A four-element vector specifying the edges of a closed box in the xy-
plane, outside of which data is to be excluded from a fit. The vector
has the form [xmin xmax ymin ymax].

"domain*® A two-element vector specifying the endpoints of a closed interval
on the x-axis, outside of which data is to be excluded from a fit. The
vector has the form [xmin xmax].

"indices” A vector of indices specifying the data points to be excluded.

"range” A two-element vector specifying the endpoints of a closed interval
on the y-axis, outside of which data is to be excluded from a fit. The
vector has the form [ymin ymax].
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Examples

Load the vote counts and county names for the state of Florida from the 2000 U.S.
presidential election:

load flvote2k

Use the vote counts for the two major party candidates, Bush and Gore, as predictors for
the vote counts for third-party candidate Buchanan, and plot the scatters:

plot(bush,buchanan, "rs*)

hold on

plot(gore,buchanan, *bo")
legend("Bush data”", "Gore data")

3500 T 5 T R
O Bushdata
30001 o Gore data [|
2500 .
2000+ .
1500 F .
1000 - mie] i
O Q
]
so0l  S0fmED oo .
2 3 4
5
¥ 10
Assume a model where a fixed proportion of Bush or Gore voters choose to vote for
Buchanan:
f = Fittype({"x"})
f =

Linear model:
f(a,x) = a*x
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Exclude the data from absentee voters, who did not use the controversial “butterfly”
ballot:

absentee = find(strcmp(counties, "Absentee Ballots"));
nobutterfly = excludedata(bush,buchanan, ...
"indices" ,absentee);

Perform a bisquare weights robust fit of the model to the two data sets, excluding
absentee voters:

bushfit = fit(bush,buchanan,f, ...

"Exclude” ,nobutterfly, "Robust®,"on");
gorefit = fit(gore,buchanan,f, ...

"Exclude” ,nobutterfly, "Robust®,"on");

Robust fits give outliers a low weight, so large residuals from a robust fit can be used to
identify the outliers:

figure

plot(bushfit,bush,buchanan,"rs*, "residuals®)
hold on

plot(gorefit,gore,buchanan, *bo*, "residuals®)

3000 T T T

O o data
zeroline ||
2000 | o © daa
Zero line
1500 .

2500

1000 F .

5001 .

0

500 |
1000} 1

-1500 ' : :
0

5
10

The residuals in the plot above can be computed as follows:
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bushres
goreres

buchanan - feval(bushfit,bush);
buchanan - feval(gorefit,gore);

Large residuals can be identified as those outside the range [-500 500]:

bushoutliers = excludedata(bush,bushres, ...
"range”,[-500 500]);

goreoutliers = excludedata(gore,goreres, ...
"range”,[-500 500]);

The outliers for the two data sets correspond to the following counties:

counties(bushoutliers)
ans =

“Miami-Dade*

“Palm Beach*

counties(goreoutliers)
ans =
“"Broward*®
“Miami-Dade*
“Palm Beach*

Miami-Dade and Broward counties correspond to the largest predictor values. Palm
Beach county, the only county in the state to use the “butterfly” ballot, corresponds to the
largest residual values.

Tips

You can combine data exclusion rules using logical operators. For example, to exclude
data inside the box [-1 1 -1 1] or outside the domain [-2 2], use:

outliersl = excludedata(xdata,ydata, "box",[-1 1 -1 1]);
outliers2 = excludedata(xdata,ydata, "domain”®,[-2 2]);
outliers = ~outliersl]outliers2;

You can visualize the combined exclusion rule using random data:

xdata = -3 + 6*rand(1,1e4);

ydata = -3 + 6*rand(1,1le4);
plot(xdata(~outliers),ydata(~outliers),".")
axis ([-3 3 -3 3]

axis square
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See Also

fit | fitoptions

Introduced before R2006a
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feval

Evaluate cfit, sfit, or Fittype object

Syntax

y = feval (cfun,x)

z = feval (sfun, [Xx,y])

z = feval (sfun,x,y)

y = feval (ffun,coeffl,coeff2,...,x)

z = feval (ffun,coeffl,coeff2,...,X,y)
Description

You can use Feval to evaluate fits, but the following simpler syntax is recommended
to evaluate these objects, instead of calling Feval directly. You can treat fit objects as
functions and call Feval indirectly using the following syntax:

cfun(x) % cfit objects;

sfun(x,y) % sfit objects

sfun([x, yD) % sfit objects
Fffun(coefl,coef2,...,x) % curve fittype objects;
ffun(coefl,coef2,...,x,y) % surface fittype objects;

N N NX
o mnmnn

Alternatively, you can use the feval method to evaluate the estimated function,

either at your original data points, or at new locations. The latter is often referred to as
interpolation or prediction, depending on the type of model. You can also use feval to
extrapolate the estimated function's value at new locations that are not within the range
of the original data.

y = feval (cfun,Xx) evaluates the cFit object cfun at the predictor values in the
column vector X and returns the response values in the column vector y.

z = feval (sfun, [X,y]) evaluates the sFit object sfun at the predictor values in the
two column matrix [X,y] and returns the response values in the column vector z.

z = feval(sfun,Xx,y) evaluates the sFit object sfun at the predictor values in the
matrices X and y that must be the same size. It returns the response values in
the matrix z that will be the same size as x and y.
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y = feval (ffun,coeffl,coeff2, ..., Xx) assigns the coefficients coeffl, coeff2,
etc. to the Fittype object TFun, evaluates it at the predictor values in the column vector
X, and returns the response values in the column vector y. ¥fun cannot be a cFit object
in this syntax. To evaluate cFit objects, use the first syntax.

z = Teval (ffun,coeffl,coeff2,...,X,y) achieves a similar result for a fittype
object for a surface.

Examples
T = fittype("a*x"2+b*exp(n*x)");
c = cfFit(f,1,10.3,-1e2);
X = rand(2)
X =
0.0579 0.8132
0.3529 0.0099
yl = feval(f,1,10.3,-1e2,X)
yl =
0.0349 0.6612
0.1245 3.8422
yl = £(1,10.3,-1e2,X)
yl =
0.0349 0.6612
0.1245 3.8422
y2 = feval(c,X)
y2 =
0.0349
0.1245
0.6612
3.8422
y2 = c(X)
y2 =
0.0349
0.1245
0.6612
3.8422
See Also

fit | fittype | cfit
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Introduced before R2006a
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fit

Fit curve or surface to data

Syntax

fitobject = fit(x,y,FitType)

fitobject = fit([x,vy],z,fitType)
Ffitobject = fit(x,y,FitType,FitOptions)
fitobject = fit(x,y,FitType,Name,Value)

[Ffitobject,gof] = fit(X,y,FitType)
[fitobject,gof,output] = fit(x,y,FitType)

Description

Ffitobject = fit(Xx,y, FitType) creates the fit to the data in X and y with the model
specified by FitType.

fitobject = fit([x,y],z,FitType) creates a surface fit to the data in vectors X, y,
and z.

fitobject = fit(x,y,fitType, fitOptions) creates a fit to the data using the
algorithm options specified by the FitOptions object.

fitobject = fit(x,y,fitType,Name,Value) creates a fit to the data using the
library model FitType with additional options specified by one or more Name, Value
pair arguments. Use Fitoptions to display available property names and default values
for the specific library model.

[fitobject,gof] = Fit(x,y,FitType) returns goodness-of-fit statistics in the
structure gof.

[fitobject,gof,output] = Fit(x,y,FitType) returns fitting algorithm
information in the structure output.
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Examples

Fit a Quadratic Curve

Load some data, fit a quadratic curve to variables cdate and pop, and plot the fit and
data.

load census;
f=Fit(cdate,pop, "poly2")
plot(f,cdate,pop)

¥f =
Linear model Poly2:

f(X) = pl*x"2 + p2*x + p3
Coefficients (with 95% confidence bounds):

pl = 0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
p3 = 2.113e+04 (1.964e+04, 2.262e+04)
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For a list of library model names, see FitType.

Fit a Polynomial Surface

2000

Load some data and fit a polynomial surface of degree 2 in X and degree 3 in y. Plot the

fit and data.
load franke

st = fit([x, vy].,z, "poly237)
plot(sf,[x,y],2)

Linear model Poly23:

st(Xx,y) = p00 + pl0*x + p0l*y + p20*x"2 + pll*x*y + p02*y"N2 + p2l*x/"2*y
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pO0
p10
pO1
p20
pl1
p02
p21
pl12
p03

+ pl2*x*y"2 + p03*y"3
Coefficients (with 95% confidence bounds):

1.118
-0.0002941
1.533
-1.966e-08
0.0003427
-6.951
9.563e-08
-0.0004401
4.999

(0.9149, 1.321)
(-0.000502, -8.623e-05)
(0.7032, 2.364)
(-7.084e-08, 3.152e-08)
(-0.0001009, 0.0007863)
(-8.421, -5.481)
(6.276e-09, 1.85e-07)
(-0.0007082, -0.0001721)
(4.082, 5.917)
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Fit a Surface Using Variables in a MATLAB Table

Load the franke data and convert it to a MATLAB® table.

load franke
T = table(x,y,2);

Specify the variables in the table as inputs to the Fit function, and plot the fit.

f = fit([T.x, T.y],T.z, " linearinterp”);
plot( ¥, [T.x, T.y], T.z )
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Create Fit Options and Fit Type Before Fitting

Load and plot the data, create fit options and fit type using the Fittype and
Fitoptions functions, then create and plot the fit.

Load and plot the data in census._mat.

load census
plot(cdate,pop,“0")
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Create a fit options object and a fit type for the custom nonlinear model ¥ = alx — ‘;’]'”,
where a and b are coefficients and n is a problem-dependent parameter.

fo = fitoptions(“Method", "NonlinearLeastSquares”, ...
“Lower*,[0,0],---
"Upper”, [Inf,max(cdate)], - ..
“StartPoint",[1 1]);

ft = fittype("a*(x-b)”n", "problem®,"n", "options”,fo);

Fit the data using the fit options and a value of n = 2.

[curve2,gof2] = fit(cdate,pop,ft, “problem”,2)
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curve2 =

General model:
curve2(x) = a*(x-b)™n
Coefficients (with 95% confidence bounds):

a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)

Problem parameters:
n = 2

gof2 =
struct with fields:

sse: 246.1543
rsquare: 0.9980
dfe: 19
adjrsquare: 0.9979

rmse: 3.5994

Fit the data using the fit options and a value of n = 3.

[curve3,gof3] = fit(cdate,pop,ft,“problem”,3)

curve3 =

General model:
curve3(x) = a*(x-b)™n
Coefficients (with 95% confidence bounds):

a = 1.359e-05 (1.245e-05, 1.474e-05)
b = 1725 (1718, 1731)

Problem parameters:
n = 3

gof3 =
struct with fields:

sse: 232.0058
rsquare: 0.9981
dfe: 19
adjrsquare: 0.9980

rmse: 3.4944
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Plot the fit results with the data.

hold on

plot(curve2,"m")
plot(curve3,“c")
legend("Data®,"n=2","n=3")
hold off

300 T T T T

250

200

= 150

100

S0

1750 1800 1850 1900 1950

Fit a Cubic Polynomial Specifying Normalize and Robust Options

2000

Load some data and fit and plot a cubic polynomial with center and scale (Normalize)

and robust fitting options.
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load census;
f=Fit(cdate,pop, "poly3", "Normalize","on","Robust”, "Bisquare®)
plot(Ff,cdate,pop)

Linear model Poly3:
F(X) = pl*x"3 + p2*x"2 + p3*x + p4d

where x is normalized by mean 1890 and std 62.05
Coefficients (with 95% confidence bounds):

pl = -0.4619 (-1.895, 0.9707)
p2 = 25.01 (23.79, 26.22)
p3 = 77.03 (74.37, 79.7)
p4 = 62.81 (61.26, 64.37)
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Fit a Curve Defined by a File
Define a function in a file and use it to create a fit type and fit a curve.

Define a function in a MATLAB file.

function y = piecewiselLine(x,a,b,c,d,k)
% PIECEWISELINE A line made of two pieces
% that is not continuous.

y = zeros(size(X)):

% This example includes a for-loop and if statement
t purely for example purposes.

X
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for 1 = 1:length(x)

if x(i) < k,
y(i) = a + b.* x(i);
else
y(i) = c + d.* x(i);
end
end
end
Save the file.

Define some data, create a fit type specifying the function piecewiseLine, create a fit
using the fit type Ft, and plot the results.

x = [0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;...
0.96;0.96;0.16;0.97;0.96] ;

y = [0.17;0.12;0.16;0.0035;0.37;0.082;0.34;0.56; ...
0.15;-0.046;0.17;-0.091;-0.071];

ft = fittype( “piecewiseLine( x, a, b, c, d, k)" )
f = fit( x, y, ft, "StartPoint*, [1, 0, 1, O, 0.5] )

plot( ¥, x, y )
Exclude Points from Fit
Load some data and fit a custom equation specifying points to exclude. Plot the results.

Load data and define a custom equation and some start points.
[x, y]l = titanium;

gausskgn = "a*exp(-((x-b)/c)"2)+d"

startPoints = [1.5 900 10 0.6]

gausskEqgn =

"a*exp(-((x-b)/c)"2)+d"

startPoints =

1.5000 900.0000 10.0000 0.6000
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Create two fits using the custom equation and start points, and define two different sets
of excluded points, using an index vector and an expression. Use Exclude to remove
outliers from your fit.

fl = fit(x",y",gaussEqn, "Start”, startPoints, "Exclude”, [1 10 25])
f2 = fit(x",y",gaussEqn, "Start”, startPoints, "Exclude”, x < 800)
fl =
General model:
T1(x) = a*exp(-((x-b)/c)"2)+d
Coefficients (with 95% confidence bounds):
a= 1.493 (1.432, 1.554)
b = 897.4 (896.5, 898.3)
c = 27.9 (26.55, 29.25)
d = 0.6519 (0.6367, 0.6672)
f2 =
General model:
T2(x) = a*exp(-((x-b)/c)"2)+d
Coefficients (with 95% confidence bounds):
a= 1.494 (1.41, 1.578)
b = 897.4 (896.2, 898.7)
c = 28.15 (26.22, 30.09)
d = 0.6466 (0.6169, 0.6764)
Plot both fits.
plot(fl,x,y)
title("Fit with data points 1, 10, and 25 excluded®)
figure
plot(f2,x,y)

title("Fit with data points excluded such that x < 800%)
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Fit with data points 1, 10, and 2

5 excluded
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Exclude Points and Plot Fit Showing Excluded Data

You can define the excluded points as variables before supplying them as inputs to the fit

function. The following steps recreate the fits in the previous example and allow you to
plot the excluded points as well as the data and the fit.

Load data and define a custom equation and some start points.

[x, y] = titanium;

gaussEgn = "a*exp(-((x-b)/c)”2)+d*
startPoints = [1.5 900 10 0.6]
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gaussEqgn =

"a*exp(-((x-b)/c)"2)+d*

startPoints =

1.5000 900.0000 10.0000 0.6000

Define two sets of points to exclude, using an index vector and an expression.

excludel
exclude2

[1 10 25];
X < 800;

Create two fits using the custom equation, startpoints, and the two different excluded
points.

Tl
2

fit(x",y",gaussEqgn, "Start”, startPoints, "Exclude”, excludel);
fit(x",y",gaussEqgn, "Start”, startPoints, "Exclude®, exclude2);

Plot both fits and highlight the excluded data.

plot(fl,x,y,excludel)
title("Fit with data points 1, 10, and 25 excluded®)

figure;
plot(f2,x,y,exclude2)
title("Fit with data points excluded such that x < 800%)
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Fit with data points excluded such that x < 800
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For a surface fitting example with excluded points, load some surface data and create
and plot fits specifying excluded data.

load franke

fl = fit([x y]l,z, "poly23", "Exclude”, [1 10 25]);

2 = fit([x y]l,z, "poly23®, "Exclude®, z > 1);

figure

plot(fl, [x y], z, "Exclude”, [1 10 25]);

title("Fit with data points 1, 10, and 25 excluded®)
figure

plot(f2, [x yl, z, "Exclude”, z > 1);

title("Fit with data points excluded such that z > 1)
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Fit with data points excluded such thatz > 1

1.5 ~

Fit @ Smoothing Spline Curve and Return Goodness-of-Fit Information

Load some data and fit a smoothing spline curve through variables month and
pressure, and return goodness of fit information and the output structure. Plot the fit
and the residuals against the data.

load enso;

[curve, goodness, output] = Ffit(month,pressure, "smoothingspline®);
plot(curve,month,pressure);

xlabel ("Month®);

ylabel ("Pressure®);
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Plot the residuals against the x-data (month).
plot( curve, month, pressure, "residuals”® )

xlabel ( "Month® )
ylabel ( "Residuals® )

180
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Use the data in the output structure to plot the residuals against the y-data
(pressure).
plot( pressure, output.residuals, “." )

xlabel ( "Pressure® )
ylabel ( "Residuals® )
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Fit a Single-Term Exponential

Generate data with an exponential trend, and then fit the data using the first equation
in the curve fitting library of exponential models (a single-term exponential). Plot the
results.

x = (0:0.2:5)";

y = 2*exp(-0.2*x) + 0.5*randn(size(x));
f = fit(x,y,"expl”);

plot(f,x.,y)
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Fit a Custom Model Using an Anonymous Function

You can use anonymous functions to make it easier to pass other data into the Fit
function.

Load data and set Emax to 1 before defining your anonymous function:

data = importdata( “OpioidHypnoticSynergy.txt® );

Propofol = data.data(:,1);
Remifentanil = data.data(:,2);
Algometry = data.data(:,3);
Emax = 1;

Define the model equation as an anonymous function:
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Effect = @(IC50A, IC50B, alpha, n, x, y) -
Emax*( x/IC50A + y/I1C50B + alpha*( x/IC50A )--
.* (y/IC50B ) ).~ ./(( x/1C50A + y/IC50B + ...
alpha*( X/1C50A ) .* ( y/IC50B ) ).~ + 1);

Use the anonymous function Effect as an input to the fit function, and plot the
results:
AlgometryEffect = fit( [Propofol, Remifentanil], Algometry, Effect,
"StartPoint", [2, 10, 1, 0.8],
"Lower®, [-Inf, -Inf, -5, -Inf],
"Robust®, "LAR" )
plot( AlgometryEffect, [Propofol, Remifentanil], Algometry )

For more examples using anonymous functions and other custom models for fitting, see
the Fittype function.

Find Coefficient Order to Set Start Points and Bounds

For the properties Upper, Lower, and StartPoint, you need to find the order of the
entries for coefficients.

Create a fit type.
ft = fittype("b*x"2+c*x+a");
Get the coefficient names and order using the coeffnames function.

coeffnames(ft)

ans =

3x1 cell array

Note that this is different from the order of the coefficients in the expression used to
create Ft with Fittype.

Load data, create a fit and set the start points.
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load enso
Ffit(month,pressure, ft, "StartPoint”,[1,3,5])

ans =

General model:
ans(x) = b*x"2+c*x+a
Coefficients (with 95% confidence bounds):

a = 10.94 (9.362, 12.52)
b = 0.0001677 (-7.985e-05, 0.0004153)
c = -0.0224 (-0.06559, 0.02079)

This assigns initial values to the coefficients as follows:a = 1,b = 3,¢c = 5.

Alternatively, you can get the fit options and set start points and lower bounds, then refit
using the new options.

options = fitoptions(ft)
options.StartPoint = [10 1 3];
options.Lower = [0 -Inf 0];
fit(month,pressure, ft,options)

options =

Normalize: "off~
Exclude: []
Weights: []
Method: “NonlinearLeastSquares”
Robust: "Off"
StartPoint: [1x0 double]
Lower: [1x0 double]
Upper: [1x0 double]
Algorithm: "Trust-Region®
DiffMinChange: 1.0000e-08
DiffMaxChange: 0.1000
Display: "Notify"
MaxFunEvals: 600
Maxlter: 400
TolFun: 1.0000e-06
TolX: 1.0000e-06

ans =
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General model:
ans(x) = b*x"2+c*x+a
Coefficients (with 95% confidence bounds):

a = 10.23 (9.448, 11.01)
b = 4.335e-05 (-1.82e-05, 0.0001049)
c = 5.523e-12 (Fixed at bound)

. “Fit Postprocessing”

. “List of Library Models for Curve and Surface Fitting” on page 4-13
. “Custom Models” on page 5-2

Input Arguments

x — Data to fit
matrix

Data to fit, specified as a matrix with either one (curve fitting) or two (surface fitting)
columns. You can specify variables in a MATLAB table using tablename.varname.
Cannot contain Inf or NaN. Only the real parts of complex data are used in the fit.

Example: X
Example: [X,VY]
Data Types: double

y — Data to fit
vector

Data to fit, specified as a column vector with the same number of rows as X. You can
specify a variable in a MATLAB table using tablename.varname. Cannot contain Inf
or NaN. Only the real parts of complex data are used in the fit.

Use prepareCurveData or prepareSurfaceData if your data is not in column vector
form.

Data Types: double

z — Data to fit
vector
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Data to fit, specified as a column vector with the same number of rows as X. You can
specify a variable in a MATLAB table using tablename.varname. Cannot contain Inf
or NaN. Only the real parts of complex data are used in the fit.

Use prepareSurfaceData if your data is not in column vector form. For example, if
you have 3 matrices, or if your data is in grid vector form, where length(X) = n,
length(Y) = mandsize(Z2) = [m,n].

Data Types: double

fitType — Model type to fit

character vector | cell array of character vectors | anonymous function | Fittype

Model type to fit, specified as a library model name character vector, a MATLAB
expression, a cell array of linear models terms, an anonymous function, or a fittype
constructed with the Fittype function. You can use any of the valid first inputs to
Fittype as an input to Fit.

For a list of library model names, see “Model Names and Equations” on page 4-14. This
table shows some common examples.

Library Model Name Description

"polyl- Linear polynomial curve
"polyll* Linear polynomial surface
"poly2* Quadratic polynomial curve
"linearinterp” Piecewise linear interpolation
"cubicinterp” Piecewise cubic interpolation

"smoothingspline* Smoothing spline (curve)

"lowess*” Local linear regression (surface)

To fit custom models, use a MATLAB expression, a cell array of linear model terms, an
anonymous function, or create a Fittype with the Fittype function and use this as
the FitType argument. For an example, see “Fit a Custom Model Using an Anonymous
Function” on page 12-82. For examples of linear model terms, see the FitType
function.

Example: 'poly2'

fitOptions — Algorithm options
fitoptions
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Algorithm options constructed using the Fitoptions function. This is an alternative to
specifying name-value pair arguments for fit options.

Name-Value Pair Arguments

Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside single
quotes (* 7). You can specify several name and value pair arguments in any order as
Namel,Valuel, ... ,NameN,ValueN.

Example: "Lower®,[0,0], "Upper”, [Inf,max(x)], "StartPoint”,[1 1] specifies
fitting method, bounds, and start points.

Options for All Fitting Methods

"Normalize" — Option to center and scale data
"off" (default) | "on*

Option to center and scale the data, specified as the comma-separated pair consisting of
"Normalize" and "on” or "off".
Data Types: char

"Exclude” — Points to exclude from fit
expression | index vector | logical vector | empty

Points to exclude from the fit, specified as the comma-separated pair consisting of
"Exclude” and one of:

+ An expression describing a logical vector, e.g., X > 10.
+ A vector of integers indexing the points you want to exclude, e.g., [1 10 25].

+ A logical vector for all data points where true represents an outlier, created by
excludedata.

For an example, see “Exclude Points from Fit” on page 12-70.

Data Types: logical | double

"Weights"™ — Weights for fit
[] (default) | vector
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Weights for the fit, specified as the comma-separated pair consisting of *"Weights® and a
vector the same size as the response data y (curves) or z (surfaces).

Data Types: double

"problem” — Values to assign to problem-dependent constants
cell array | double

Values to assign to the problem-dependent constants, specified as the comma-separated
pair consisting of "problem® and a cell array with one element per problem dependent
constant. For details, see Fittype.

Data Types: cell | double

Smoothing Options

"SmoothingParam® — Smoothing parameter
scalar value in the range (0,1)

Smoothing parameter, specified as the comma-separated pair consisting of
"SmoothingParam” and a scalar value between 0 and 1. The default value depends on
the data set. Only available if the fit type is smoothingspline.

Data Types: double

"Span™ — Proportion of data points to use in local regressions
0.25 (default) | scalar value in the range (0,1)

Proportion of data points to use in local regressions, specified as the comma-separated

pair consisting of "Span® and a scalar value between 0 and 1. Only available if the fit
type is lowess or loess.

Data Types: double
Linear and Nonlinear Least-Squares Options

"Robust™ — Robust linear least-squares fitting method
"off" (default) | LAR | Bisquare

Robust linear least-squares fitting method, specified as the comma-separated pair
consisting of "Robust” and one of these values:
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*  "LAR" specifies the least absolute residual method.

+ "Bisquare” specifies the bisquare weights method.

Available when the fit type Method is LinearLeastSquares or
NonlinearLeastSquares.

Data Types: char

"Lower" — Lower bounds on coefficients to be fitted
[] (default) | vector

Lower bounds on the coefficients to be fitted, specified as the comma-separated pair
consisting of "Lower® and a vector. The default value is an empty vector, indicating that
the fit is unconstrained by lower bounds. If bounds are specified, the vector length must
equal the number of coefficients. Find the order of the entries for coefficients in the vector
value by using the coeffnames function. For an example, see “Find Coefficient Order to
Set Start Points and Bounds” on page 12-83. Individual unconstrained lower bounds

can be specified by - InT.

Available when the Method is LinearLeastSquares or NonlinearLeastSquares.

Data Types: double

"Upper™ — Upper bounds on coefficients to be fitted
[] (default) | vector

Upper bounds on the coefficients to be fitted, specified as the comma-separated pair
consisting of "Upper ™ and a vector. The default value is an empty vector, indicating that
the fit is unconstrained by upper bounds. If bounds are specified, the vector length must
equal the number of coefficients. Find the order of the entries for coefficients in the vector
value by using the coeffnames function. For an example, see “Find Coefficient Order to
Set Start Points and Bounds” on page 12-83. Individual unconstrained upper bounds

can be specified by +InT.

Available when the Method is LinearLeastSquares or NonlinearLeastSquares.

Data Types: logical

Nonlinear Least-Squares Options

"StartPoint" — Initial values for the coefficients
[] (default) | vector
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Initial values for the coefficients, specified as the comma-separated pair consisting of
"StartPoint” and a vector. Find the order of the entries for coefficients in the vector
value by using the coeffnames function. For an example, see “Find Coefficient Order to
Set Start Points and Bounds” on page 12-83.

If no start points (the default value of an empty vector) are passed to the Fit function,
starting points for some library models are determined heuristically. For rational and
Weibull models, and all custom nonlinear models, the toolbox selects default initial
values for coefficients uniformly at random from the interval (0,1). As a result, multiple
fits using the same data and model might lead to different fitted coefficients. To avoid
this, specify initial values for coefficients with a Fitoptions object or a vector value for
the StartPoint value.

Available when the Method is Nonl inearLeastSquares.
Data Types: double

"Algorithm® — Algorithm to use for fitting procedure
'Levenberg-Marquardt' (default) | "Trust-Region'

Algorithm to use for the fitting procedure, specified as the comma-separated pair
consisting of "Algorithm® and either "Levenberg-Marquardt® or "Trust-Region”.

Available when the Method is NonlinearLeastSquares.
Data Types: char

"DiffMaxChange™ — Maximum change in coefficients for finite difference gradients
0.1 (default)

Maximum change in coefficients for finite difference gradients, specified as the comma-
separated pair consisting of "DiffMaxChange” and a scalar.

Available when the Method is Nonl inearLeastSquares.
Data Types: double

"DiffMinChange” — Minimum change in coefficients for finite difference gradients
107° (default)

Minimum change in coefficients for finite difference gradients, specified as the comma-
separated pair consisting of "DiffMinChange” and a scalar.

Available when the Method is Nonl inearLeastSquares.
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Data Types: double

"Display” — Display option in Command Window
"notify" (default) | "final® | "iter" | "off"

Display option in the command window, specified as the comma-separated pair
consisting of "Display” and one of these options:

+ "notify" displays output only if the fit does not converge.
+ "final” displays only the final output.

+  T"iter" displays output at each iteration.

+  "off" displays no output.

Available when the Method is Nonl inearLeastSquares.

Data Types: char

"MaxFunEvals®" — Maximum number of evaluations of model allowed
600 (default)

Maximum number of evaluations of the model allowed, specified as the comma-separated
pair consisting of "MaxFunEvals™ and a scalar.

Available when the Method is Nonl inearLeastSquares.

Data Types: double

"Maxlter” — Maximum number of iterations allowed for fit
400 (default)

Maximum number of iterations allowed for the fit, specified as the comma-separated pair
consisting of "Maxlter® and a scalar.

Available when the Method is Nonl inearLeastSquares.

Data Types: double

*TolFun™ — Termination tolerance on model value
107 (default)

Termination tolerance on the model value, specified as the comma-separated pair
consisting of "TolFun® and a scalar.
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Available when the Method is Nonl inearLeastSquares.

Data Types: double

*TolX" — Termination tolerance on coefficient values
107° (default)

Termination tolerance on the coefficient values, specified as the comma-separated pair
consisting of "TolX" and a scalar.

Available when the Method is Nonl inearLeastSquares.

Data Types: double

Output Arguments

fitobject — Fit result
cfit | sTit

Fit result, returned as a cFit (for curves) or sFit (for surfaces) object. See “Fit
Postprocessing” for functions for plotting, evaluating, calculating confidence intervals,
integrating, differentiating, or modifying your fit object.

gof — Goodness-of-fit statistics
gof structure |

Goodness-of-fit statistics, returned as the goF structure including the fields in this table.

Field Value

sse Sum of squares due to error

rsquare R-squared (coefficient of determination)

dfe Degrees of freedom in the error

adjrsquare Degree-of-freedom adjusted coefficient of
determination

rmse Root mean squared error (standard error)

output — Fitting algorithm information
output structure




fit

Fitting algorithm information, returned as the output structure containing information
associated with the fitting algorithm.

Fields depend on the algorithm. For example, the output structure for nonlinear least-
squares algorithms includes the fields shown in this table.

Field Value

numobs Number of observations (response values)

numparam Number of unknown parameters (coefficients) to fit
residuals Vector of residuals

Jacobian Jacobian matrix

exitflag Describes the exit condition of the algorithm. Positive flags

indicate convergence, within tolerances. Zero flags indicate
that the maximum number of function evaluations or
iterations was exceeded. Negative flags indicate that the
algorithm did not converge to a solution.

iterations Number of iterations
funcCount Number of function evaluations
firstorderopt Measure of first-order optimality (absolute maximum of

gradient components)

algorithm Fitting algorithm employed

See Also

See Also

Apps
Curve Fitting

Functions
confint | feval | Fitoptions | fittype | plot | prepareCurveData |
prepareSurfaceData

Topics
“Fit Postprocessing”
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“List of Library Models for Curve and Surface Fitting” on page 4-13
“Custom Models” on page 5-2
“Parametric Fitting” on page 4-2

Introduced before R2006a
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fitoptions

Create or modify fit options object

Syntax
fitOptions = fitoptions

FfitOptions = Fitoptions(libraryModelName)
FfitOptions = Fitoptions(libraryModelName,Name,Value)

FfitOptions = fitoptions(fitType)
FfitOptions = Fitoptions(Name,Value)

newOptions = fitoptions(FitOptions,Name,Value)
newOptions = Ffitoptions(optionsl,options?2)

Description
fitOptions = Ffitoptions creates the default fit options object FitOptions.

fitOptions = fitoptions(libraryModelName) creates the default fit options
object for the library model.

fitOptions = fitoptions(libraryModelName,Name,Value) creates fit options for
the specified library model with additional options specified by one or more Name,Value
pair arguments.

fitOptions = fitoptions(FitType) gets the fit options object for the specified
FitType. Use this syntax to work with fit options for custom models.

fitOptions = Fitoptions(Name,Value) creates fit options with additional options
specified by one or more Name, Value pair arguments.

newOptions = fitoptions(FitOptions,Name,Value) modifies the existing fit
options object FitOptions and returns updated fit options in newOptions with new
options specified by one or more Name, Value pair arguments.

newOptions = fitoptions(optionsl,options2) combines the existing fit options
objects optionsl and options2 in newOptions.
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+ If Method agrees, the nonempty values for the properties in options2 override the
corresponding values in optionsl in newOptions.

+ If Method differs, newOptions contains the optionsl value for Method and values
from options2 for Normalize, Exclude, and Weights.

Examples

Modify Default Fit Options to Normalize Data

Create the default fit options object and set the option to center and scale the data before
fitting.

options = fitoptions;
options.Normal = “on

options =

Normalize: "on*®
Exclude: [1x0 double]
Weights: [1x0 double]

Method: "None*

Create Default Fit Options for Gaussian Fit

options = fitoptions(“gauss2®)

options

Normalize: "off~
Exclude: []
Weights: []
Method: “NonlinearLeastSquares”
Robust: "Off"
StartPoint: [1x0 double]
Lower: [-Inf -Inf O -Inf -Inf 0]
Upper: [1x0 double]

Algorithm: "Trust-Region®
DiffMinChange: 1.0000e-08
DiffMaxChange: 0.1000

Display: "Notify*
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MaxFunEvals: 600

Maxlter: 400
TolFun: 1.0000e-06
TolX: 1.0000e-06

Set Polynomial Fit Options

Create fit options for a cubic polynomial and set center and scale and robust fitting

options.

options =

options

Normalize:
Exclude:
Weights:

Method:
Robust:
Lower:
Upper:

fitoptions("poly3®, "Normalize®,

"on", "Robust®, "Bisquare-)

“on®
L1
[1

"LinearlLeastSquares*
"Bisquare”

[1x0 double]

[1x0 double]

Create Fit Options for Linear Least Squares

options =

options =

Normalize:
Exclude:
Weights:

Method:
Robust:
Lower :
Upper:

fitoptions(“Method®, "LinearLeastSquares®)

"off"
L1
[1

"LinearLeastSquares*
"Off*

[1x0 double]

[1x0 double]

Use Identical Fit Options in Multiple Fits

Modifying the default fit options object is useful when you want to set the Normalize,
Exclude, or Weights properties, and then fit your data using the same options with
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different fitting methods. For example, the following uses the same fit options to fit
different library model types.

load census
options = fitoptions;
options.Normalize = "on~;

fl = fit(cdate,pop, "poly3”,options);

2 = fit(cdate,pop, "expl”,options);

3 = fit(cdate,pop, "cubicspline”,options)
f3 =

Cubic interpolating spline:
f3(x) = piecewise polynomial computed from p
where x is normalized by mean 1890 and std 62.05
Coefficients:
p = coefficient structure

Find and Change the Smoothing Fit Option

Find the smoothing parameter. Data-dependent fit options such as the smooth
parameter are returned in the third output argument of the Fit function.

load census

[f,gof,out] = fit(cdate,pop, “SmoothingSpline™);
smoothparam = out.p
smoothparam =

0.0089

Modify the default smoothing parameter for a new fit.

options = fitoptions(“Method®, "SmoothingSpline®, ...
“SmoothingParam®,0.0098);

[f.,gof,out] = fit(cdate,pop, "SmoothingSpline”,options);

Apply Coefficient Bounds to Improve Gaussian Fit

Create a Gaussian fit, inspect the confidence intervals, and specify lower bound fit
options to help the algorithm.
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Create a noisy sum of two Gaussian peaks, one with a small width, and one with a large

width.
al = 1; bl = -1; c1 = 0.05;
a2 = 1; b2 = 1; c2 = 50;

x = (-10:0.02:10)";
gdata = al*exp(-((x-bl)/cl)."2) + ...
a2*exp(-((x-b2)/c2) .~"2) + ...
0.1*(rand(size(x))-.5);

plot(x,gdata)

2.2

1.8

1.6

1.4

1.2

0.8

I A A

0 B8 6 4 2

Fit the data using the two-term Gaussian library model.

gfit = fit(x,gdata, "gauss2”)
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95% confidence bounds):

(-1.486, 1.195)
(-14.71, 34.15)
(-15.84, 30.07)
(-1.958e+04, 1.961e+04)
(-3.194e+05, 3.206e+05)

plot(gfit,x,gdata)
gfit =
General model Gauss2:
gfit(x) =
Coefficients (with
al = -0.145
bl = 9.725
cl = 7.117
a2 = 14.06
b2 = 607.1
c2 = 376

(-9.738e+04, 9.814e+04)

al*exp(-((x-b1)/c1)"2) + a2*exp(-((x-b2)/c2)"2)

2.2

181

141

data
fitted curve
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The algorithm is having difficulty, as indicated by the wide confidence intervals for

several coefficients.

To help the algorithm, specify lower bounds for the nonnegative amplitudes al and a2

and widths c1, c2.
options = fitoptions(“gauss2®, "Lower”, [0 -Inf O O -Inf O0]);

Alternatively, you can set properties of the fit options using the form
options.Property = NewPropertyValue.

options = fitoptions(“gauss27);
options.Lower = [0 -InfF 0 O -Inf 0];

Recompute the fit using the bound constraints on the coefficients.
gfit = fit(x,gdata, "gauss2”,options)
plot(gfit,x,gdata)
gfit =
General model Gauss2:

gfit(x) = al*exp(-((x-b1l)/c1)"2) + a2*exp(-((x-b2)/c2)"2)
Coefficients (with 95% confidence bounds):

al = 1.005 (0.966, 1.044)
bl = -1 (-1.002, -0.9988)
cl = 0.0491 (0.0469, 0.0513)
a2 = 0.9985 (0.9958, 1.001)
b2 = 0.8059 (0.3879, 1.224)
c2 = 50.6 (46.68, 54.52)
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22 T T T T T T T T T
+ data
. fitted curve

2 - -
1871 i
161 i

=

14 -

This is a much better fit. You can further improve the fit by assigning reasonable values
to other properties in the fit options object.

Copy and Combine Fit Options

Create fit options and set lower bounds.

options = fitoptions(“gauss2®, “Lower”, [0 -Inf O O -Inf 0])
options =

Normalize: "off"
Exclude: []
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Weights:
Method:
Robust:

StartPoint:
Lower:

Upper:
Algorithm:
DiffMinChange:
DiffMaxChange:
Display:
MaxFunEvals:

Maxlter:
TolFun:

TolX:

Make a new copy of the fit options and modify the robust parameter.

[1

"NonlinearLeastSquares*
"Off"

[1x0 double]

[0 -Inf O O -Inf O]
[1x0 double]
"Trust-Region®
1.0000e-08

0.1000

"Notify"

600

400

1.0000e-06
1.0000e-06

newoptions = fitoptions(options, “Robust®,"Bisquare-®)

newoptions

Normalize:
Exclude:
Weights:

Method:
Robust:
StartPoint:
Lower:

Upper:
Algorithm:
DiffMinChange:
DiffMaxChange:
Display:
MaxFunEvals:
Maxlter:
TolFun:

TolX:

Combine fit options.

"off"
]
1

“"NonlinearLeastSquares*
"Bisquare*®

[1x0 double]

[0 -Inf O O -Inf O]
[1x0 double]
"Trust-Region®
1.0000e-08

0.1000

"Notify*

600

400

1.0000e-06
1.0000e-06

options2 = fitoptions(options, newoptions)
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options2 =

Normalize:
Exclude:
Weights:

Method:
Robust:
StartPoint:
Lower:

Upper:
Algorithm:
DiffMinChange:
DiffMaxChange:
Display:
MaxFunEvals:
Maxlter:
TolFun:

TolX:

"off"
]
1

“"NonlinearLeastSquares*
"Bisquare*

[1x0 double]

[0 -Inf O O -Inf O]
[1x0 double]
"Trust-Region®
1.0000e-08

0.1000

"Notify*

600

400

1.0000e-06
1.0000e-06

Change Custom Model Fit Options

Create a linear model fit type.

Ift =

Ift =

Linear model:

Fittype({"x",

"sSinCO", "1}

Ift(a,b,c,x) = a*x + b*sin(xX) + ¢

Get the fit options for the fit type 1Ft.

fo = fitoptions(Ift)
fo =
Normalize: "off~
Exclude: []
Weights: []
Method: “LinearLeastSquares”

Robust:
Lower:
Upper:
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Set the normalize fit option.

fo.Normalize = "on”

fo =

Normalize: “on*
Exclude: []
Weights: []
Method: “LinearLeastSquares”
Robust: “Off*
Lower: [1x0 double]
Upper: [1x0 double]

. “Specifying Fit Options and Optimized Starting Points” on page 4-6
. “Fit Postprocessing”
. “List of Library Models for Curve and Surface Fitting” on page 4-13

Input Arguments

libraryModelName — Library model to fit
character vector

Library model to fit, specified as a character vector. This table shows some common
examples.

Library Model Name Description

"polyl* Linear polynomial curve
"polyl1l* Linear polynomial surface
"poly2* Quadratic polynomial curve
"linearinterp” Piecewise linear interpolation
"cubicinterp” Piecewise cubic interpolation
"smoothingspline” Smoothing spline (curve)
"lowess*” Local linear regression (surface)
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For a list of library model names, see “Model Names and Equations” on page 4-14.
Example: "poly2*
Data Types: char

fitType — Model type to fit
fittype

Model type to fit, specified as a Fittype constructed with the Fittype function. Use
this to work with fit options for custom models.

fitOptions — Algorithm options
fitoptions

Algorithm options, specified as a Fitoptions object created using the Fitoptions
function.

optionsl — Algorithm options to combine
fitoptions

Algorithm options to combine, constructed using the Fitoptions function.

options2 — Algorithm options to combine
fitoptions

Algorithm options to combine, constructed using the Fitoptions function.

Name-Value Pair Arguments

Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside single
quotes (" 7). You can specify several name and value pair arguments in any order as
Namel,Valuel, ... ,NameN,ValueN.

Example: "Method*" , "NonlinearLeastSquares”, “"Lower*",[0,0], “Upper"-,
[Inf,max(x)], "Startpoint®,[1 1] specifies fitting method, bounds, and start
points.

Options for All Fitting Methods

"Normalize" — Option to center and scale data
"off" (default) | "on*
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Option to center and scale the data, specified as the comma-separated pair consisting of
"Normalize" and "on" or "off".

Data Types: char

"Exclude” — Points to exclude from fit
expression | index vector | logical vector | empty

Points to exclude from the fit, specified as the comma-separated pair consisting of

"Exclude” and one of:

* An expression describing a logical vector, e.g., X > 10.

+ A vector of integers indexing the points you want to exclude, e.g., [1 10 25].

* Alogical vector for all data points where true represents an outlier, created by
excludedata.

For examples, see Fit.

"Weights™ — Weights for fit
[ ] (default) | vector

Weights for the fit, specified as the comma-separated pair consisting of "Weights"® and a
vector the same size as number of data points.
Data Types: double

"Method" — Fitting method
"None" (default) | character vector

Fitting method, specified as the comma-separated pair consisting of "Method" and one of
the fitting methods in this table.

Fitting Method Description
"Nearestinterpolant*® Nearest neighbor interpolation
"Linearinterpolant” Linear interpolation
"Pchiplnterpolant*® Piecewise cubic Hermite interpolation
(curves only)
"CubicSplinelnterpolant” Cubic spline interpolation
"Biharmoniclnterpolant™ Biharmonic surface interpolation
"SmoothingSpline* Smoothing spline
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Fitting Method Description

"LowessFit” Lowess smoothing (surfaces only)
"LinearLeastSquares” Linear least squares
"NonlinearLeastSquares*” Nonlinear least squares

Data Types: char

Smoothing Options

"SmoothingParam™ — Smoothing parameter
scalar value in the range (0,1)

Smoothing parameter, specified as the comma-separated pair consisting of
"SmoothingParam” and a scalar value between 0 and 1. The default value depends on
the data set. Only available if the Method is SmoothingSpline.

Data Types: double

"Span™ — Proportion of data points to use in local regressions
0.25 (default) | scalar value in the range (0,1)

Proportion of data points to use in local regressions, specified as the comma-separated
pair consisting of "Span” and a scalar value between 0 and 1. Only available if the
Method is LowessFit.

Data Types: double

Linear and Nonlinear Least-Squares Options

"Robust” — Robust linear least-squares fitting method
"off" (default) | "LAR" | "Bisquare”

Robust linear least-squares fitting method, specified as the comma-separated pair
consisting of "Robust” and one of these values:

*  "LAR" specifies the least absolute residual method.

+ "Bisquare” specifies the bisquare weights method.

Available when the Method is LinearLeastSquares or NonlinearLeastSquares.
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Data Types: char

"Lower"™ — Lower bounds on coefficients to be fitted
[ ] (default) | vector

Lower bounds on the coefficients to be fitted, specified as the comma-separated pair
consisting of "Lower" and a vector. The default value is an empty vector, indicating
that the fit is unconstrained by lower bounds. If bounds are specified, the vector length
must equal the number of coefficients. Find the order of the entries for coefficients in the
vector value by using the coeffnames function. For an example, see Fit. Individual
unconstrained lower bounds can be specified by - InT.

Available when the Method is LinearLeastSquares or NonlinearLeastSquares.

Data Types: double

"Upper" — Upper bounds on coefficients to be fitted
[ ] (default) | vector

Upper bounds on the coefficients to be fitted, specified as the comma-separated pair
consisting of "Upper" and a vector. The default value is an empty vector, indicating
that the fit is unconstrained by upper bounds. If bounds are specified, the vector length
must equal the number of coefficients. Find the order of the entries for coefficients in the
vector value by using the coeffnames function. For an example, see Fit. Individual
unconstrained upper bounds can be specified by +InT.

Available when the Method is LinearLeastSquares or Nonl inearLeastSquares.

Data Types: logical

Nonlinear Least-Squares Options

"StartPoint" — Initial values for coefficients
[T (default) | vector

Initial values for the coefficients, specified as the comma-separated pair consisting of
"StartPoint” and a vector. Find the order of the entries for coefficients in the vector
value by using the coeffnames function. For an example, see Fit.

If no start points (the default value of an empty vector) are passed to the Fit function,
starting points for some library models are determined heuristically. For rational and
Weibull models, and all custom nonlinear models, the toolbox selects default initial
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values for coefficients uniformly at random from the interval (0,1). As a result, multiple
fits using the same data and model might lead to different fitted coefficients. To avoid
this, specify initial values for coefficients with a vector value for the StartPoint
property.

Available when the Method is Nonl inearLeastSquares.

Data Types: double

"Algorithm® — Algorithm to use for fitting procedure
'Levenberg-Marquardt' (default) | 'Trust-Region'

Algorithm to use for the fitting procedure, specified as the comma-separated pair
consisting of "Algorithm® and either "Levenberg-Marquardt® or "Trust-Region”.

Available when the Method is Nonl inearLeastSquares.
Data Types: char

"DiffMaxChange”™ — Maximum change in coefficients for finite difference gradients
0.1 (default)

Maximum change in coefficients for finite difference gradients, specified as the comma-
separated pair consisting of "DiffMaxChange® and a scalar.

Available when the Method is Nonl inearLeastSquares.

Data Types: double

"DiffMinChange” — Minimum change in coefficients for finite difference gradients
1078 (default)

Minimum change in coefficients for finite difference gradients, specified as the comma-
separated pair consisting of "DiffMinChange” and a scalar.

Available when the Method is Nonl inearLeastSquares.

Data Types: double

"Display" — Display option in the Command Window
"notify" (default) | "final®" | "iter” | "off"

Display option in the command window, specified as the comma-separated pair
consisting of "Display” and one of these options:
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+ "notify" displays output only if the fit does not converge.
+  "Ffinal" displays only the final output.

*  T"iter" displays output at each iteration.

+ "off" displays no output.

Available when the Method is Nonl inearLeastSquares.

Data Types: char

"MaxFunEvals®" — Maximum number of evaluations of model allowed
600 (default)

Maximum number of evaluations of the model allowed, specified as the comma-separated
pair consisting of *"MaxFunEvals™ and a scalar.

Available when the Method is Nonl inearLeastSquares.
Data Types: double

"Maxlter® — Maximum number of iterations allowed for fit
400 (default)

Maximum number of iterations allowed for the fit, specified as the comma-separated pair
consisting of "Maxlter" and a scalar.

Available when the Method is Nonl inearLeastSquares.
Data Types: double

*TolFun™ — Termination tolerance on model value
10°° (default)

Termination tolerance on the model value, specified as the comma-separated pair
consisting of "TolFun® and a scalar.

Available when the Method is Nonl inearLeastSquares.
Data Types: double

"TolX" — Termination tolerance on coefficient values
107°. (default)

Termination tolerance on the coefficient values, specified as the comma-separated pair
consisting of "TolX" and a scalar.

12-111



12  Functions — Alphabetical List

Available when the Method is Nonl inearLeastSquares.

Data Types: double

Output Arguments

fitOptions — Algorithm options
fitoptions

Algorithm options, returned as a Fitoptions object.

newOptions — New algorithm options
fitoptions

New algorithm options, returned as a fitoptions object.

See Also

See Also

Apps
Curve Fitting

Functions

fit | fittype | get | set | setoptions

Topics

“Specifying Fit Options and Optimized Starting Points” on page 4-6
“Fit Postprocessing”

“List of Library Models for Curve and Surface Fitting” on page 4-13

Introduced before R2006a
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fittype

Fit type for curve and surface fitting

Syntax
aFittype = Fittype(libraryModelName)

aFittype = fittype(expression)
aFittype = Fittype(expression,Name,Value)

aFittype = Fittype(linearModelTerms)
aFittype = fittype(linearModelTerms,Name,Value)

aFittype = fittype(anonymousFunction)
aFittype = fittype(anonymousFunction,Name,Value)

Description

aFittype = fittype(libraryModelName) creates the Fittype object aFittype for
the model specified by 1ibraryMode IName.

aFittype = Fittype(expression) creates a fit type for the model specified by the
MATLAB expression.

aFittype = Fittype(expression,Name,Value) constructs the fit type with
additional options specified by one or more Name,Value pair arguments.

aFittype = Fittype(linearModelTerms) creates a fit type for a custom linear
model with terms specified by the cell array of character vector expressions in
linearModelTerms.

aFittype = Fittype(linearModelTerms,Name,Value) constructs the fit type with
additional options specified by one or more Name ,Value pair arguments.

aFittype = fittype(anonymousFunction) creates a fit type for the model specified
by anonymousFunction.
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aFittype = Ffittype(anonymousFunction,Name,Value) constructs the fit type
with additional options specified by one or more Name,Value pair arguments.

Examples

Create Fit Types for Library Models
Construct fit types by specifying library model names.

Construct a Fittype object for the cubic polynomial library model.

f

Ffittype(“poly37)

Linear model Poly3:
T(pl,p2,p3,p4,x) = pl*xX"3 + p2*x"2 + p3*x + p4

Construct a fit type for the library model rat33 (a rational model of the third degree for
both the numerator and denominator).

f = fittype("rat33”)

General model Rat33:
f(pl,p2,p3,p4,.91,092,093,%X) = (P1*X"3 + p2*x"2 + p3*x + p4d) /
(X"3 + gq1*x"2 + g2*x + g3)
For a list of library model names, see I itbraryMode IName.
Create Custom Linear Model

To use a linear fitting algorithm, specify a cell array of terms.

Identify the linear model terms you need to input to Fittype: a*x + b*sin(x)

+ c. The model is linear in a, b and c. It has three terms X, sin(x) and 1 (because
c=c*1). To specify this model you use this cell array of terms: LinearModelTerms =
{"x","sin(x)","1"}.
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Use the cell array of linear model terms as the input to fittype.

ft

Fittype({"x", "sin(x)","1"})

ft =

Linear model:
ft(a,b,c,x) = a*x + b*sin(x) + c

Create a linear model fit type for a*cos(x) + b.

ft2

fittype({ cos(x)", 1"}

ft2 =

Linear model:
ft2(a,b,x) = a*cos(x) + b

Create the fit type again and specify coefficient names.

ft3

fittype({ cos(x)"," 1"}, "coefficients”,{"al","a2"})

Tt3 =

Linear model:
ft3(al,a2,x) = al*cos(x) + a2

Create Custom Nonlinear Models and Specify Problem Parameters and Independent Variables

Construct fit types for custom nonlinear models, designating problem-dependent
parameters and independent variables.

Construct a fit type for a custom nonlinear model, designating n as a problem-dependent
parameter and u as the independent variable.

g = Fittype(a*u+b*exp(n*u)”, ...
“problem®," n", ...
"independent®, “"u*

g =
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General model:
g(a,b,n,u) = a*u+b*exp(n*u)

Construct a fit type for a custom nonlinear model, designating time as the independent
variable.

fittype(Ta*timen2+b*time+c”, "independent”, "time", "dependent”, "height")

g

General model:
g(a,b,c,time) = a*time™2+b*time+c

Construct a fit type for a logarithmic fit to some data, use the fit type to create a fit, and
plot the fit.

X linspace(1,100);

y =5 + 7*log(Xx);

myfittype = Fittype("a + b*log(x)", .-
"dependent” ,{"y"}, "independent” ,{"x"}, ...
"coefficients”,{"a","b"})

myfit = fit(x",y",myfittype)

plot(myfit,x,y)

myfittype =

General model:
myfittype(a,b,x) = a + b*log(x)
Warning: Start point not provided, choosing random start point.

myfit =

General model:

myfFit(x) = a + b*log(x)

Coefficients (with 95% confidence bounds):
a = 5 (5, 5)
b = 7 (7, 7)
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You can specify any MATLAB command and therefore any .m file.
Fit a Curve Defined by a File
Define a function in a file and use it to create a fit type and fit a curve.

Define a function in a MATLAB file.

function y = piecewiselLine(x,a,b,c,d,k)

% PIECEWISELINE A line made of two pieces
% that is not continuous.

y = zeros(size(X)):
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% This example includes a for-loop and if statement
% purely for example purposes.
for 1 = 1:length(x)

if x(i) < k,
y(i) = a + b.* x(i);
else
y(i) = c + d.* x(i);
end
end
end

Save the file.

Define some data, create a fit type specifying the function piecewiseLine, create a fit
using the fit type Ft, and plot the results.

X = [0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;. ..
0.96;0.96;0.16;0.97;0.96];
y = [0.17;0.12;0.16;0.0035;0.37;0.082;0.34;0.56; ...

0.15;-0.046;0.17;-0.091;-0.071];
ft = fittype( “piecewiseLine( x, a, b, ¢, d, k)" )
f = fit( x, y, ft, °“StartPoint*, [1, O, 1, O, 0.5] )
plot( f, x, y )
Create Custom Linear Model

To use a linear fitting algorithm, specify a cell array of terms.

Identify the linear model terms you need to input to Fittype: a*x + b*sin(x)

+ C. The model is linear in a, b and c. It has three terms X, sin(x) and 1 (because
c=c*1). To specify this model you use this cell array of terms: LinearModelTerms =
{"x","sin(xX)","1"}.

Use the cell array of linear model terms as the input to fittype.

ft = fittype({"x", "sin(x)", 1"}

ft =

Linear model:
ft(a,b,c,x) = a*x + b*sin(x) + c

Create a linear model fit type for a*cos(x) + b.
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ft2

fittype({ cos(x)","1"})

ft2 =

Linear model:
ft2(a,b,x) = a*cos(x) + b

Create the fit type again and specify coefficient names.

Tt3

fittype({ cos(x)", 1"}, "coefficients”,{"al","a2"})

t3 =

Linear model:
ft3(al,a2,x) = al*cos(x) + a2

Create Fit Types Using Anonymous Functions
Create a fit type using an anonymous function.
g = fittype( @(a, b, c, x) a*x."2+b*x+c )

Create a fit type using an anonymous function and specify independent and dependent
parameters.

g = fittype( @Ca, b, c, d, X, y) a*x."2+b*x+c*exp(...-
-(y-d)."2 ), "independent®, {"x", "y"},...
"dependent”, "z" );

Create a fit type for a surface using an anonymous function and specify independent and
dependent parameters, and problem parameters that you will specify later when you call
fit

g = fittype( @(a,b,c,d,x,y) a*x."2+b*x+c*exp( -(y-d)."2 ),
"problem®, {"c","d"}, "independent®, {"x", "y"},
"dependent®, "z" );

Use an Anonymous Function to Pass in Workspace Data to the Fit

Use an anonymous function to pass workspace data into the Fittype and fit functions.

Create and plot an S-shaped curve. In later steps, you stretch and move this curve to fit
to some data.
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% Breakpoints.

xs = (0:0.1:1).%;

% Height of curve at breakpoints.

ys = [0; 0; 0.04; 0.1; 0.2; 0.5; 0.8; 0.9; 0.96; 1; 1];

% Plot S-shaped curve.

xi = linspace( 0, 1, 241 );

plot( xi, interpl( xs, ys, xi, “pchip® ), “LineWidth®, 2 )
hold on

plot( xs, ys,
hold off
title S-curve

0", "MarkerFaceColor®, "r* )

Create a fit type using an anonymous function, taking the values from the workspace
for the curve breakpoints (xs) and the height of the curve at the breakpoints (ys).
Coefficients are b (base) and h (height).

ft = fittype( @(b, h, x) interpl( xs, b+h*ys, x, "“pchip® ) )
Plot the Fittype specifying example coefficients of base b=1.1 and height h=-0.8.

plot( xi, ft( 1.1, -0.8, xi ), °“LineWidth", 2 )
title "Fittype with b=1.1 and h=-0.8"

Load and fit some data, using the fit type Ft created using workspace values.

% Load some data

xdata = [0.012;0.054;0.13;0.16;0.31;0.34;0.47;0.53;0.53; ...
0.57;0.78;0.79;0.93];

ydata = [0.78;0.87;1;1.1;0.96;0.88;0.56;0.5;0.5;0.5;0.63;...
0.62;0.39];

% Fit the curve to the data

f = fit( xdata, ydata, ft, “Start", [0, 1] )

% Plot fit

plot( f, xdata, ydata )

title "Fitted S-curve®

Use Anonymous Functions to Work with Problem Parameters and Workspace Variables

This example shows the differences between using anonymous functions with problem
parameters and workspace variable values.

Load data, create a fit type for a curve using an anonymous function with problem
parameters, and call Fit specifying the problem parameters.

% Load some data.
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xdata = [0.098;0.13;0.16;0.28;0.55;0.63;0.81;0.91;0.91;...
0.96;0.96;0.96;0.97];

ydata = [0.52;0.53;0.53;0.48;0.33;0.36;0.39;0.28;0.28; ...
0.21;0.21;0.21;0.2];

% Create a fittype that has a problem parameter.
g = Fittype( @(a,b,c,x) a*x.”2+b*x+c, "problem”, "c" )

% Examine coefficients. Observe c is not a coefficient.
coeffnames( g )

% Examine arguments. Observe that c is an argument.
argnames( g )

% Call fit and specify the value of c.
fl = fit( xdata, ydata, g, “problem®, 0, "StartPoint®, [1, 2] )

% Note: Specify start points in the calls to fit to
% avoid warning messages about random start points
% and to ensure repeatability of results.

% Call fit again and specify a different value of c,
% to get a new Fit.
f2 = fit( xdata, ydata, g, “problem®, 1, "start®, [1, 2] )

% Plot results. Oberve the specified c constants
% do not make a good Ffit.

plot( fl1, xdata, ydata )

hold on

plot( 2, "b" )

hold off

Modify the previous example to create the same fits using workspace values for variables,
instead of using problem parameters. Using the same data, create a fit type for a curve
using an anonymous function with a workspace value for variable c:

% Remove c from the argument list.
try

g = Fittype( @(a,b,x) a*x."2+b*x+c )
catch e

disp( e.message )
end
% Observe error because now c is undefined.
% Define c and create fittype:
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c = 0;
gl = Fittype( @(a,b,x) a*x."2+b*x+c )

% Call Ffit (now no need to specify problem parameter).
fl = fit( xdata, ydata, g1, "StartPoint”, [1, 2] )
% Note that this f1 is the same as the fl above.

% To change the value of c, recreate the fittype.
c =1;

g2 = Fittype( @(a,b,x) a*x."2+b*x+c ) % uses c = 1
f2 = fit( xdata, ydata, g2, "StartPoint”, [1, 2] )
% Note that this 2 is the same as the f2 above.

% Plot results

plot( fl1, xdata, ydata )

hold on

plot( 2, "b" )

hold off

. “Custom Linear Fitting” on page 5-7

Input Arguments

libraryModelName — Library model to fit
character vector

Library model to fit, specified as a character vector. This table shows some common

examples.

Library Model Name Description

"polyl- Linear polynomial curve
"polyll- Linear polynomial surface
"poly2* Quadratic polynomial curve
"linearinterp” Piecewise linear interpolation
"cubicinterp” Piecewise cubic interpolation
"smoothingspline* Smoothing spline (curve)
"lowess*” Local linear regression (surface)

For a list of library model names, see “Model Names and Equations” on page 4-14.

Example: "poly2*®
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Data Types: char

expression — Model to fit
character vector

Model to fit, specified as a character vector. You can specify any MATLAB command and
therefore any .m file. See “Fit a Curve Defined by a File” on page 12-117.

Data Types: char

linearModelTerms — Model to fit

cell array of character vectors

Model to fit, specified as a cell array of character vectors. Specify the model terms by the
expressions in the character vectors. Do not include coefficients in the expressions for the
terms. See “Linear Model Terms” on page 12-126.

Data Types: cell

anonymousFunction — Model to fit
anonymous function

Model to fit, specified as an anonymous function. For details, see “Input Order for
Anonymous Functions” on page 12-125.

Data Types: char

Name-Value Pair Arguments

Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside single
quotes (* ). You can specify several name and value pair arguments in any order as
Namel,Valuel, ... ,NameN,ValueN.

Example: "coefficients”,{"al","a2"}

"coefficients” — Coefficient names
character vector | cell array of character vectors

Coefficient names, specified as the comma-separated pair consisting of "coefficients”
and a character vector, or a cell array of character vectors for multiple names. You can
use multicharacter symbol names. You cannot use these names: i, j, pi, inf, nan, eps.

Data Types: char | cell
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"dependent” — Dependent (response) variable name
y (default) | character vector

Dependent (response) variable name, specified as the comma-separated pair consisting
of "dependent® and a character vector. If you do not specify the dependent variable, the
function assumes y is the dependent variable.

Data Types: char

" independent” — Independent (response) variable names
X (default) | character vector | cell array of character vectors

Independent (response) variable names, specified as the comma-separated pair consisting
of "independent” and a character vector or cell array of character vectors. If you do not
specify the independent variable, the function assumes X is the independent variable.

Data Types: char

"options*” — Fit options
fitoptions

Fit options, specified as the comma-separated pair consisting of "options” and the
name of a Fitoptions object.

"problem” — Problem-dependent (fixed) parameter names
cell array

Problem-dependent (fixed) parameter names, specified as the comma-separated pair
consisting of "problem” and a character vector, or cell array of character vectors with
one element per problem dependent constant.

Data Types: char | cell

Output Arguments

aFittype — Model to fit
Tittype object

Model to fit, returned as a Fittype. A Fittype encapsulates information describing a
model. To create a fit, you need data, a Fittype, and (optionally) Fitoptions and an
exclusion rule. You can use a Fittype as an input to the Fit function.
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Definitions

Dependent and Independent Variables
How do I decide which variables are dependent and independent?

To determine dependent and independent variables and coefficients, consider this
equation:

y=f(x)=a+(b*x)+(c*x2)_

* y1is the dependent variable.

* x1s the independent variable.

* a, b, and c are the coefficients.

The " independent” variable is what you control. The "dependent” variable is what
you measure, i.e., it depends on the independent variable. The "coefficients” are the
parameters that the fitting algorithm estimates.

For example, if you have census data, then the year is the independent variable because
it does not depend on anything. Population is the dependent variable, because its value
depends on the year in which the census is taken. If a parameter like growth rate is
part of the model, so the fitting algorithm estimates it, then the parameter is one of the
"coefficients”.

The Fittype function determines input arguments by searching the fit type expression
input for variable names. fittype assumes X is the independent variable, y is the
dependent variable, and all other variables are coefficients of the model. X is used if no
variable exists.

Input Order for Anonymous Functions

If the fit type expression input is an anonymous function, then the order of inputs must
be correct. The input order enables the Fittype function to determine which inputs are
coefficients to estimate, problem-dependent parameters, and independent variables.

The order of the input arguments to the anonymous function must be:

fcn = @(coefficients,problemparameters,x,y) expression
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You need at least one coefficient. The problem parameters and y are optional. The last
arguments, X and y, represent the independent variables: just x for curves, but x and y
for surfaces. If you don't want to use X and/or y to name the independent variables, then
specify different names using the " independent” argument name-value pair. However,
whatever name or names you choose, these arguments must be the last arguments to the
anonymous function.

Anonymous functions make it easier to pass other data into the Fittype and fit
functions.

1 Create a fit type using an anonymous function and a variable value (C) from the
workspace.

c =1;
g = fittype( @(a, b, x) a*x."2+b*x+c )

2 The Fittype function can use the variable values in your workspace when you
create the fit type. To pass in new data from the workspace, recreate the fit type,

e.g.,
c = 5 % Change value of c.
g = Fittype( @(a, b, xX) a*x."2+b*x+c )

3 Here, the value of c is fixed when you create the fit type. To specify the value of c at
the time you call fit, you can use problem parameters. For example, make a fit with
Cc = 2 and then a new fit withc = 3.

g = Fittype( @(a,b,x) a*x."2+b*x+c, "problem”, "c" )

fit( xdata, ydata, g, "problem”™, 2 )

fl =
f2 = fit( xdata, ydata, g, “problem™, 3 )

Linear Model Terms

How do I define linear model terms?

To use a linear fitting algorithm, specify 1inearModelTerms as a cell array of terms.

afittype = Fittype({exprl,...,exprn})

Specify the model terms by the expressions in the character vectors expr2, . .. ,exprn.
Do not include coefficients in the expressions for the terms. If there is a constant term,
use "1" as the corresponding expression in the cell array.

To specify a linear model of the following form:
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coeffl * terml + coeff2 * term2 + coeff3 * term3 + ...
where no coefficient appears within any of terml, term2, etc., use a cell array where
each term, without coefficients, is specified in a cell of expr, as follows:

LinearModelTerms = {"terml®, “"term2®, “"term3", ... }

For example, the model

a*x + b*sin(xX) + ¢

is linear in a, b, and c. It has three terms X, sin(x) and 1 (because c=c*1) and therefore
expr is:

LinearModelTerms = {"x","sin(x)","1"}

In the Curve Fitting app, see the Linear Fitting model type.

Algorithms

If the fit type expression input is a character vector or anonymous function, then the
toolbox uses a nonlinear fitting algorithm to fit the model to data.

If the fit type expression input is a cell array of terms, then the toolbox uses a linear
fitting algorithm to fit the model to data.

See Also

See Also

Apps
Curve Fitting

Functions
fit | fitoptions

Topics

“Custom Linear Fitting” on page 5-7
“Parametric Fitting” on page 4-2

Introduced before R2006a

12-127



12  Functions — Alphabetical List

12-128

fn2fm

Convert to specified form

Syntax

g = fn2fm(fF,form)
sp = fn2fm(Ff, "B-",sconds)
fn2fm(F)

Description

g = fn2fm(F,form) describes the same function as is described by F, but in the
form specified by the character vector form. Choices for form are "B-", "pp~, "BB",
"rBT, "rp", for the B-form, the ppform, the BBform, and the two rational spline forms,
respectively.

The B-form describes a function as a weighted sum of the B-splines of a given order k
for a given knot sequence, and the BBform (or, Bernstein-Bézier form) is the special
case when each knot in that sequence appears with maximal multiplicity, k. The ppform
describes a function in terms of its local polynomial coefficients. The B-form is good for
constructing and/or shaping a function, while the ppform is cheaper to evaluate.

Conversion from a polynomial form to the corresponding rational form is possible only
if the function in the polynomial form is vector-valued, in which case its last component
is designated as the denominator. Converting from a rational form to the corresponding
polynomial form simply reverses this process by reinterpreting the denominator of the
function in the rational form as an additional component of the piecewise polynomial
function.

Conversion to or from the stform is not possible at present.

If Formis "B-" (and F is in ppform), then the actual smoothness of the function in

T across each of its interior breaks has to be guessed. This is done by looking, for
each interior break, for the first derivative whose jump across that break is not small
compared to the size of that derivative nearby. The default tolerance used in this is
1l.e-12.
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sp = fn2fm(F, "B-",sconds) permits you to supply, as the input argument sconds,
a tolerance (strictly between 0 and 1) to be used in the conversion from ppform to B-form.

Alternatively, you can input sconds as a vector with integer entries, with at least as
many entries as the ppform in f has interior breaks. In that case, sconds (1) specifies
the number of smoothness conditions to be used across the ith interior break. If the
function in F is a tensor product, then sconds, if given, must be a cell array.

fn2fm(F) converts a possibly old version of a form into its present version.

Examples

sp = fn2fm(spline(x,y), "B-") gives the interpolating cubic spline provided by the
MATLAB command spline, but in B-form rather than in ppform.

pO
pl

ppmak([0 1],[3 0 01);
fn2fm(Fn2fm(Fnrfn(p0,[-4 .61),"B-"),"pp");

gives pl identical to pO (up to round-off in the coefficients) since the spline has no
discontinuity in any derivative across the additional breaks introduced by fnrfn, hence
conversion to B-form ignores these additional breaks, and conversion to ppform does not
retain any knot multiplicities (like the knot multiplicities introduced, by conversion to B-
form, at the endpoints of the spline's basic interval).

Cautionary Note

When going from B-form to ppform, any jump discontinuity at the first and last knot,
t(1) or t(end), will be lost since the ppform considers f to be defined outside its basic
interval by extension of the first, respectively, the last polynomial piece. For example,
while sp=spmak([0 1],1) gives the characteristic function of the interval [0..1],
pp=Ffn2fm(spmak ([0 1],1),"pp") is the constant polynomial, x| —1.

Algorithms

For a multivariate (tensor-product) function, univariate algorithms are applied in each
variable.
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For the conversion from B-form (or BBform) to ppform, the utility command sprpp
is used to convert the B-form of all polynomial pieces to their local power form, using
repeated knot insertion at the left endpoint.

The conversion from B-form to BBform is accomplished by inserting each knot enough
times to increase its multiplicity to the order of the spline.

The conversion from ppform to B-form makes use of the dual functionals discussed in .
on page 10-2 Without further information, such a conversion has to ascertain the actual
smoothness across each interior break of the function in f.

See Also

ppmak | spmak | rsmak | stmak
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fnbrk

Name and part(s) of form

Syntax

[outl, ...,outn] = fnbrk(Ff,partl,...,partm)
fnbrk(F, interval)

fnbrk(pp.J)
fnbrk ()

Description

[outl, ...,outn] = fnbrk(f,partl, ...,partm) returns the part(s) of the form in
T specified by partl, . . .,partn (assuming that n<=m). These are the parts used when
the form was put together, in spmak or ppmak or rpmak or rsmak or stmak, but also
other parts derived from these.

You only need to specify the beginning character(s) of the relevant character vector.

Regardless of what particular form F is in, parti can be one of the following.

"form* The particular form used
"variables* The dimension of the function's domain
"dimension* The dimension of the function's target
"coefficients” The coefficients in that particular form
"interval " The basic interval of that form

Depending on the form in F, additional parts may be asked for.

If ¥is in B-form (or BBform or rBform), then additional choices for parti are

"knots” The knot sequence
"coefficients” The B-spline coefficients
"number* The number of coefficients

12-131



12  Functions — Alphabetical List

12-132

"order-” The polynomial order of the spline

If ¥ is in ppform (or rpform), then additional choices for parti are

"breaks*" The break sequence

"coefficients” The local polynomial coefficients

"pieces” The number of polynomial pieces

“order-” The polynomial order of the spline

"guide* The local polynomial coefficients, but in the form needed
for PPVALU in PGS

If the function in F is multivariate, then the corresponding multivariate parts are
returned. This means, e.g., that knots, breaks, and the basic interval, are cell arrays,
the coefficient array is, in general, higher than two-dimensional, and order, number and
pieces are vectors.

If ¥ is in stform, then additional choices for parti are

"centers” The centers

"coefficients” The coefficients

"number*® Number of coefficients or terms
"type* The particular type

fnbrk(f, interval) with interval a 1-by-2 matrix [a b] with a<b does not return
a particular part. Rather, it returns a description of the univariate function described

by f and in the same form but with the basic interval changed, to the interval given. If,
instead, interval is [ ], fis returned unchanged. This is of particular help when the
function in Fis m-variate, in which case interval must be a cell array with m entries,
with the ith entry specifying the desired interval in the ith dimension. If that ith entry is
[ 1, the basic interval in the ith dimension is unchanged.

fnbrk(pp,J), with pp the ppform of a univariate function and j a positive integer, does
not return a particular part, but returns the ppform of the jth polynomial piece of the
function in pp. If pp is the ppform of an m-variate function, then j must be a cell array
of length m. In that case, each entry of J must be a positive integer or else an interval,
to single out a particular polynomial piece or else to specify the basic interval in that
dimension.
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Ffnbrk(f) returns nothing, but a description of the various parts of the form is printed at
the command line instead.

Examples

If p1 and p2 contain the B-form of two splines of the same order, with the same knot
sequence, and the same target dimension, then

plplusp2 = spmak(fnbrk(pl, "k"),fnbrk(pl,“c™)+fnbrk(p2,*c"));
provides the (pointwise) sum of those two functions.

If pp contains the ppform of a bivariate spline with at least four polynomial pieces in the
first variable, then ppp=fnbrk(pp,{4,[-1 1]1}) gives the spline that agrees with the
spline in pp on the rectangle [b4 .. b5] x [-1 .. 1], where b4, b5 are the fourth and fifth
entry in the break sequence for the first variable.

See Also

ppmak | rpmak | rsmak | spmak | stmak
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Change part(s) of form

Syntax

Tt = fnchg(Ff,part,value)

Description

f = fnchg(F,part,value) returns the given function description ¥ but with the
specified part changed to the specified value.

The character vector part can be (the beginning character(s) of) :

"dimension” The dimension of the function's target

“"interval-* The basic interval of that form

The specified value for part is not checked for consistency with the rest of the
description in F in case the character vector part terminates with the letter z.

Examples

fndir(f,directions) returns a vector-valued function even when the function
described by Fis ND-valued.You can correct this by using fnchg as follows:

fdir = fnchg( fndir(f,directions), ...
“dim", [fnbrk(f, "dim"),size(directions,2)] );

See Also

fnbrk
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fncmb

Arithmetic with function(s)

Syntax

fn = fncmb(Function,operation)

T = fncmb(function, function)
fncmb(function,matrix,function)
fncmb(Function,matrix,function,matrix)
T = fncmb(function,op,function)

Description

The intent is to make it easy to carry out the standard linear operations of scaling and
adding within a spline space without having to deal explicitly with the relevant parts of
the function(s) involved.

fn = fncmb(Function,operation) returns (a description of) the function obtained
by applying to the values of the function in Function the operation specified by
operation. The nature of the operation depends on whether operation is a scalar, a
vector, a matrix, or a character vector, as follows.

Scalar Multiply the function by that scalar.

Vector Add that vector to the function's values; this requires the
function to be vector-valued.

Matrix Apply that matrix to the function's coefficients.

Character array Apply the function specified by that character vector to

the function's coefficients.

The remaining options only work for univariate functions. See Limitations for more
information.

f = fncmb(Ffunction, function) returns (a description of) the pointwise sum of the
two functions. The two functions must be of the same form. This particular case of just
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two input arguments is not included in the above table since it only works for univariate
functions.

fncmb(Function,matrix,function) isthe same as
fncmb(Fnemb(Function,matrix),function).

fncmb(function,matrix,function,matrix) isthe same as
fnemb((Fncmb(Function,matrix), fncmb(function,matrix))).

T = fncmb(function,op,function) returns the ppform of the spline obtained by
the pointwise combining of the two functions, as specified by the character vector op.
op can be one of the character vectors "+", =", "*", If the second function is to be a
constant, it is sufficient simply to supply here that constant.

Examples
fncmb(Fn,3.5) multiplies (the coefficients of) the function in n by 3.5.

fncmb(F, 3,9, -4) returns the linear combination, with weights 3 and —4, of the
function in ¥ and the function in g.

fncmb(F,3,9) adds 3 times the function in F to the function in g.

If the function fin ¥ happens to be scalar-valued, then £3=fncmb(F, [1;2;3])contains
the description of the function whose value at x is the 3-vector (f(x), 2f(x), 3f(x)). Note
that, by the convention throughout this toolbox, the subsequent statement fnval(f3, x)
returns a 1-column-matrix.

If ¥ describes a surface in R?, i.e., the function in F is 3-vector-valued bivariate, then 2
= fncmb(F,[1 0 0;0 O 1]) describes the projection of that surface to the (x, z)-plane.

The following commands produce the picture of a ... spirochete?

c = rsmak(“circle™);
fnplt(fncmb(c,diag([1.5,1]))); axis equal, hold on
sc = fncmb(c, .4);

fnplt(fncmb(sc,-[-2;-.5]))
fnplt(fncmb(sc,-[-2,-.5]))

hold off, axis off

If t is a knot sequence of length n+k and a is a matrix with n columns, then
fncmb(spmak(t,eye(n)),a) is the same as spmak(t,a).
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fncmb(spmak([0:4],1), "+ ,ppmak([-1 5],[1 -1])) is the piecewise-polynomial
with breaks -1:5 that, on the interval [0 .. 4], agrees with the function x| — B(x|
0,1,2,3,4) + x (but has no active break at 0 or 1, hence differs from this function outside
the interval [0 .. 4]).

fncmb(spmak([0:4],1),"-",0) has the same effect as
fn2fm(spmak([0:4],1),"pp").

Assuming that sp describes the B-form of a spline of order <k, the output of
fn2fm(Fncmb(sp, "+" , ppmak(Fnbrk(sp, "interv®),zeros(1,k))), "B-)

describes the B-form of the same spline, but with its order raised to k.

Limitations

fncmb only works for univariate functions, except for the case
fncmb(Function,operation), i.e., when there is just one function in the input.

Further, if two functions are involved, then they must be of the same type. This means
that they must either both be in B-form or both be in ppform, and, moreover, have the
same knots or breaks, the same order, and the same target. The only exception to this is
the command of the form fncmb(function,op,function).

Algorithms

The coefficients are extracted (via fnbrk) and operated on by the specified matrix

or operation (and, possibly, added), then recombined with the rest of the function
description (via ppmak, spmak, rpmak, rsmak, stmak). To be sure, when the function is
rational, the matrix is only applied to the coefficients of the numerator. Again, if we are
to translate the function values by a given vector and the function is in ppform, then only
the coefficients corresponding to constant terms are so translated.

If there are two functions input, then they must be of the same type (see Limitations,
below) except for the following.

fncmb(F1,0p, £2) returns the ppform of the function

x| f1(x) op f2(x)

12-137



12  Functions — Alphabetical List

with op one of "+", "-", "*" and F1, F2 of arbitrary polynomial form. If, in addition,
T2 is a scalar or vector, it is taken to be the function that is constantly equal to that
scalar or vector.
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fnder

Differentiate function

Syntax

fprime = fnder(F,dorder)
fnder (¥)

Description

fprime = fnder(f,dorder) isthe description of the dorderth derivative of the
function whose description is contained in F. The default value of dorder is 1. For
negative dorder, the particular |dorder |th indefinite integral is returned that
vanishes |dorder |-fold at the left endpoint of the basic interval.

The output is of the same form as the input, i.e., they are both ppforms or both B-forms
or both stforms. fnder does not work for rational splines; for them, use fntlr instead.
fnder works for stforms only in a limited way: if the type is tp00, then dorder can be
[1,0] or [O,1].

fnder(T) isthe same as fnder(f,1).

If the function in f is multivariate, say m-variate, then dorder must be given, and must
be of length m.

Examples

If ¥ is in ppform, or in B-form with its last knot of sufficiently high multiplicity, then, up
to rounding errors, ¥ and Fnder(fnint(f)) are the same.

If Fis in ppform and Fa is the value of the function in F at the left end of its basic
interval, then, up to rounding errors, ¥ and fnint(fnder (F),fa) are the same, unless
the function described by ¥ has jump discontinuities.

If ¥ contains the B-form of f, and ¢; is its leftmost knot, then, up to rounding errors,
fnint(fnder (F)) contains the B-form of f— f(¢;). However, its leftmost knot will have
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lost one multiplicity (if it had multiplicity > 1 to begin with). Also, its rightmost knot will
have full multiplicity even if the rightmost knot for the B-form of fin ¥ doesn't.

Here 1s an illustration of this last fact. The spline in sp = spmak([0 0 1], 1) is,
on its basic interval [0..1], the straight line that is 1 at 0 and 0 at 1. Now integrate its
derivative: spdi = fnint(fnder(sp)). As you can check, the spline in spdi has the
same basic interval, but, on that interval, it agrees with the straight line that is 0 at 0
and -1 at 1.

See the examples “Intro to B-form” and “Intro to ppform” for examples.

Algorithms

For differentiation of either polynomial form, the derivatives are found in the piecewise-
polynomial sense. This means that, in effect, each polynomial piece is differentiated
separately, and jump discontinuities between polynomial pieces are ignored during
differentiation.

For the B-form, the formulas [PGS; (X.10)] for differentiation are used.

For the stform, differentiation relies on knowing a formula for the relevant derivative of
the basis function of the particular type.

See Also

fndir | fnint | fnplt | fnval
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fndir

Directional derivative of function

Syntax

df = fndir(f,y)

Description

df = fndir(f,y) isthe ppform of the directional derivative, of the function fin T,
in the direction of the (column-)vector y. This means that df describes the function

D,y f(x):=limy o (f (x +2y)— f(2)) /£ .

If y is a matrix, with n columns, and f is d-valued, then the function in d¥ is prod(d)*n-
valued. Its value at x, reshaped to be of size [d,n], has in its jth “column” the directional
derivative of f at x in the direction of the jth column of y. If you prefer dT to reflect
explicitly the actual size of f, use instead

df = fnchg( fndir(F,y), “dim",[fnbrk(f, *dim"),size(y,2)] );

Since fndir relies on the ppform of the function in ¥, it does not work for rational
functions nor for functions in stform.

Examples

For example, if ¥ describes an m-variate d-vector-valued function and X is some point
in its domain, then, e.g., with this particular ppform F that describes a scalar-valued
bilinear polynomial,

f = ppmak({0:1,0:1},[1 0;0 1]);: x = [0;0];

[d,m] = fnbrk(f, "dim","var®);

jJacobian = reshape(fnval (fndir(f,eye(m)),x),d,m)

is the Jacobian of that function at that point (which, for this particular scalar-valued
function, is its gradient, and it is zero at the origin).
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As a related example, the next statements plot the gradients of (a good approximation to)
the Franke function at a regular mesh:

xx = linspace(--1,1.1,13); yy = linspace(0,1,11);

[x,y] = ndgrid(xx,yy); z = franke(x,y);

pp2dir = fndir(csapi ({xx,yy}.,z),eye(2));

grads = reshape(fnval (pp2dir,[x(:) y(:)1-7),---
[2,1ength(xx),length(yy)]);

quiver(x,y,squeeze(grads(l,:,:)),squeeze(grads(2,:,:)))

Here is the resulting plot.
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Algorithms

The function in F is converted to ppform, and the directional derivative of its polynomial
pieces is computed formally and in one vector operation, and put together again to form
the ppform of the directional derivative of the function in F.

See Also

fnchg | fnder | fnint | franke
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fnint

Integrate function

Syntax

intgrf = fnint(f,value)
fnint(F)

Description

intgrf = fnint(f,value) is the description of an indefinite integral of the
univariate function whose description is contained in F. The integral is normalized to
have the specified value at the left endpoint of the function's basic interval, with the
default value being zero.

The output is of the same type as the input, i.e., they are both ppforms or both B-forms.
fnint does not work for rational splines nor for functions in stform.

fnint(T) isthe same as fnint(f,0).

Indefinite integration of a multivariate function, in coordinate directions only, is
available via fnder (f,dorder) with dorder having nonpositive entries.

Examples

The statement di fF(Fnval (Fnint(f),[a b])) provides the definite integral over the
interval [a .. b] of the function described by F.

If ¥ is in ppform, or in B-form with its last knot of sufficiently high multiplicity, then, up
to rounding errors, ¥ and fnder (Fnint(F)) are the same.

If £ 1s in ppform and fa is the value of the function in F at the left end of its basic

interval, then, up to rounding errors, ¥ and fnint(fnder (F),fa) are the same, unless
the function described by F has jump discontinuities.
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If ¥ contains the B-form of f, and ¢, is its leftmost knot, then, up to rounding errors,
fnint(fnder(T)) contains the B-form of f — f(¢;). However, its leftmost knot will have
lost one multiplicity (if it had multiplicity > 1 to begin with). Also, its rightmost knot will
have full multiplicity even if the rightmost knot for the B-form of fin ¥ doesn't.

Here 1s an illustration of this last fact. The spline in sp = spmak([0 0 1], 1) is,
on its basic interval [0..1], the straight line that is 1 at 0 and 0 at 1. Now integrate its
derivative: spdi = fnint(fnder(sp)). As you can check, the spline in spdi has the
same basic interval, but, on that interval, it agrees with the straight line that is 0 at 0
and -1 at 1.

See the examples “Intro to B-form” and “Intro to ppform” for examples.

Algorithms

For the B-form, the formula [PGS; (X.22)] for integration is used.

See Also

fnder | fnplt | fnval
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fnjmp

Jumps, i.e., f(x+)-f(x-)

Syntax

Jumps = fnjmp(F,x)

Description

Jumps = fnjmp(F,x) 1islike Fnval (F,X) except that it returns the jump f(x+) — f(x—)
across X (rather than the value at X) of the function f described by F and that it only
works for univariate functions.

This 1s a function for spline specialists.

Examples

fnjymp(ppmak(1:4,1:3),1:4) returns the vector [0,1,1,0] since the pp function
hereislon[1..2],20n[2.. 3], and 3 on [3 .. 4], hence has zero jump at 1 and 4 and a
jump of 1 across both 2 and 3.

If xis cos([4:-1:0]*pi1/4), then fFnymp(Fnder (spmak(x,1),3),Xx) returns the
vector [12 -24 24 -24 127 (up to round-off). This is consistent with the fact that the
spline in question is a so called perfect cubic B-spline, i.e., has an absolutely constant
third derivative (on its basic interval). The modified command

fnjmp(Fnder (Fn2fm(spmak(x,1), "pp"),3),x)

returns instead the vector [0 -24 24 -24 0], consistent with the fact that, in contrast
to the B-form, a spline in ppform does not have a discontinuity in any of its derivatives
at the endpoints of its basic interval. Note that fnjmp(fnder (spmak(x,1),3),-x)
returns the vector [12,0,0,0,12] since -X, though theoretically equal to X, differs from
X by roundoff, hence the third derivative of the B-spline provided by spmak(x,1) does
not have a jump across -x(2),-x(3), and -x(4).
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fnmin

Minimum of function in given interval

Syntax

fnmin(F)
fnmin(F, interv)
[minval ,minsite] = famin(F,...)

Description

fnmin(F) returns the minimum value of the scalar-valued univariate spline in F on its
basic interval.

fnmin(f, interv) returnsthe minimum value on the interval [a..b] specified by
interv.

[minval ,minsite] = fnmin(Ff,...) alsoreturns a location, minsite, at which the
function in f takes that minimum value, minval.

Examples

Example 1. We construct and plot a spline f with many local extrema, then compute
its maximum as the negative of the minimum of —f. We indicate this maximum value by
adding a horizontal line to the plot at the height of the computed maximum.

rng(21);

f = spmak(1:21,rand(1,15)-.5);

fnplt(F)

maxval = -fnmin(fncmb(F,-1));

hold on, plot(fnbrk(f, "interv™),maxval([1 1]1)), hold off



fnmin
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Example 2. Since spmak(1:5,-1) provides the negative of the cubic B-spline with knot
sequence 1:5, we expect the command

[y,x] = famin(spmak(1:5,-1))

to return -2/3 for y and 3 for x.
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Algorithm

fnmin first changes the basic interval of the function to the given interval, if any. On the
interval, fnmin then finds all local extrema of the function as left and right limits at a
jump and as zeros of the function's first derivative. It then evaluates the function at these
extrema and at the endpoints of the interval, and determines the minimum over all these
values.

See Also
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fnplt

Plot function

Syntax

fnplt(F)
fnplt(f,argl,arg2,arg3,arg4)
points = fnplt(f,...)
[points, t] = fnplt(F,...)

Description
fnplt(f) plots the function, described by F, on its basic interval.

If fis univariate, the following is plotted:

+ If fis scalar-valued, the graph of fis plotted.
+ If fis 2-vector-valued, the planar curve is plotted.

+ If fis d-vector-valued with d > 2, the space curve given by the first three components
of f1is plotted.

If f is bivariate, the following is plotted:

+ If fis scalar-valued, the graph of fis plotted (via surf).
+ If fis 2-vector-valued, the image in the plane of a regular grid in its domain is plotted.

+ If fis d-vector-valued with d > 2, then the parametric surface given by the first three
components of its values is plotted (via sur¥).

If fis a function of more than two variables, then the bivariate function, obtained by
choosing the midpoint of the basic interval in each of the variables other than the first
two, 1s plotted.

fnplt(f,argl,arg2,arg3,arg4) permits you to modify the plotting by the

specification of additional input arguments. You can place these arguments in whatever
order you like, chosen from the following list:
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* A character vector that specifies a plotting symbol, such as "-." or "*"; the default
is "-"
* A scalar to specify the linewidth; the default value is 1.

* A character vector that starts with the letter " j " to indicate that any jump in the
univariate function being plotted should actually appear as a jump. The default is to
fill in any jump by a (near-)vertical line.

* A vector of the form [a,b], to indicate the interval over which to plot the
univariate function in F. If the function in F is m-variate, then this optional
argument must be a cell array whose ith entry specifies the interval over which the
ith argument is to vary. In effect, for this arg, the command fnplt(f,arg,...)
has the same effect as the command fnplt(fnbrk(f,arg), - ..). The default is the
basic interval of f.

* An empty matrix or character vector, to indicate use of default(s). You will find this
option handy when your particular choice depends on some other variables.

points = fnplt(f,...) plots nothing, but the two-dimensional points or three-
dimensional points it would have plotted are returned instead.

[points, t] = fnplt(F,...) alsoreturns, for a vector-valued T, the corresponding
vector t of parameter values.

Cautionary Note

The basic interval for f in B-form is the interval containing all the knots. This means
that, e.g., f is sure to vanish at the endpoints of the basic interval unless the first and
the last knot are both of full multiplicity %k, with % the order of the spline f. Failure to
have such full multiplicity is particularly annoying when [ is a spline curve, since the
plot of that curve as produced by Fnplt is then bound to start and finish at the origin,
regardless of what the curve might otherwise do.

Further, since B-splines are zero outside their support, any function in B-form is zero
outside the basic interval of its form. This is very much in contrast to a function in
ppform whose values outside the basic interval of the form are given by the extension of
its leftmost, respectively rightmost, polynomial piece.

Algorithms

A vector X of evaluation points is generated by the union of:



anlt

1 101 equally spaced sites filling out the plotting interval
2 Any breakpoints in the plotting interval
The univariate function f described by F is evaluated at these X evaluation points. If fis

real-valued, the points (x,f(x)) are plotted. If f is vector-valued, then the first two or three
components of f(x) are plotted.

The bivariate function f described by F is evaluated on a 51-by-51 uniform grid if f

is scalar-valued or d-vector-valued with d > 2 and the result plotted by surf. In the
contrary case, [ 1s evaluated along the meshlines of a 11-by-11 grid, and the resulting
planar curves are plotted.

See Also

fnder | fnint | fnval
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fnrfn

Refine partition of form

Syntax

g = fnrfn(f,addpts)

Description

g = fnrfn(f,addpts) describes the same function as does F, but uses more terms to
do it. This is of use when the sum of two or more functions of different forms is wanted or
when the number of degrees of freedom in the form is to be increased to make fine local
changes possible. The precise action depends on the form in F.

If the form in Fis a B-form or BBform, then the entries of addpts are inserted into the
existing knot sequence, subject to the following restriction: The multiplicity of no knot
exceed the order of the spline. The equivalent B-form with this refined knot sequence for
the function given by ¥ is returned.

If the form in F is a ppform, then the entries of addpts are inserted into the existing
break sequence, subject to the following restriction: The break sequence be strictly
increasing. The equivalent ppform with this refined break sequence for the function in ¥
is returned.

Ffnrfn does not work for functions in stform.

If the function in F is m-variate, then addpts must be a cell array, {addptsi, .. .,
addptsm}, and the refinement is carried out in each of the variables. If the ith entry in
this cell array is empty, then the knot or break sequence in the ith variable is unchanged.

Examples

Construct a spline in B-form, plot it, then apply two midpoint refinements, and also plot
the control polygon of the resulting refined spline, expecting it to be quite close to the
spline itself:



Fann

k = 4; sp = spapi( k, [1,1:10,10], [cos(1l),sin(1:10),cos(10)] ):;
fnplt(sp), hold on
sp3 = fnrfn(fnrfn(sp));
plot( aveknt( fnbrk(sp3, "knots"),k), fnbrk(sp3, “coefs"), "r%)
hold off

A third refinement would have made the two curves indistiguishable.

Use fnrfn to add two B-splines of the same order:

Bl = spmak([0:4],1); B2 = spmak([2:6],1);
Bir = fnrfn(Bl,fnbrk(B2, “knots*));
B2r = fnrfn(B2,fnbrk(B1, "knots*));
B1pB2 = spmak(fnbrk(B1lr, *knots*®),fnbrk(Blr, c")+fnbrk(B2r,"c"));
fnplt(B1,"r"),hold on, fnplt(B2,*b"), fnplt(B1pB2,"y",2)
hold off

Algorithms

The standard knot insertion algorithm is used for the calculation of the B-form
coefficients for the refined knot sequence, while Horner's method is used for the
calculation of the local polynomial coefficients at the additional breaks in the refined
break sequence.

See Also

fncmb | ppmak | spmak
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fntlr

Taylor coefficients

Syntax

taylor = fntlr(f,dorder,x)

Description

taylor = fntlr(f,dorder,x) returns the unnormalized Taylor coefficients, up to
the given order dorder and at the given X, of the function described in F.

For a univariate function and a scalar X, this is the vector
T(f,dorder, x) = [f(x); Df (x);...; DI £( )]

If, more generally, the function in F is d-valued with d>1 or even prod(d)>1 and/

or is m-variate for some m>1, then dorder is expected to be an m-vector of positive
integers, X is expected to be a matrix with m rows, and, in that case, the output is of size
[prod(d)*prod(dorder),size(x,2)], with its j-th column containing

T(f ,dorder, x(:, )1, ...,im) = D;'17..D, ™ f(x(:, )

for i1=1:dorder (1), ..., im=1:dorder(m). Here, D/f is the partial derivative of f with
respect to its ith argument.

Examples

If £ contains a univariate function and X is a scalar or a 1-row matrix, then
fntlr(F,3,X) produces the same output as the statements

df = fnder(F); [fnval(f,x); fnval(df,x); fnval(fnder(df),x)]:

As a more complicated example, look at the Taylor vectors of order 3 at 21 equally spaced
points for the rational spline whose graph is the unit circle:



fntlr

i = rsmak("circle®); in = fnbrk(ci,"interv®);
linspace(in(1),in(2),21); t(end)=[];
fntlr(ci,3,t);

We plot ci along with the points v(1:2, ), to verify that these are, indeed, points on
the unit circle.

fnplt(ci), hold on, plot(v(1,:),v(2,:),"0")

Next, to verify that v(3:4,j) is a vector tangent to the circle at the point v(1:2,j), we
use the MATLAB quiver command to add the corresponding arrows to our plot:

quiver(v(1,:),v(2,:),v(3,:),v(4,:))

Finally, what about v(5:6, :)? These are second derivatives, and we add the
corresponding arrows by the following quiver command, thus finishing First and Second
Derivative of a Rational Spline Giving a Circle.

quiver(v(1,:),v(2,:),v(5,:),v(6,:)), axis equal, hold off
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First and Second Derivative of a Rational Spline Giving a Circle

Now, our curve being a circle, you might have expected the 2nd derivative arrows to
point straight to the center of that circle, and that would have been indeed the case

if the function in ci had been using arclength as its independent variable. Since the
parameter used is not arclength, we use the formula, given in “Example: B-form Spline
Approximation to a Circle” on page 10-23, to compute the curvature of the curve given by
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ci at these selected points. For ease of comparison, we switch over to the variables used
there and then simply use the commands from there.

dspt = v(3:4,:); ddspt = v(5:6,:);

kappa = abs(dspt(1,:)-*ddspt(2,:)-dspt(2,:)-*ddspt(1,:))-7/--.
(sum(dspt.~2)) -~(372);

max(abs(kappa-1))

ans = 2.2204e-016

The numerical answer is reassuring: at all the points tested, the curvature is 1 to within
roundoff.

See Also

fnder | fndir
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fnval

Evaluate spline function

Syntax

v = fnval (f,x)
fnval (x,T)
fnval(...,"1%)

Description

v = fnval(f,x) andv = fnval (X, ) both provide the value f(x) at the points in X
of the spline function f whose description is contained in F.

Roughly speaking, the output Vv is obtained by replacing each entry of X by the value
of f at that entry. This is literally true in case the function in F is scalar-valued and
univariate, and is the intent in all other cases, except that, for a d-valued m-variate
function, this means replacing m-vectors by d-vectors. The full details are as follows.

For a univariate f:

+ If fis scalar-valued, then v is of the same size as X.

+ Iffis[dl,...,dr]-valued, and X has size [nl, - .. ,ns], then v has size
[dl,...,dr, nl,...,ns],withv(:,...,2, J1,...,JS) thevalueoffat
x(J1,-.-..,JS),—except that
(1) nlisignored ifitis 1 and s is 2, i.e., if X is a row vector; and

(2) MATLAB ignores any trailing singleton dimensions of X.

For an m-variate f with m>1, with f [d1, . . . ,dr]-valued, X may be either an array, or
else a cell array {x1, ...,xm}.

+ If xis an array, of size [nl, - . .,ns] say, then n1 must equal m, and v has size
[dl,...,dr, n2,...,ns],withv(:,...,:, J2,.-..,]S) thevalueof fat
x(:,j2,---,J5),—except that
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(1) d1, ..., dr is ignored in case [ is scalar-valued, i.e., both r and nl are 1;

(2) MATLAB ignores any trailing singleton dimensions of X.

+ If xis a cell array, then it must be of the form {x1, . . . ,xm}, with Xj a vector,
of length nj, and, in that case, v has size [d1,...,dr, nl,...,nm], with
v(:i,---,:, J1,...,Jm) the value of f at (X1(j1), ..., xm(jm)), — except that d1, ...,
dr is ignored in case f is scalar-valued, i.e., both r and nl are 1.

If f has a jump discontinuity at X, then the value f(x +), i.e., the limit from the right, is
returned, except when X equals the right end of the basic interval of the form; for such X,
the value f(x—), i.e., the limit from the left, is returned.

fnval (X, F) isthe same as fnval (F,Xx).

fnval(...,"1") treats fas continuous from the left. This means that if f has a jump
discontinuity at X, then the value f(x—), 1.e., the limit from the left, is returned, except
when X equals the left end of the basic interval; for such X, the value f(x +) is returned.

If the function is multivariate, then the above statements concerning continuity from the
left and right apply coordinatewise.

Examples

Evaluate Functions at Specified Points
Interpolate some data and plot and evaluate the resulting functions.

Define some data.

X
y

= [0.074 0.31 0.38 0.53 0.57 0.58 0.59 0.61 0.61 0.65 0.71 0.81 0.97];
= [0.91 0.96 0.77 0.5 0.5 0.51 0.51 0.53 0.53 0.57 0.62 0.61 0.31];

Interpolate the data and plot the resulting function, f.

f = csapi( X, ¥y )
fnplt( )

Find the value of the function fat x = 0.5.

fnval( f, 0.5 )
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Find the value of the function fat0, 0.1, ..., 1.
fnval( £, 0:0.1:1 )
Create a function 2 that represents a surface.

0.0001+(-4:0.2:4);
-3:0.2:3;

, XX] = meshgrid( y, X );
pi*sqrt( XxX."2+yy."2 );
sin( r )./r;

2 = csapi( {x,y¥}, z );

=N =< X
1l II§ I

Plot the function 2.

fnplt( 2 )
axis( [-5, 5, -5, 5, -0.5, 1] );

Find the value of the function f2 at x = -2 andy = 3.

fval( 2, [-2; 31 )

Algorithms

For each entry of X, the relevant break- or knot-interval is determined and the relevant
information assembled. Depending on whether F is in ppform or in B-form, nested
multiplication or the B-spline recurrence (see, e.g., [PGS; X.(3)]) is then used vector-
fashion for the simultaneous evaluation at all entries of X. Evaluation of a multivariate
polynomial spline function takes full advantage of the tensor product structure.

Evaluation of a rational spline follows up evaluation of the corresponding vector-valued
spline by division of all but its last component by its last component.

Evaluation of a function in stform makes essential use of stcol, and tries to keep the
matrices involved to reasonable size.

See Also

fnbrk | ppmak | rsmak | spmak | stmak
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fnxtr

Extrapolate function

Syntax

g = fnxtr(f,order)
fnxtr(F)

Description

g = fnxtr(f,order) returns the spline (in ppform) that agrees with the spline in
on the latter's basic interval but is a polynomial of the given order outside it, with 2 the
default for order, in such a way that the spline in g satisfies at least order smoothness
conditions at the ends of F's basic interval, i.e., at the new breaks.

f must be in B-form, BBform, or ppform.

While order can be any nonnegative integer, fnxtr is useful mainly when order is
positive but less than the order of F.

If order is zero, then g describes the same spline as fFn2fm(F, "B-) but is in ppform and
has a larger basic interval.

If order is at least as big as f's order, then g describes the same pp as fn2fm(F, "pp~)
but uses two more pieces and has a larger basic interval.

If ¥ is m-variate, then order may be an m-vector, in which case order (i) specifies the
matching order to be used in the i-th variable, § = 1:m.

If order<0, then g is exactly the same as fn2fm(F, "pp"). This unusual option is useful
when, in the multivariate case, extrapolation is to take place in only some but not all

variables.

fnxtr(f) isthe same as fnxtr(fF,2).
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Examples

Example 1. The cubic smoothing spline for given data X,y is, like any other “natural'
cubic spline, required to have zero second derivative outside the interval spanned by
the data sites. Hence, if such a spline is to be evaluated outside that interval, it should
be constructed as s = fnxtr(csaps(x,y)). A Cubic Smoothing Spline Properly
Extrapolated, generated by the following code, shows the difference.

rng(6); x = rand(1,21); s = csaps(X,x-"3); sn = fnxtr(s);
fnplt(s,[--5 1.4],3), hold on, fnplt(sn,[-.5 1.4],.5,"r",2)
legend("cubic smoothing spline®," ... properly extrapolated®)
hold off
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Figurel EI@
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A Cubic Smoothing Spline Properly Extrapolated

Example 2. Here is the plot of a bivariate B-spline, quadratically extrapolated in the
first variable and not at all extrapolated in the second, as generated by

fnplt(fnxtr(spmak({0:3,0:4},1),[3,-1]1))

12-162



fnxtr

/I"n\‘%\\
/ "
,///,l¢

‘ Illl'%‘

o“\\\\\

A Bivariate B-spline Quadratically Extrapolated In One Direction

See Also

ppmak | spmak | fn2fm
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fnzeros

Find zeros of function in given interval

Syntax

z = fnzeros(f,[a b])
z = fnzeros(f)
Description

z = fnzeros(f,[a b]) is an ordered list of the zeros of the univariate spline f in the
interval [a .. b] .

z = fnzeros(¥) is a list of the zeros in the basic interval of the spline F.

A spline zero 1s either a maximal closed interval over which the spline is zero, or a zero
crossing (a point across which the spline changes sign).

The list of zeros, z, is a matrix with two rows. The first row is the left endpoint of the
intervals and the second row is the right endpoint. Each column z(:, J) contains the left
and right endpoint of a single interval.

These intervals are of three kinds:

+ If the endpoints are different, then the function is zero on the entire interval. In this
case the maximal interval is given, regardless of knots that may be in the interior of
the interval.

+ If the endpoints are the same and coincident with a knot, then the function in ¥ has a
zero at that point. The spline could cross zero, touch zero or be discontinuous at this
point.

+ If the endpoints are the same and not coincident with a knot, then the spline has a
zero crossing at this point.

If the spline, F, touches zero at a point that is not a knot, but does not cross zero, then
this zero may not be found. If it is found, then it may be found twice.
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Examples

Example 1. The following code constructs and plots a piecewise linear spline that
has each of the three kinds of zeros: touch zero, cross zero, and zero for an interval.
fnzeroscomputes all the zeros, and then the code plots the results on the graph.

sp = spmak(augknt(1:7,2),[1,0,1,-1,0,0,1]);

fnplt(sp)

z = fnzeros(sp)

nz = size(z,2);

hold on

plot(z(1,:),zeros(1,nz),"*>",z(2,:),zeros(1,nz),"<"), hold off

This gives the following list of zeros:
5 =

2.0000 3.5000 5.0000
2.0000 3.5000 6.0000

In this simple example, even for the second kind of zero, the two endpoints agree to all

places.

0.8

0.6r

0.4r

0.2

Example 2. The following code generates and plots a spline function with many extrema
and locates all extrema by computing the zeros of the spline function's first derivative

there.
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f = spmak( 1:21, rand( 1, 15 )-0.5 );
interval = fnbrk( f, "interval® );

z = fnzeros( fnder( ¥ ) );

z = z(1,:);

values = fnval( f, [interval, z] );
min( values )

fnplt(f)

hold on

plot(z,fnval(f,z),"ro")

hold off

Your plot will be different to the example following because of the use of rand to generate
random coefficients.
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Example 3. We construct a spline with a zero at a jump discontinuity and in B-form and
find all the spline's zeros in an interval that goes beyond its basic interval.
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sp = spmak([O 0 1 1 2],[1 O -.2]);

fnplt(sp)

z = fnzeros(sp,[-5, 2-7])

zy = zeros(l,size(z,2));

hold on, plot(z(1,:),zy,">",z(2,:),zy,"<"), hold off

This gives the following list of zeros:
zZ =

1.0000 2.0000
1.0000 2.7000

Notice the resulting zero interval [2..2.7], due to the fact that, by definition, a spline in B-
form is identically zero outside its basic interval, [0..2].

Example 4. The following example shows the use of fnzeros with a discontinuous
function. The following code creates and plots a discontinuous piecewise linear function,
and finds the zeros.

sp =spmak([0 0 112 2],[-1 1 -1 1]);

Tfnplt(sp);
fnzeros(sp)

This gives the following list of zeros, in (1..2) and (0..1) and the jump through zero at 1:

ans =

-5000 1.0000 1.5000
-5000 1.0000 1.5000

0
0
Algorithms

fnzeros first converts the function to B-form. The function performs some preprocessing
to handle discontinuities, and then uses the algorithm of Meorken and Reimers.

Reference: Knut Merken and Martin Reimers, An unconditionally convergent method for
computing zeros of splines and polynomials, Math. Comp. 76:845--865, 2007.

See Also

fnmin | fnval
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formula

Formula of cfit, sfit, or Fittype object

Syntax

formula(fun)

Description

formula(fun) returns the formula of the cFit, sFit, or Fittype object fun as a
character array.

Examples

f = fittype("weibull®™);
formula(f)

ans =
a*b*xN(b-1)*exp(-a*x"b)

g = fittype(“cubicspline®);
formula(g)

ans =
piecewise polynomial

See Also

fittype | coeffnames | numcoeffs | probnames | coeffvalues

Introduced in R2006b
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franke

Franke's bivariate test function

Syntax

z = franke(x,y)

Description
z = franke(X,y) returns the value z(i1) of Franke's function at the site (x(i1),y (1)),
i=1:numel (X), with z of the same size as X and y (which must be of the same size).

Franke's function is the following weighted sum of four exponentials:

3 ((9x-22+9y=27)/4 . 3 —(©x+1)>/49—(9y+1)/10)

—e +—e
4
1 _ _7)? —2)2 1 _ 2 2
L A0 +0y-3)4 1 04 +0y-77)
2 5
Examples

The following commands provide a plot of Franke's function:

pts = (0:50)/50; [X,y] = ndgrid(pts,pts); z = franke(x,y);
surf(x,y,z), view(145,-2), set(gca, "Fontsize",16)
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References

[1] Richard Franke. “A critical comparison of some methods for interpolation of scattered
data.” Naval Postgraduate School Tech.Rep. NPS-53-79-003, March 1979.
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get

Get fit options structure property names and values

Syntax

get(options)
s = get(options)
value = get(options, fld)

Description

get(options) displays all property names and values of the fit options structure
options.

s = get(options) returns a copy of the fit options structure options as the structure
S.
value = get(options, fl1d) returns the value of the property f1d of the fit options

structure options. f1d can be a cell array of character vectors, in which case value is
also a cell array.

Examples

options = fitoptions("fourierl®);
get(options, "Method")
ans =
NonlinearLeastSquares
get(options, "Maxlter"®)
ans =

400
set(options, "Maxiter",1le3);
get(options, "Maxlter")
ans =

1000

Property values can also be referenced and assigned using the dot notation. For example:

12-171



12  Functions — Alphabetical List

12-172

options._Maxlter
ans =
1000
options_Maxlter = 500;
options._Maxlter
ans =
500

See Also

fitoptions | set

Introduced before R2006a
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getcurve

Interactive creation of cubic spline curve

Syntax

[xy,spcv] = getcurve

Description

[xy,spcv] = getcurve displays a gridded window and asks you for input. As you click
on points in the gridded window, the broken line connecting these points is displayed. To
indicate that you are done, click outside the gridded window. Then a cubic spline curve,
spcv, through the point sequence, Xy, is computed (via cscvn) and drawn. The point
sequence and, optionally, the spline curve are output.

If you want a closed curve, place the last point close to the initial point.

If you would like the curve to have a corner at some point, click on that point twice (or
more times) in succession.

You can’t use getcurve over an existing figure, but you can use these functions to do the
same thing: MATLAB function ginput, and cscvn in Curve Fitting Toolbox.

Examples

Draw a Spline Over an Image

You can’t use getcurve over an existing figure, but you can use these functions to do the
same thing. The following example code allows you to click an existing image to draw a
spline through the points.

Draw the default image.
image

The function ginput collects mouse click points until you press Enter.
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[x, yl = ginput

Click on the axis to select points. Press Enter when you have finished selecting points.
Fit and plot a spline through the points using the cscvn function.

spcv = cscevn( [x, y]-7 )

hold on

fnplt( spcv )
hold off

See Also

cscvn
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indepnames

Independent variable of cFit, sTit, or Fittype object

Syntax

indep = indepnames(fun)

Description

indep = indepnames(fun) returns the independent variable name or names (indep)
of the cFit, sFit, or Fittype object fun. For curves indep is a 1-by-1 cell array of
character vectors, and for surfaces indep is a 2-by-1 cell array of character vectors.

Examples

fl = fittype(Ta*x"2+b*exp(n*x)");
indepl = indepnames(f1)
indepl =

e
2 = fittype("a*x"2+b*exp(n*x) ", "independent”, " n");
indep2 = indepnames(f2)
indep2 =

n"

See Also

dependnames | Fittype | formula

Introduced in R2006b
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integrate

Integrate cFit object

Syntax

int = integrate(fun,x,x0)

Description

int = integrate(fun,Xx,Xx0) integrates the cFit object Fun at the points specified
by the vector X, starting from X0, and returns the result in int. int is a vector the same
size as X. X0 is a scalar.

Examples

Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)";
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0._*randn(size(y0)); % Response-dependent
% Gaussian noise
ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:

T = fittype(C"a*sin(b*x)");
fitl = fit(xdata,ydata,f, "StartPoint”,[1 1]);

Find the integral of the fit at the predictors:
int = integrate(fitl,xdata,0);
Plot the data, the fit, and the integral:

subplot(2,1,1)
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plot(fitl,xdata,ydata) % cfit plot method
subplot(2,1,2)

plot(xdata,int,"m") % double plot method
grid on

legend("integral ™)

6 T T T T T T
Al : +  data |
. . + fitted curve
7 i
=
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25 T T

Note that integrals can also be computed and plotted directly with the cFit plot
method, as follows:

plot(fitl,xdata,ydata,{"fit", "integral"})

The plot method, however, does not return data on the integral.

See Also

fit | plot | differentiate

Introduced before R2006a
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islinear

Determine if cFit, sFit, or Fittype object is linear

Syntax

flag = islinear(fun)

Description

flag = islinear(fun) returns a flag of 1 if the cFit, sfit, or Fittype object fun
represents a linear model, and a Flag of O if it does not.

Note: islinear assumes that all custom models specified by the Fittype
function using the syntax ftype = Fittype("expr™) are nonlinear models.
To create a linear model with Fittype that will be recognized as linear by
islinear (and, importantly, by the algorithms of Fit), use the syntax ftype =
fittype({ exprl®,“expr2®,...,"exprn=}).

Examples
f = Ffittype("a*x+b")
f =

General model:
f(a,b,x) = a*x+b

g = fittype({"x","1"})
g =
Linear model:
g(a,b,x) = a*x + b
h = fittype(“polyl®)
h =

Linear model Polyl:
h(pl,p2,x) = pl*x + p2
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islinear(f)
ans =

0
islinear(Q)
ans =

1
islinear(h)
ans =

1

See Also

fittype

Introduced in R2006b
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knt2brk, knt2mlt

Convert knots to breaks and their multiplicities

Syntax

knt2brk(knots)

[breaks,mults] = knt2brk(knots)
m = knt2mlt(t)

[m,sortedt] = knt2mlt(t)

Description

The commands extract the distinct elements from a sequence, as well as their
multiplicities in that sequence, with multiplicity taken in two slightly different senses.

knt2brk(knots) returns the distinct elements in knots, and in increasing order,
hence 1s the same as unique(knots).

[breaks,mults] = knt2brk(knots) additionally provides, in mults, the
multiplicity with which each distinct element occurs in knots. Explicitly, breaks and
mults are of the same length, and knt2brk is complementary to brk2knt in that,
for any knot sequence knots, the two commands [xi,mlts] = knt2brk(knots);
knotsl = brk2knt(xi,mlts); give knotsl equal to knots.

m = knt2mlt(t) returns a vector of the same length as t, with m(i1) counting,

in the vector sort(t), the number of entries before its ith entry that are equal to

that entry. This kind of multiplicity vector is needed in spapi or spcol where such
multiplicity is taken to specify which particular derivatives are to be matched at the
sites in t. Precisely, if t is nondecreasing and z is a vector of the same length, then sp =
spapi(knots, t, 2z) attempts to construct a spline s (with knot sequence knots) for

which D"s(t(i)) equals 2(i), all i.
[m,sortedt] = knt2mlt(t) also returns the output from sort(t).

Neither knt2brk nor knt2mlt is likely to be used by the casual user of this toolbox.
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Examples

[xi,mits]=knt2brk([1 2 3 3 1 3]) returns [1 2 3] for xi and [2 1 3] for
mlts.

[m,t]=knt2mIt([1 2 3 3 1 3D returns [0 1 0 0 1 2] formand[1 1 2 3 3 3]
for t.

See Also

brk2knt | spapi | spcol
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newknt

New break distribution

Syntax

newknots = newknt(f,newl)
newknt(f)
[--..,distfn] = newknt(...)

Description

newknots = newknt(f,newl) returns the knot sequence whose interior knots cut
the basic interval of ¥ into newl pieces, in such a way that a certain piecewise linear
monotone function related to the high derivative of F is equidistributed.

The intent is to choose a knot sequence suitable to the fine approximation of a function
g whose rough approximation in f is assumed to contain enough information about g to

make this feasible.

newknt(f) uses for newl its default value, namely the number of polynomial pieces in
f.

[---,distfn] = newknt(...) alsoreturns, in distfn, the ppform of that piecewise
linear monotone function being equidistributed.

Examples

If the error in the least-squares approximation Sp to some data X,y by a spline of order k
seems uneven, you might try for a more equitable distribution of knots by using

spap2(newknt(sp),k,x,y);

For another example, see the last part of the example “Solving an ODE by Collocation”.
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Algorithms

This is the Fortran routine NEWNOT in PGS. With k the order of the piecewise-polynomial
function fin pp, the function | D*f| is approximated by a piecewise constant function

obtained by local, discrete, differentiation of the variation of D*7'f. The new break
sequence is chosen to subdivide the basic interval of the piecewise-polynomial fin such a
way that

J~newkn0ts(i+1)

newknots(7) | Dkf |1/k =const, i=k:k+newl-1
w 12
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numargs

Number of input arguments of cFit, sFit, or Fittype object

Syntax

nargs = numargs(fun)

Description

nargs = numargs(fun) returns the number of input arguments nargs of the cfit,
sfit, or Fittype object Fun.

Examples

T = Fittype("a*x™"2+b*exp(n*x)");
nargs = numargs(f)
nargs =

args
args

argnames(f)

. u
X SO I I H
.

See Also

fittype | formula | argnames

Introduced in R2006b

12-184



numcoeffs

numcoeffs

Number of coefficients of cFit, sFit, or Fittype object

Syntax

ncoeffs = numcoeffs(fun)

Description

ncoeffs = numcoeffs(fun) returns the number of coefficients ncoeffs of the cFit,

sfit, or Fittype object Fun.

Examples

T = Fittype("a*x™"2+b*exp(n*x)");

ncoeffs = numcoeffs(fT)
ncoeffs
3
coeffs
coeffs
"a
H*

n

coeffnames(fF)

See Also

fittype | formula | coeffnames

Introduced in R2006b
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optknt

Knot distribution “optimal” for interpolation

Syntax

knots = optknt(tau,k,maxiter)
optknt(tau,k)

Description

knots = optknt(tau,k,maxiter) provides the knot sequence t that is best for
interpolation from Si; at the site sequence tau, with 10 the default for the optional
input maxiter that bounds the number of iterations to be used in this effort. Here, best
or optimal is used in the sense of Micchelli/Rivlin/Winograd and Gaffney/Powell, and
this means the following: For any recovery scheme R that provides an interpolant Rg
that matches a given g at the sites tau(l), ..., tau(n), we may determine the smallest

constant consty, for which ||g — Rg|| < constg ||D",|| for all smooth functions g.

Here, ||f]l:=SUPtau) <x < tauw | f(x) | . Then we may look for the optimal recovery scheme as
the scheme R for which constg is as small as possible. Micchelli/Rivlin/Winograd have
shown this to be interpolation from Sy, with t uniquely determined by the following
conditions:

t()= ... =t(k) =tau(l);
2 t(n+1l) = ... = t(n+k) = tau(n);

3 Any absolutely constant function A with sign changes at the sites t(k+1), ..., t(n)
and nowhere else satisfies

tau(n)
jtau(l) f()h(x)dx =0 for all f e Sy,

Gaffney/Powell called this interpolation scheme optimal since it provides the center
function in the band formed by all interpolants to the given data that, in addition, have
their kth derivative between M and —M (for large M).
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optknt(tau,k) 1isthe same as optknt(tau,k,10).

Examples

See the last part of the example “Spline Interpolation” for an illustration. For the
following highly nonuniform knot sequence

t = [0, .0012+[0, 1, 2+[0,.1], 4]*1le-5, .002, 1];:

the command optknt(t,3) will fail, while the command optknt(t,3,20), using a
high value for the optional parameter maxiter, will succeed.

Algorithms

This is the Fortran routine SPLOPT in PGS. It is based on an algorithm described in
“References” on page 12-187, for the construction of that sign function 2 mentioned
above. It is essentially Newton's method for the solution of the resulting nonlinear
system of equations, with aveknt(tau, k) providing the first guess for t(k+1), ...,t(n),
and some damping used to maintain the Schoenberg-Whitney conditions.

References

[1]C. de Boor, “Computational aspects of optimal recovery”, in Optimal Estimation in
Approximation Theory, C.A. Micchelli & T.J. Rivlin eds., Plenum Publ., New York, 1977,
69-91.

[2]P.W. Gaffney & M.J.D. Powell, “Optimal interpolation”, in Numerical Analysis, G.A.
Watson ed., Lecture Notes in Mathematics, No. 506, Springer-Verlag, 1976, 90-99.

[3]C.A. Micchelli, T.J. Rivlin & S. Winograd, “The optimal recovery of smooth functions”,
Numer. Math. 80, (1974), 903-906.

See Also

aptknt | aveknt | newknt

12-187



12  Functions — Alphabetical List

12-188

plot

Plot cFit or sFit object

Syntax

plot(sfit)
plot(sfit, [x, v], 2)
plot(sfit, [x, yl, z, "Exclude®, outliers)

H = plot(sfit, ., "Style", Style)

H = plot(sfit, ..., "Level”, Level)

H = plot(sfit, ..., "XLim", XLIM)

H = plot(sfit, ..., "YLim", YLIM)

H = plot(sfit, ...)

H = plot(sfit, ..., "Parent®, HAXES )
plot(cfit)

plot(cfit,x,y)

plot(cfit,x,y,DataLineSpec)
plot(cfit,FitLineSpec,x,y,DataLineSpec)
plot(cfit,x,y,outliers)
plot(cfit,x,y,outliers,OutlierLineSpec)
plot(...,ptype,...)

plot(...,ptype, level)

h = plot(...)

Description
For surfaces:

plot(sfit) plots the sFit object over the range of the current axes, if any, or
otherwise over the range stored in the fit.

plot(sfit, [x, y], 2) plots z versus x and y and plots sFit over the range of x
and y.

plot(sfit, [x, y], z, "Exclude®, outliers) plots the excluded data in a
different color. outliers can be an expression describing a logical vector, e.g., X >
10, a vector of integers indexing the points you want to exclude, e.g., [1 10 25],



p|ot

or a logical array where true represents an outlier. You can create the array with
excludedata.

H = plot(sfit, ..., "Style", Style) selects which way to plot the surface fit
object sfFit.

Style may be any of the following character vectors

+ "Surface” Plot the fit object as a surface (default)
"PredFunc”® Surface with prediction bounds for function
"PredObs" Surface with prediction bounds for new observation

+ "Residuals” Plot the residuals (fit is the plane Z=0)

+ "Contour® Make a contour plot of the surface

H = plot(sfit, ..., "Level”, Level) sets the confidence level to be used

in the plot. Level is a positive value less than 1, and has a default of 0.95 (for 95%
confidence). This option only applies to the "PredFunc® and "PredObs” plot styles.
H = plot(sfit, ..., "XLim", XLIM) andH = plot(sfit, ..., "YLim",
YLIM) sets the limits of the axes used for the plot. By default the axes limits are
taken from the data, XY. If no data is given, then the limits are taken from the surface
fit object, sFit.

H = plot(sfit, ...) returns a vector of handles of the plotted objects.

H = plot(sfit, ..., "Parent”, HAXES ) plots the fit object sSFit in the axes
with handle HAXES rather than the current axes. The range is taken from these axes
rather than from the fit or the data.

For curves:

plot(cfit) plots the cFit object over the domain of the current axes, if any. If there
are no current axes, and fun is an output from the Fit function, the plot is over the
domain of the fitted data.

plot(cfit,x,y) plots cFit together with the predictor data X and the response
datay.

plot(cfit,x,y,DatalLineSpec) plots the predictor and response data using the
color, marker symbol, and line style specified by the DataL ineSpec formatting
character vector. Datal ineSpec character vectors take the same values as LineSpec
character vectors used by the MATLAB plot function.

plot(cfit,FitLineSpec,x,y,DataLineSpec) plots fun using the color, marker
symbol, and line style specified by the FitLineSpec formatting character vector,
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and plots X and y using the color, marker symbol, and line style specified by the
DatalL ineSpec formatting character vector. FitLineSpec and DatalL ineSpec
character vectors take the same values as LineSpec character vectors used by the
MATLAB plot function.

plot(cfit,x,y,outliers) plots data indicated by outliers in a different color.
outliers can be an expression describing a logical vector, e.g., X > 10, a vector of
integers indexing the points you want to exclude, e.g., [1 10 25], or a logical array
where true represents an outlier. You can create the array with excludedata.

plot(cfit,x,y,outliers,OutlierLineSpec) plots outliers using

the color, marker symbol, and line style specified by the OutlierLineSpec.
OutlierLineSpec character vectors take the same values as LineSpec character
vectors used by the MATLAB plot function.

plot(...,ptype, -..) uses the plot type specified by ptype. Supported plot types
are:
"fit" — Data and fit (default)
+ "predfunc® — Data and fit with prediction bounds for the fit
* "predobs® — Data and fit with prediction bounds for new observations
* "residuals®™ — Residuals

+ "stresiduals®™ — Standardized residuals (residuals divided by their standard
deviation).

"derivl® — First derivative of the fit
+ "deriv2®™ — Second derivative of the fit
"integral " — Integral of the fit

plot(...,ptype, level) plots prediction intervals with a confidence level specified
by level. level must be between O and 1. The default value of level is 0.95.

For both curves and surfaces:

Plot types can be single or multiple, with multiple plot types specified as a cell array
of character vectors. With a single plot type, plot draws to the current axes and
can be used with commands like hold and subplot. With multiple plot types, plot
creates subplots for each plot type.

h = plot(...) returns a vector of handles to the plotted objects.
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Examples

Create a baseline sinusoidal signal:

xdata = (0:0.1:2*pi)";
y0 = sin(xdata);

Add noise to the signal with non-constant variance:

% Response-dependent Gaussian noise
ghoise = yO.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));
ydata = y0 + gnoise + spnoise;

Fit the noisy data with a baseline sinusoidal model:

f = Fittype("a*sin(b*x)");
fitl = fit(xdata,ydata,f, "StartPoint”,[1 1]);

Identify “outliers” as points at a distance greater than 1.5 standard deviations from the
baseline model, and refit the data with the outliers excluded:

fdata = feval (Fitl,xdata);
1 = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata, "indices”,1);

fit2 = fit(xdata,ydata,f, "StartPoint”,[1 1],---
"Exclude” ,outliers);

Compare the effect of excluding the outliers with the effect of giving them lower bisquare
weight in a robust fit:

fit3 = fit(xdata,ydata,f,"StartPoint”,[1 1], "Robust®,"on");
Plot the data, the outliers, and the results of the fits:

plot(fitl,"r-",xdata,ydata, "k.",outliers, "m*")
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hold on
plot(fit2,"c--")
plot(fit3,"b:")
xim([0 2*pi])

3 : : T T . .
#* +  data
gl * o, N #*  excluded data |
* #* fitted curve
al * fitted cunve
""""" fitted curve

Plot the residuals for the two fits considering outliers:

figure

plot(fit2,xdata,ydata, "co", "residuals™)
hold on

plot(fit3,xdata,ydata, "bx", "residuals®)



p|ot

6 T T T T T T
. x" B og data
al zero line |
« *  data
Zero lina
21 £ .
=
><x % 5 o X
)
0 S * P omm W MKy % 2 |
® 3 . e
% ® *
2 r H _
4t “ 1
w o X
* £ w
_6 1 1 1 1 1 1
0 1 2 3 4 5 G 7
¥

Load data and fit a Gaussian, excluding some data with an expression, then plot the fit,
data and the excluded points.

[x, y] = titanium;
fl = fit(xX",y","gauss2", "Exclude®, x<800);
plot(fl,x,y,x<800)

For more examples excluding data and plotting fits, see Fit.

See Also

See Also

Apps
Curve Fitting

Functions
differentiate | excludedata | fit | integrate

Introduced before R2006a
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ppmak

Put together spline in ppform

Syntax

ppmak(breaks, coefs)

ppmak

ppmak(breaks, coefs,d)
ppmak(breaks,coefs,sizec)

Description

The command ppmak(. . .) puts together a spline in ppform from minimal information,
with the rest inferred from that information. fnbrk provides any or all of the parts of
the completed description. In this way, the actual data structure used for the storage

of the ppform is easily modified without any effect on the various fn. .. commands
that use this construct. However, the casual user is not likely to use ppmak explicitly,
relying instead on the various spline construction commands in the toolbox to construct
particular splines.

ppmak(breaks,coefs) returns the ppform of the spline specified by the break
information in breaks and the coefficient information in coefs. How that information is
interpreted depends on whether the function is univariate or multivariate, as indicated
by breaks being a sequence or a cell array.

If breaks is a sequence, it must be nondecreasing, with its first entry different from its
last. Then the function is assumed to be univariate, and the various parts of its ppform
are determined as follows:

1  The number I of polynomial pieces is computed as length(breaks)-1, and the
basic interval is, correspondingly, the interval [breaks(1) .. breaks(1+1)].

2 The dimension d of the function's target is taken to be the number of rows in
coefs. In other words, each column of coefs is taken to be one coefficient. More
explicitly, coefs(:, i*k+]j) is assumed to contain the jth coefficient of the (i+1)st
polynomial piece (with the first coefficient the highest and the kth coefficient the
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lowest, or constant, coefficient). Thus, with kI the number of columns of coefs, the
order k of the piecewise-polynomial is computed as Fix(k1/1).

After that, the entries of coefs are reordered, by the command
coefs = reshape(permute(reshape(coefs,[d,k,11]),[1 3 2]),[d*1,k])

in order to conform with the internal interpretation of the coefficient array in

the ppform for a univariate spline. This only applies when you use the syntax
ppmak(breaks, coefs) where breaks is a sequence (row vector), not when it is a cell-
array. The permutation is not made when you use the three-argument forms of ppmak.
For the three-argument forms only a reshape is done, not a permute.

If breaks is a cell array, of length m, then the function is assumed to be m-variate (tensor
product), and the various parts of its ppform are determined from the input as follows:

1  The m-vector | has length(breaks{i})-1 asits ith entry and, correspondingly,
the m-cell array of its basic intervals has the interval [breaks{i}(1) -.
breaks{i}(end)] asits ith entry.

2 The dimension d of the function's target and the m-vector k of (coordinate-wise
polynomial) orders of its pieces are obtained directly from the size of coefs, as
follows.

a If coefsis an m-dimensional array, then the function is taken to be scalar-
valued, i.e., d is 1, and the m-vector K is computed as size(coefs) ./1.
After that, coefs is reshaped by the command coefs = reshape(coefs,
[1,size(coefs)]).

b If coefsis an (r+m)-dimensional array, with sizec = size(c) say, thend
1s set to sizec(1l:r), and the vector K is computed as sizec(r+(1:m))./

I. After that, coefs is reshaped by the command coefs = reshape(coefs,
[prod(d),sizec(r+(1:m))]D).

Then, coefs is interpreted as an equivalent array of size
[d,1(1).k(1),1(2).k(2), ..., 1(m),k(m)], with its
G,i(D),r(V),i(2),r(2), - - -, i(m),r(m))th entry the coefficient of

m

H (x(u) —breaks I,Ll](i(u)))(k(“)"(“))
=1

=

in the local polynomial representation of the function on the (hyper)rectangle with sides
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[breaks| ul(i(w)) .. breaks | ul(i()+1)], wu=1:m

This is, in fact, the internal interpretation of the coefficient array in the ppform of a
multivariate spline.

ppmak prompts you for breaks and coefs.

ppmak(breaks,coefs,d) with d a positive integer, also puts together the ppform of

a spline from the information supplied, but expects the function to be univariate. In that

case, coefs is taken to be of size [d*1,k], with I obtained as length(breaks)-1, and
this determines the order, k, of the spline. With this, coefs(i*d+j, :) is taken to be the
Jth components of the coefficient vector for the (i+1)st polynomial piece.

ppmak(breaks,coefs,sizec) with sizec a row vector of positive integers, also puts
together the ppform of a spline from the information supplied, but interprets coefs

to be of size sizec (and returns an error when prod(size(coefs)) differs from
prod(sizec)). This option is important only in the rare case that the input argument
coefs is an array with one or more trailing singleton dimensions. For, MATLAB
suppresses trailing singleton dimensions, hence, without this explicit specification of the
intended size of coefs, ppmak would interpret coefs incorrectly.

Examples

The two splines

pl = ppmak([1 3 4],[1 2 5 6:;3 4 7 8]):;
p2 = ppmak([1 3 4]1,[1 2;3 4;5 6;7 8]1,2);

have exactly the same ppform (2-vector-valued, of order 2). But the second command
provides the coefficients in the arrangement used internally.

ppmak([0:2],[1:6]) constructs a piecewise-polynomial function with basic interval
[0..2] and consisting of two pieces of order 3, with the sole interior break 1. The resulting
function is scalar, i.e., the dimension d of its target is 1. The function happens to be
continuous at that break since the first piece is x| —x* + 2x + 3, while the second piece is

x| —4(x — 1)* + 5(x—1) + 6.

When the function is univariate and the dimension d is not explicitly specified, then
it is taken to be the row number of coefs. The column number should be an integer
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multiple of the number I of pieces specified by breaks. For example, the statement
ppmak([0:2],[1:3;4:6]) leads to an error, since the break sequence [0:2] indicates
two polynomial pieces, hence an even number of columns are expected in the coefficient
matrix. The modified statement ppmak([0:1],[1:3;4:6]) specifies the parabolic

curve x| —(1,4)x* + (2,5)x + (3,6). In particular, the dimension d of its target is 2. The
differently modified statement ppmak([0:2],[1:4;5:8]) also specifies a planar curve
(i.e., d is 2), but this one is piecewise linear; its first polynomial piece is x| —(1,5)x + (2,6).

Explicit specification of the dimension d leads, in the univariate case, to a different
interpretation of the entries of coefs. Now the column number indicates the polynomial
order of the pieces, and the row number should equal d times the number of pieces.
Thus, the statement ppmak([0:2],[1:4;5:8],2) is in error, while the statement
ppmak([0:2],[1:4;5:8],1) specifies a scalar piecewise cubic whose first piece is x|
—x + 227 + 3x + 4.

If you wanted to make up the constant polynomial, with basic interval [0..1] say, whose
value is the matrix eye(2), then you would have to use the full optional third argument,
1.e., use the command

pp = ppmak(0:1,eye(2),[2,2,1,1]);

Finally, if you want to construct a 2-vector-valued bivariate polynomial on the rectangle
[-1..1] x [0 .. 1], linear in the first variable and constant in the second, say

coefs = zeros(2,2,1); coefs(:,:,1) = [1 0; 0 1];
then the straightforward
pp = ppmak({[-1 1],[0 1]},coefs);
will fail, producing a scalar-valued function of order 2 in each variable, as will

pp = ppmak({[-1 1],[0 1]},coefs,size(coefs));

while the following command will succeed:
pp = ppmak({[-1 1],[0 1]},coefs,[2 2 1]);

See the example “Intro to ppform” for other examples.

See Also

fnbrk
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predint

Prediction intervals for cFit or sFit object

predint(fitresult,x)
predint(fitresult,x, level)

= predint(fitresult,x,level,intopt,simopt)
i,y] = predint(...)

000
O == o o
|

Description

ci = predint(Ffitresult,Xx) returns upper and lower 95% prediction bounds for
response values associated with the cFit object Fitresult at the new predictor values
specified by the vector X. Fitresult must be an output from the fit function to contain
the necessary information for ci. ci is an n-by-2 array where n = length(x). The left
column of ci contains the lower bound for each coefficient; the right column contains the
upper bound.

ci = predint(fitresult,Xx, level) returns prediction bounds with a confidence
level specified by level. level must be between O and 1. The default value of level is
0.95.

ci = predint(fitresult,x,level,intopt,simopt) specifies the type of bounds to
compute.

intopt is one of

+ "observation®™ — Bounds for a new observation (default)
+ "functional® — Bounds for the fitted curve

simopt is one of

+ "off" — Non-simultaneous bounds (default)

* "on" — Simultaneous bounds

Observation bounds are wider than functional bounds because they measure the
uncertainty of predicting the fitted curve plus the random variation in the new
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observation. Non-simultaneous bounds are for individual elements of X; simultaneous
bounds are for all elements of x.

[ci,y] = predint(...) returns the response values y predicted by fitresult at the
predictors in X.

Note: predint cannot compute prediction intervals for non-parametric regression
methods such as Interpolant, Lowess, and Spline.

Examples

Compute Prediction Intervals
Compute and plot observation and functional prediction intervals for a fit to noisy data.

Generate noisy data with an exponential trend.

X
y

(0:0.2:5)";
2*exp(-0.2*x) + O0.5*randn(size(x));

Fit a curve to the data using a single-term exponential.
Ffitresult = fit(x,y, "expl”);

Compute 95% observation and functional prediction intervals, both simultaneous and
nonsimultaneous.

pll = predint(fitresult,x,0.95, "observation”, "off");
pl2 = predint(fitresult,x,0.95, "observation”, on");
p21 = predint(fitresult,x,0.95, "functional®, "off");
p22 = predint(fitresult,x,0.95, "functional”,"on");

Plot the data, fit, and prediction intervals. Note that the observation bounds are wider
than the functional bounds.

subplot(2,2,1)

plot(fitresult,x,y), hold on, plot(x,pll, m--"), xblim([0 5]), yvlim([-1 5])
title("Nonsimultaneous Observation Bounds®, "FontSize*",9)

legend off

subplot(2,2,2)

plot(fitresult,x,y), hold on, plot(x,pl2,"m--"), xblim([0 5]), ylim([-1 5])
title("Simultaneous Observation Bounds®, "FontSize~®,9)
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legend off

subplot(2,2,3)
plot(fitresult,x,y), hold on, plot(x,p21, m--"), xblim([0 5]), ylim([-1 5])
title("Nonsimultaneous Functional Bounds®,"FontSize®,9)

legend off

subplot(2,2,4)
plot(fitresult,x,y), hold on, plot(x,p22,"m--"), xblim([0 5]), ylim([-1 5])
title("Simultaneous Functional Bounds®, "FontSize®",9)
legend({"Data", "Fitted curve®, "Prediction intervals®},...

"FontSize",8, "Location”, "northeast”)
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Monsimultaneous Observation Bounds

4
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See Also

confint | fit | plot

Introduced before R2006a
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prepareCurveData

Prepare data inputs for curve fitting

Syntax

[XOut,YOut] = prepareCurveData(XIn,YIn)
[XOut, YOut,Wout] = prepareCurveData(XIn,YIn,WIn)

Description

[XOut,YOut] = prepareCurveData(XIn,YIn) transforms data, if necessary, for
curve fitting with the Fit function. The prepareCurveData function transforms data as
follows:

* Return data as columns regardless of the input shapes. Error if the number of
elements do not match. Warn if the number of elements match, but the sizes differ.

+  Convert complex to real (remove imaginary parts) and warn of this conversion.
* Remove NaN or Inf from data and warn of this removal.

*  Convert nondouble to double and warn of this conversion.

Specify XIn as empty if you want to fit curves to y data against the index. If XIn is
empty, then XOut is a vector of indices into YOut. The Fit function can use the vector
XOut for the x data when there is only y data.

[XOut,YOut,WOout] = prepareCurveData(XIn,YIn,WIn) transforms data including
weights (WIn) for curve fitting with the Fit function.

When you generate code from the Curve Fitting app, the generated code includes a
call to prepareCurveData (or prepareSurfaceData for surface fits). You can call
the generated file from the command line with your original data or new data as input
arguments, to recreate your fits and plots. If you call the generated file with new data,
the prepareCurveData function ensures you can use any data that you can fit in the
Curve Fitting app, by reshaping if necessary to column doubles and removing NaNs,
Infs, or the imaginary parts of complex numbers.
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Input Arguments

XIn

X data variable for curve fitting, of any numeric type. XIn can be empty. Specify empty
(I D when you want to fit curves to y data against index (x=1:length(y)). See YOUt.

YIn
Y data variable for curve fitting, of any numeric type.
Win

Weights variable for curve fitting, of any numeric type.

Output Arguments

XOut
X data column variable prepared for curve fitting, of type double.

If XIn is empty, then XOut is a vector of indices into YOut. The Fit function can use the
vector XOut for the x data when there is only y data.

YOut
Y data column variable prepared for curve fitting, of type double.
WOut

Weights column variable prepared for curve fitting, of type double.

Examples

Reshape Rows to Columns for Curve Fitting

The following commands load the example titanium data in which X and y are row
vectors. Attempting to use rows as inputs to the Fit function produces an error. The
prepareCurveData function reshapes X and y to columns for use with the Fit function.
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[x.y] = titaniumQ;
[x.y]l = prepareCurveData(x,y);

Create and plot a fit using the reshaped data.

f = fit(x,y, "smoothingspline®);
plot(f,x,y)

2.2

[
1671

0.6 ' '

+ data
fitted curve |

500 G600 700 800

See Also

See Also

excludedata | fit | prepareSurfaceData
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Introduced in R2013a
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prepareSurfaceData

Prepare data inputs for surface fitting

Syntax

[XOut, YOut, ZOut] = prepareSurfacebData(XIn, YIn, ZIn)
[XOut, YOut, ZOut, WOut] = prepareSurfaceData(XIn, YIn, ZIn, WIn)

Description

[XOut, YOut, ZOut] = prepareSurfaceData(XIn, YIn, ZIn) transforms data,
if necessary, for surface fitting with the Fit function. The function transforms data as
follows:

*  For grid vectors, transform row (Y In) and column (XIn) headers into arrays YOut and
XOut that are the same size as ZIn. Warn if XIn and YIn are reversed.

* Return data as columns regardless of the input shapes. Error if the number of
elements do not match. Warn if the number of elements match, but the sizes are
different.

+  Convert complex to real (remove imaginary parts) and warn of this conversion.
* Remove NaN or Inf from data and warn of this removal.

+  Convert nondouble to double and warn of this conversion.

[XOut, YOut, ZOut, WOut] = prepareSurfaceData(XIn, YIn, ZIn, WIn)
transforms data including weights (WIn) for surface fitting with the it function.

Use prepareSurfaceData if your data is not in column vector form. For example, you
have 3 matrices. You can also use prepareSurfaceData if you have grid vectors, where
length(XIn) = n, length(YIn) = mandsize(ZIn) = [m,n]. You must process
grid vector data for use with the Fit function by using prepareSurfaceData. If you use
Curve Fitting app, you can select grid vector data and it automatically converts the data
for you.

If your data is in a MATLAB table, you do not need to use prepareSurfaceData. You
can specify variables in a MATLAB table as inputs to the Fit function using the form
tablename.varname.
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When you generate code from Curve Fitting app, the generated code includes a call

to prepareSurfaceData (or prepareCurveData for curve fits). You can call the
generated file from the command line with your original data or new data as input
arguments, to recreate your fits and plots. If you call the generated file with new data,
the prepareCurveData function ensures you can use any data that you can fit in Curve
Fitting app, by reshaping if necessary and removing NaNs, Infs, or the imaginary parts
of complex numbers.

Examples

Prepare surface data for the fit function

Create some data that is unsuitable for the fit function without preprocessing, because it
is nondouble, noncolumn, and contains some Nan and Inf values.

X int32(1:4);
y int32(1:5);
z rand(5,4);
z(13) = Inf;
z(3) = NaN;

Use the prepareSurfaceData to convert rows to columns, nondoubles to doubles, and
remove Nan and InfT.

[xo,y0,z0] = prepareSurfaceData(x,y,z);

The function displays the same warnings that you see if you select this data in the Curve
Fitting app. The warnings tell you how your data is processed to be suitable for the Fit
function.

Use whos to check that the prepareSurfaceData converted the variables to column
vectors that are doubles.

whos xo0 yo zo

See Also

See Also

excludedata | fit | prepareCurveData
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Topics
“Selecting Compatible Size Surface Data” on page 2-11

Introduced in R2010b
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probnames

Problem-dependent parameter names of cFit, sFit, or Fittype object

Syntax

pnames = probnames(fun)

Description

pnames = probnames(fun) returns the names of the problem-dependent (fixed)
parameters of the cFit, sFit, or Fittype object Fun as a cell array of character vectors.

Examples

f = fittype("(x-a)™n + b, "problem”,{"a","b"});
coeffnames(f)
ans =
"
probnames(f)
ans =
“ar
IbI

load census

c = fit(cdate,pop, T, "problem”,{cdate(1),pop(D},---
"StartPoint”",2);

coeffvalues(c)
ans =

0.9877
probvalues(c)
ans =

1.0e+003 *
1.7900 0.0039
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See Also

fittype | coeffnames | probvalues

Introduced in R2006b
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probvalues

Problem-dependent parameter values of cFit or sFit object

Syntax

pvals = probvalues(fun)

Description

pvals = probvalues(fun) returns the values of the problem-dependent (fixed)
parameters of the cFit object fun as a row vector.

Examples

f = fittype("(x-a)™n + b, "problem”,{"a","b"});
coeffnames(f)
ans =
"
probnames(f)
ans =
“ar
IbI

load census

c = fit(cdate,pop, T, "problem”,{cdate(1),pop(D},---
"StartPoint”",2);

coeffvalues(c)
ans =

0.9877
probvalues(c)
ans =

1.0e+003 *
1.7900 0.0039
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See Also

fit | fittype | probnames

Introduced in R2006b
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quad2d

Numerically integrate sFit object

Syntax
Q = quad2d(FO, a, b, c, d)

[Q,ERRBND] = quad2d(...)
[Q,ERRBND] = QUAD2D(FO,a,b,c,d,PARAM1,VAL1,PARAM2,VAL2,...)

Description

Q = quad2d(FO, a, b, c, d) approximates the integral of the surface fit object FO

over the planar region @ <% < b and dx) <y <d(x) . The bounds ¢ and d can each be a
scalar, a function handle, or a curve fit (CFit) object.

[Q,ERRBND] = quad2d(...) also returns an approximate upper bound on the absolute
error, ERRBND.

[Q,ERRBND] = QUAD2D(FO,a,b,c,d,PARAM1,VAL1,PARAM2,VAL2, . ..) performs
the integration with specified values of optional parameters.

See the MATLAB function quad2d for details of the upper bound and the optional
parameters.

See Also

quad2d | fit | sfit | cfit

Introduced in R2009b
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rpmak

Put together rational spline

Syntax

rp = rpmak(breaks,coefs)

rp = rpmak(breaks,coefs,d)
rpmak(breaks,coefs,sizec)

rs = rsmak(knots,coefs)

rs = rsmak(shape,parameters)

Description

Both rpmak and rsmak put together a rational spline from minimal information. rsmak
is also equipped to provide rational splines that describe standard geometric shapes. A
rational spline must be scalar- or vector-valued.

rp = rpmak(breaks,coefs) has the same effect as the command ppmak(breaks,
coefs) except that the resulting ppform is tagged as a rational spline, i.e., as a rpform.

To describe what this means, let R be the piecewise-polynomial put together by the
command ppmak(breaks,coefs), and let r(x) = s(x)/w(x) be the rational spline

put together by the command rpmak(breaks,coefs). If v is the value of R at x,

then v(1:end-1)/v(end) is the value of r at x. In other words, R(x) = [s(x);w(x)].
Correspondingly, the dimension of the target of r is one less than the dimension of the
target of R. In particular, the dimension (of the target) of R must be at least 2, i.e., the
coefficients specified by coefs must be d-vectors with d > 1. See ppmak for how the
input arrays breaks and coefs are being interpreted, hence how they are to be specified
in order to produce a particular piecewise-polynomial.

rp = rpmak(breaks,coefs,d) has the same effect as ppmak(breaks,coefs,d+1),
except that the resulting ppform is tagged as being a rpform. Note that the desire to have
that optional third argument specify the dimension of the target requires different values
for it in rpmak and ppmak for the same coefficient array coefs.

rpmak(breaks,coefs,sizec) has the same effect as
ppmak(breaks, coefs,sizec) except that the resulting ppform is tagged as being a
rpform, and the target dimension is taken to be sizec(1)-1.
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rs = rsmak(knots,coefs) is similarly related to spmak(knots, coefs), and
rsmak(knots, coefs,sizec) to spmak(knots, coefs,sizec). In particular,
rsmak(knots, coefs) puts together a rational spline in B-form, i.e., it provides a
rBform. See spmak for how the input arrays knots and coefs are being interpreted,
hence how they are to be specified in order to produce a particular piecewise-polynomial.

rs = rsmak(shape,parameters) provides a rational spline in rBform that describes
the shape being specified by the character vector shape and the optional additional
parameters. Specific choices are:

rsmak("arc” ,radius,center, [alpha,beta])
rsmak("circle”,radius,center)
rsmak("cone” ,radius,halfheight)
rsmak("cylinder”,radius,height)
rsmak("southcap”,radius,center)
rsmak("torus” ,radius,ratio)

with 1 the default value for radius, halfheight and height, and the origin the
default for center, and the arc running through all the angles from alpha to beta
(default is [-pi/2,pi/2]), and the cone, cylinder, and torus centered at the origin
with their major circle in the (x,y)-plane, and the minor circle of the torus having radius
radius*ratio, the default for ratio being 1/3.

From these, one may generate related shapes by affine transformations, with the help of
fncmb(rs, transformation).

All fn. .. commands except fnint, fnder, fndir can handle rational splines.

Examples

The commands

rsmak([-5 5],[1 11; 26 -24 26]);

runges -5 -
rpmak([-5 5],[ ; 1 -10 26],1);

rungep

both provide a description of the rational polynomial r(x) = 1/(x* + 1) on the interval [-5
5]. However, outside the interval [-5 .. 5], the function given by runges is zero, while the

rational spline given by rungep agrees with 1/(x* + 1) for every x.

The figure of a rotated cone is generated by the commands
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fnplt(fncmb(rsmak("cone”,1,2),[0 O -1;0 1 0;1 O 0]))
axis equal, axis off, shading interp

A Rotated Cone Given by a Rational Quadratic Spline

A Helix, showing a helix with several windings, is generated by the commands

arc = rsmak("arc*,2,[1;-1],[0 7.3*pi]);

[knots,c] = fnbrk(arc, "k","c");

helix = rsmak(knots, [c(1:2,:);aveknt(knots,3).*c(3,:);
c(B,:)D:;

fnplt(helix)
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A Helix

For further illustrated examples, see “NURBS and Other Rational Splines” on page 10-29

See Also

rsmak | fnbrk | ppmak | spmak
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rscvn

Piecewise biarc Hermite interpolation

Syntax

c = rscvn(p,u)
C rscvn(p)

Description

c = rscvn(p,u) returns a planar piecewise biarc curve (in quadratic rBform) that
passes, in order, through the given points p(:, J) and is constructed in the following way
(see Construction of a Biarc). Between any two distinct points p(:,J) and p(:,j+1),
the curve usually consists of two circular arcs (including straight-line segments) which
join with tangent continuity, with the first arc starting at p(:,J) and normal there to
u(:,J), and the second arc ending at p(:, j+1) and normal there to u(:, j+1), and
with the two arcs written as one whenever that is possible. Thus the curve is tangent-
continuous everywhere except, perhaps, at repeated points, where the curve may have a
corner, or when the angle, formed by the two segments ending at p(:,J), is unusually
small, in which case the curve may have a cusp at that point.

p must be a real matrix, with two rows, and at least two columns, and any column must
be different from at least one of its neighboring columns.

U must be a real matrix with two rows, with the same number of columns as p (for two
exceptions, see below), and can have no zero column.

c = rscvn(p) chooses the normals in the following way. For j=2:end-1, u(:,j) is
the average of the (normalized, right-turning) normals to the vectors p(:,j)-p(:,J-1)
and p(:,Jj+1)-p(:,3). If p(:,1)==p(:,end), then both end normals are chosen

as the average of the normals to p(:,2)-p(:,1) and p(:,end)-p(:,end-1) thus
preventing a corner in the resulting closed curve. Otherwise, the end normals are

so chosen that there is only one arc over the first and last segment (not-a-knot end
condition).

rscvn(p,u), with u having exactly two columns, also chooses the interior normals as for
the case when u is absent but uses the two columns of u as the end-point normals.
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Examples

Example 1. The following code generates a description of a circle, using just four pieces.
Except for a different scaling of the knot sequence, it is the same description as is
supplied by rsmak(*circle”,1,[1;1]).

p=[10-101; 010 -10]; c = rscvn([p(d,:)+1;p(2,:)+1]1,p);
The same circle, but using just two pieces, is provided by
c2 = rscvn([0,2,0; 1,1,1]D);

Example 2. The following code plots two letters. Note that the second letter is the result
of interpolation to just four points. Note also the use of translation in the plotting of the
second letter.

p=[1.8-11-1-1-1; 31.75 .5 -1.25 -3 -3 3];
i z—eye(@; u=1i(,[2121211]); B = rscvn(p,u);
S =rscevn(1 -1 1 -1; 2.5 2.5 -2.5 -2.5]);

fnplt(B), hold on, fnplt(fncmb(S,[3;0])), hold off
axis equal, axis off

Two Letters Composed of Circular Arcs

Example 3. The following code generates the Construction of a Biarc, of use in the
discussion below of the biarc construction used here. Note the use of Fntlr to find the
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tangent to the biarc at the beginning, at the point where the two arcs join, and at the
end.

p=1[01;00]; u=1[.5-.1;-.25 .5];

plot(p(1,:),p(2,:), k"), hold on

biarc = rscvn(p,u); breaks = fnbrk(biarc,"b");
fnplt(biarc,breaks(1:2),"b",3), fnplt(biarc,breaks(2:3),"r",3)
vd = fntlr(biarc,2,breaks);
quiver(vd(l,:),vd(2,:),vd(4,:),-vd(3,:)), hold off

§ \D\ -
u

Construction of a Biarc

Algorithms

Given two distinct points, pl and p2, in the plane and, correspondingly, two nonzero
vectors, Ul and u2, there is a one-parameter family of biarcs (i.e., a curve consisting of
two arcs with common tangent at their join) starting at p1 and normal there to ul and
ending at p2 and normal there to u2. One way to parametrize this family of biarcs is

by the normal direction, v, at the point q at which the two arcs join. With a nonzero v
chosen, there is then exactly one choice of g, hence the entire biarc is then determined. In
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the construction used in rscvn, v is chosen as the reflection, across the perpendicular to
the segment from p1 to p2, of the average of the vectors ul and u2, -- after both vectors
have been so normalized that their length is 1 and that they both point to the right of the
segment from pl to p2. This choice for v seems natural in the two standard cases: (1) u2
is the reflection of ul across the perpendicular to the segment from pl to p2; (i1) ul and
u2 are parallel. This choice of v is validated by Biarcs as a Function of the Left Normal
which shows the resulting biarcs when p1, p2, and u2 = [.809; .588]are kept fixed
and only the normal at p1 is allowed to vary.

Biarcs as a Function of the Left Normal

But it is impossible to have the interpolating biarc depend continuously at all four data,
pl, p2, ul, u2. There has to be a discontinuity as the normal directions, ul and u2, pass
through the direction from p1l to p2. This is illustrated in Biarcs as a Function of One
Endpoint which shows the biarcs when one point, p1 = [0;0], and the two normals,
ul = [1;1] andu2 = [1;-1], are held fixed and only the other point, p2, moves, on a
circle around p1l.
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Biarcs as a Function of One Endpoint

See Also

rsmak | cscvn
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rsmak

Put together rational spline for standard geometric shapes

Syntax

rs = rsmak(shape,parameters)

Description

rs = rsmak(shape, parameters) provides a rational spline in rBform that describes
the shape being specified by the character vector shape and the optional additional
parameters. Specific choices for shape are:

rsmak("arc” ,radius,center, [alpha,beta])
rsmak("circle”,radius,center)
rsmak("cone” ,radius,halfheight)
rsmak("cylinder”,radius,height)
rsmak("southcap”,radius,center)
rsmak("torus” ,radius,ratio)

with 1 the default value for radius, halfheight and height, and the origin the
default for center, and the arc running through all the angles from alpha to beta
(default is [-p1/2,pi1/2]), and the cone, cylinder, and torus centered at the origin
with their major circle in the (x,y)-plane, and the minor circle of the torus having radius
radius*ratio, the default for ratio being 1/3.

From these, one may generate related shapes by affine transformations, with the help of
fncmb(rs, transformation).

See rpmak for more information on other options.

See Also

rpmak
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set

Assign values in fit options structure

Syntax

set(options)

s = set(options)
set(options,fldi,vall,fld2,val2,...)
set(options, flds,vals)

Description

set(options) displays all property names of the fit options structure options. If
a property has a finite list of possible character vector values, these values are also
displayed.

s = set(options) returns a structure s with the same property names as options. If
a property has a finite list of possible character vector values, the value of the property
in s is a cell array containing the possible character vector values. If a property does not
have a finite list of possible character vector values, the value of the property in s is an
empty cell array.

set(options,fldi,vall,fld2,val2,...) sets the properties specified by the
character vectors f1d7, f1d2, ... to the values vall, val2, ..., respectively.

set(options, flds,vals) sets the properties specified by the cell array of character
vectors T1dS to the corresponding values in the cell array vals.

Examples

Create a custom nonlinear model, and create a default fit options structure for the model:

T = Fittype(Ca*x2+b*exp(n*c*x) ", "problem®,"n");
options = fitoptions(f);

Set the Robust and Normal i ze properties of the fit options structure using property
name/value pairs:
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set(options, "Robust”, "LAR", "Normalize","0On")

Set the Display, Lower, and Algorithm properties of the fit options structure using cell
arrays of property names/values:

set(opts,{"Disp”, "Low","Alg"}, ...
{*Final~",[0 O 0], "Levenberg-})

See Also

fitoptions | get

Introduced before R2006a

12-225



12  Functions — Alphabetical List

setoptions

Set model fit options

Syntax

FT = setoptions(FT, options)

Description

FT = setoptions(FT, options) sets the fit options of FT to options, where FT is
a Fittype, cfit, or sFitobject. The FT output argument must match the FT input
argument.

See Also

Ffitoptions | Fit | Fittype

Introduced in R2009b
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sfit

Constructor for sFit object

Syntax

surfacefit = sfit(fittype,coeffl,coeff2,...)

Description

An sfit object encapsulates the result of fitting a surface to data. They are normally
constructed by calling the Fit function, or interactively by exporting a fit from the Curve
Fitting app to the workspace. You can get and set coefficient properties of the sfit
object.

You can treat an sFit object as a function to make predictions or evaluate the surface at
values of X and Y.

Like the cfit class, sFit inherits all fFittype methods.

surfacefit = sfTit(fittype,coeffl,coeff2,._.) constructs the sFit object
surfacefit using the model type specified by the Fittype object and the coefficient
values coefFfl, coeff2, etc.

Note: sTit is called by the fit function when fitting Fittype objects to data. To create
a sFit object that is the result of a regression, use Fit.

You should only call sFit directly if you want to assign values to coefficients and
problem parameters of a Fittype object without performing a fit.

Methods of sFit objects:

argnames Input argument names of cFit, sFit, or
Fittype object

category Category of fit of cFit, sFit, or Fittype
object
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coeffnames

coeffvalues

confint
dependnames

differentiate
feval
formula

indepnames

islinear

numargs

numecoeffs

plot
predint

probnames
probvalues

quad2d
setoptions
sfit

type

Coefficient names of cFit, sfit, or
fittype object

Coefficient values of cFit or sFit object

Confidence intervals for fit coefficients of
cfitor sfitobject

Dependent variable of cFit, sFit, or
fittype object

Differentiate cFit or sFit object
Evaluate cfit, sfit, or Fittype object
Formula of cFit, sFit, or Fittype object

Independent variable of cFit, sfit, or
Fittype object

Determine if cFit, sfit, or Fittype
object is linear

Number of input arguments of cFit, sFit,
or Fittype object

Number of coefficients of cFit, sFit, or
fittype object

Plot cfit or sTit object
Prediction intervals for cFit or sFit object

Problem-dependent parameter names of
cFit, sTit, or Fittype object

Problem-dependent parameter values of
cfitor sfitobject

Numerically integrate sFit object

Set model fit options

Constructor for sFit object

Name of cFit, sFit, or Fittype object
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Examples

You can treat an sTit object as a function to make predictions or evaluate the surface at
valuesof X and Y, e.g.,

X =3 -6 * rand( 49, 1 );
y =3 -6 * rand( 49, 1 );
z = peaks( X, Yy );

st = fit( [x, y], z, "poly32" );
zhat = sf( mean( x ), mean( y ) )

See Also

fit | fittype | feval | cfit

Topics
“Evaluate a Surface Fit” on page 7-32
“Fit Postprocessing”

Introduced in R2009a
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sftool

Open Curve Fitting app

Syntax

sftool

sftool (X,vy,2)
sfttool (X,y,z,w)
sfttool (filename)

Description

Note: sTtool will be removed in a future release. Use cftool instead. See Curve
Fitting.

sfTtool opens Curve Fitting app or brings focus to the tool if it is already open.

sftool (X,y,Zz) creates a fit to X and y inputs (or predictor data) and z output (or
response data). sftool opens Curve Fitting app if necessary.

X, Y, and z must be numeric, have two or more elements, and have compatible sizes.
Sizes are compatible if either:

* X,Y,and z all have the same number of elements, or

* X andy are vectors, z is a 2D matrix, where length(x) = n, length(y) = m, and
[m,n] = size(2).

sfttool (X,y,z,w) creates a fit with weights w. w must be numeric and have the same
number of elements as z.

sttool (filename) loads the surface fitting session in filename into Curve Fitting
app. The filename should have the extension .sFit.

Infs, NaNs, and imaginary parts of complex numbers are ignored in the data.
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Curve Fitting app provides a flexible interface where you can interactively fit curves and
surfaces to data and view plots. You can:
+ Create, plot, and compare multiple fits

* Use linear or nonlinear regression, interpolation, local smoothing regression, or
custom equations

+  View goodness-of-fit statistics, display confidence intervals and residuals, remove
outliers and assess fits with validation data

+ Automatically generate code for fitting and plotting surfaces, or export fits to
workspace for further analysis

See Also

See Also

Apps
Curve Fitting

Topics
“Interactive Curve and Surface Fitting” on page 2-2

Introduced in R2009a
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smooth

Smooth response data

Syntax

yy = smooth(y)

yy = smooth(y,span)

yy = smooth(y,method)

yy = smooth(y,span,method)

yy = smooth(y, “sgolay”,degree)

yy = smooth(y,span, "sgolay” ,degree)
yy = smooth(x,y,--.)

gpuarrayYY = smooth(gpuarrayY)

Description
yy = smooth(y) smooths the data in the column vector y using a moving average filter.
Results are returned in the column vector yy. The default span for the moving average is

5.

The first few elements of yy are given by

yy(1) = y(1)

yy(2) = (y(1) + y(2) + y(3))/3

yy@3) = (y(1) + y(2) + y(3) + y(4) + y(5))/5
=@ +y@ +y@® +y() + y(6))/5

yy(4)

Because of the way endpoints are handled, the result differs from the result returned by
the Filter function.

yy = smooth(y,span) sets the span of the moving average to span. span must be odd.

yy = smooth(y,method) smooths the data in y using the method method and the
default span. Supported values for method are listed in the table below.



smooth

method Description

"moving*” Moving average (default). A lowpass filter with filter coefficients
equal to the reciprocal of the span.

"lowess*” Local regression using weighted linear least squares and a 1st
degree polynomial model

"loess” Local regression using weighted linear least squares and a 2nd
degree polynomial model

"sgolay*® Savitzky-Golay filter. A generalized moving average with filter
coefficients determined by an unweighted linear least-squares
regression and a polynomial model of specified degree (default is
2). The method can accept nonuniform predictor data.

"rlowess” A robust version of " lowess" that assigns lower weight to
outliers in the regression. The method assigns zero weight to
data outside six mean absolute deviations.

"rloess” A robust version of " loess” that assigns lower weight to
outliers in the regression. The method assigns zero weight to
data outside six mean absolute deviations.

yy = smooth(y,span,method) sets the span of method to span. For the loess and
lowess methods, span is a percentage of the total number of data points, less than or
equal to 1. For the moving average and Savitzky-Golay methods, span must be odd (an
even span is automatically reduced by 1).

yy = smooth(y, "sgolay” ,degree) uses the Savitzky-Golay method with polynomial
degree specified by degree.

yy = smooth(y,span, "sgolay” ,degree) uses the number of data points specified by
span in the Savitzky-Golay calculation. span must be odd and degree must be less than
span.

yy = smooth(X,YV, - -.) additionally specifies X data. If X is not provided, methods
that require X data assume x = 1:length(y). You should specify X data when it is not
uniformly spaced or sorted. If X is not uniform and you do not specify method, lowess is
used. If the smoothing method requires X to be sorted, the sorting occurs automatically.

gpuarrayYY = smooth(gpuarrayY) performs the operation on a GPU. The input
gpuarrayy is a gpuArray column vector. The output gpuarrayYY is a gpuArray column
vector. This syntax requires the Parallel Computing Toolbox™.
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Note: You can use gpuArray x and y inputs with the smooth function, but this is only
recommended with the default "method”, "moving”. Using GPU data with other
methods does not offer any performance advantage.

Examples

Smooth Data Using Moving Average Filter

Smooth data by linear index and by each column separately, using a moving average
filter. Plot and compare the results.

Load the data in count.dat. The 24-by-3 array count contains traffic counts at three
intersections for each hour of the day.

load count.dat

Use a moving average filter with a 5-hour span to smooth all the data simultaneously (by
linear index).

c = smooth(count(:));
Cl = reshape(c,24,3);

Use the same filter to smooth each column of the data separately.

C2 = zeros(24,3);
for 1 = 1:3,

c2(:,1) = smooth(count(:,1));
end

Plot the original data and the data smoothed by linear index and by each column
separately. Then, plot the difference between the two smoothed data sets. The two
methods give different results near the endpoints.

subplot(3,1,1)
plot(count,”:");

hold on

plot(C1,"-");

title("Smooth C1 (AIl Data)*®)

subplot(3,1,2)
plot(count,”:");
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hold on
plot(C2,"-");
title("Smooth C2 (Each Column)*®)

subplot(3,1,3)

plot(C2 - C1,%0-%)
title("Difference C2 - C1%)

Smooth C1 [All Data)

400 . '
200 + 1
. G T e,
0 5 10 15 20 2
Smooth C2 (Each Column)
400 . ' ' '
200 b 1
0 e T e -_“—‘-ﬂ—--—--—-—-. — --—l—r—"__-"_d____n_-_—“"'
0 5 10 15 20 25
Difference C2 - C1
10 . ' ' '
0 o= ‘-::\9 2
-10 . ! : . @
0 5 10 15 20 <

Smooth Data Using loess and rloess

Plot and compare the results of data smoothed using the loess and rloess methods.
Then determine which method is less sensitive to outliers.

Create noisy data with two outliers.
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x = (0:0.1:15)";
sin(x) + 0. 5*(rand(S|ze(x)) -0.5);

y([90 110D =

Smooth the data with the loess and rloess methods using a span of 10% of the total
number of data points.

smooth(x,y,0.1,"loess™);
smooth(x,y,0.1, "rloess");

yyl =
yy2 =
Plot the original and smoothed data. The outliers have less influence with the robust
method.

subplot(2,1,1)

plot(xX,y, b.",x,yyl, " r-*)

set(gca, "YLIm",[-1.5 3.5])

legend("Original data", "Smoothed data using ""loess""",
"Location”,"NW")

subplot(2,1,2)

PIOt(X,y, "b. "%, yy2, " r-*)

set(gca, "YLim",[-1.5 3.5])

legend("Original data", "Smoothed data using ""rloess""",
"Location”,"NW")
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+  DOriginal data
7t Smoothed data using ‘loess’

*  Original data
7+ Smoothed data using ‘rloess’

Tips

Another way to generate smoothed data is to fit it with a smoothing spline. Refer to the

Fit function for more information.

See Also

fit | sort

Introduced before R2006a
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slvblk

Solve almost block-diagonal linear system

Syntax

slvblk(blokmat,b)

X =
x = slvblk(blockmat,b,w)

Description

x = slvblk(blokmat,b) returns the solution (if any) of the linear system Ax =

b, with the matrix A stored in blokmat in the spline almost block-diagonal form. At
present, only the command spcol provides such a description, of the matrix whose
typical entry is the value of some derivative (including the Oth derivative, i.e., the value)
of a B-spline at some site. If the linear system is overdetermined (i.e., has more equations
than unknowns but is of full rank), then the least-squares solution is returned.

The right side b may contain several columns, and is expected to contain as many rows
as there are rows in the matrix described by blokmat.

X = slvblk(blockmat,b,w) returns the vector X that minimizes the weighted sum

Zw()((Ax - b)())*.

Examples
sp=spmak(knots,slvblk(spcol (knots,k,x,1),y.")) provides in sp the B-form of

the spline s of order k with knot sequence knots that matches the given data (x,y), i.e.,
for which s(x) equals y.

Algorithms

The command bkbrk is used to obtain the essential parts of the coefficient matrix
described by blokmat (in one of two available forms).



sivblk

A QR factorization is made of each diagonal block, after it was augmented by the
equations not dealt with when factoring the preceding block. The resulting factorization
is then used to solve the linear system by backsubstitution.

See Also

bkbrk | spap2 | spapi | spcol
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sorted

Locate sites with respect to mesh sites

Syntax

pointer = sorted(meshsites,sites)

Description

Various commands in this toolbox need to determine the index j for which a given x lies
in the interval [¢..¢;+ 1], with (;) a given nondecreasing sequence, e.g., a knot sequence.
This job is done by sorted in the following fashion.

pointer = sorted(meshsites,sites) isthe integer row vector whose j-th entry
equals the number of entries in meshsites that are < ssites(j), with ssites the
vector sort(sites). Thus, if both meshsites and sites are nondecreasing, then

meshsites(pointer(jJ)) = sites(J) < meshsites(pointer(jJ)+1)
with the obvious interpretations when
pointer(jg) < 1 or length(meshsites) < pointer(j) + 1

Specifically, having pointer(jJ) < 1 then corresponds to having sites(j) strictly to
the left of meshsites(1), while having length(meshsites) < pointer(j)+1 then
corresponds to having sites(J) at, or to the right of, meshsites(end).

Examples
The statement
sorted([1 1122 3 3 3],[0:4D

will generate the output 0 3 5 8 8, as will the statement

sorted([3 2 113231].,[23041])
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Algorithms

The indexing output from sort([meshsites(:).",sites(:)."]) is used.
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spap2

Least-squares spline approximation

Syntax

spap2(knots,k,x,y)

spap2(l,k,x,y)

sp = spap2(-.-,X,y,w)

spap2({knorll, ..., knorim},k,{x1,..., xXm},y)
spap2({knorll, ..., knorIm},k,{x1,...,xm},y,w)

Description

spap2(knots,k,x,y) returns the B-form of the spline f of order k with the given knot
sequence knots for which

™ yG.1 = fx@)), all j

in the weighted mean-square sense, meaning that the sum

> wi) |y, - f(x()
J

is minimized, with default weights equal to 1. The data values y(:, J) may be scalars,

vectors, matrices, even ND-arrays, and | z|? stands for the sum of the squares of all the
entries of z. Data points with the same site are replaced by their average.

If the sites X satisfy the (Schoenberg-Whitney) conditions

knots(j) < x(j) < knots(j+ k)
(¥%) j=1,...,length(x) = length(knots) — &

then there i1s a unique spline (of the given order and knot sequence) satisfying (¥) exactly.
No spline is returned unless (*¥) is satisfied for some subsequence of X.
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spap2(l,k,x,y) , with I a positive integer, returns the B-form of a least-squares
spline approximant, but with the knot sequence chosen for you. The knot sequence

is obtained by applying aptknt to an appropriate subsequence of X. The resulting
piecewise-polynomial consists of I polynomial pieces and has k-2 continuous derivatives.
If you feel that a different distribution of the interior knots might do a better job, follow
this up with

spl = spap2(newknt(sp).k,x,y)):

sp = spap2(.--..,X,Y,Ww) lets you specify the weights w in the error measure (given
above). w must be a vector of the same size as X, with nonnegative entries. All the
weights corresponding to data points with the same site are summed when those data
points are replaced by their average.

spap2({knorll, ... ,knorIm},k,{x1,...,xm},y) provides a least-squares spline
approximation to gridded data. Here, each knorli is either a knot sequence or a positive
integer. Further, K must be an m-vector, and y must be an (r+m)-dimensional array, with
y(:,i1,...,im) the datum to be fitted at the site [x{1}(il), - .., x{m}(im)], all
il, ..., im. However, if the spline is to be scalar-valued, then, in contrast to the univariate
case, Y is permitted to be an m-dimensional array, in which case y(il, ..., im) is the
datum to be fitted at the site [x{1}(i1), ..., x{m}(im)], all i1, ..., im.

spap2({knorll, ..., knorIm},k,{x1,...,xm},y,w) also lets you specify the
weights. In this m-variate case, w must be a cell array with m entries, with w{i} a
nonnegative vector of the same size as X1, or else w{1} must be empty, in which case the
default weights are used in the ith variable.

Examples
sp = spap2(augknt([a,xi,b],4),4,x,y)

is the least-squares approximant to the data X, y, by cubic splines with two continuous
derivatives, basic interval [a..b], and interior breaks X1, provided xi has all its entries
in (a..b) and the conditions (**) are satisfied in some fashion. In that case, the
approximant consists of length(xi1)+1 polynomial pieces. If you do not want to worry
about the conditions (**) but merely want to get a cubic spline approximant consisting of
I polynomial pieces, use instead

sp = spap2(l,4,x,Y);

If the resulting approximation is not satisfactory, try using a larger I. Else use
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sp = spap2(newknt(sp),4,X,y);

for a possibly better distribution of the knot sequence. In fact, if that helps, repeating it
may help even more.

As another example, spap2(1, 2, X, Yy); provides the least-squares straight-line fit
to data X,y, while

w = ones(size(x)); w([1 end]) = 100; spap2(1,2, X,y,W);

forces that fit to come very close to the first data point and to the last.

Algorithms

spcol is called on to provide the almost block-diagonal collocation matrix (B;,z(x;)), and
slvblk solves the linear system (*) in the (weighted) least-squares sense, using a block
QR factorization.

Gridded data are fitted, in tensor-product fashion, one variable at a time, taking
advantage of the fact that a univariate weighted least-squares fit depends linearly on the
values being fitted.

See Also

slvblk | spapi | spcol
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spapi

Spline interpolation

Syntax

spline = spapi(knots,Xx,y)

spapi(k,x,y)
spapi({knorkl, ... ,knorkm},{x1,...,xm},y)
spapi(-.., "noderiv")

Description

spline = spapi(knots,X,y) returns the spline f (if any) of order
k = length(knots) - length(x)

with knot sequence knots for which

) f&x@)) = y(.1), all j.

If some of the entries of X are the same, then this is taken in the osculatory sense, i.e.,
in the sense that D"?f(x()) = y(, j), with m(§) : =#{i<j: x(i) =x(§) }, and D"f the
mth derivative of f. Thus r-fold repetition of a site z in X corresponds to the prescribing
of value and the first r — 1 derivatives of f at z. If you don't want this, call spapi with
an additional (fourth) argument, in which case, at each data site, the average of all data
values with the same data site is matched.

The data values, y(:, J), may be scalars, vectors, matrices, or even ND-arrays.

spapi(k,x,y) ,with k a positive integer, merely specifies the desired spline order, K,
in which case aptknt is used to determine a workable (though not necessarily optimal)
knot sequence for the given sites X. In other words, the command spapi(k,X,y) has
the same effect as the more explicit command spapi (aptknt(x,k),x,y).

spapi ({knorkl, . ..,knorkm},{x1,...,xm},y) returns the B-form of a tensor-
product spline interpolant to gridded data. Here, each knorki is either a knot sequence,
or else is a positive integer specifying the polynomial order to be used in the ith variable,
thus leaving it to spapi to provide a corresponding knot sequence for the ith variable.
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Further, y must be an (r+m)-dimensional array, with y(:,i1, ..., im) the datum to be
fitted at the site [x{1}(11), ..., x{m}(im)], all i1, ..., im, unless the spline is to be
scalar-valued, in which case, in contrast to the univariate case, y is permitted to be an m-
dimensional array.

spapi(.-..,"noderiv"™) with the character vector "noderiv" as a fourth argument,
has the same effect as spapi (- - .) except that data values sharing the same site are
interpreted differently. With the fourth argument present, the average of the data values
with the same data site is interpolated at such a site. Without it, data values with the
same data site are interpreted as values of successive derivatives to be matched at such a
site, as described above, in the first paragraph of this Description.

Examples

spapi(J0 0 0012222],[01112],[2012 -1])produces the unique
cubic spline f on the interval [0..2] with exactly one interior knot, at 1, that satisfies the
five conditions

f0+) =2, (1) =0, DA(1) = 1, D°’f(1) = 2, f(2-) = -1

These include 3-fold matching at 1, i.e., matching there to prescribed values of the
function and its first two derivatives.

Here is an example of osculatory interpolation, to values y and slopes s at the sites X by a
quintic spline:

sp = spapi(augknt(x,6,2),[x,x,min(x),max(x)],[y,s,ddy0,ddyl]);
with ddyO and ddy1 values for the second derivative at the endpoints.

As a related example, if the function sin(X) is to be interpolated at the distinct data
sites X by a cubic spline, and its slope is also to be matched at a subsequence X(S), then
this can be accomplished by the command

sp = spapi(4,[x x(s)], [sin(x) cos(x(s))1);

in which a suitable knot sequence is supplied with the aid of aptknt. In fact, if you
wanted to interpolate the same data by quintic splines, simply change the 4 to 6.

As a bivariate example, here is a bivariate interpolant.

X
z

-2:.5:2; y = -1:.25:1; [xx, yy] = ndgrid(x,y);
exp(-(xx."2+yy."2));
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sp = spapi({3,4},{x,y},z); fnplt(sp)

As an illustration of osculatory interpolation to gridded data, here is complete bicubic
interpolation, with the data explicitly derived from the bicubic polynomial g(u,v) =

u’v?, to make it easy for you to see exactly where the slopes and slopes of slopes (i.e.,
cross derivatives) must be placed in the data values supplied. Since our g is a bicubic
polynomial, its interpolant, f, must be g itself. We test this.

sites = {[0,1],[0,2]}; coefs = zeros(4,4); coefs(1,1) = 1;

g = ppmak(sites,coefs);

Dxg = fnval(fnder(g,[1,0]),sites);

Dyg = fnval(fnder(g,[0,1]),sites);

Dxyg = fnval(fnder(g,[1,1]),sites);

T = spapi({4.4}, {sites{1}([1,2,1,2]),sites{2}([1,2,1,2])},
[fnval (g,sites), Dyg ;

Dxg. " » Dxygl);
it any( squeeze( fnbrk(fn2fm(Ff,"pp"), “c") ) - coefs )
"something went wrong®, end

Limitations

The given (univariate) knots and sites must satisfy the Schoenberg-Whitney conditions
for the interpolant to be defined. Assuming the site sequence X to be nondecreasing, this
means that we must have

knots(j) < x(j) < knots(j +£&), all j

(with equality possible at knots(1) and knots(end)). In the multivariate case, these
conditions must hold in each variable separately.

Algorithms

spcol is called on to provide the almost-block-diagonal collocation matrix (Bj,x(x)) (with
repeats in X denoting derivatives, as described above), and slvblk solves the linear
system (¥), using a block QR factorization.

Gridded data are fitted, in tensor-product fashion, one variable at a time, taking
advantage of the fact that a univariate spline fit depends linearly on the values being
fitted.
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See Also

csapi | spap2 | spaps | spline
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spaps

Smoothing spline

Syntax

sp = spaps(x,y,tol)

[sp,values] = spaps(x,y,tol)
[sp,values,rho] = spaps(x,y,tol)
[---1 = spaps(x,y,tol,argl,arg2,...)
[---1 = spaps({x1,...,xr},y,tol,...)

Description

sp = spaps(X,y,tol) returnsthe B-form of the smoothest function f that lies within
the given tolerance tol of the given data points (X(J), y(:,J)), J=1:length(x).
The data values y(:, J) may be scalars, vectors, matrices, even ND-arrays. Data points
with the same data site are replaced by their weighted average, with its weight the sum
of the corresponding weights, and the tolerance tol is reduced accordingly.

[sp,values] = spaps(X,y,tol) alsoreturns the smoothed values, i.e., values is
the same as fnval (sp, x).

Here, the distance of the function f from the given data is measured by

E(N) =Y wl) | () - Fx() P

J=1

with the default choice for the weights w making E(f) the composite trapezoidal rule
ly-fP

min(x)

J'max( x)

approximation to , and | z|? denoting the sum of squares of the entries of

z.

Further, smoothest means that the following roughness measure is minimized:
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max(x)
FO"= | A@| D F@)|? dt

min(x)

where D™f denotes the mth derivative of f. The default value for mis 2, the default value
for the roughness measure weight A is the constant 1, and this makes f a cubic smoothing
spline.

When tol is nonnegative, then the spline fis determined as the unique minimizer of

the expression pE(f) + F(D™f), with the smoothing parameter p (optionally returned) so
chosen that E(f) equals tol. Hence, when m is 2, then, after conversion to ppform, the
result should be the same (up to roundoff) as obtained by csaps(x,y,p/(p + 1)). Further,
when tol is zero, then the “natural” or variational spline interpolant of order 2m

is returned. For large enough tol, the least-squares approximation to the data by
polynomials of degree <m is returned.

When tol is negative, then p is taken to be -tol.

The default value for the weight function A in the roughness measure is the constant
function 1. But you may choose it to be, more generally, a piecewise constant function,
with breaks only at the data sites. Assuming the vector X to be strictly increasing, you
specify such a piecewise constant A by inputting tol as a vector of the same size as X. In
that case, tol (1) is taken as the constant value of A on the interval (x(i-1) .. x(1)),
i=2:length(x), while tol (1) continues to be used as the specified tolerance.

[sp,values,rho] = spaps(x,y,tol) alsoreturns the actual value of p used as the
third output argument.

[---1 = spaps(x,y,tol,argl,arg2,...) letsyou specify the weight vector w and/
or the integer m, by supplying them as an argi. For this, w must be a nonnegative vector
of the same size as X; m must be 1 (for a piecewise linear smoothing spline), or 2 (for the
default cubic smoothing spline), or 3 (for a quintic smoothing spline).

If the resulting smoothing spline, sp, is to be evaluated outside its basic interval, it
should be replaced by fFnxtr(sp,m) to ensure that its m-th derivative is zero outside that
interval.

[---1 = spaps({x1,-..,xr},y,tol,...) returnsthe B-form of an r-variate
tensor-product smoothing spline that is roughly within the specified tolerance to the
given gridded data. (For scattered data, use tpaps.) Now y is expected to supply the
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corresponding gridded values, with size(y) equal to [length(x1), - .., length(xr)]
in case the function is scalar-valued, and equal to [d, length(x1), - .., length(xr)]
in case the function is d-valued. Further, tol must be a cell array with r entries, with
tol{i} the tolerance used during the i-th step when a univariate (but vector-valued)
smoothing spline in the i-th variable is being constructed. The optional input for m must
be an r-vector (with entries from the set {1,2,3}), and the optional input for w must

be a cell array of length r, with w{i} either empty (to indicate that the default choice is
wanted) or else a positive vector of the same length as Xi.

Examples

The statements

w = ones(size(x)); w([1 end]) = 100;
sp = spaps(x,y, l.e-2, w, 3);

give a quintic smoothing spline approximation to the given data that close to interpolates
the first and last datum, while being within about 1.e-2 of the rest.

-2:.2:2; y=-1:.25:1; [xx,yy] = ndgrid(x,y); rng(39);
exp(-(xXx."2+yy."2)) + (rand(size(xx))--5)/30;
sp = spaps({X,y},z,8/(60"2)); Tnplt(sp), axis off

X
z

produces the figure below, showing a smooth approximant to noisy data from a smooth
bivariate function. Note the use of ndgrid here; use of meshgrid would have led to an
error.
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Algorithms

Reinsch's approach “References” on page 12-253 is used (including his clever way of
choosing the equation for the optimal smoothing parameter in such a way that a good
initial guess is available and Newton's method is guaranteed to converge and to converge
fast).
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References

[1] C. Reinsch, “Smoothing by spline functions”, Numer. Math. 10 (1967), 177-183.

See Also

csaps | spap2 | spapi | tpaps
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spcol

B-spline collocation matrix

Syntax

colmat = spcol(knots,k,tau)
colmat = spcol(knots,k,tau,argl,arg2,...)

Description

colmat = spcol(knots,k,tau) returnsthe matrix, with length(tau) rows and
length(knots)-k columns, whose (i,j)th entry is

D™V B; (tau(i)

This is the value at tau(i) of the m(i)th derivative of the jth B-spline of order k for the
knot sequence knots. Here, tau is a sequence of sites, assumed to be nondecreasing, and
m = knt2mlt(tau), i.e., m(i) is #{j < i:tau(j) = tau(@)}, all i.

colmat = spcol(knots,k,tau,argl,arg2,...) also returns that matrix, but
gives you the opportunity to specify some aspects.

If one of the argi is a character vector with the same first two letters as in "slvblk",
the matrix is returned in the almost block-diagonal format (specialized for splines)
required by slvblk (and understood by bkbrk).

If one of the argi is a character vector with the same first two letters as in "sparse”,
then the matrix is returned in the sparse format of MATLAB.

If one of the argi is a character vector with the same first two letters as in "noderiv”,
multiplicities are ignored, i.e., m(i) is taken to be 1 for all i.

Examples

To solve approximately the non-standard second-order ODE
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D?y(t) =5 (y(t) - sin(2¢))

on the interval [0..11], using cubic splines with 10 polynomial pieces, you can use spcol in
the following way:

tau = linspace(0,pi,101); k = 4;

knots = augknt(linspace(0,pi,11),k);

colmat = spcol(knots, k,brk2knt(tau,3));

coefs = (colmat(3:3:end, :)/5-colmat(l:3:end, :))\(-sin(2*tau).");
sp = spmak(knots,coefs.");

You can check how well this spline satisfies the ODE by computing and plotting the
residual, D*y(t) — 5 (y(t) — sin(2¢)), on a fine mesh:

t = linspace(0,pi,501);

yt = fnval(sp,t);

D2yt = fnval(fnder(sp,2),t);

plot(t,D2yt - 5*(yt-sin(2*t)))

title(["residual error; to be compared to max(abs(D™2y)) = *,...
num2str(max(abs(D2yt)))1)

The statement spcol ([1:6],3, -1+[2:4]) provides the matrix

ans =

0.5900 0.0050 0
0.4050 0.5900 0.0050
0O 0.4050 0.5900

in which the typical row records the values at 2.1, or 3.1, or 4.1, of all B-splines of order

3 for the knot sequence 1:6. There are three such B-splines. The first one has knots
1,2,3,4, and its values are recorded in the first column. In particular, the last entry in the
first column is zero since it gives the value of that B-spline at 4.1, a site to the right of its
last knot.

If you add the character vector "sl® as an additional input to spcol, then
you can ask bkbrk to extract detailed information about the block structure of
the matrix encoded in the resulting output from spcol. Thus, the statement
bkbrk(spcol (1:6,3, .1+2:4,"sl ")) gives:

block 1 has 2 row(s)
0.5900 0.0050 0
0.4050 0.5900 0.0050
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next block is shifted over 1 column(s)
block 2 has 1 row(s)

0.4050 0.5900 0.0050
next block is shifted over 2 column(s)

Limitations

The sequence tau is assumed to be nondecreasing.

Algorithms

This is the most complex command in this toolbox since it has to deal with various
ordering and blocking issues. The recurrence relations are used to generate,
simultaneously, the values of all B-splines of order k having anyone of the tau(i) in
their support.

A separate calculation is carried out for the (presumably few) sites at which derivative
values are required. These are the sites tau(i) with m(i) > 0. For these, and for every
order &k —j, j =Jjo, jo— 1,...,0, with j, equal to max(m), values of all B-splines of that order
are generated by recurrence and used to compute the jth derivative at those sites of all B-
splines of order K.

The resulting rows of B-spline values (each row corresponding to a particular tau(i))
are then assembled into the overall (usually rather sparse) matrix.

When the optional argument "sl* is present, these rows are instead assembled into a
convenient almost block-diagonal form that takes advantage of the fact that, at any site
tau(i), at most k B-splines of order k are nonzero. This fact (together with the natural
ordering of the B-splines) implies that the collocation matrix is almost block-diagonal,
i.e., has a staircase shape, with the individual blocks or steps of varying height but of
uniform width k.

The command slvblk is designed to take advantage of this storage-saving form
available when used, in spap2, spapi, or spaps, to help determine the B-form of a
piecewise-polynomial function from interpolation or other approximation conditions.

See Also

slvblk | spap2 | spapi
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spcrv

Spline curve by uniform subdivision

Syntax
spcrv(c,k)

spcrv(c)
spcrv(c,k,maxpnt)

Description

spcrv(c,k) provides a dense sequence f(tt) of points on the uniform B-spline curve f
of order k with B-spline coefficients c. Explicitly, this is the curve

n
fit|> D Bt—k/2]| j....j+k) c(j),
Jj=1

N |

St<n+

e

with B(-|a,...,2) the B-spline with knots a,...,z, and n the number of coefficients in c, i.e.,
[d,n] equals size(c).

spcrv(c) chooses the order k to be 4.

spcrv(c,k,maxpnt) makes sure that at least maxpnt points are generated. The
default value for the maximum number of sites €t to be generated is 100.

The parameter interval that the site sequence tt fills out uniformly is the interval [k/2 ..
(n-k/2)].

The output consists of the array f(tt).

Examples

The following would show a questionable broken line and its smoothed version:

points = [0 0110-1-100 ;
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0001210 -1-2];
plot(points(l,:),points(2,:),":")
values = spcrv(points,3);
hold on, plot(values(l,:),values(2,:)), hold off

Algorithms

Repeated midpoint knot insertion is used until there are at least maxpnt sites. There are
situations where use of fnplt would be more efficient.

See Also

fnplt
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splinetool

Experiment with some spline approximation methods

Syntax

splinetool
splinetool (X,y)

Description

splinetool is a graphical user interface (GUI), whose initial menu provides you with
various choices for data including the option of importing some data from the workspace.

splinetool (x,y) brings up the GUI with the specified data x and y, which are
vectors of the same length.

Examples

+ “Exploring End Conditions For Cubic Spline Interpolation” on page 12-259
+ “Estimating the Second Derivative at an Endpoint” on page 12-262

+ “Least-Squares Approximation” on page 12-263

* “Smoothing Spline” on page 12-265

Exploring End Conditions For Cubic Spline Interpolation

The purpose of this example is to explore the various end conditions available with cubic
spline interpolation:

1 Type splinetool at the command line.

2 Select Import your own data from the initial screen, and accept the default
function. You should see the following display.
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Bottorrline:  splinet = csapi(x,y); % same as csape(z,y, not-a-knot) or splinecz,y)

The default approximation shown is the cubic spline interpolant with the not-a-knot
end condition.

The vector x of data sites is I inspace(0,2*pi,31) and the values are cos(x).
This differs from simply providing the vector y of values in that the cosine function
is explicitly recorded as the underlying function. Therefore, the error shown in the
graph is the error in the spline as an approximation to the cosine rather than as an
approximation to the given values. Notice the resulting relatively large error, about
5e-5, near the endpoints.

For comparison, follow these steps:

* Click on New in the List of approximations.
+ In Approximation method, select complete from the list of End conditions.

+  Since the first derivative of the cosine function is sine, adjust the first-derivative
values to their known values of zero at both the left end and the right end.
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This procedure results in the display shown below (after the mouse is used to move
the Legend further down). Note that the right end slope is zero only up to round-off.
Bottomline tells you that the toolbox function csape was used to create the spline.

<) Spline Tool
File Edit Wiew Tools Help

=10l x|
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Delete LI
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Left End Right Enc
tstDeriv. | 1stDeriv.
] |p77556-017

cos

-0.2
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-06

-08

0g

06

0.4

0z

data
------- splingt |+
spline2

—Data, breaksknots, weights, ...

I Sites and Values d

-0.104525

LI -0.309017 LI

. F.ozozsas ﬂ

Errar in spline2

-5

0

linzpace(0,2*pi,31)
Bottomline:  spline2 = csapex [0y 0] 'complete”); % same as splinedx [0y 00

Be impressed by the improvement in the error, which is only about 5e-6.

For further comparison, follow these steps:

* Click on New in the List of approximations.

* In Approximation method, select natural from the list of End conditions.

Note the deterioration of the approximation near the ends, an error of about 2e-3,
which is much worse than with the not-a-knot end conditions.
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For a final comparison, follow these steps:

Click on New in the List of approximations.
Since we know that the cosine function is periodic, in Approximation method,
select periodic from the list of End conditions.

Note the dramatic improvement in the approximation, back to an error of about
5e-6, particularly compared to the natural end conditions.

Estimating the Second Derivative at an Endpoint

This example uses cubic spline interpolation and least-squares approximation to
determine an estimate of the initial acceleration for a drag car:

1

1N

Type splinetool at the command line or if the GUI is already running, click on
File > Restart.

Choose Richard Tapia's drag racing data. These data show the distance traveled
by a drag car as a function of time. The message window asks you to estimate the
initial acceleration by setting the initial speed to zero. Click on OK, or use Space or
Enter, to remove the message window.

In Approximation method, select complete from the list of End conditions.
Adjust the initial speed by changing the first derivative at the left endpoint to zero.

Look for the value of the initial acceleration, which is given by the value of the
second derivative at the left endpoint. You can toggle between the first derivative
and the second derivative at this endpoint by clicking on the left end button. The
value of the second derivative should be around 187 in the units chosen. Choose
View > Show 2nd Derivative to see this graphically.

For comparison, click on New, then choose Least-Squares Approximation as
the Approximation method. With this method, you can no longer specify end
conditions. Instead, you may vary the order of the method. Verify that the initial
acceleration is close to the cubic interpolation value.

The results of this procedure are shown below.
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Errar in spline2

2 25

time in seconds

3

Least-Squares Approximation

This example encourages you to place five interior knots in such a way that the least-
squares approximation to these data by cubic splines has an absolute error no bigger
than .04 everywhere:

1

w

Type splinetool at the command line or if the GUI is already running, click on

File > Restart.

Choose Titanium heat data.

Select Least-Squares Approximation as the Approximation method.

Notice how poorly this approximates the data since there are no interior knots. To
view the current knots and add new knots, choose knots from Data, breaks/knots,
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weights. The knots are now listed in knots, and also displayed in the data graph as
vertical lines. Notice that there are just the two end knots, each with multiplicity 4.

Right-click in the data graph and choose Add Knot. This brings up crosshairs for
you to move with the mouse. Its precise horizontal location is shown in the edit field
below the list of knots. A mouse click places a new knot at the current location of
the crosshairs. One possible strategy is to place the additional knot at the place of
maximum absolute error, as shown in the auxiliary graph below the data graph.

) spline Tool =10l =

File Edit View Tools Help

—List of spproximstions 22 T T T 18] T
O dsta
new [ - | 2| ©
salingt
Replicate 184 e |
Delete =l 150 o 1
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o

08

04+

0.2 L L

15

Error in splined
o
n
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075 # pieces

05 I L I L I
-k ﬂ K 500 600 700 500 00 1000 1100
temperature

Bottorline:  splinel = spap2(1 4 x ¥ % we are starting off with the least sguares polynomial approximation of order 4

If you right-click and choose Replicate Knot, you will increase the multiplicity of
the current knot, which is shown by its repeated occurrence in Knots. If you don't
like a particular knot, you can delete it. To delete a specific knot, you must first
select it in either the list of knots or the data graph, and then right-click in the graph
and choose Delete Knot.

You could also ask for an approximation using six polynomial pieces, which
corresponds to five interior knots. To do this, enter 6 as # pieces in Data, breaks/
knots, weights.
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After you have the five interior knots, try to make the error even smaller by moving
the knots. To do this, select the knot you want to move by clicking on its vertical line
in the graph, then use the interface control below Knots in Data, breaks/knots,
weights and observe how the error changes with the movement of the knot. You
can also use the edit field to overwrite the current knot location. You could also try
adjust, which redistributes the current knot sequence.

Use Replicate in List of approximations to save any good knot distribution
for later use. Rename the replicated approximation to Istsqr using Rename. To
return to the original approximation, click on its name in List of approximations.

Smoothing Spline

This example experiments with smoothing splines:

1

Type splinetool at the command line or, if the GUI is already running, click on
File > Restart.

Choose Titanium heat data.
In Approximation method, choose Smoothing Spline.

Vary Parameter between 0 and 1, which changes the approximation from the least-
squares straight-line approximation to the “natural” cubic spline interpolant.

Vary Tolerance between 0 and some large value, even inf. The approximation
changes from the best possible one, the “natural” cubic spline interpolant, to the
least-squares straight-line approximation.

As you increase the Parameter value or decrease the Tolerance value, the error
decreases. However, a smaller error corresponds to more roughness, as measured by
the size of the second derivative. To see this, choose View > Show 2nd Derivative
and vary the Parameter and Tolerance values once again.

This step modifies the weights in the error measure to force the approximation to

pass through a particular data point.

+ Set Tolerance to 0.2. Notice that the approximation does not pass through the
highest data point. To see the large error at this site, choose View > Error.

+ To force the smoothing spline to go through this point, choose Error Weights
from Data, breaks/knots, weights.

Click on the highest data point in the graph and notice its site, which is indicated
in Sites and Values.
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Use the edit field beneath the list of weights to change the current weight to
1000. Notice how much closer the smoothing spline now comes to that highest
data point, and the decrease in the error at that site. Turn on the grid, by Tools >
Grid, to locate the error at that site more readily.

This step modifies the weights in the roughness measure to permit a more accurate
but less smooth approximation in the peak area while insisting on a smoother, hence
less accurate, approximation away from the peak area.

Choose Jumps in Roughness Weight from Data, breaks/knots, weights.
Choose View > Show 2nd Derivative
Select any data point to the left of the peak in the data.

Set the jump at the selected site to -1 by changing its value in the edit field below
it. Since the roughness weight for the very first site interval is 1, you have just set
the roughness weight to the right of the highlighted site to 0. Correspondingly,
the second derivative has become relatively small to the left of that site.

Select any data point to the right of the peak in the data.

Set the jump across the selected site to 1. Since the roughness weight just to the
left of the highlighted site is 0, you have just set the roughness weight to the right
of the highlighted site to 1. Correspondingly, the second derivative has become
relatively small to the right of that site. The total effect is a very smooth but not
very accurate fit away from the peak, while in the peak area, the spline fit is
much better but the second derivative is much larger, as is shown in the auxiliary
graph below.

At the sites where there is a jump in the roughness weight, there is a
corresponding jump in the second derivative. If you increase the Parameter
value, the error across the peak area decreases but the second derivative remains
quite large, while the opposite holds true away from the peak area.
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Bottomline:  splinet = spaps(xy [0.02 cumsum(diam)] weights);, % spaps is used to enforce specified tolerance; weights as shown
in Data display on left; diam are the jumps in roughness weight shown in Data display on left;

Tips

The Spline Tool is shown in the following figure comparing cubic spline interpolation
with a smoothing spline on sample data created by adding noise to the cosine function.
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Bottomline:  smoothsp = spaps(x vy 0.02); % spaps is used to enforce specified tolerance;

Approximation Methods

The approximation methods and options supported by the GUI are shown below.

Approximation Method Option

Cubic Interpolating Spline Adjust the type and values of the end conditions.

Smoothing Spline Choose between cubic (order 4) and quintic (order

6) splines. Adjust the value of the tolerance and/or
smoothing parameter. Adjust the weights in the error
and roughness measures.

Least-Squares Approximation |Vary the order from 1 to 14. The default order is 4, which
gives cubic approximating splines. Modify the number of
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Approximation Method Option

polynomial pieces. Add and move knots to improve the
fit. Adjust the weights in the error measure.

Spline Interpolation Vary the order from 2 to 14. The default order is 4, which
gives cubic spline interpolants. If the default knots
supplied are not satisfactory, you can move them around
to vary the fit.

Graphs

You can generate and compare several approximations to the same data. One of the
approximations is always marked as “current” using a thicker line width. The following
displays are available:

* Data graph. It shows:
* The data

+ The approximations chosen for display in List of approximations
The current knot sequence or the current break sequence

+ Auxiliary graph (if viewed) for the current approximation. You can invoke this graph
by selecting any one of the items in the View menu. It shows one of the following:

* The first derivative

The second derivative
* The error

By default, the error is the difference between the given data values and the value of the
approximation at the data sites. In particular, the error is zero (up to round-off) when the
approximation is an interpolant. However, if you provide the data values by specifying a
function, then the error displayed is the difference between that function and the current
approximation. This also happens if you change the y-label of the data graph to the name
of a function.

Menu Options
You can annotate and print the graphs with the File > Print to Figure menu.

You can export the data and approximations to the workspace for further use or analysis
with the File > Export Data and File > Export Spline menus, respectively.
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You can create, with the File > Generate Code menu, a function file that you can
use to generate, from the original data, any or all graphs currently shown. This file
also provides you with a written record of the commands used to generate the current
graph(s).

You can save, with the Replicate button, the current approximation before you
experiment further. If, at a later time, you click on the approximation so saved,
splinetool restores everything to the way it was, including the data used in
the construction of the saved approximation. This is true even if, since saving this
approximation, you have edited the data while working on other approximations.

You can add, delete, or move data, knots, and breaks by right-clicking in the graph, or
selecting the appropriate item in the Edit menu.

You can toggle the grid or the legend in the graph(s) with the Tools menu.

See Also

csape | csapi | csaps | spap2 | spapi | spaps
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splpp, sprpp

Taylor coefficients from local B-coefficients

Syntax

[v.,b] = splpp(tx,a)
[v,b] = sprpp(tx,a)
Description

These are utility commands of use in the conversion from B-form to ppform (and in
certain evaluations), but of no interest to the casual user.

[v.,b] = splpp(tx,a) provides the matrices v and b, both of the same size [r,k] as
a, and related to the input in the following way.

For i=1:r, b(i, :) are the B-coefficients, with respect to the knot sequence
[tx(i,1:k-1),0,...,0], of the polynomial of order k on the interval

[tx(i,k-1) .. tx(i,k)] whose k B-spline coefficients, with respect to the knot
sequence tx(i,:), arein a(i, :). This is done by repeated knot insertion (of the knot
0). It is assumed that tx (i ,k-1)<0<=tx (i, k).

For i=1:r, v(i, :) are the polynomial coefficients for that polynomial, i.e., v(i,j)
is the number D*7s(0-)/k —j)!, j=1:k, with s having the knots tx(i, :) and the B-
coefficients a(i, o).

[v,b] = sprpp(tx,a) carries out exactly the same job, except that now

b(i, :) are the B-coefficients for that polynomial with respect to the knot sequence
[0,...,0,tx(i,k: 2*(k-1))], and, correspondingly, V(i , j) is D*7s(0 + )/ — j)!,
J=1:k. Also, now it is assumed that tx(i,k-1)<=0<tx(i,k).

Examples

The statement [v,b]=splpp([-2 -1 0 1],[0 1 O]) provides the sequence
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v = -1.0000 -1.0000 0.5000 = D%s(0-)/2,Ds(0-),s(0-)

with s the B-spline with knots -2, -1, 0, 1. This is so because the I in splpp indicates the
limit from the left, and the second argument, [0 1 0], indicates the spline s in question
to be

s=0xB(|[?,-2,-L0D+1xB(- [[-2,-1,0,1)+ 0x B(- |[-1,0,1,7])

1.e., this particular linear combination of the third-order B-splines for the knot

sequence ..., -2, -1,0,1,... (Note that the values calculated do not depend on the knots
marked ?.) The above statement also provides the sequence b = 0 1.0000 0.5000 of
B-spline coefficients for the polynomial piece of s on the interval [-1. .0], and with respect
to the knot sequence ?, -2, -1, 0, 0, ?.

In other words, on the interval [-1. .0], the B-spline with knots 2, -1, 0, 1 can be written

0x B(-|[?,-2,-1,0]) +1x B(-|[-2,-1,0,0]) + 5x B(- |[-1,0,0,?])
The statement [v,b]=sprpp([-1 0 1 2],[1 O 0]) provides the sequence

v = [0.5000 -1.0000 0.5000] =D2%s(0+)/ 2, Ds(0+),s(0+)

with s the B-spline with knots ?,-1,0,1. Its polynomial piece on the interval [0..1] is
independent of the choice of ?, so we might as well think of ? as -2, i.e., we are dealing
with the same B-spline as before. Note that the last two numbers agree with the limits
from the left computed above, while the first number does not. This reflects the fact
that a quadratic B-spline with simple knots is continuous with continuous first, but
discontinuous second, derivative. (It also reflects the fact that the leftmost knot of a B-
spline is irrelevant for its right-most polynomial piece.) The sequence b = 0.5000 0O
0 also provided states that, on the interval [0. .1], the B-spline B(-|[?,-1,0,1]) can be
written

0.5x B(-|10,0,0,1D+0xB( |[0,0,1,2D) + 0 x B(- |[0,1,2,7])
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spmak

Put together spline in B-form

Syntax

spmak(knots, coefs)
spmak(knots, coefs,sizec)
spmak

sp = spmak(knots, coeffs)

Description

The command spmak(. . .) puts together a spline function in B-form, from minimal
information, with the rest inferred from the input. fnbrk returns all the parts of the
completed description. In this way, the actual data structure used for the storage of this
form is easily modified without any effect on the various fn. .. commands that use this
construct.

spmak(knots,coefs) returns the B-form of the spline specified by the knot
information in knots and the coefficient information in coefs.

The action taken by spmak depends on whether the function is univariate or
multivariate, as indicated by knots being a sequence or a cell array. For the description,
let sizec be size(coefs).

If knots is a sequence (required to be non-decreasing), then the spline is taken to be
univariate, and its order K is taken to be length(knots)-sizec(end). This means
that each “column' coefs(:,J) of coefs is taken to be a B-spline coefficient of the
spline, hence the spline is taken to be sizec(1:end-1)-valued. The basic interval of the
B-form is [knots(1) .. knots(end)].

Knot multiplicity is held to be < k. This means that the coefficient coefs(:,J) is
simply ignored in case the corresponding B-spline has only one distinct knot, i.e., in case
knots(J) equals knots(J+k).

If knots is a cell array, of length m, then the spline is taken to be m-variate, and coefs
must be an (r+m)-dimensional array, — except when the spline is to be scalar-valued,

12-273



12  Functions — Alphabetical List

12-274

in which case, in contrast to the univariate case, coefs is permitted to be an m-
dimensional array, but sizec is reset by

sizec = [1, sizec]; r = 1;

The spline is sizec(1:r)-valued. This means the output of the spline is an array with
r dimensions, e.g., if sizec(1:2) = [2, 3] then the output of the spline is a 2-by-3
matrix.

The spline 1s sizec(1:r)-valued, the ith entry of the m-vector K is computed as
length(knots{i}) - sizec(r+i), i=1:m, and the ith entry of the cell array of basic
intervals is set to [knots{i}(1), knots{i}(end)].

spmak(knots, coefs,sizec) lets you supply the intended size of the array coefs.
Assuming that coefs is correctly sized, this is of concern only in the rare case that
coefs has one or more trailing singleton dimensions. For, MATLAB suppresses trailing
singleton dimensions, hence, without this explicit specification of the intended size of
coefs, spmak would interpret coefs incorrectly.

spmak prompts you for knots and coefs.

sp = spmak(knots, coeffs) returns the spline sp.

Examples

spmak(1:6,0:2) constructs a spline function with basic interval [1. .6], with 6 knots
and 3 coefficients, hence of order 6 - 3 = 3.

spmak(t, 1) provides the B-spline B(:|t) in B-form.

The coefficients may be d-vectors (e.g., 2-vectors or 3-vectors), in which case the resulting
spline is a curve or surface (in R? or R?).

If the intent is to construct a 2-vector-valued bivariate polynomial on the rectangle [-1..1]
x [0..1], linear in the first variable and constant in the second, say

coefs = zeros([2 2 1]); coefs(:,:,1) = [1 0;0 1];
then the straightforward

sp = spmak({[-1 -1 1 1],[0 1]}.,coefs);
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will result in the error message "There should be no more knots than
coefficients”, because the trailing singleton dimension of coefs will not be perceived
by spmak, while proper use of that third argument, as in

sp = spmak({[-1 -1 1 1],[0 1]},coefs,[2 2 1]);
will succeed. Replacing here [2 2 1] by size(coefs) would not work.

See the example “Intro to B-form” for other examples.

Diagnostics

There will be an error return if the proposed knot sequence fails to be nondecreasing, or
if the coefficient array is empty, or if there are not more knots than there are coefficients.
If the spline is to be multivariate, then this last diagnostic may be due to trailing
singleton dimensions in coefs.

See Also

fnbrk
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Explain spline terms

Syntax

spterms(term)
expl = spterms(term)
[---,term] = spterms(...)

Description

spterms(term) provides, in a message box, an explanation of the technical term
indicated by the character vector term as used in the Curve Fitting Toolbox spline
functions and, specifically, in the GUI splinetool. Only the first few (but at least two)
letters of the desired term need to be specified, and the full term is shown in the title of
the message box.

expl = spterms(term) returns, in expl, the character vector, or cell array of
character vectors, comprising the explanation of the desired term.

[--.,term] = spterms(...) alsoreturns,in term, the fully spelled-out term
actually used.

Examples

spterms("sp”) gives an explanation of the term “spline', while spterms("spline i")
explains the terms “spline interpolation’'.

help spterms provides the list of all available terms.

See Also

splinetool
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Topics
“List of Terms for Spline Fitting” on page A-2
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stcol

Scattered translates collocation matrix

Syntax

colmat = stcol(centers,Xx,type)
colmat = stcol(...,"tr")

Description
colmat = stcol(centers,Xx,type) isthe matrix whose (i,j)th entry is
vj(x(,0), i=1:size(x,2),j=1:n

with the bivariate functions y; and the number n depending on the centers and the
character vector type, as detailed in the description of stmak.

centers and X must be matrices with the same number of rows.

The default for type is the character vector "tp*®, and for this default, n equals
size(centers,2), and the functions y; are given by

v j(x) =y (x—centers(:,j)), j=1:n
with / the thin-plate spline basis function

¥ (@) =]« log|x|®

and with |x| denoting the Euclidean norm of the vector x.

Note See stmak for a description of other possible values for type.
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The matrix colmat is the coefficient matrix in the linear system

Zajl//j(x(:,i)) =y;, i=1:size(x,2)
J

that the coefficients a; of the function f = Xa;; must satisfy in order that f interpolate the
value y; at the site x(:, 1), all 1.

colmat = stcol(...,"tr") returns the transpose of the matrix returned by
stcol (...).

Examples

Example 1. The following evaluates and plots the function

fl)=y(x—cp) +y(x—cy) +y(x —c3) - 3.5y(x)

on a regular mesh, with i the above thin-plate basis function, and with ¢y, ¢s, c3 three
points on the unit circle; see the figure below.

a = [0,2/3*pi,4/3*pi]; centers = [cos(a), 0; sin(a), 0];
[xx,yy] = ndgrid(linspace(-2,2,45));

xy = [xXx(:) yy(:)1-";

coefs = [1 1 1 -3.5];

zz = reshape( coefs*stcol(centers,xy, "tr") , size(Xx));
surf(xx,yy,zz), view([240,15]), axis off
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Example 2. The following also evaluates, on the same mesh, and plots the length of the
gradient of the function in Example 1.

zz = reshape( sqrt(...
([coefs,0]*stcol (centers,xy, "tpl0~,"tr*))."2 + ...
([coefs,0]*stcol (centers,xy, "tr","tp0l*))."2),
size(xx));
figure, surf(xx,yy,zz), view([220,-15]), axis off

See Also

spcol | stmak
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stmak

Put together function in stform

Syntax

stmak(centers,coefs)

st = stmak(centers,Xx, type)

st = stmak(centers,coefs, type, interv)

Description

stmak(centers,coefs) returns the stform of the function f given by
n

f(x)= z coefs(:, j) -y (x —centers(:, j))

j=1

with

v (@) =« log|x|®

the thin-plate spline basis function, and with |x| denoting the Euclidean norm of the
vector x.

centers and coefs must be matrices with the same number of columns.

st = stmak(centers,Xx,type) storesin st the stform of the function f given by

flx)= 2 coefs(:, j) -y ;(x)
=l

with the y; as indicated by the character vector type, which can be one of the following:
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* "tp00°", for the thin-plate spline;
* "tpl0", for the first derivative of a thin-plate spline wrto its first argument;
+ "tp01-", for the first derivative of a thin-plate spline wrto its second argument;

* "tp", the default.

Here are the details.

"tp00* wi(x) = o(lx —¢;|?), ¢c;=centers(:,j), j=1:n-3
with @(?) = tlog(?)

Wn2(x) = x(1)

Yn-1(x) = x(2)

Walx) =1

"tpl0o*” wix) = o(lx—¢;|?), ¢c;=centers(:,j), j=1:n-1
with @(f) = (D1t)(logt + 1), and D;t the partial derivative of ¢ = t(x) = | x — ¢;| 2
wrto x(1)

wa(x) =1

"tp01-” wix) = o(lx—¢;|?), ¢c;=centers(:,j), j=1:n-1

with @(t) = (Dst)(logt + 1), and Dst the partial derivative of ¢t = t(x) = |x —¢; 2

wrto x(2)
Walx) =1
“tp*© wix) = o(lx—¢;|?), ¢c;=centers(:,j), j=1:n

(default)

with @(f) = tlog(t)

st = stmak(centers,coefs,type, interv) also specifies the basic interval for the
stform, with interv{j} specifying, in the form [a,b], the range of the jth variable. The
default for interv is the smallest such box that contains all the given centers.

12-282



stmak

Examples

Example 1. The following generates the figure below, of the thin-plate spline basis

function, v (x) = |x|2 10g|x|2, but suitably restricted to show that this function is negative

near the origin. For this, the extra lines are there to indicate the zero level.

inx = [-1.5 1.5]; iny = [0 1.2];
fnplt(stmak([0;0],1),{inx,iny})
hold on, plot(inx,repmat(linspace(iny(1),iny(2),11),2,1),"r")
view([25,20]),axis off, hold off

Example 2. We now also generate and plot, on the very same domain, the first partial
derivative Doy of the thin-plate spline basis function, with respect to its second

argument.

inx = [-1.5 1.5]; iny = [0 1.2];
fnplt(stmak([0;0],[1 0], "tp0ol®,{inx,iny}))
view([13,10]),shading flat,axis off

Note that, this time, we have explicitly set the basic interval for the stform.
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The resulting figure, below, shows a very strong variation near the origin. This reflects

the fact that the second derivatives of ¢ have a logarithmic singularity there.
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See Also

stcol
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subplus

Positive part

Syntax

Xp = subplus(x)

Description
xp = subplus(x) returns (x)., i.e., the positive part of X, which is X if X is nonnegative

and 0 if X is negative. In other words, Xp equals max(x,0). If X is an array, this
operation is applied entry by entry.

Examples

Example 1. Here is a plot of the essential part of the subplus function, as generated by

X = -2:2; plot(x,subplus(x),"linew",4), axis([-2,2,-.5,2.5])

25

151

0.5r

-0.5,

Example 2. The following anonymous function describes the so-called hat function:

hat = @(x) subplus(x) - 2*subplus(x-1) + subplus(x-2);
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i.e., the spline also given by spmak(0:2,1), as the following plot shows.

X = -.5:.5:2_.5; plot(x,hat(x),"linew",4), set(gca, "Fontsize",16)
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0.4r
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0.2r

0.1r

Q
-0.5 25
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titanium

Titanium test data

Syntax

[x,y] = titanium

Description

[x,vy] titanium returns measurements of a certain property of titanium as a
function of temperature. Since their use in “References” on page 12-288, these data
have become a standard test for data fitting since they are hard to fit by classical
techniques and have a significant amount of noise.

Examples

The plot of the data shown below is generated by the following commands:

[x.vy]l

titanium; plot(x,y,"ok"), set(gca, "Fontsize",16)
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References

C. de Boor and J. R. Rice, Least squares cubic spline approximation II - Variable knots,
CSD TR 21, Comp.Sci., Purdue Univ., April 1968.
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tpaps

Thin-plate smoothing spline

Syntax

tpaps(x,y)
tpaps(x.y.p)

[---.p] = tpaps(.-.)
Description

tpaps(X,y) is the stform of a thin-plate smoothing spline f for the given data sites
X(:,]J) and the given data values y(:,j). The X(:,J) must be distinct points in the
plane, the values can be scalars, vectors, matrices, even ND-arrays, and there must be
exactly as many values as there are sites.

The thin-plate smoothing spline f is the unique minimizer of the weighted sum

pE(f)+1 - p)R(f)

with E(f) the error measure

E(f) =3 |y, )~ (2, )
J

and R(f) the roughness measure

2
R(f) = [(DyDy f[” +2|Dy Dyff +DyDy )

Here, the integral is taken over all of R?, | z|? denotes the sum of squares of all the
entries of z, and D;f denotes the partial derivative of f with respect to its ith argument,
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hence the integrand involves second partial derivatives of f. The smoothing parameter

p is chosen so that (1-p)/p equals the average of the diagonal entries of the matrix

A, with A + (1-p)/p*eye(n) the coefficient matrix of the linear system for the n
coefficients of the smoothing spline to be determined. This choice of p is meant to ensure
that we are in between the two extremes, of interpolation (when p is close to 1 and the
coefficient matrix is essentially A) and complete smoothing (when p is close to O and the
coefficient matrix is essentially a multiple of the identity matrix). This should serve as a
good first guess for p.

tpaps(X,y,p) alsoinputs the smoothing parameter, p, a number between 0 and 1. As
the smoothing parameter varies from O to 1, the smoothing spline varies, from the least-
squares approximation to the data by a linear polynomial when p is O, to the thin-plate
spline interpolant to the data when p is 1.

[---.p] = tpaps(.-..) alsoreturnsthe smoothing parameter actually used.

Examples

Example 1. The following code obtains values of a smooth function at 31 randomly
chosen sites, adds some random noise to these values, and then uses tpaps to recover
the underlying exact smooth values. To illustrate how well tpaps does in this case, the
code plots, in addition to the smoothing spline, the exact values (as black balls) as well as
each arrow leading from a smoothed value to the corresponding noisy value.

rng(23); nxy = 31;

xy = 2*(rand(2,nxy)-.5); vals = sum(xy.”"2);

noisyvals = vals + (rand(size(vals))-.5)/5;

st = tpaps(xy,noisyvals); fnplt(st), hold on

avals = fnval(st,xy);

plot3(xy(1,:),xy(2,:),vals,"wo", "markerfacecolor”, "k")

quiver3(xy(1,:),xy(2,:),avals,zeros(1,nxy),zeros(1,nxy),
noisyvals-avals, "r*), hold off
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Example 2. The following code uses an interpolating thin-plate spline to vector-valued
data values to construct a map, from the plane to the plane, that carries the unit square
{x: |x(G)| <1,j=1:2} approximately onto the unit disk {x : x(1)* + x(2)*> < 1} , as shown by
the picture generated.

n = 64; t = linspace(0,2*pi,n+l); t(end) = [];
values = [cos(t); sin(t)]:

centers = values./repmat(max(abs(values)),2,1);
st = tpaps(centers, values, 1);

fnplt(st), axis equal
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Note the choice of 1 for the smoothing parameter here, to obtain interpolation.

0.8

0.6

0.4r

0.2

Limitations

The determination of the smoothing spline involves the solution of a linear system with
as many unknowns as there are data points. Since the matrix of this linear system is
full, the solving can take a long time even if, as is the case here, an iterative scheme is
used when there are more than 728 data points. The convergence speed of that iteration
is strongly influenced by p, and is slower the larger p is. So, for large problems, use
interpolation, i.e., p equal to 1, only if you can afford the time.

See Also

csaps | spaps
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type

Name of cFit, sFit, or Fittype object

Syntax

name = type(fun)

Description

name = type(fun) returns the custom or library name name of the cfit, sfit, or

Fittype object fun as a character array.

Examples

T = Fittype("a*x"2+b*exp(n*x)");
category(f)

ans =

custom

type(f)

ans =

customnonl inear

g = fittype(“fourierd4®);
category(Q)

ans =

library

type(9)
ans =
fourier4

See Also

fittype | category

Topics

“List of Library Models for Curve and Surface Fitting” on page 4-13
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Introduced in R2006b
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